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E l ő s z ó  
 
 

 
A jó tervezés és a kiváló mérnöki munka alapvető az üzleti tevékenységben. A CAD-alapú tervezés 

alapvető eszköze a jó tervezésnek, a gyártásnak és az építészetnek. CAD tanulás a tervezéshez, a 

rajzoláshoz népszerűvé vált, beleszámítva azokat az embereket is akik kevesebbet tudnak a 

számítógép kezeléséről, mint a diákság vagy a háziasszonyok, akiknek kevesebb jártasságuk van a 

modern asztali számítógépek kezelésében.   A bevezető tankönyvek ezen a területen gyakran adnak 

nyakatekert leírást a témákról. Ezenfelül, a rajzolási alapelvek, valamint az elvek mögött a szabályok 

nem írják le a gépek gyártási folyamatát vagy az épületek építését.  A CAD alapú tervezés, anélkül 

hogy a rajzolás alapvető szabályait alkalmazná,  amely inkább a képek festéséhez hasonlítható, 

ehelyett a gépek szerkezetét vagy az építészetben a bonyolult épületek struktúráját  jeleníti meg. 

Viszont az effajta CAD tervezés nem segít a gépek gyártásánál, vagy az épületek szerelésénél. A 

CADian kézikönyv bemutatja a CAD rajzolást és ehhez további számos példát tartalmaz még.  

A különböző alkalmazói programok amelyeket a CADian motorja háttérben támogat, alapját képezi 

annak, hogy kihasználja a könyvtárak szabványos alkatrészeit a gépészeti rajzokhoz, hogy használja a 

CAM-et, építészetet, belsőépítészetet, villamos tervezést, üzemi és térképészeti tervezést. 

Kihasználva az alapfunkciókat, lerövidítheti a tervezési időt, például a darabjegyzék (BOM, bill of 

material) alkalmazásával. Ebben a kézikönyvben, kezdő CAD tervezők számtalan paranccsal, 

beállítással találkoznak, továbbá megtanulják használni is őket. A tapasztalt CAD tervezők 

értékelhetik a sok kiváló CADian program funkciót, és értékelhetik a Lisp nyelvet is. Mind a CADian 

mind az AutoCAD hasonló parancsokat és billentyű parancsokat támogatnak.  Azok a tervezők akik 

jártasságot szereztek a CADian-ban könnyebben tudják használni az  AutoCAD-et. Az AutoCAD  

vagy Microstation tudással rendelkező szakemberek külön tanulmányok nélkül könnyen 

rákapcsolódhatnak a CADian-ra.  Reméljük a kézikönyv segít a tanulmányaiban és a 

tájékozódásában. A kéziköny tartalmazhat néhány elírást, hiányosságot, és bizonyára híjján lehet a 

kifinomultságnak is.  A kézikönyv szerzői értékelik minden visszajelzést és kritikát az olvasók 

részéről. A korrekciók és átdolgozások majd egy későbbi kiadásban jelennek meg. Köszönjük a 

számos CADian felhasználónak, hogy támogatták, valamint nagyra értékeljük a Book Media 

segítségét, hogy kiadta a kézikönyvet. 

  

 

 
2012. december 1. 

Paul  H.  Park 

cadian@cadian.com 
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Bevezetés a CADian-ba 
 
 
 
 
 
 
 
 

   A következő témákat fogjuk tárgyalni a fejezetben: 
 

•  A CADian 2012-ről                           •  CAD felhasználási területek 

•  A  CAD használat előnyei                •  CADian 2012 elkezdése 

•  CADian 2012 felhasználói felület    •  Parancsok elérése, végrehajtása 

•  Parancs kiválasztás opciók        •  Új rajzfájl léztehozása 

•  Mentés és kilépés                            •  Rajzi segédletek 
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CADian 2012 
 

 
 
 

01 Bevezetés a CADian-ba 
 

 

1.1 Mi a CADian? 
 
 
 

A CADian 2012 egy 2D/3D szoftver, amely lehetővé teszi a felhasználónak, rajzokat készítsen ipari 

ágazatonként, mint építészet, épületgépészet, villamos és építészeti területek felhasználva a Microsoft 

Windows GUI (grafikus felhasználói felület) környezetet.  Az AutoCAD-éhez hasonló eszközökről 

gondoskodik, mint a parancsok, fájl(DWG), vonaltípus, sraff minta és szövegtípus, továbbá jó adat 

kompatibilitásról. Az említettek lehetővé teszik a tervező mérnököknek, hogy könnyen megtanulják és 

használják.    
 
 
 

❏ Főbb funkciók 

 

•  Kiváló kompatibilitás az AutoCAD-del  (összes verzió) 

•  Az   AutoCAD-hez hasonló parancsok  és a DWG használata 

•  Támogatja az AutoLISP,  VBA, ADS(SDS a CADian-ban) és ARX(IRX a CADian-ban) 

•  Gondoskodik az AutoCAD menüről (MNU), párbeszéd ablakokról(DCL),  szkriptről (SCR), 

szimbólum könyvtárról 

•  Az  AutoCAD-éhez hasonló munkakörnyezet 

•  Támogatja az AutoCAD álneveket és import eszközöket  

•  Támogatja a 3D szilárdtest (ACIS  3D) modellezést 

•  Támogatja a  3DS (Autodesk 3D Studio  fájl formátum)  fájlolvasást 

•  Támogatja a hálózati verziót (csak a Professional) 

•  Különböző alkalmazói program támogatás  
 
 

•  Építészet •  Lézesítmény tervezés 

•  Építőmérnöki/földmérés  •  Üzem elrendezés 

•  Bútortervezés/belsőépítészet •  Gépészet/megmunkálás 

•  Fejlesztési, technikai ábrák •  NC megmunkálás támogatás 

•  Villamos tervezés •  Vektorizálás 

•  3D szilárdtest modellezés Pr
ó

ba
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1.2 CAD az ipari területeken 
 

 
 

•  Építészet /  Építőmérnöki tervezés 

•  Villamos  /  elektronikai tervezés 

•  Gépészeti tervezés (auto, repülő, hajó, stb...) 

•  Kerttervezés 

•  Térképészet 

•  Ipar /  belsőépítészet /  terméktervezés 

•  Szimuláció  (katonai,  tudomány,  etc...) 

•  Animáció  (mozi, reklám,  stb...) 

•  Mérnöki rajzok 
 
 

 
 

 

 

A CAD felhasználható az Arch, Civil, GIS/MAP, Car, Aero, Ship, Plant  és különböző Mech design  

projektekhez.  Részben használható a félvezető,  PCB és az elektronikai iparban. 
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Napjainkban nem csak 2D tervezéshez használják, hanem 3D-re is, és kiterjesztik különféle 

szimulációkhoz, valamint fejlett számítógépes grafikát alkalmazva az animációkhoz is.    
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1.3 A  CAD használat előnyei 

 Idő megtakarítás 

  Rugalmas  (részek szerkeszthetők,  újra 

használható) 

  Magas minőség mellett kevés hiba 

  Megbízható 

  Versenyképes 

  Költség érzékeny 

  Szabványosítható 

  Csökkenti a kifizetés idő intervallumait 

CAD(Computer  Aided  Design - Számítógéppel támogatot tervezés) 

CAD-et azért vezették be, hogy fejlett számítógépes számításokra használják,  az alkalmazói eszközökkel 

megcsinálja a tervezési projekteket, vizualizálja az általános tervezési elképzeléseket a koncepcionális 

tervezéstől a részletes tervezésig, valamint különböző beállításokat megadva automatikusan tervezzen, 

elemezzen. 

CAD- jelentése a Computer  Aided  Drafting  amely csupán kreatív tervezést jelent, de használják 
számítógépes rekurzív adatkezelés eszközökhöz, hogy megrajzolják a szükséges munkát mértani módszerekkel. 
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CADian 2012 

1.4 Rendszer követelmények 

CADian 2012  a következő rendszerkörnyezetben alkalmazható. 

Szükséges rendszer specifikáció 

A fent bemutatott környezet  minimum rendszer leírás. Akinek 3D modellezés szükséges az fejlettebb 

rendszer környezetet alakítson ki.  

18 

Eszközök  Követel,ények 

CPU Intel®  i5  vagy i7  / AMD®  processzor 

 

Memória (RAM)  4GB vagy nagyobb  (javasolt  8  Gb) 

 

VGA Megjelenítő 1024  x 768  vagy nagyobb 

 

HDD 50GB szabad hely vagy nagyobb  

 

ODD DVD-ROM  meghajtó 

 

Input  eszköz Microsoft  kompatibilis  egér mutató 

 

Op. rendszer Microsoft  XP  Professional,  (javasolt  Windows  7/8 Pro) 

Internet  kapcsolat a web letöltéshez és a regisztrációhoz 

Internet  

Microsoft  Internet  Explorer®  6-tól(SP2)  

 

Nyomtató eszköz Plotter  vagy nyomtató  amely  A3-s oldalt tud nyomtatni 
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02 A CADian 2012 elkezdése 

2.1 A CADian  2012 indítása 

  Klikk (start)  gomb. 

  Klikk [összes program]. 

  Klikk [CADian  2012]. 

  Klikk [CADian  2012  

Professional]. 

  VAGY dupla klikk (CADian 2012) ikonra az asztalon 

  VAGY dupla kattintás a rajzra (*.DWG) a fájlkezelőben.  
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03 CADian 2012   Felhasználói felület  

Kiinduló rajz 

Mint fent,  a kiinduló rajz egy üres rajzra hívatkozik egy előre megadott  alapbeállításokkal, mint a 
mértékegységek és  keretek. 
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Tap- fül, Application menü - alkalmazási menü, Quick access toolbar - gyors elérésű eszköztár, Titel bar - 
címsor,  Statusbar - állapotsor, crossbar - szálkereszt  

such  as  Units  and  Limits. Pr
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CADian Introduction   01 

3.1 Felhasználói menü 

Az új CADian gondoskodik a Microsoft  Windows  Interface eszközről,  amely tartalmazza a   

felhasználói menüt,  a gyors elérésű eszköztárat és a szalag menüt.  

A fő menü a CADian 2012-ben  a szalag interfész menü.  Van egy 

(felhasználói program) menü  gomb  a bal felső sarokban.  Ez  megváltoztatja a  hagyományos menü 

struktúrát, amely az előző verziókban voltak, és lehetővé teszi a felhasználóknak, hogy gyorsan elérjék a 

leggyakrabban használt parancsokat, ezt egy vízsztintes interfész menü szolgáltatja.  

Kattintás         az  Application  Program(C) gombra a bal felső sarokban a következő opciókhoz:   új, 

 megnyitás, mentés, nyomtatás,  rajz eszközök,  stb.  Amely lehetővé teszi, hogy a felhasználó gyorsan 

dolgozzon. 

 NEW,  OPEN vagy SAVE  (Új, megnyitás vagy mentés) 

 Rajz exportálás különféle típusban  (EXPORT) 

 Rajz nyomtatás (PLOT) 

 Audit  fájl (AUDIT),  visszaállítás (RECOVER)  vagy tisztítás (PURGE) 

 Find file  :  jelenlegi dokumentumok 

 Call CADian option  toolbar  (OPTIONS) 

 Close Drawing,  Rajz lezárás rész vagy  Exit, kilépés  a  CADian-ból 
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CADian 2012 

3.2  Gyorselérésű eszköztár 

A gyorselérésű eszköztár (Quick access toolbar) a bal felső sarokban van  és tartalmazza a 

leggyakrabban használt parancsokat , mint  egy felhasználói menü. Ez két típust és leírást tartalmaz, 

amelyek a következők:  

 Amikor nincs rajz megnyitva, a gyors (Quick Access Toolbar) elérésű eszköztár csak az új, a 

megnyitás és a visszaállítás ikonokat tartalmazza, mint ahogy lentebb látható.  

  Amikor egy rajz meg van nyitva,  a gyorselérésű eszköztár (Quick Access Toolbar) az új, a megnyitás, 

mentés,  undo, redo, a plot ikonokat mutatja, mint ahogy lentebb látható. 

 

Ezek fontos eszközök, amely szükségesek a rajz megnyitásahoz és lezárásahoz. 

22 

Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

CADian Introduction   01 

 A gyors elérésű eszköztár testre szabása   Add/Remove  ikonok 

Amikor (kirepülő)  gombra kattint a gyorselérésű eszköztár jobb oldalán  a gyors elérésű 

eszköztár menüje jelenik meg, mint a lenti ábra szerint.  

Ha jelölt a parancs bal oldala  mint, ahogy a Customize  Quick Access  Toolbar  mutatja  

fent,  ez azt jelenti, hogy a jelöltet  hozzáadjuk  a gyors elérésű eszköztárhoz.   

Ha  nem jelölt a parancs,  ez azt jelenti, hogy a parancsot nem tartalmazza a gyors elérésű 

eszköztár.   

A felhasználó átjelölheti egy kattintással az ellenőrző jelet a parancs nevénél, hogy eltávolítsa a 

parancsot a gyors elérésű eszköztárból.  

Másfelől,  a felhasználó jelölheti az ellenőrző jellel, hogy a parancsot hozzáadja a gyors elérésű 

eszköztárhoz. 

Toolbar. 
Végezetül,  a Quick Access Toolbar  testreszabása a menü átkapcsolgatását jelenti.  

23 

Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

 
 

 
 

 
 

CADian 2012 

3.3 Legördülő menü 

Mostanáig, a fő menü a CAian-ban legördülő menü volt;  azonban mostmár nem az, hanem a szalag 

menü a fő menü, bár a legördülő menü tartalmazza a a legtöbb parancsot 

Amikor egy parancs csoport címére rákattint, egysorban lévő legördülő menü soron a  'Quick Access Toolbar'  

menü alatt, akkor az almenü megjelenik. 

Az almenü  CADian parancsokat tartalmaz, amely azonnal fut mihelyst rákattint.   

Az almenü jobb oldalán  a háromszög ( )  jel mutatja azt, hogy létezik egy másik almenü,  mint ahogy az 

alábbi kép mutatja, amikor rákattintunk.  

Például,  amikor a felhasználó rákattint [View(V)]     [Disply(L)]     [UCS Icon(U)]   [On/Off(O)]   

legördülő menüre sorrendben, hogy az UCS Icon meg legyen jelenítve az ablak bal alsó sarkában, vagy el 

legyen távolítva onnan.  
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CADian Introduction   01 

3.4 Szalag menü 

CADian 2012  gumiszalag menüvel rendelkezik mint főmenü. A gumiszalag menü egy eszköz, amelyet 

a Windows 7 grafikája alkalmaz a füleken és panelokban lévő parancsok gyors meghívásához. 

Ikonokkal lehet a parancsokat futtatni, amelyet a  Microsoft   window alkalmazói programok 

felhasználói interfészén keresztül érünk el a legördülő menükkel ellentétben.    

 

A CADian egy window alkalmazói program amely legördülő menüként van beállítva, a lenti képhez 

hasonlóan.  

 

 Amikor a fül nevére kattint, amely a szalag menü tetején helyezkedik el,   a panel olyan fület jelenít 

meg, amely csoportba szedett funkcióktól függő parancs ikonokat tartalmaz. 

Tehát, amikor 'HOME' (Kezdőlap) fülre kattint, a  panel azonnal megjeleníti a ’RIBBON’,  (Szalag) 

'DRAW',  (Rajz)  'MODIFY', (Módosítás) 'PROPERTIES' (Tulajdonságok),  'ANNOTATION' 

(Feliratozás),  'BLOCK'  (Blokk) és a  'CLIPBOARD'  (Vágólap) paneleket. Mindegyik panel 

csoportba szervezett parancs ikonokat tartalmaz.  

 Számos panel tartalmaz további  hasznos parancsokat.  Amikor a     ( ) kirepülő gombra kattint a 

panel   
jobb sarkában. Ez megjeleníti az idevonatkozó eszköz palettát vagy a dialógus dobozt, mint ahogy a 

képen látszik.   

below. 
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CADian 

2Szalag menü 

minimalizálás

a a fülhöz 
012 Szalag menü minimalizálása a fülhöz 

A felhasználó kattinthat 

 a kirepülő gombra  a jobb felső sarokban, hogy minimalizálja a    a szalag menüt, amely lehetővé teszi a felhasználónak, hogy   maximalizálja a rajzterületet. 

A felhasználó megint kattinthat 

gomb  kapcsolhatóvá teszi a szalag menüt, amellyel  

a kirepülő gombra, hogy  megjelenítse a szalag menüt. Ez a kirepülő 

minimalizálhatja vagy maximalizálhatja. 
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CADian InRajz ablak 

(Graphic  Window/ 

Drawing  Tab) ahol a 

felhasználó tervez,  

ahol az entitások és az   

objektumok 

megjelennek.   Nagy 

rajz ablakot használva 

a felhasználónak segít, 

hogy maximalizálja a 

tervezés hatékonyságát, 

hogy előnyösen 

használja a nagy rajz 

ablakot, ha nem akar 

különféle rajzoló 

eszközöket, parancs 

sorokat, nagyító 

kicsinyítő, eltolás 

eszközöket  

megjeleníteni.  
troduction 

01 

3.5 Rajz ablak 

Rajz ablak (Graphic  Window/ Drawing  Tab), ahol a felhasználó tervez,  ahol az entitások és az   

objektumok megjelennek.   Nagy rajz ablakot használva a felhasználónak segít, hogy maximalizálja a 

tervezés hatékonyságát, hogy előnyösen használja a nagy rajz ablakot, ha nem akar különféle rajzoló 

eszközöket, parancs sorokat, nagyító kicsinyítő, eltolás eszközöket  megjeleníteni.  
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3.6 Felhasználói koordináta rendszer (UCS) ikon 

UCS ikon a bal alsó sarokban van elhelyezve.  Az  X,  Y,  Z nyilak az irányokat mutatja a  3D térben, 

amely megmutatja, hogy hogyan helyezkedik el az objektum az aktív nézetben.   UCS ikon megmutatja a  3D 

síkokat és az abszolult kezdőpontot  (0,0,0) a felhasználó részére a rajzon. Az abszolút origó egy fix pont, 

amelyet soha nem lehet módosítani. UCS ikon fontos szerepet játszik a 3D rajzolásban. 
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CADian Introduction 01 

Az UCSICON parancs  vezérli és pozícionálja az  UCS ikont. 

Parancs: UCSICON 

ON/OFF/All/Noorigin/ORigin/<ON>: 

3.7 Parancs ablak 

Általában a parancs ablak (Command  Window) lent helyezkedik el. 

Command Window az, ahol a felhasználó a tervezés során a CADian-nal kommunikál.  A felhasználó 

parancsokat gépel angolul, a billentyűzetet használva, és a CADian megjeleníti a parancs beállításokat vagy 

a folytatáshoz promptokat ad a felhasználó részére.  

Ezért a felhasználó valójában nem nélkülözheti a parancsablakot. Ha a felhasználó mindent ért a 

megjelenített parancs ablakban, nem lesz érdekes számára, hogy elolvassa vagy tanulmányozza ezt a 

könyvet.  
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Opció Leírás 

 

ON Megjeleníti az  UCS ikont. 

 

OFF Kikapcsolja az  UCS ikont. 

 

All Megváltoztatott beállítások alkalmazása az aktív nézetablakokban.  

 

Noorigin Rögzíti az UCS ikont a lenti bal sarokban,  nem törödve azzal hol helyezkedik el az origó.  . 

 

ORigin Az  UCS ikon  elhelyezése az  origóban (0,0,0) a meglévő koordináta rendszerben. 
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CADian 2012 

Az entitások vagy az objektum tulajdonságok megjelenítéséhez az Inquiry (Lekérdezés) parancsokat 

használjuk. Nyomja meg az F2-t, hogy megnézze 

CADian 2012  prompt 
a történeti fájlt. 

 

Parancs: CMDBAR 

Floating/Lower/Upper/<Hide  Command  Bar>: 

30 

Opció Leírás 

Floating Feloldja a  Command  Bar-t..Mozgatható az egér jobb gombjára kattintva.  

 

Lower A Command  Bar mozgatása az ablak alsó részére. 

 

Upper  A Command  Bar mozgatása az ablak felső részére. 
  

Hide  Command  Bar A  Command  Bar elrejtése 

 

Show  Command  Bar Command  Bar megjelenítése Pr
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CADian Introduction 01 

Command  Window megjelenítése/ Elrejtése 

 

Kattintás [Tools]    [Command  line]  (Parancs sor) a legördülő menün. 

A parancs ablak eltünik a rajzból. 

 

 Kattintás [Tools]    [Command  line]  (Parancs sor) a legördülő menün. 

 Újra, a parancs ablak megjelenik a rajzban. 

 

Gépelés CMDBAR és F a parancs soron. 

Parancs: CMDBAR 
 

Floating/Lower/Upper/<Hide  Command  Bar>: F 

A Parancssor mozgatható lesz, hogy a felhasználó átmozgathassa  bármelyik ideiglenes helyre 

a Parancssorra kattintva, és a jobb egér gombot használva. A felhasználó rögzítheti a Parancs- 

sort a jelre kattintva a lenti kép szerint.  
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CADian 2012 

3.8 Állapot eszköztár (Status  Toolbar) 

A Status  eszköztár lehetővé teszi, hogy a felhasználó kezelje a segéd eszköztárat a kurzor koordináta 

helyek beállításait, további beállítások státuszait.     

 

Amikor mindegyik segéd-eszközre rákattintott a jobb egérgombbal,  a parancsikon menü megjelenik az 

alábbi kép szerint. A felhasználó beállíthatja vagy szerkesztheti a beállítási státuszokat.  

 

Ha a felhasználó a Státusz soron a Ready-re kattint a jobb egérgombbal, akkor eltávolíthat vagy 

hozzáadhat a segéd eszközökhöz.  

the  sub-tool. 
Ha
a 

kijelölés kerül a név elé, akkor a segéd eszköz megjelenítésre kerül a státusz soron.   
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CADian Introduction 01 

Rajz támogató eszközök beállítása a Státusz soron 

Jobb egérgomb kattintás a  'ENTITY  SNAP'  kapcsoló gombra  a Státusz soron, ezt követően   

megjelenik a lenti képnek megfelelően. Kattintson a 'Settings'-re (Beállításokra)  a folytatáshoz. 

Jobb egérgomb kattintás a koordináta megjelenítés jobb oldalára a Státusz soron, hogy 

megnyissa a parancsmenüt a lenti képnek megfelelően. 

 
A következő képen; 

 Jelölt lista megjelenítése a Státusz soron. 

 Kattintás a  jelölt listára, hogy eltávolítsuk a Státusz sorról. 

 Kattintás a  jelöletlen listára, hogy hozzáadjuk a Státusz sorhoz. 
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CADian 2012 

Parancssort és állapotsort Megmutat/Elrejt  

Jobb egérgomb kattintás a szalag üres területére a parancs menü megjelenítéséhez a lenti kép 

ábrája szerint. 

 

 Jelölt lista megjelenítése a rajzban. 

 Kattintás a  jelölt listára, hogy eltávolítsuk a rajzból. 

 Kattintás a  jelöletlen listára, hogy hozzáadjuk a rajzhoz. 
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CADian Introduction 01 

Kapcsoló gombok és  eszköz leírások 

Ortogonális mód kapcsolása 
(F8) 

Objektum követés átkapcsolása 
(F11) 

versa 

gomb 

35 

Parancs/eszköz Gyorsgomb  
Kapcsoló  

Leírás 

 

HELP F1  Súgó megnyitása 

 

PMTHIST F2  Prompt történet megnyitása 

 

ENTITY  SNAP CTRL-F F3  Tárgyraszter mód kapcsolása 

 

ISOPLANE F5    ISOPLANE kapcsolás 

 

COORDS CTRL-D F6  Koordináta kapcsolás 

 

GRID CTRL-G  F7  Háló mód kapcsolás 

 

ORTHO CTRL-L F8  Ortogonál mód kapcsolás 

 

SNAP CTRL-B F9  Snap  (Raszter) mód kapcsolás 

 

POLAR CTRL-U F10  Polar  nyomkövetés kapcsolása 

 

OTRACK CTRL-W F11  Objektum követés átkapcsolás 

Eszköz Név Leírás 

 

Aktuális fájl verzió Megmutatja a jelenlegi rajz fájl formátumát 

 

Snap  mód  (F9)  Kapcsolja a Snap (Raszter) módot 

 

Háló  (F7)  Kapcsolja a Hálót a rajzterületen 

Ortogonális mód 

      
 

Polar  nyomkövetés(F10) Kapcsolja a polár nyomkövetést 

 

Entitás  Snap  (F3) Kapcsolja az aktív tárgyrasztert 

Objektum követés 

 
 

Vonal vastagság Kapcsolja a vonalvastagságot 

Modell  mód  
Kapcsolja az elrendezési módot a modell módból és vica 
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CADian 2012 

3.9 Szálkereszt beállítása 

A szálkereszt vonalait az egér vezérli (mutató eszköz),  a helyeket állítja be és kiválasztja az 

objektumokat a rajzban. Az egér szálkereszt kurzort úgy kell beállítani, hogy végtelenített vízszintes és 

függőleges vonalként látszódjon a rajzterületen.   

Ha a szálkereszt rövidebb vízszintes és függőleges vonalból áll, kattintson a [Tools(T)]  

[Options(N)]  legördülő menüre és a 'Display' fülre az Options  dialógus dobozra. A lenti képnek 

megfelelően,  állítsa be a szálkereszt méretét ’100’-ra a csúszkát használva.  

A szálkereszt megjeleníti a kurzor mutatóját az aktuális koordinátával a rajz területen. Amikor mozgatja 

a kurzort a koordináta értékek frissülnek a Státusz sor bal oldalán.     
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CADian Introduction   01 

04   Parancsok elérése és végrehajtása 

4.1 Egér funkciók 

A tervezés során a felhasználónak lennie kell egy egérnek mint beviteli eszköznek.  A következő   

fejezetben bemutatjuk, hogy hogyan működik az egérgomb és görgő a CADian-ban. 
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Gomb Leírás 

 

Bal egér  Kattintás akiválasztáshoz, menükre pikkelés, ikonok,  eszközök,  dialógus dobozok beállítása  

gomb  (LMB)  rajz terület pozíciójának beállítása 

 
 
 

Görgő 

 

 

A görgő lenyomásával aktiválja a valós idejű eltolást a rajzterületen. 

 
A görgő fel-le tekerése a  Zoom beállításához a   rajzterületen. 

 
 

Jobbt  egér Megnyitja a gyorselérésű menüt a kiválasztott objektumhoz és aktiválja az  

gomb  (RMB) Enter gombot a parancs befejezéséhez.    

Click menu - menüre kattintás, Access command - parancs elérés, Set location - hely beállítás  Select object  

- objektum kiválasztás, Access pop-up menu - legördülő menü elérése, Move screen - képernyő mozgatás 
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CADian 2012 

4.2 A kiválasztó doboz beállítása 

Amikor a felhasználó kiválaszt egy entitást vagy objektumot, ha a pick box (kiválasztó doboz ) kicsi 

mint a lenti képen,  ezzel alig lehet kiválasztani az objektumot, és ha a pick box túlságosan nagy, ekkor 

más entitásokat is kiválaszthat, amelyeket a felhasználó nem szeretett volna kiválasztani. 

Következésképpen  a felhasználónak a Pick doboz méretét a helyzettől függően kell megválasztania. 

Kattintson a 'select' (kiválasztás) a  fülre az 'option' (beállítás) dialógus dobozban, a lenti kép szerint,  

hogy beállítsa a helyes (40%)  méretét a pick doboznak a csuszka segítségével. 
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CADian Introduction   01 

Application  Command  Interface 

Egy programban az alkalmazás parancsinterfész a megjelenítés egyik kulcsfontosságú eleme, 

ahol a parancs és prompt információkat átveszi a feldolgozáshoz, ahogy a kliens ezt végrehajtani szándékozta.   

Három típusa van a parancsinterfésznek. 

•  Parancs ­vonal  interfész 
 

A billentyűzetet használva begépeljük és futtatjuk a parancsot, “TTY(Teletypewriter).”-

nek hívjuk. 

•  Menü­vezérelt 

Interface 
Parancs futtatása a menün egy parancsra kattintva   

•  GUI  - grafikus felhasználói interfész 

Egy parancs futtatásának a legprogresszívebb módja.  Kattintson egy parancs ikonra a mutató eszközt 

használva, mint ceruza, egér, tablet, joystick. 
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CADian 2012 

4.3 Hogyan érjük el a parancsot 

Segéd eszközöket állíthatunk be vagy parancsokat hívhatunk be  a szalag menüből, a 

legördülő menüből, eszköztárról, helyi (egér) menün vagy a státusz soron. 

 
Általában,  a parancs  elérése és futtatása a  CADian-ban a következőképpen: 
follows. 

•  Parancs elérés ⇨ Hely vagy objektum kiválasztás   a rajz ablakban 

•  Objektumok kiválasztása rajz ablakban ⇨ parancs kiválasztás 

Parancs elérése a CADian 2012-ben a   következőképpen. 

•  Parancssor használata gépeléssel 

•  Legördülő menü használata kattintással 

•  Szalag menü használata kattintással 

•  Eszköztárak használata kattintással 

•  Helyi (egér) menü használata kattintással 

A fentiek mellett,  az új, ment és a nyomtat parancsok elérhetőek 

Quick  Access Toolbar (Gyors elérésű eszköztáron)  vagy az 

Application  Program menüben. Néhány parancsot elérhetünk a 

Státusz sor vagy a Paletta használatával. 

Összességében három mód van arra, hogy elérjük a parancsokat a 

CADian-ban, a kezdőknek a legkönyebb, ha csak az ikonokat 

használják; azonban,  a Command  alias (álparancs nevek) 

használata sokkal könyebbé válik azok részére, akik sokat 

használják a CAD-et. Végezetül a felhasználó azt használhatja, 

amivel tervezését könyebben megoldhatja.  
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CADian Introduction   01 

❏ Főnév/ige  kijelölés 

A felhasználó bejelölheti a Noun/Verb  kiválasztást a parancsok eléréséhez  és sorrend szerinti 

futtatáshoz a fent leírt módszerek szerint.  

4.4 Parancs beléptetése a parancssoron 

Az egyik módja, hogy elérjük a parancsot, a fenti képhez hasonlóan az, hogy angolul begépeljük a parancsot.  

Ez a mód tradicionális elérési mód a CADian-ban az MS-DOS óta mind a mai napig. A billentyűzeten 

begépeljük az angol parancsot és lenyomjuk az (Enter-t)  vagy a jobb egérgombra kattintunk.   A CADian 2012 

program rendszerint eléri a parancsokat, amelyet angolul ütünk be a parancs promptba (Command:) a 

parancs ablakba. 
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CADian 2012 

A felhasználónak folyamatosan figyelnie kell a Command  Window-t,  bal kezét használva a parancsok 

beviteléhet, másik kezét az egéren tartja.   

CADian nem case-sensitive,  ez azt jelenti, hogy a felhasználónak nem kell törődnie a CapsLock miatt. 

Kényelmes álnevek vannak, ami megengedi a felhasználónak , hogy gyorsabban dolgozzanak.  

Az álparancsok a parancsok gyorsbillentyűs változatát nyújtják.  Például,  használjuk az 'L'-t a 'LINE'  

parancs helyett a 'C'  -t  'CIRCLE'  parancs helyett a parancs eléréséhez.    

CADian támogatja azt, hogy a  kis és nagy   betűket ne vegye figyelembe, amikor a beállításokat és az 

álparancsokat használja a hatékonyabb rajzolás miatt.  
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4.5 Parancsra kattintás a legördülő menüben 

A legördükő menüt fontos főmenüként használjuk, amely a legtöbb parancsot szolgáltatja az első  that 

CADian óta. 

•  A legördülő menü a név (verzió és rajz név) alatt jelenik meg a standard eszköztár fölött. Tulajdonságok 

szerint van szétosztva, csoportosított menü listákban jelenítik meg.  

• Az eszköztár menütől eltérőena legördüklő menü egy opciót tartalmaz, amely megengedi a 

felhasználónak, hogy annak elérése után futtassa a programot. Ez azt jelenti, hogy a felhasználó 

beállíthatja a kívánt opciót a futtatáshoz , csak a parancsra kattintva.  

• A legördülő menü Cascade menü, ez egy kicsivel több időt vesz igénybe a parancs elérés, mint a többinél 

és sok helyet használ.  

•  Ha van   (háromszög)  jel a legördülő menü jobb oldalán, ez azt jelenti, hogy egy másik  

almanü is rendelkezésre áll. 
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4.6 Parancsikonra kattintás a szalag menün 

•  Mint a lenti képen, a kívánt parancs futtatása a jobb egérgomb kattintásával. 

• Mint a lenti képen, amikor a felhasználó rákattint a háromszögre a szalag menü parancs ikonjának  jobb 

oldalára, az alparancs ikonok megjelennek, ezután a felhasználó kattintással elérheti a kívánt parancsot.     

4.7 Parancs ikonokra kattintás az eszköztáron 

Az eszköztár csoportba gyűjtött parancs ikonokat tartalmaz egy sorba, amelyet a felhasználó előhívhat, 

amikor szüksége van rá, és elhelyezheti bárhová ahová akarja. 
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A tervtől függően, azokat az eszköztárakat megjeleníthetin amelyek valóban kellenek, és eltávolíthatja azokat, amelyek a 

tervezéshez szükségtelenek a nagyobb rajzterület elérése végett.   

 

Klikk [Tools]  ⇨ [ToolBars]  ⇨ [CADian]  az eszköztár  lista megjelenítése a lenti kép szerint. Ha a 

felhasználó a kívánt eszköztárra kattint a jobb egér gombot használva, az az eszköztár megjelenítésre 

kerül a rajzterületen. 

•  A bejelölt megjelenik az aktuális ablakban. Ha a felhasználó megint rákattint a bejelöltre, akkor 

eltávolításra kerül az aktuális ablakból. 

•  Ha a felhasználó rákattint a kívánt eszköztárra, akkor megjelenítésre kerül az ablakban, és ha el 

akarja ezt helyezni máshová, akkor ezt egy egyszerű bal egérgomb kattintással megteheti. A 

méretét is beállíthatja annak oldalára kattintva.  
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•  A mozgatható eszköztárat a rajzterület bármelyik oldalához rögzítheti.  Az az eszköztár amely az 

ablak fölé került a Szalag menü alatt lesz megjelenítve.  

•  Nem-mozgatható eszköztár megjeleníthető bárhol a rajzterületen, és mérete módosítható.  

•  Az eszköztár csak hasznos eszközöket tartalmaz, amely megpróbálja maximalizálni a 

rajzterületet, így könyebbé téve a felhasználónak a tervezési munkát. 

Kapcsolható eszköztár 

❶ Használja a  Pull-down  

menüt 
⇨ ⇨ Klikk [Tools] 

 

[ToolBars] [CADian] eszköztár legördülő menü megnyitása, a kívánt eszköztárak kiválasztása. 

❷ Legördülő menü vagy a helyi kurzor  menü használata. 
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Klikk  jobb egér gombra egy üres eszköztár területen, hogy megnyissa a legördülő menüt. 

❸ Közvetlenül a parancssorba gépelés 

Command: -TOOLBAR 

? to list/All/Enter  toolbar  name:  ALL 

Show/Hide:  S 

Az összes eszköztár megjelenítésre kerül a rajzterületen. 

Command: -TOOLBAR 
 

? to list/All/Enter  toolbar  name:  Standatd 
 

Show/Hide:  S 

<Standard  eszköztár> 
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4.8 Parancsra kattintás a billentyűparancs menün 

A billentyűparancs menüt bármikor hívni lehet, amikor a CADian fut a (Parancs) ’Command:’ prompt  

módban. 
A következőkben két módja van a menü elérésének. 

❶ Jobb egérgomb kattintás az üres rajz területre.  

❷ Válasszon ki entitást a rajzterületen,  ezután kattintson az egér jobb gombjára.. 

A bal oldali kép mutatja a billentyűparancs  menüt, amikor nem fut parancs, a jobb oldali kép amikor 

egy vonal entitás van kiválasztva.  
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05 Parancs opciók kiválasztása 

Amikor a parancs fut a CADian-ban, A felhasználó aktíválhatja a kívánt opciót a két következő módon: 

•  Beírja az opciót  a parancssorba (Command line) 

•  Kiválasztja az opciót a billentyűrarancs (előugró)  menüben 

5.1 Parancs opciók beléptetése a parancssoron 

Amikor a felhasználó elér egy opciót mialatt a parancs fut,  hasonlóan a következő példához,  ha a 

CIRCLE (kör) parancs  fut, az opciókat elválasztó jelekkel  (/) jeleníti meg köztük.  Csak egy nagy 

betűjét kell begépelni a zárójelbe tett szónak a folytatáshoz. 

Például,  amikor egy kört rajzol, gépeljen  'C'  vagy 'Circle'  a parancs promptba  és nyomjon entert. 

Gépeljen '3P' -t, hogy elérje a  '3P' opciót. 

Command:  C or CIRCLE 

2Point/3Point/TanTanRad/TTT/Arc/Multiple/<Center  of  Circle>:  3P 

Első pont a körön:  P1 

Második pont:  P2 

Harmadik pont:  P3 
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5.2 Parancs opciók kiválasztása a billentyűparancs (előugró) menüben   

 Billentyűparancs (előugró) menü megjelenítésre kerül mialatt fut a parancs  az egér jobb gombjára kattintva egy üres területen. Ez 

tartalmazza az összes parancs opciót. 

Ha a PLINE(Polyline) (Vonallánc)  parancsot elérjük,  két pont,  P1, P2, már be van kattintva és a jobb 

egérgombbal kattintottunk a rajz területre,  'Shortcut(pop-up)' menü megjelenik,  ezután a felhasználó kattinthat 

'Draw  arcs' és a P3 -ra hogy megrajzolja a lenti képet. 

Command:  _PLINE 

Start  of polyline:  P1 

Arc/Distance/Follow/Halfwidth/Width/<Next  point>:  P2 

Arc/Distance/Follow/Halfwidth/Width/Undo/<Next  point>:  Arc (Pop-up  Menu) 

Angle/CEnter/CLose/Direction/Halfwidth/Line/Radius/Secondpt/Wid th/Undo/<End of arc>: P3 

Angle/CEnter/CLose/Direction/Halfwidth/Line/Radius/Secondpt/Width/Undo/<End of arc>: 
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2Point/3Point/TanTanRad/TTT/Arc/Multiple/ Option  Prompt 

 

First  point  on  circle: (Első pont a körön) 3P  Option  Prompt 
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5.3 Hasznos tippek a parancsokhoz és a parancs opciókhoz 

❏Néhány parancs elérésekor, a felhasználó először beállítja az értékeket , hogy megmutassa a prompt 

beállításokat. 

Command:  _FILLET 

Current  settings:  mode  =  TRIM,  radius  =  0.0000 

Fillet:  Undo/Polyline/Radius/Trim/Multiple/<Select  first  entity>: 

❏ Az összes parancs  a CADian-ban fut  begépelve a parancs a parancs promptba., és ezután nyomjunk  

ENTER-t vagy  szóköz billentyűt. 

❏ Amikor nem fut parancs,  és a felhasználó megnyomja az 

megint, a jelenlegi parancs futni fog.   

ENTER-t  vagy a szóköz billentyűt 

❏ A jobb egér gombbal a  Command Prompt-ra kattintva, a felhasználó újra hívhatja az előbb használt 

parancsot a lenti képhez hasonlóan. Továbbá a felhasználó elérhet standard window vágólap eszközöket, 

mint  ‘UNDO’,  ‘REDO’,  ‘ZOOM’,  ‘PAN’  vagy opció eszközök. 
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❏ Cancel vagy  Exit  parancs 

•  Cancel :  Kattintson az egér jobb gombjára a parancs futása alatt ,  ezután kattintson a cancel-re  

billentyűparancs menüben 

menu. 

•  Cancel :  Nyomjon az ESC billentyűre a billentyűzeten.   

•  Exit  :  Nyomjon ESC-et, Enter vagy szóköz billentyűt, vagy a jobb egér gombot. 

❏ Parancs folyamatos használatához 

•  A felhasználó kattinthat a jobb egér gombra  mialatt nem fut parancs, hogy az előtte használt 

parancsot futtassa. 

•  A felhasználó futtathatja a parancsot nem törődve azzal, hogy hányszor törölte a programot.  

• A parancs ismétléséhez nyomjon Enter-t vagy szóköz billentyű. 
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Opciók közvetlen beütése a parancssoron  

Gépelje a 'CIRCLE'-t a parancssorba. 

Command  : CIRCLE 

2Point/3Point/TanTanRan/TTT/Arc/Multiple/<Center  of  circle>: 

 <Center  of  circle> :  Ez egy alapértelmezett opció  ahová beütheti a középpont koordinátáját vagy 

kattinthat   az egér kurzort használva. A következő példában gépeljen  100,100  a középpont 

koordinátának. 

2Point/3Point/TanTanRan/TTT/Arc/Multiple/<Center  of  circle>:100,100 

2P Option  :  Ez egy opció amely perjellel van elosztva(/). Az opciók elérése angol (magyar)  

nyelvű szöveggel történik a zárójelek között.  A következő példához gépeljen  2P-t a 2P beállítások 

eléréséhez.   

2Point/3Point/TanTanRan/TTT/Arc/Multiple/<Center  of  circle>:  2P 
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Gyors elérésű menü használata az opciók kiválasztásához 

Gépelje a 'CIRCLE'-t a parancssorba. 

Command  : CIRCLE 

2Point/3Point/TanTanRan/TTT/Arc/Multiple/<Center  of  circle>: 

Jobb egérgomb kattintás egy üres területen  a rajz ablakban   a billentyűparancs eléréséhez. Ezt 

mutatja a következő kép. A   billentyűparancs menü a   CIRCLE parancshoz  megjelenik. 

A fenti képhez hasonlóan, kattintás a '2P'  opcióra a  billentyűrarancs menün. 

Klikk (P2, P3) a rajz ablakon a lenti kép szerint. 
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06 Új rajzfájl létrehozása 

Rajzfájl elkezdése és elmentése parancsok, amelyekkel a felhasználó megnyithatja és elmentheti a 

rajzfájlt, helyrehozhatja a hibákat és tisztíthatja a fájlt a CADian-ban. 

file  format. 
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Ikon Parancs Leírás 

 

New Új rajz megnyitása. 

 

OPEN Elmentett rajz megnyitása. 

 
SAVE Egy fájl elmentése 

 
SAVEAS Aktuális rajz elmentése külön néven. 

 

EXPORT 
Egy rajz vagy kiválasztott objektum exportálása  más néven 

 

CLOSE Aktuális rajz bezárása 

 
QUIT Program bezárása 

 

EXIT Program bezárása 

 
RECOVER Egy sérült fájl megnyitása helyrehozása után . 

AUDIT 
Átvizsgálja a rajzot, hogy van-e hiba benne, ha van benne 

megjavítja azt.    

 

PURGE 
Kitörli a nem használt elemeket  a rajzból, mint a blokkok, 

vagy fóliák. 
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6.1 Rajzfájl áttekintés 

CADian elindítása egy új rajzzal hivatkozni lehet sablonra és prototípus rajzra, eltérően más Microsoft 

Window  alkalmazói programokhoz.  Ilyen rajzfájlokban,  néhány elem már be van állítva, mint a  

mértékegység, papírméret és a korlátok. 

A vázlatrajzok új rajzfájlok, amelyben az objektumokat megtervezheti, továbbá  ez örökli az öszes 

tulajdonságot az erre hivatkozó sablonfájltól.  Végeredményként,  a megnyitott új vázlatfájl beállítás 

elemeinek mértékegysége és rajzhatárai vannak 12.00 x  9.00. 

Ha a sablonfájl véletlenül törlődöt,  nem lehet megnyitni  egy új vázlat rajzfájlt. 

Be kell szerezni egy sablon fájlt és abba a mappába kell helyezni, ahol az új rajzfájlt nyitja meg.  

A sablon vagy prototípus fájl kiterjesztése  DWT,  a standard protótípus rajzok a Sablon  'Templates'  

mappába vannak elmentve.  Ha testreszabot prototípus rajzot ment el ebbe a mappába,  akkor ezt 

felhasználhatja a CADian 'StartUp' dialógus dobozban. 
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❏ Sablon (protótípus rajz) fájl (.DWT) 

CADian általában gondoskodik néhány prototípus rajzról, olyanról mint ANSI vagy ISO amelyek rajzi 

szabványként vannak beállítva. Ezeket  sablon rajznak (Drawing  Template)  vagy prototípus rajznak 

(Prototype  Drawing) nevezzük.  Szabványos elemek vannak beállítva, mint a rajzlap mérete, a szög 

egységek és formátuma, munka környezet, határok, a cím blokk és a BOM. Sablon (prototípus) rajzként, 

van elmentve, ezeket felhasználja, amikor egy új rajzot megnyit.  

Végeredményként, ha testreszabot sablon fájlt használ, akkor konzisztens marad a tervezéseknél, 

mert ugyanazon rajzi beállításokat használja.   Ezt szabványos rajzolásnak nevezik (Drawing  

Standard). 

Ezek a rajz beállítások, amelyeket  elment  a sablon fájlba. 

•  Határok 

•  Méretarány 

•  Mértékegység és mértékegység formátum,  pontosság 

•  Cím blokk, BOM, középpont jel 

•  Fólia létrehozás és beállítás  

•  Vonaltípus és vonalvastagság  

•  Szöveg stílus 

•  Méretstílusok 

•  Különféle szimbólumok 

•  Elrendezés és mértetarány 

•  Lapbeállítás 

Állítsa be a következő opciókat. 

•  Raszter és háló   

•  Többszörös mutató stílus 

•  Táblázat stílus 

•  Elrendezés és lap beállítás 
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6.2 Új parancs 

Új rajz megnyitása, hivatkozás a protótípus rajzra. 

Dialógus doboz elindítása (Új rajz elindításához) 

❶ Újrabeállítás  'STARTUP'  változó '0'-ra 

Parancs: STARTUP 

Új érték beléptetés  STARTUP <ON>:  1 

❷ Gépeljen 'Új'-at (NEW) a parancs soron. 

Három fül van a  'StartUP'  dialógus doboz tetején. 

•  (Indulás a vázlatból)   :  Megnyit egy új rajzfájlt  csak a szabványos mértékegységekkel. 

•  (Sablon használata)  :Sablon fájl használat, elmentve a rendszerbe új rajzfájl elindításához 

•  (Varázsló használata) :  Varázsló használata az új megnyitott rajzfájl mértékegységének  lap 

méretének,  szög méret és szög irányának   beállításához. 

Klikk (Indulás a vázlatból)   'StartUP'  dialógus doboz gombra. 
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❸  Ellenőrizze a Metrikus (Metric)  alapértelmezett beállítást,  és ‘Ok’  gomb. 

•  Angol English (Láb és hüvelyk) - Új rajzot hoz létre angol mértékegység rendszerrel  és belső 

alapértékeket használ, a  standard  háló megjelenítés 12 x  9 inch (A4). 

•  Metrikus (Metric)  –  Új rajzot hoz létre metrikus mértékegység rendszerrel és a standard háló 

beállítás 420 x  290mm(A3). 

❏   Sablon használat 

❶ Klikk (Sablon használat) gomb 'StartUp'  dialógus dobozon és válassza az 'ICAD.DWT-t  a Sablon 

 

 

kiválasztás panelen és klikk az 'Ok'  gombra. 

Az új vázlat rajz fájl megnyitja és angol használja az angol mértékegység rendszert a határokkal,    

59 

Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

 
 

 
 

 
 

CADian 2012 

12 x 9 inch(A4). Amikor már megszokta a  CADian-t, rendszerint már nem használja a 'StartUp' 

dialógus dobozt. 

Végeredményképpen,  amikor a CADian-t futtatja, ez automatikusan futtatja a  'ICAD.DWT'  

fájlt, hogy megnyissa a vázlat rajzfájlt.   

❏ Varázsló használata 

❶ Klikk (Varázsló használata) gombra a 'StartUp' dialógus  dobozon, Speciális beállítások 

('Advanced  Setup' és válassza a beállítást és klikk  az 'Ok' gombra. 

❷ Állítsa be a Mértékegységet (Units) a Linear  Units  dialógus dobozban. Mint a lenti képen, válassza 

ki a tizedest (Decimal(D))  a mértékegységnek. 

and click Next   button. 
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❸ Állítsa be a szög mértékegységét a Szög mértékegysége (Angular  Units)  dialógus 

dobozban. Válassza ki a tizedes fokot  (Decimal  degrees(D))  és klikk a Tovább 

(Next)  gombra. 

❹ Válassza ki az irányt a szögméréshez  a Szög mérése (Angular Measurement)  dialógus 

dobozban. Válassza a Kelet (East(E))  klikk a Tovább (Next) gombra. 

 

 

. 

 

 

❺ Válassza ki a tájolást a szögméréhez  (Angular  Direction) dialógus  dobozban. 

Válassza az óramutató járásával ellentétes (Counter  clockwise(O)) és klikk a Tovább (Next)  

gombra. 

61 

Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

 
 

 
 

 
 

CADian 2012 

❻  Léptesse be a rajzterületet, amelyet meg akar jeleníteni,  használja a mértékegységet a Terület 

(Area)  dialógus dobozban. Hivatkozzon a szabványra (KS  A0106  KS B0001)  a mérethez 

és állítsa be a rajzterületet  a szélességével, 420 és a hossz,  297(A3). Klikk a Tovább (Next)  

gombra. 

 

❼ Állítsa be a nyomtatási stílust  a 'Print  Style' dialógus dobozban. 
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Tudjon meg többet a  a Styles  Manager-ben   vagy a  Print  parancsok fejezetben. 

•  Név stílus tábla  (.stb  fájl)(&N) 

•  Szín-függő  stílus táblák (.ctb  fájlok)(&C) 

❽ Válassza ki, hogyan szeretne entitásokat létrehozni az új rajzban, az (Entity  Creation)  

dialógus dobozban. 

     Klikk a Befejezés (Finish)  gombra. 

Dialógus doboz elindítása 

A Startup Dialog  Box-ot, a STARTUP System Variable vezérli, amely egy általánosan használt segéd 
program a speciális ipari, építészeti projektek, vállalatok, intézetek részére, amelyeknek testreszabott  sablon 
szükséges. 

 

 

Projekt menedzser aki jól ismeri a speciális ipari szabványokat, beállíthat testreszabott rajzfájlt, amelyet 
szétoszthat az osztályok között. 

files  and  will  distribute  to  each  department. 

A CADian indítását követően, az ügyfelek kiválaszthatják a szükséges sablonokat Startup   Dialog   Box-

ból, hogy alkalmazzák a megadott beállításokat az új rajzban.    
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❾  Ha nem akarja használni a 'StartUp'  dialogus dobozt. Vegye ki a bejelölést a  'Show  this  

dialog  when  starting up'   jelölő négyzetből, hogy ne lássa ezt a dialógust. 

Vagy állítsa be újra a  STARTUP  rendszer változót 0 -ra. 

Command:  STARTUP 

Enter new  value  for STARTUP <ON>:  0 

Most,  amikor az Új-ra  (NEW) kattint, a CADian  megnyitja a  'Select  a  Template  File' 

dialógus dobozt, a   'StartUp' helyett. 

Ezután válassza ki a kívánt sablon fájlt (template) és kattintson a Megnyitásra (Open). 
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A megnyitott új vátlat rajz elindul, beállíthatja vagy módosíthatja a rajzbeállításokat a tervezési 

munkák elkezdéséhez. 

 

6.3 OPEN (Megnyit) parancs 

OPEN parancs eszköz arra, hogy megnyissa az elmentett rajzot, hogy ezt tovább szerkessze vagy 

kinyomtassa. 
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Menü  File  >  Open 

 
Eszköztár Quick  Access  Toolbar 

 
Szalag 

 
Parancs Pr
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Rajz fájl formátum 

Más programokhoz hasonlóan,   a CADian támogatja a   felfele kompatibilitást   rajzfájl adatokat,   de nem támo-
gatja a lefelé kompatibilitást  az új funkciók és interfészek frissítése miatt.  Általában,  ugyanaz a fájl formátum 
van   felosztva   egymásból következő három verzióra.  

Open Drawing Files 

Klikk (Open) ikon a Quick Access Toolbar-on, majd az Open Drawing dialógus megjelenik. 

A dialógus dobozban, 
click 

(Up One Level) gomb  jobb oldalán a  Look  in, hogy elmozgassa 

amappát  oda ahová a  
rajzot elmentettük.  Ha csak a kívánt fájlnevet gépeli be, akkor a rajz indexképe megjelenik az 

előnézeti hely jobb oldalán.  

A név a File név mezőn jelenik meg és klikk az Open gombra a jobb oldalon.   A rajz 

megjelenik a rajz területen a lenti képhez  hasonlóan . 
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Legutóbbi dokumentumok megnyitása az alkalmazás menüben 

Klikk (Open) ikon a Quick Access Toolbar-on, majd az Open Drawing dialógus megjelenik. 

megjelenik.megjelenítése. 

Klikk (Application  program menü), hogy megjelenítse a mostanában megnyitott rajzfájlok  listáját. 
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Mint a fenti képen, az egér kurzort a kívánt rajzfájlra viszi, a helyi súgó ideiglenesen megjelenik.  

Ezután, bal oldali egérgomb kattintás a kívánt rajzfájl névre, hogy megnyissa a rajzot a rajz 

területen. 

Dokumentumok megnyitása a legördülő menüből 

Klikk  File(F) a legördülő menüre, hogy megjelenítse a mostanában megnyitott rajzfájlok listáját. 
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Mint a fenti képen, a listából, bal oldali egérgomb kattintás a megnyitni kívánt rajzra, ezután, az 

megnyílik. 
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Mentés és kilépés  
 

 
A felhasználónak gyakran el kell mentenie a fájlt az előforduló problémák megakadályozása miatt.  

 

Az egészség megtartásához a felhasználónak 50 percenként szünetet kell tartania és el kell mentenie a 

munkáját  
 

Ajánlott, amikor elkezdi a munkát, a rajz első elmentése egy újonnan megnevezett fájl legyen.  
 

A CADian rajzfájl .DWG kiterjesztést használ. Ha a felhasználó nem változtatja meg a kiterjesztést, 

amikor elmenti, addig megmarad mint CADian verziójú rajzfájl.  A fájl tömörítésre optimalizált és 

hálózatban lehet használni.   
 

DWG fájl neve maximum 256 karakter lehet. 
 

 
 
 

7.1 Mentés  (SAVE)  parancs 
 

 
Elmenti az aktuális fájlt a cím fülön lévő fájl név szerint a fájl továbbra is nyitva marad.    

 
 

 
Menü  File  >  Save 

 

 
Eszköztár Quick  Access  Toolbar   

 
Szalag 

 

 
Parancssor ,   

 
 
 

7.2 Mentés másként  (SAVEAS) parancs 
 

 
 

Elmenti az aktuális rajzot egy fájlba ‘SAVEAS’ a  dialógus panelbe.  Az aktuális rajzot lezárja és azt a fájlt 

amelyre elmentette megnyitja. Az előző fájl ugyanaz marad. Pr
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Menü  File  >  Save  as 

 

 
Eszköztár 

 

 
Szalag 

 

 
Parancs  

 
 
 
 

 
 

❏  [Alkalmazói  program] ⇨ [Save As] Mentés máskéntPr
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7.3 Rajzfájl formátum 
 
 
 

CADian a következőképpen menti el a rajzokat.  CADian ugyanazon fájltípusokat támogatja, mint az AutoCAD. 

 
Fájl típus  Fájl formátum Leírás 

 

 
Rajz file 

 
*.DWG 

 
CADian  és AutoCAD alapértelmezett fájl formátum 

 

DXF fájl 
 

*.DXF 
 

Rajzfájl formátum a rajz cseréhez 

 

Standard  fájl 
 

*.DWS 
 

Rajzfájl formátum a szabványosításhoz 

 

Sablon fájl 
 

*.DWT 
 

Rajzfájl formátum az indulási sablonhoz 

 
 
 
 
 

DXF(DRAWING  EXCHANGE FORMAT) fájl formátum 
 

 
 

Rajzcsere formátumot (Drawing  Exchange  Format)  eredetileg a z Autodesk   Inc.  fejlesztette ki és vezette be  Pr
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 a rajzok cseréjéhez az AutoCAD-ek és annak különböző  verziói és alkalmazásai között. Most már széles körben   

használt adat csere formátum különböző CAD/CAM programok között és vált világ ipari szabvánnyá. 

A DXF fájl adatok részleteit és követelményei megtalálhatók a   [Help]   ⇨ [AutoLISP,   Visual   LISP 

&  DXF] ⇨ [DXF Reference] 

 
 
 
 
 
 
 

 
File Format  Compatibility 

 

 
 

CADian  megnyitja az AutoCAD 2.5-2012 dwg fájlokat, az AutoCAD nem támogatja 

az AutoCAD R14-nél kisebbeket. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ezért,   CADian rajzfájl formátumok nagyobb kompatibilitásáért,  SAVE-re kattintva               vagy 

SAVEAS       menü, az ügyfél különböző formátumokban mentheti el a rajzot  a legördülő menüben rákattintva.   
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7.4 Fájl biztonsági elővigyázatosság 
 

 
 

❏ Automatikus mentés (AutoSave) 

 

 
CADian automatikusan elmenti az információkat az ‘.SV$’  fájlba.  A felhasználó beállíthatja azt az időt, 

amikor  azt akarják, hogy a CADian automatikusan  mentse a munkáját. 

 

 
 

•  Klikk  ⇨    Klikk Megnyitás és elmentés ‘Open  and  Save’ fül,  ezután beállítja  

az időt (percek) mint a lenti képen. 
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❏ Ideiglenes fájl  

 

 

•  Klikk a fájl ‘File’ fülre a dialógusablak opciókban.  Mentés mint  .AC$  kiterjesztéssel az  

ideiglenes rajzfájl helyén. 

 
 

Automatikus mentés  C:\Documents  and  Settings\User\Locals~\Temp 
 

•  Ha a CADian összeomlik vagy a rendszer kikapcsol,  a felhasználó megkeresheti és újraindíthatja  

az ideiglenesen elmentett ‘XXX.SV$’ fájlt lecserélve a  ‘XXX.DWG’ formátumra. 

Ahhoz, hogy erről többet megtudjon, olvassa el a Drawing Recover Manger Pallette-t a következőkre 

kattintva  [Application  Program menu] ⇨ [Drawing Utilities]  ⇨ [Drawing  Recover Manager]. 

 
 
 
 

Rajz biztonsági beállítás 

 

 
Az ügyfél jelszót állíthat be mindegyik rajzfájlhoz.  Amikor egy rajzfájl lezárásra került,  ezt csak akkor 

nyithatja meg , ha a helyes jelszót beütötte.  
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7.5 Kilépés (QUIT,  EXIT) parancsok 
 

 
 

•   Kilépés a CADian programból. 

 
 
 
 

Menü  File  >  Exit 
 

 
Eszköztár 

 

 
Szalag 

 

 
Parancs  

 
 
 

•  Klikk [File]  ⇨ [Exit]  a legördülő menün. 
 

 

 
 

 

•  Rajzfájl lezárása (CLOSE) 

 
 

Menü  File  >  Close 
 

 
Eszköztár  

 

 
Szalag 

 

 
Parancs  

 
 
 
 

A jelenleg megnyitott rajzfájl lezárása.  CADian események folytatásához,  meg kell nyitnia új vagy más 

rajzfájlokat.  
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08 Rajzi segédeszközök 
 

 
CADian különböző segéd parancsokkal lát el,  amelyeket a felhasználó a mentéshez és a rajzok 

kezeléséhez alkalmazhat.  

 
 

8.1 Helyrehoz (RECOVER) parancs 
 

 
Amikor a felhasználó hibával nyitja meg a rajzot, a CADian azt automatikusan helyreállítja és megnyitja. 

 
 
 

Menü    ➤Drawing Utilities  ➤ Recover(R) 

 
Eszköztár 

 

Szalag    ➤Drawing Utilities ➤ Recover(R) 

 
Parancs  
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RECOVER parancs ellenőrzi, hogy a rajznak van vagy nincs hibája, de az AUDIT parancs a hibákat ellenőrzi a 

rajzban és javítja azt.   
 

 

Menü   ➤Drawing Utilities ➤ Audit 

 

Eszköztár 

 

Szalag   ➤Drawing  Utilities  ➤ Audit 

 

Parancssor 

 

AUDIT 

 

 

 
 

Hiba gyakran előfordul a  HEADER részben, a BLOCKS, XREF és a SOLID objektumokban a rajz 

adatbázisban.  

A következő kép mutatja a DWG adatfájlnak a DXF formátum belső struktúráját. 
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Command: _AUDIT 

Fix any errors detected? [Yes/No] <N>: Y 

5228 objects audited 

E:\CADian2012\DWG\1st     floor.dwg 

Sat Jul 21 13:21:00 2012 

Total errors found during audit 0, fixed 0 

8.2 AUDIT  parancs 

CADian Introduction  01 
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8.3 Tisztít (PURGE)  parancs 
 

 
 

A felhasználó eltávolíthatja a megnevezett szimbólumokat, amelyeket nem használ az aktuális rajban. Ez 

blokk definíciókat,  méret stílust,  csoportot,  elrendezést,  vonal típust  és szöveg típust tartalmaz.  

Továbbá, a felhasználó eltávolíthatja a zéró hosszúságú és üres szöveg objektumokat.  Akkor futassa ezt a 

programot amikor a tervezést befejezte, és ezután mentse el. 

 
 
 

Menü    ➤ Drawing Utilities  ➤ Purge 

 
Eszöztár 

 

Szalag    ➤ Drawing Utilities ➤ Purge 

 
Parancs  PURGE 

 
 

 

❶ Klikk [Application  program]  ⇨  Rajz segédeszközök [Drawing utilities] ⇨ Tisztít [Purge]. 
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❷ Klikk ‘+’  a 'Fóliák' (Layers) bal oldalára  a  Megtisztít (Purge)  dialógus ablakba. 
 

 

 
 

 
 

❸ Klikk ‘Purge  All’  gombra. 
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8.4 EXPORT  parancs 
 

 
Más alkalmazói program is használja a rajz adatokat, a felhasználó elmentheti és exportálhatja a fájl típus. 

 
 
 

Menü   ➤ Export 

 
Eszköztár  

 

Szalag  

 
Parancs  

 
 

 

❶ Klikk  [Application  Program]  ⇨ [Export]. 

 
 

 
 

 
 

 
 

 
 
 
 
 

❷ Állítsa be a fájl formátumot az ‘Export  Drawing’  dialódus ablakban és klikk a ‘Save’  gombra. Pr
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File Format Meaning 

 
*.DWF,  *.DWFx Autodesk  Design  Web formátum 

 
*.PDF Adobe  Portable  Document  (Adobe hordozható dokumentum) formátum 

 
*.STL Stereolithography  (Szilárdtest  3D objektumok nyomtatása) 

 
*.BMP Bit  Map képformátum 

 
*.SVG Scalable  Vector  Graphics  (Skálázható vektorgrafikus) formátum 

 
*.WMF Windows  Meta  File  formátum 

 
*.EMF Enhanced Meta  File  (Továbbfejleszettt meta fájl) Pr
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Eszköztip (Tooltip) 
 
 

Egy ikon rövid leírását mutatja,  mint a Név  (Name),  Parancs ( Command)  vagy a  Gyorsbillentyű  

( Hot  Key)  és  Leírás (Description), amikor az egeret ráhelyeztük. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 

Eszköztíppek kapcsolása (Toggle Tooltip) 
 

 
 

Az Eszköztippek eléréséhez (Tooltip), kattintással nyissa meg  az  Eszközök [Tools]   ⇨ Beállítások [Option],   és menjen  

a Képernyő 'Display' fülre.    Ezután, kattintással tegye üressé a jelölőnégyzetet mellet az Eszköztippek 

megjelenítése ”show   ToopTips“ , amely le fogja kapcsolni az Eszköztip leírást.  
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02 
 

 
 

Rajzolási alapok 
 
 
 
 
 
 

 

A következő fogalmakat tárgyaljuk meg ebben a fejezetben: 

•  Vonalak rajzolása és entitások törlése 
•  Parancsok, UNDO és REDO parancsbeállítások  
•  Koordináta rendszer 
•  Megjelenítés kezelés 
•  Linearis objektumok rajzolása 
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Most megtanulja a ‘LINE’,  ‘ERASE’,  ‘UNDO’,  és ‘REDO’  parancsokat, amelyeket leggyakrabban használ a 

tervezéshez.  Továbbá  a koordináta rendszert, és azt hogyan állítsuk be az objektumok megjelenítési 

arányait. Ezek alap parancsok a CADian-ban. 

 
 

 
 
 

Ikon Parancs Leírás 

 
LINE  Egy vonal (Line) megrajzolása. 

 

 

ERASE Egy entitás kitörlése (Erase) a rajzból. 
 

 

UNDO  Visszavonás (Undo), a multban végrehajtott akció visszavonása.  
 

 

REDO Redo  egy művelet, amely törli a megelőző Visszavoná (UNDO) parancsot. 
 

 

ZOOM Nagyítja vagy kicsinyíti (Zoom In  or Out) a nézetet  egy aktív nézetablakban. 
 

 
PAN Elmozgatja az aktuális ablakot a rajzon. 

 

 
REDRAW Újrarajzol (Redraw) egy látható entitás készletet az aktuális ablakban. 

 

 
REDRAWALL Újrarajzolja (Redraw) az össszes entitást a rajzban.   

 
 

REGEN Újraszámolja a megjelenítési koordinátákat   az aktuális ablakban  

REGENALL Újraszámolja a megjelenítési koordinátákat az egészre. 
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01 Vonal rajzolása és entitások törlése 
 

 
1.1 Vonalak áttekintése 

 

 
A Vonal (Line) objektum egy alakzat amely két pontot köt össze a legrövidebb távolsággal. A következő 

képhez hasonlóan, van vízszintes, függőleges, tört és folytonos vonal,  amely egy sorozat folytonos vonal 

szegmensből áll. A Vonal (Line) objektum az egyik legfontosabb elem vagy entitás a CADian-ban.   

 

 
 

 
 

 
Az a mód, hogy pontosan határozzuk meg a vonalak végpontjait a következők:  

 

 

•  Használjon abszolut vagy relatív koordinátát a vég pont koordináta értékeinek beléptetéséhez.    

•  Állítson be relatív objektum rasztert (OSNAP) a standard objektumhoz. 

•  Kapcsolja be a Hálót (GRID) és a Rasztert (SNAP). 
 

 
Vonal entitáshoz tulajdonságot (Property) jelölhetünk ki, mint Szín (Color), Vonaltípus (LINETYPE)  és 

Vonalvastagság   (Lineweight),  valamint a kiterjesztett vonal szegmensnek van kezdőpontja és vég 

pontja és mozgó középpontja. 
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1.2  VONAL (LINE)  parancs 
 

 
 

Vonal (LINE) parancs használatával,  egy egyenes vonalat húzhat a kezdőpontot a végponttal 

összekötve. Továbbá, rajzolhat vonalakból egy szegmens sorozatot. 

 

Menü  Draw(D)  ➤ Line(L) 

Eszköztár  

Szalag Home ➤ Draw  ➤ Line 

 
Parancs  

 
 

 
 

•  Klikk (Line) a Szalagon Rajz (Draw)  ikon. 

•  Klikk [Draw(D)]  ⇨ [Line(L)]  a legördülő menüben. 

•  Gépeljen LINE vagy  L (rövidnév)  a Parancssoron, ezután nyomjon  (entert). 

 
 

 
Command:  _LINE 

Start  of line:  P1 

Angle/Length/<End  point>:  P2 

Angle/Length/Follow/Undo<End  point>:  P3 
 

Angle/Length/Follow/Close/Undo<End  point>: Pr
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❏ Vonal LINE parancs beállítások 

 
 

Opció Leírás 

 
 

 Vonal kezdése 
Állítsa be a kezdőpontot, vagy egy másik vonal végpontját vagy használjon ívet és Enter 

(  )  gomb. 

 
Vég pont Állítsa be a szegmens végpontját. 

 
Szög                   Húzzon egy egyenes szegmenst  amely szöget zár be egy vízszintes vonallal.          

Hossz                    Húzzon egy egyenest egy adott hosszal. 

Follow Megrajzolja egy vonal kiterjesztését  a vonalszegmens utolsó pontjától. 
 

 

Lezár 
Egy vonal szegmens utolsó pontját  kapcsolja össze egy másik kezdő pontjával,  így zárt 

objektumot készít. 

 
Visszavonás  Eltávolítja az előzőleg rajzolt szegmenst. 

 

 
 

 

 

Vonal húzása egér kurzor használatával 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  Klikk [Draw(D)]  ⇨ [Line(L)]  a legördülő menüben. 
 

 
Line:  _LINE 

Start  of line:  P1 

Angle/Length/<End  point>:  P2 

Angle/Length/Follow/Undo<End  point>:  P3 

Angle/Length/Follow/close/Undo<End  point>:  P4 
 

Angle/Length/Follow/Close/Undo<End  point>:  C Pr
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Rajzolást segítő eszközök használata 
 

 
 

Nem könnyű pontos vízszintes vagy függőleges vonalat húzni,   mert csaknem lehetetlen kézzel kijelölni 

egzakt módon a pontot. A rajzolást támogató eszközök nagyon hasznosak hasonló esetekben.  Például, azért, 

hogy pontos vízszintes/függőleges vonalat húzzon kapvsolja be az Ortogonális módot “Orthogonal   

mode” F8  gombot használva. 

 
 
 
 
 
 
 
 
 
 
 
 

Merőleges vonal húzása 

 

 
 

Klikk (Line) ikon  a Szalagon  (Ribbon)  [Home]  fül  ⇨ [Draw]  panel  és  P1.  

Klikk    kapcsoló gombra, hogy aktiválja az ortogonális módot. 

  Ha mozgatja a kurzort, csak merőleges vonalat fog húzni. 
 

Klick P2, P3, P4 és P5, és P6 lenyomva a ‘Shift’  billentyűt. hogy ideiglenesen felfüggessze az 

ortogonális módot. Ezután  mozgassa felfelé, hogy a P7-re kattintson. 
 

  Ismét aktiválja az ortogonális módot, engedje el a ‘Shift’ gombot  és klikk P1. Pr
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Command:  _LINE 

Start  of  line:  P1 

Angle/Length/<End  point>: P2 

Angle/Length/Follow/Undo/<End  point>:  P3 

Angle/Length/Follow/Close/Undo/<End  point>:  P4 

Angle/Length/Follow/Close/Undo/<End  point>:  P5 

Angle/Length/Follow/Close/Undo/<End  point>:  P6  (Hold  ‘Shift’) 

Angle/Length/Follow/Close/Undo/<End  point>:  P7  (Hold  ‘Shift’) 

Angle/Length/Follow/Close/Undo/<End  point>:  P1  (Release  ‘Shift’) 

Angle/Length/Follow/Close/Undo/<End  point>: 
 

 
 
 
 

1.3  TÖRLÉS (ERASE) parancs 
 

 
A felhasználó törölheti a nem használt objektumot vagy entitást.  Különbözőképpen tud törölni. 

 
Menü  Modify(O)  ➤ Erase 

 
Eszköztár  

 

Szalagn Home  ➤ Modify  ➤ Erase 

 
Parancs  

 

 
 

•  Klikk  (Erase) ikon  a Szalag módosítás paneljében. 

 
 

Command:  _Erase 

Select  entities  to delete:  P1  Entities  in  set:  1 

Select  entities  to delete:  P2  Entities  in  set:  2 
 

Select  entities  to delete: Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

92 

 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 

 

 
 

 

 
•  Klikk (Erase drawing)  ikon  a standard eszköztáron. 

 
 

Command: _DELETE 

Select  entities  to delete:  _ALL 5  found 
 
 
 
 

 

•  Entitások törlése –   Válassza ki az entitásokat a rajzban,  használja a [Del]  gombot  a billentyűzeten. 

•  ‘ALL’  Option  –   Az összes entitás törléséhez a rajzban,  használja az ‘ALL’  beállítást. 
 

 
 

 

 
 

 

1.4 Parancsok, UNDO és REDO parancsbeállítások 
 

 
 

CADian a felhasznált parancsokat és szerkesztett alakzatokat mindig követi és visszaemlékszik a rajzban. Ha 

a felhasználó hibát ejt, visszatérhet az előző rajzra, felhasználva a Visszavonás (UNDO) parancsot. Ha a 

felhasználó véletlenül megnyomja a Visszavonás (UNDO) parancsot, és visszaakar térni az előző rajzhoz, 

akkor használhatja a Mégis (REDO) parancsot.  Ellentétesen használhatja a Visszavonás (UNDO) a 

Mégis (REDO)  parancsokat, és használhatja az U opciót is függetlenül mialatt fut a parancs. 

 

Amíg az  UNDO parancs fut,        a (Command  recover)  ikon  nem aktív. Pr
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1.5 Visszavonás (UNDO)  parancs 
 

 
Visszavonás (UNDO) parancs törli az előző parancsot. 

 
 

 
Menü  Edit(F)  ➤ Undo(Ctrl+Z) 

Eszköztár  

Szalag Edit ➤ Undo 

 
Parancs  

 
 
 
 

 

A Visszavonás ( UNDO) parancs 
 
 

 
  Használja a Vonal ( ‘LINE’)  parancsot egy egyenes megrajzolásához. 

 

Klikk (Undo)  ikon  a  ‘Quick  Access Toolbar-on. 

Törli a jelenleg futó programot. Pr
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Command:  UNDO 

UNDO aktuális beállítások:  Auto  =  ON, Control  =  All,  Combine  =  Yes,  Layer  =  Yes 

Műveletek számának beléptetése a visszavonáshoz  vagy [Auto/Control/BEgin/End/Mark/Back] 

<1>: 
 

 
 

 
 

 
❏ UNDO parancs beállítások 

 

 

Beállítás Leírás 

 

Műveletek száma Törli a megadott számú előző akciót. 

 

ON 

Auto Ugyanazon parancsokat csoportba állítja,  lehetővé teszi, hogy vissszavonja  az összest egy  paranccsal. 

OFF 

 
 
 
 

 
Control 

 

All Bekapcsolj az  Undo összes beállítását 

 

None  
Kikapcsolja az U vagy UNDO parancsot,  letiltja az Undo parancs ikont a Standard eszköztáron és  az 
Undo történeti fájlt elhagyja. 

 

One  Limitálja az  UNDO parancsot  egy akcióra egy esetben. 

 
Combine Meghatározza, hogy az   UNDO parancs számolja aTöbszörös   vagy a Valós idejű Zoom-ot/Eltolást. 

 

BEgin/End 
Egy akció csoportot képez.  Miután a  BEgin  opció beindult,  az öszes akció az  End  opció előtt 

készletté válik a csoportban. 

 

Beszúr egy jelet,  hogy jelezze a z  Undo akciót a z  Undo történeti fájlban. A Back opció törli az 

összes  végrehajtott akciót a jel után. 

Mark/Back Használja az Undo parancsot  amikor egyszerre szeretne elérni azt a pontot, ahová a jelet húzták. Pr
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Törölt entitások visszaállítása 
 

 
Ha az entitások véletlenül törlődtek,  a felhasználó visszaállíthatja azokat,  az UNDO vagy OOPS paranccsal 

 

 

•  OOPS parancs visszaállítja egy előzőleg ERASE paranccsal törölt objektumot. 

 
 
 
 
 
 
 
 
 
 
 

 

•  A  BLOCK vagy WBLOCK parancsot végrehajtva a blokk létrehozásához, a felhasználó visszaállíthatja a törölt 

entitásokata az OOPS parancs használatával.  
 

 
 
 
 
 
 
 
 
 
 

•  OOPS parancs nem állítja vissza a PURGE paranccsal törölt tételeket. 
 

 
 
 
 

 
 

 
 

1.6 MÉGIS (REDO) parancs   
 
 
 

‘REDO’  parancs lehetővé teszi, hogy visszatérjen az előző oldalra  az UNDO vagy U parancs használata után. 

Jelentése,  visszaállítja azt a parancsot, amely törlésre került.  Kivéve  UNDO  vagy  U  parancs   
 

(Parancs visszaállítás)  ikon nem aktív. Pr
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Menü Edit(E)  ➤ Redo(Ctrl+Y) 

 

 
Eszköztár 

 
 

Szalag 

Quick  Access  Tolbar 

Home ➤ Edit  ➤ Redo 
 

 

Parancs  REDO, MREDO 

 
 

 

 

•  Klikk (Command  recover)  ikon  a  Gyorselérésű eszköztáron (Quick  Access Toolbar). 

•  Vagy klikk a jobb egérgomb kattintással  a rajz területen, hogy megnyissa  a helyi menüt  és  klikk 

a Command recover-re mialatt parancs nem fut  és entitás sincs kiválasztva. 
 
 

 
 
 
 
 

Visszavonás (UNDO) és Mégis (REDO) 
 
 
 

Mégis (REDO) parancs törli egy Visszavonás (UNDO) vagy U parancs műveletét.  
 

Mégis (REDO) parancs a  Visszavonás ( UNDO) vagy U parancs után végezhető el. Pr
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1.7 Töröl (Cancel) (U) parancsbeállítások 
 

 
A legtöbb CADian parancsnak van Undo beállítása, így a felhasználó szerkesztheti a hibát a parancs 

törlése nélkül.  Például, ha a felhasználó rajzol egy vonalat vagy egy vonalláncot mint, ahogy a kép 

mutatja lentebb, törölheti az előző munkát az U-t beléptetve.  

 

 
 

Command:  _LINE 

Start  of line:  P1 

Angle/Length/<End  point>:  P2 

Angle/Length/Follow/Undo<End  point>:  P3 

Angle/Length/Follow/Close/Undo/<End  point>:  P4 

Angle/Length/Follow/Close/Undo/<End  point>:  P1 
 

Angle/Length/Follow/Close/Undo/<End  point>:  U 

Angle/Length/Follow/Close/Undo/<End  point>:  U 

 

 

 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

98 

 

 

 
 

 
 

 

02 Megjelenítés kezelés 
 

 
A felhasználó a tárgyak tervezésénél figyelembe veszi az aktuális nagyságát vagy méretét a CADian 

végtelenített rajzterületén; ezért ezeket nehéz megrajzolni ZOOM vagy (Tol) PAN eszköz nélkül. A 

felhasználónak nagyítania/kicsinyítenie vagy mozgatnia kell,  mivel a monitor mérete korlátozott. 

Ha a felhasználó 2D-s házat tervez,  azért hogy pontosan elhelyezze az ablakot és az ajtót, ezért bele kell 

nagyítani bizonyos területekbe.   
 

 

 
 

 

 

 

Tolja el az alakzatot a lépték szerkesztéséhez belenagyítva (zoom in), vagy állítsa be újra az elrendezést a rajzterületen. 
 

 

 
 

 

 

 

Képernyő megjelenítés vezérlő parancsok támogatják az ilyen eszközöket. A meglévő ábrák aktuális méretét 

nem változtatja meg, csak a képernyő megjelenítés arányt. Pr
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2.1 ZOOM parancs 
 
 

 
ZOOM  parancs lehetővé teszi, hogy a felhasználó entitásokat nagyítson vagy kicsinyítsen a rajz területen.  

Ez csak a méretét változtatja meg nem a tulajdonságát. 
 

 
 

Menü  View  ➤ Zoom ➤ Real-Time-Zoom 
 

 
Eszköztár 

 

Szalag Home ➤ View ➤ Zoom ➤ Real-Time-Zoom 

 
Parancs  

 

 
•  Klikk  legördülő menü  [View]  ⇨ [Zoom] ⇨ [Window]. 

 

 
 
 

•  Klikk  Nézet (View)  fül  on  Ribbon  menü  és klikk    ikon kirepülőjére  a  Navigate  panelablakon.      

Válassza ki a kívánt megjelenítési opciót.. Pr
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Command:  '_ZOOM 

Zoom:    In/Out/All/Center/Dynamic/Extents/Left/Previous/Scale/Right/Window/OBject 

<real  time>: 

 

❏ ZOOM parancs opciók 

 

Opció Leírás 

 
In 2x nagyítás az aktuális rajzon. 

 
Out 0.5x(1/2x)  nagyítás az aktuális rajzon. 

 
All Zoom In  the  current  drawing  to  the  outer  bounds(Limits)  of  the  drawing. 

 

Center 
Vegye a középpontot és a zoom léptéktényezőt /a  magassági érték , és igazítsa a zoom tartományt a kapott 

értékeket tekintve.   
 

 
Dynamic 

 

A nagyítást és az eltolást ugyanabban az időben hajtja végre  négyzetes nézetablakot használva. 

 
 

Extents 
Nagyítás egy minimális területre, ahol a rajzban lévő összes látható objektumot elhelyezheti az aktuális nézet 

- ablakban. 

Left 
Adjon meg egy új nézetablakot a hivatkozási ponttal a bal alsó sarokban zoom tényezővel. 

 

 

Previous Visszatér az előző nézetablakhoz.  A felhasználó visszatérhet az előző 10 nézetablakhoz. 

 

Scale 
Nagyítás szorzóval,  ha az nagyobb mint  1.0,  kicsinyítés h a  a szorzó kisebb mint 1.0.  Negatív   szorzónál 

nem hajtja végre a parancsot. 
 

Right Adjon meg egy új nézetablakot a hivatkozási ponttal a jobb alsó sarokban zoom tényezővel. 

Window Egy virtuális négyszöget hoz létre két kiválasztott ponttal és belenagyíthat a négyszögletes területbe.  

OBject 
Nagyítás egy minimális területre , hogy megjelenítse az összes kiválasztott objektumot.  A felhasználó 

objektumot választhat ki a ZOOM parancs kiadása előtt és után. 

 
Real-time Valós idejű nagyítás.  S kurzor átvált  (+)  vagy (-)    ikonra  nagyításkor/kicsinyítéskor. 
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❏ In(I)  - Az aktuális ábrát kétszeresére növeli. 

 
 
 

❏ Out(O)  - Az aktuális ábrát 1/2 arányban  

osztja. 

 
 
 

❏ All(A) - Nagyítja az egész rajzterületet. 

 
 
 

❏ Center(C) - Megjeleníti a középponttal definiált nagyított nézetet, scaled value or  height. A lépték 

növekszik, ahogy a magasság értéke megy fel.   

 
 

 

❏ Dynamic(D) - Négyzetes keretet használ az eltoláshoz és a nagyításhoz. A négyzetes keret a nézet, amellyel 

nagyíthat és mozgathatja a rajzot.  Állítsa be a nézet dobozt és ennek méretét az eltoláshoz 

vagy a zoom nézetablakhoz.   . Pr
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•  A négyzetes keret méretének megváltoztatásához kattintson,  állítson be egy méretet,  és megint 

kattintson  a négyzetes keret méretének megadásához 

•  A négyzetes keretet mozgassa a kívánt helyhez,  húzza oda a keretet és nyomjon egy entert. 

 
 

❏ Extents(E) - Nagyítás a kiterjesztett területre, ahol az összes objektum megjelenik. 

 

❏ Previous(P) - Visszatér az előző megjelenítéshez. 

 
 

 

❏ Scale(S) (nX/nXP) - Az érték nagyobb mint 1.0  nagyítani fog és kicsinyíteni, ha az érték kisebb mint   

1.0. Nem támogatja a negatív értéket. 
 

•  Az aktuális nézetből való skálázáshoz, írjon  X-et  az érték végébe. 

•  Rajz terület egységének skálázáshoz, írjon  XP-t  az érték végébe 
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❏ Window(W) - Mint a lenti képen,  belenagyít az elképzelt négyzet területbe, amelyet a két átlóban lévő 

pont határoz meg.  

 
 
 

❏ OBject(O) - A kiválasztott egy vagy több objektum nagyítása amennyire csak lehet. Kiválaszthatja az objektumokat 

a ZOOM parancs előtt vagy után. 

 
 
 

❏  Real time –  Interaktív nagyítás és a nézet méret arányának változtatása . A kurzor átváltozik egy nagyító 

jelre (+) és (-) jellel.  
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2.2  Tol (PAN) parancs 
 
 
 

Kijelöl két pontot, hogy elmozgassa az entitások megjelenítését. Jelentése, az első pontból a másodikba mozgatás. 

 
Menü  View  ➤ Pan 

 
Eszköztár 

 
Szalag Home ➤ View ➤ Pan 

 
Parancs  

 

 
 

 

•  Klikk (Valós idejű eltolás) a standard eszköztáron. Amikor a  kurzor kéz formaként jelenik meg, 

kattintás arra a pontra amelyet mozgatni szeretne, és a bal oldali egérgombbal  húzza a kívánt irányba. 
 

•  Klikk  a Nézet (View)  fülre a  Szalag menün és    ikon  a Navigate  panelen. 

 

 
 

 

Mialatt futtatja a Zoom parancsot,  és fa a jobb egérgombra kattintott egy üres rajz területen, a Helyi 

menü megjelenik, és a futtathatja a PAN parancsot. 
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2.3 Rajz tisztítása 
 
 
 

Törli az objektumokat a rajz ablakból, hogy eltávolítsa a kiválasztási pontokat,  ‘+  jelek’, amelyek 

ottmaradhattak a rajzban és az elszóródott pixeleket.   

 
 

•  Használj a  REDRAW  parancsot, hogy eltávolítsa a kiválasztási pontot. 

•  Használja a REGEN parancsot a szétszóródot pixelek törléséhez. 

 

 
 
 
 

BLIPMODE rendszer változó 
 

 
 

Ideiglenes pontokat határoz meg a rajzban, hogy látható vagy láthatatlan legyen.    
 

Ha a   BLIPMODE  engedélyezett,  +  jel mutatja a kiválasztott koordinátákat. 
 
 
 

BLIPMODE  Leírás 
 

0  Tiltó jel  +  jelek 
 

1  Engedély jel  +  jelek 
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2.4 Entitások újrarajzolása és regenerálása 
 

 
 

•  REDRAW  –   Megújítja az aktuális nézetablak megjelenítést. 
 

 

 
 

 

•  REGEN –   REGEN frissíti az aktuális rajzot  és újraszámolja sz összes objektum koordinátáit  az összes 

nézetablakban.   Továbbá optimalizálja a megjelenítést és az objektum kiválasztás 

végrehajtását az indexelt rajzi adatbázisban.  

 
 
 

 
 

 

•  REGEN ALL – REGENALL  újraalkotja az összes rajzot és újrakalkulálja az összes koordinátát az 

összes nézetablakban   Továbbá,  optimalizálja a megjelenítést és az objektum 

kiválasztás végrehajtást az indexelt rajzi adatbázisban.    
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2.5 Transzparens  parancs 
 
 
 

Transzparens  parancs akkor fut, amikor a másik aktuális fut.  Általában változó beállításának 

szerkesztéséhez használjuk vagy al eszköz bekapcsolásához, mint a SNAP, GRID vagy ZOOM.  A 

Transparent  Command eléréséhez üssön aposztrófot ‘(Apostrophe)  a parancs elé. 

 
 
 

 
Command:  _LINE 

Start  of line:  'ZOOM 

Zoom:  In/Out/All/Center/Dynamic/Extents/Left/Previous/Scale/Right/Window/ 
 

OBject<real  time>:W 

First  corner:P1 

Opposite  corner:P2 

Start  of line:  P3 

Angle/Length/<End  point>:P4 
 

Angle/Length/Follow/Undo/<End  point>: 
 
 
 

 
Transzparens parancs Transzparens parancs 

 
cal  (  or 'cal  ) dist (  or 'dist) 

 
grid (  or 'grid  ) id (  or 'id) 

 
layer (  or 'layer  ) limits  (  or 'limoits) 

linetype  (  or 'linetype  ) ltscale  (  or 'ltscale) 

osnap  (  or 'osnap  ) snap  (  or 'snap) 

style (  or 'style  ) redraw  (  or 'redraw) 

zoom (or  'zoom  ) pan  (  or 'pan) 

DDGRIPS DDRMODES Pr
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03 Koordináta-rendszer 
 

 

3.1 Koordináta-rendszer a CADian-ban 
 
 

A Koordináta-rendszer egy eszköz a CADian-ban,  hogy virtuális pontokat helyezzünk el a 2D és 

a 3D rajzokba. Mint a két lenti ábra mutatja,  a Koordináta-rendszer Origó(0,0,0)  abszolút 

standard hely a térben.  

A hivatalos rajznak követnie kell egy ipari szabványt, olyan mint a KS (Koreai Ipari Szabvány),  

amely megrajzolja a koordinátákat és pontosan jelöli a szimbólumokat.  
 

 
 

 

Ahogy a lenti ábra mutatja, a Descartes koordináta-rendszert és Polar koordináta-rendszert 

használunk a pontos rajzoláshoz a CADian-ban. 
 

 
 

 

Mindegyik koordináta-rendszer megvalósítható  Abszolút vagy Relatív koordinátákkal.  A pontos és 

helyes rajzolhoz,  a tervezőnek teljes mértékben tisztába kell lennie a két kootdináta-rendszerrel. Pr
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3.2 Koordináta-rendszer típusok 
 
 
 

A CADianban fix koordináta-rendszer un. WCS (Világ koordináta rendszer VK) és mozgatható 

koordináta-rendszer un. UCS (FKR felhasználói koordináta rendszer) van. 

 

 
❏ VK Világ koordináta-rendszer (WCS(World Coordinate  System)) 

 
 

Az összes megrajzolt objektum a CADian-ban pontos. Bármelyik objektum a rajzban amely 

bizonyos pontban áll, meghatározott az X és Y koordinátákkal. Ezt így hívják, hogy Világ 

koordináta-rendszer VK (WCS(World Coordinate System)). A felhasználóknak meg kell érteni 

VK-t (WCS) azért, hogy az objektumot a kívánt pozícióba rajzolja.  Amikor eg y parancs 

feldolgozásra kerül, hogy kiválasszon egy pontot, a felhasználók mutató eszközt használhatnak, 

ilyent mint az egér, hogy beléptessék a egzakt helyet a rajzban.   

, bármelyik pozíció a CADian rajzban kifejezhető X,  Y,  Z  koordinátákkal. Az x 

koordináta a vízszintes, az y koordináta a függőleges irányra hivatkozik. A VK kezdőpontja a az 

X és Y tengelyek metszéspontjává vált (0,0). Ezt a pontot az abszolut kezdőpontnak nevezzük. 

Amikor a CADian-t elindítjuk, a felhasználó egy alapértelmezett FK (UCS) síkon fog rajzolni. Ami 

azt jelenti, hogy az alapértelmezett FK (UCS)az a WCS. 
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❏ F K  ( Felhasználói koordináta-rendszer) UCS(User Coordinate  System) 

 

 

FK egy abszolút koordináta-rendszer amelynek testreszabot origója és  tájolása van.. 

 

 
 

 

 
 

 

Amikor a felhasználó 3D-ben dolgozik lehetőség van arra, hogy meghatározzon saját FK-t új origóval és 

tájolással, amely megkülönböztethető a VK-tól. A felhasználó meghatározhat több FK-t, amennyit akar, és 

alkalmazhatja, amikor szükségessé válik egy megfelelő nézőpont egy komplikáltabb 3D entitás 

részére.  Pr
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Például, amikor különböző FK van megadva egy épület minden oldalához, ezért sokkal könnyebb 

ablakokat rajzolni minden oldalra az FK-t megváltoztatva, és beléptetve a megfelelő X, Y 

koordinátákat mindegyik FK-hoz. Ez a módszer időt takarít meg, hogy újraszámoljuk az ablak 

pozícióit különböző oldalakon.  
 

 
 

 

Amikor egynél több FK-t határozunk meg, az aktuális FK válik standardá, hogy beléptessük az új 

kezdőpontot és tájolást. Természetesen, meg lejhet változtatni a kezdőpontot és a tájolást az FK-

ban. Következésképpen, a testreszabott VK-t (Világ koordináta-rendszert ) FK-nak nevezzük.  Ez 

az egyik kritikus elem a 3D rajzolásban. 
 
 
 

3.3 Hogyan határozzuk meg a pontok pozícióját 
 
 
 

Egy pont pozícióját egy abszolut koordináta-rendszerben a vízszintes távolsággal (X koordináta) és 

egy függőleges távolsággal (Y koordináta) az origótól (0,0) adható meg.  A magasság (Z koordináta) 

pontját  3D térben adjuk meg. 
 

 

Amikor egy pontra van szükség, az aktuális X, Y, Z koordinátákat a Státusz sor bal oldala mutatja, ahogy 

a felhasználó mozgatja a kurzor mutatóját a rajzon.   Ha a felhasználó egyenest szeretne rajzolni 
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a CADian a helyek kezdő és vég pontját igényli.  

Két módja van annak, hogy a pontok pozícióját beléptessük. 
 
 

•  Pontokra kattintás a rajzon mutató eszköz használatával  (pl.  egér). 

 

 
 

•  Koordináták beléptetése(X,  Y)  a parancs soron. 

 

 
Command:  _LINE 

Start  of line:  10,10 

Angle/Length/<End  point>:  100,100 
 

Angle/Length/Follow/Undo/<End  point>: 
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3.4 Hogyan mérjük meg a szöget 
 
 
 

A tervezőnek ismernie kell a szögek mérését a rajzolás során. Ez nagyon fontos amikor íveket rajzolunk 

vagy egyenes igazítunk, objektumot forgatunk.   

A lenti ábra szerint,  CADian megad 0  fokot, mint az X tengely pozitív irányt a descartesi koordináta- 

rendszerben. Egy szög nő, ahogy óramutatóval ellentétesen mozgatjuk. CCW(Counter Clockwise) és a szög 

csökken, amikor óramutatónak megfelelően mozgatjuk CW(Clockwise). Ezért a szög mérése az óramutató 

járásának megfelelően történik, akkor az érték negatív. Például, 10<315  ugyanabban a pozícióban találjuk, 

mint a 10<-45. 
 

 
 

 

A beállítás megváltoztatásához  menj  [Format] ⇨ [Units]. 
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3.5 Abszolut koordináta 
 
 
 

A standard koordináta-rendszert Descartes  koordináta-rendszernek nevezik amelyet a francia 

matematikus  René Descartes vezette be. 

Amint a következő ábra mutatja, egy pont A a 2D síkon az X és Y koordináták kombinációjával 

van kifejezve, amelyet az origótól (0,0) mérünk  és vesszővel van ellátva (,). 
 

     Koordináta-rendszer  Formátum 
 

Abszolút koordináta X,Y 

 

 
 

 

 
 

Abszolút koordináta használata 
 
 
 

 
 
 

A fenti ábrán van egy négyzet és az egyik oldala 30.  Itt vannak az abszolút koordinátái a 

négyzet valamennyi sarkának. Pr
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Sarok 

 

Abszolút koordináta 

 

X  koordináta  Y  koordináta 

 

A 10  10 

 

B 40  10 

 

C 40  40 

 

D 10  40 

 
 

A fenti táblázat koordinátáira hivatkozva,  rajzoljon egy négyszöget a rajz területen a vonal (LINE) 

parancsot használva. 
 

 
Command:  Z 

Zoom:  In/Out/All/Center/Dynamic/Extents/Left/Previous/Scale/Right/Window/ 
 

OBject<real  time>:  A 
 

Command:  _LINE 

Start  of line:  10,10 

Angle/Length/<End  point>:  40,10 
 

Angle/Length/Follow/Undo<End  point>:  40,40 
 

Angle/Length/Follow/Close/Undo<End  point>:  10,40 
 

Angle/Length/Follow/Close/Undo<End  point>:  C 
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3.6 Relatív koordináta 
 
 
 

CADian támogatja az objektumokhoz a relatív koordinátát  (Relative  coordinate), 

amely gyors és precíz a  2D és 3D térben. 

A P2 relatív koordinátáit és az előző P1 pont X tengely és Y tengely menti különbségeikből számoljuk ki  

( X  – távolság és  Y-tengely   Y – távolság). 

 

 

Relatív koordináta a következő formulát követi  @X,  Y.   @  szimbólum a CADian-ban azt jelenti, 

hogy mesterséges pontként (relatív kezdőpont), mint a következő pont új koordinátáiként lehet 

használni az előző ponthoz viszonyítva. 

 

 
Coordinate  System  Format 

 

Relative  coordinate  @X,Y 

 

 
 

 

Az sokkal hatékonyabb, hogy az új pozíció számítása az előző pontból, a relatív koordinátákkal történik, mint újra 

számítani az abszolút kezdőpontból.  

Ezért a felhasználóknak azt ajánljuk, hogy a jövőben ismerjék meg teljesen ezt a koncepciót a 

relatív koordináták gyakori használatához. 
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Relatív koordinátá használata 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
A következő táblázat egy négyzet sarkainak relatív koordinátáit mutatja, amelynek minden oldal 

hossza 30.  (Figyelje meg, hogy az A pont abszolút koordinátákkal van jelölve.)    
 

 

 
Corner 

 

Relative  Coordinate 

 

X  Coordinate  Y  Coordinate 

 

A 10  10 

 

B @30  0 

 

C @0 30 

 

D @-30 0 

 

 
Command:  _LINE 

 

Start  of line:  10,10  <---------------------  Abszlút koordináták 

Angle/Length/<End  point>:  @30,0  <------------  Relatív koordináták 

Angle/Length/Follow/Undo/<End  point>:  @0,30 

Angle/Length/Follow/Close/Undo/<End  point>:  @-30,0 
 

Angle/Length/Follow/Close/Undo/<End  point>:  @0,-30 
 

Angle/Length/Follow/Close/Undo/<End  point>: 
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3.7 Polár  koordináta 
 
 

A polár koordináta egy pont, amely egy sugár(távolság) és egy szög.  

 
 
 

Koordináta-rendszer  Formátum 
 

Polár koordináta  D <  α 

 

 
 

 
 

 
 
 
 
 
 
 
 

Polár koordináta használata 
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Sarok 

Abszolút koordináta 

 
X  koordináta Y  koordináta 

 
P1  -100 0 

 
P2  0  0 

 

 
Kiválasztott pont 

Polár koordináta 

 
Távolság Szög 

 

P3  100  45 
 

 
 
 

Command:  _LINE 

Start  of line:  -100,0 

Angle/Length/<End  point>:  0,0 
 

Angle/Length/Follow/Undo<End  point>:  100<45 
 

Angle/Length/Follow/Close/Undo/<End  point>: 
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3.8  Relatív polár koordináta  
 
 
 

A relatív polár koordináta hely a következő pont, amelyhez egy sugárat és egy szöget használunk az X-

tengely mentén, hívatkozva az előző pontra, mint ideiglenes origóra. 
 

 
Coordinate  System  Format 

 

Relative  Polar Coordinate  @D <   a 
 

 
 

 
 

 
 
 

 

 

 
   Relatív polár koordináták használata 

 

 

 
A következő táblázat egy négyzet sarkainak relatív polár koordinátáit mutatja, amelynek 

minden oldal hossza 30.    (Figyelje meg, hogy az A pont abszolút koordinátákkal van jelölve.) 
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Corner 

 

Relatív  polár koordináta 

 

X  koordináta  Y  koordináta 

 

A 10  10 

 

B @30  <0 

 

C @30  <90 

 

D @30  <180 

 
 
 

Line:  _LINE 
 

Start  of line:  10,  10  <---------------------  Abszolút  koordináta 

Angle/Length/<End  point>:  @30<0 <---------  Relatív  polár koordináta 

Angle/Length/Follow/Undo/<End  point>:  @30<90 

Angle/Length/Follow/Close/Undo/<End  point>:  @30<180 
 

Angle/Length/Follow/Close/Undo/<End  point>:  C 
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3.9 Utolsó pont   
 
 
 

CADian mindig nyomon követi az utolsó pont koordinátáit. Ezt úgy hívják, hogy "Utolsó pont" 

'Last Point(Final Point)'.  Az Utolsó pont kifejezése a @ szimbólum. Az  Utolsó pont nem tesz 

semmit a koordináta-rendszer típusával, csak az előző pontot használja fel.  

A következő példa egy kör a középponttól X tengely mentén 20 és 15 Y irányban a két vonal 

metsződésétől.  
 
 
 

 
 

 
 

Utolsó pont használata  (Final  Point) 
 
 
 

❶ Húzzon ideíglenesen egy vízszintes és függőleges vonalakat a LINE parancsot használva. 

 

 
 

 

❷ Azonosítsa a metsződést, mint Utolsó pont  (Last Point) a LINE parancs használatával. 

 
Command:  _line 

ENTER to use  last  point/Follow/<Start  of  line>:  P1 
 

Angle/Length/<End  point>: Pr
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❸ Rajzoljon egy kört 20 átmérővel CIRCLE parancsot használva. 
 

Command:  _circle 
 

2Point/3Point/TanTanRad/TTT/Arc/Multiple/<Center  of  circle>:  @20,15 

Diameter/<Radius>:  10 
 
 
 
 

 
 
 
 
 

 

3.10 Pont szűrő (Point  Filter) 
 

 
 

CADian támogatja a  Pont szűrő 'Point Filter' amely egy  pont komponens koordinátáit 

használhatom fel egy másik pont koordinátáihoz, amikor beléptetem az aktuális pont helyzetét. 

Például, Pont szűrő (Point Filter) használata,  vegyük az  első pont  X koordinátáját és a második 

pont Y koordinátáját. A Pont szűrő két módon áll rendelkezésre:  Helyi menü (Pop-up Menu) 

vagy  gépeljünk közvezlenül a Parancssorba. Pr
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Mint ahogy a lenti ábra mutatja, a Pont szűrő nagyon hasznos, amikor a felhasználó megpróbál egy 

kört rajzolni  egy négyszög 2   oldalának közepével megadott középpont segítségével.  
 

 
 

 
 

 
 

Kattintson a CIRCLE ikonra a Drawing Panel-on a Ribbon Bar-on. Léptesse be az .X-et a Parancssoron, 

nyomjon Szóköz billentyűt‘Space  Bar’  és kattintson a P1, P2 és P3-ra sorban. 

Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

Basic  Drafting  02 

125 

 

 

 
 

 
 

 
 

 
 

 
 

 
 
 
 

Command:  _CIRCLE 

2Point/3Point/TanTanRad/TTT/Arc/Multiple/<Center  of  circle>: 

.x (Press  Spacebar) 

Select  X  of:  P1 

Still  need  YZ  of:  P2 
 

Diameter/<Radius>  <1.2>: P3 
 
 

 
 
 
 
 

 

3.11 Koordináta-rendszerek összegzése és formái   
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Koordináta-rendszer  Formátum 

Absolút  koordináta  X,Y relatív 

Koordináta  @X,Y 

Polár koordináta  D <  a 

 
Relatív  polár koordináta  @D <  a 

 

 

Parancs/Eszköz Gyors bill.  
Kapcs. 
kulcs 

Leírás 

 

 

HELP  
 

F1 
 

Súgó megnyitás 

 

PMTHIST  
 

F2 
 

Megnyitja a promt történeti fájlt (Prompt  History) 

 

ENTITY  SNAP 
 

CTRL-F 
 

F3 
 

Kapcsolja a tárgyraszter módot 

 

ISOPLANE  
 

F5 
 

Kapcsolja az izometrikus sík beállítást  ( ISOPLANE) 

 

COORDS 
 

CTRL-D 
 

F6 
 

Kapcsolja a valós idejű koordinátát 

 

GRID 
 

CTRL-G 
 

F7 
 

Kapcsolja a háló módot 

 

ORTHO 
 

CTRL-L 
 

F8 
 

Kapcsolja az ortogonális módot 

 

SNAP 
 

CTRL-B 
 

F9 
 

Kapcsolja a raszter módot 

 

POLAR 
 

CTRL-U 
 

F10 
 

Kapcsolja a poláris követést 

 

OTRACK 
 

CTRL-W 
 

F11 
 

Kapcsolja a tárgyraszter követést 
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Exercise 1  Rajzolja le a következőt a LINE parancsot használva a megfelelő koordinátákkal. 
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Exercise 2  Rajzolja le a következőt a LINE parancsot használva a megfelelő koordinátákkal. 
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Exercise  3  Rajzolja le a következőt a LINE parancsot használva a megfelelő koordinátákkal. 
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Exercise 4  Rajzolja le a következőt a LINE parancsot használva a megfelelő koordinátákkal. 
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Exercise 5  Rajzolja le a következőt a LINE parancsot használva a megfelelő koordinátákkal. 
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Exercise 6 Rajzolja le a következőt a LINE parancsot használva a megfelelő koordinátákkal.s 

( Megjegyzés : X80/Y120   –  Abszolút koordináta ) 
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Exercise 7  Rajzolja le a következőt a LINE parancsot használva a megfelelő koordinátákkal. 

(Megjegyzés : X25/Y140   –  Abszolút koordináta ) 
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Exercise 8  Rajzolja le a következőt a LINE parancsot használva a megfelelő koordinátákkal. 

( Note : X150/Y40   –  Absolute Coordinate ) 
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Exercise 9 Rajzolja le a következőt a LINE parancsot használva a megfelelő koordinátákkal. 
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Alapok: tervezés és rajzolás 
 
 
 
 
 
 
 
 

A következő fogalmakat tárgyaljuk meg ebben a fejezetben: 

•  Rajzlap  és részei 
•  Vetület 
•  Lépték 
•  Vonaltípusok és céljaik 
•  Lépések a rajzoláshoz 
•  Rajz beállítása 
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01 Rajzlap és részei 
 
 

Gépészeti rajzoláshoz, két szabványos (KS B 0001  and KS A 0106)  méret készletet használunk. 

Következésképpen, az A0, A1, A2 A3, A4 rajzlapot használjuk és rajzoljuk meg a keretet 

(Borderline), központjelet (Center mark) és feliratmezőt (Title block).  
 

 
 

 

•  Keret (Borderline) –  Tiszta terület ahol létrehozhatja a rajzot.  0.5mm folytonos vonalat 

használjon.  

 

•  Központjel (Center mark) – 0.5mm-es folytonos vonal, a hatékonyság uniformozálásához, 

ha másolja a rajzot vagy mikrofilmet készít.    
 

•  Feliratmező (Title block) –  A feliratmező a keret jobb alsó sarkában van, és olyan dolgokat 

rögzít, mint a rajzszám, neve, méretarány, vetület, a tervez neve és a dátum.  Nincs 

elírt szabály a feliratmező  méretére és formájára, csak információkat tartalmazzon a 

megtekintő részére, hogy tisztába legyen a rajzzal. 
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1.1 Rajzlap méretek 
 
 
 

Koreai ipari szabvány(KS A 0206) megadja hogy a rajz méretének megfelelően jelenítse meg a 

rajzlap méretét. A Koreai ipari szabvány (KS A 5201) előírja az A0~A4 méretek megadását. 
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Név A0 A1 A2 A3 A4 

 

Méret (W  x V)mm 1189x841  841x594  594x420  420x297  210x297 

 

C 20  20  10  10  10 

 

 
D 

 

Nem kötelező 20  20  10  10  10 

 

Kötelező 25  25  25  25  25 
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1.2 Feliratmező és darabjegyzék 
 

 
Amint már említettük, a feliratmezőt a keret jobb alsó sarkában jelenítjük meg és állítjuk össze 

az információt a rajzról, mint a rajz szám, méretarány vetület.  Nincs előírt szabály a feliratmező 

méretére és formájára, csak információkat tartalmazzon a megtekintő részére, hogy tisztába 

legyen a rajzzal.   
 

A darabjegyzék megjelenítése a bal felső vagy a jobb sarokban van. Ilyen információkat 

tartalmaz mint sorszám, név, az anyag minőség és mennyiség. Nincs szabály ami meghatározza a 

méretét és formáját.   

A következő kép egy darabjegyzék példa.    
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02   Nézet 
 

 

2.1 A nézet áttekintése  
 
 

Vetület (Projection) egy három dimenziós kép  megjelenítésének módszere egy síkra különböző 

nézetekből. Egy fényforrás, egy objektum, egy sík felület van elhelyezve egy vonalon. Egy síkra 

rajzolja az objektum árnyékát, hogy így mutassa meg 2D-ben az objektumot. 
 

A fényforrás irányát vetítő vonalnak (Projecting  Line),  a síkot vetületi síknak (Projection  

Plane)  és az árnyékot a síkon vetületi nézetnek (Projection View) nevezzük. Egy 3D objektumot 

a síkon ábrázolhatjuk a méretével és formájával, elrendezésével, és különböző pontokból a 

vetületi nézeteivel.  

 
 

 
 

Merőleges nézetek (Orthographic  Projection)   amely merőleges 

vetületben van megrajzolva, és egy objektum felszínével párhuzamos. A merőleges vetület az 

objektumot pontosan és helyesen fejezi ki. A legtöbb rajzot a három merőleges vetületben 

rajzolják.  

 
 

Az egy vetületű és a három vetületű nézetet használjuk a gépészeti tervezéshez. Manapság a 

legtöbb rajz a harmadik vetületben van. A perspektívikus vetület általánosan használt az 

építészetben. Dőlt vetületet  (Oblique Projection) használnak a katalógusok ábráihoz.  Az egy 

vetületű nézet kényelmetlen, amikor  hosszú objektumot rajzolunk. A három vetületű nézet 

ellentétes elrendezésben van az egy vetületű nézettal, így annak sokkal könyebb 

összehasonlítani az oldalait.  
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A vetület egy módszer az objektum ábrázolására. Az objektum minden merőleges oldala egy síkra rajzolt,  úgy 

kell elképzelni, mintha az objektum átlátszó lenne.   
 
 

 
 

 
 

 
 

 
 
 

2.2 Vetületi nézetek neve 
 
 
 

A nézőponttól függően,  a vetületi nézetnek külön nevei vannak. Rendszerint az az oldal, ahol az 

objektum jellemző tulajdonságai vannak, az válik az előnézetté.  
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Nézet neve 
 

Nézet 
 

Nézet neve 
 

  Nézet 

 

felül nézet,  sík nézet 
 

felül 
 

hátul nézet 
 

hátsó 

 

Alul nézet 
 

alsó 
 

jobb oldali nézet 
 

jobb 

 

elől nézet 
 

elől 
 

bal oldali nézet 
 

bal 

 

 
 

❏ Perspektíva nézet 

 

A vetületi vonalakkal egy objektumot rajzolunk, amelyek egy pontban metsződnek, úgy ahogy 

az emberek látják a 3D objektumot.  
 
 

 
 

 

•  Egy rajznak perspektívája van akkor, amikor ugyanazon távolság távolabb rövidebbnek látszik.  

  Általában az építészetben használják.  

•  A perspektívikus rajzolás nem megfelelő, ha a rajznak pontosnak kell lennie. 
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❏ Derékszögű nézet 

 

Párhuzamos vetületi vonalakkal egy objektum vetülete mellőzi a perspektívát a rajzból.  

 

•  A hossz nem változok, a rajzon lévő távolság figyelembevétele nélkül. 

•  Az összes vetületi vonal merőleges a vetítési síkra.  

•  Az első és a harmadik vetület típus az általánosan alkalmazott derékszögű vetület., 

 
 

 

Nézet neve Nézet 

 

 

 
 

 

1.   Az objektum elhelyezése a 3 sík 

nézetbe. 

2. Vetületi sorrend: 

Szem  –  Nézet sík  –  Objektum 

3. Elölnézet: 

A test tükröződése az első síkra. 

4. Sík/Felülnézet: 

A test tükröződése a felső síkra. 

5. Hátsó nézet: 

A test tükröződése a hátulsó síkra. 
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❏ Dőlt vetület 
 

 

Párhuzamos vetületi vonalakkal egy objektum vetülete mellőzi a perspektívát a rajzból.  
 

 

• A hossz nem változok, a rajzon lévő távolság figyelembevétele nélkül. 

•  Az összes vetületi vonal egy meghatározott szögben képzi a vetületi síkot. 
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2.3 Az egy és a három  vetületű nézetek 
 

 
 

•  Helyezzen el egy objektumot egy négyzetes üvegtest belsejébe.  Az összes felületnek 

párhuzamosnak kell lennie az objektum mindegyik oldalával.  

•  Az összes vetületi vonal párhuzamos egymással és merőleges az üvegtest felületére.  
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❏ Az elől nézetű vetület 

 

 

Helyezze az előlnézetet középre és vetítse ki valamennyi nézetet az alábbi ábra szerint.  
 
 
 

 
 

 
 
 
 

❏A három vetületű nézet 

 

Helyezze az előlnézetet középre és húzza el valamennyi nézetet  a nézetek irányításához a lenti ábra 

szerint. 
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❏ Merőleges nézetek elrendezése 

 
 

 

❏ Vetület szimbólumok 

 

Itt vannak a szimbólumok, amelyek kifejezik az első és harmadik nézetű vetületeket. 
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03 Méretarány 
 
 

Egy objektum méretének aránya a rajzon az aktuális mérethez viszonyítva a Méretarány. SA 

tervezésnél a méretarány az egyik kulcsfontosságú szempont.  

A pontosság és helyesség amely meghatározza a rajz minőségét, ez függ a tervező képességétől 

és a méretaránytól a megfelelő vetületi nézetekben, az ipari szabványokra támaszkodva.  KS A 

0110 rajzi méretarány megköveteli az 1:1 méretarány használatát, és számos további rögzített 

nagyobb/kisebb méretarányt.  

 
 

Típus 
 

Jelentése 
 

Szabványos méretarány (gépészethez) 

 

Kis méretarány 
 

Kisebb mint az objektum 
 

1:2,  1:5,  1:10, 1:20, 1:50, 1:100, 1:200 

 

Teljes méretarány 
 

Az objektummal megegyező méretű 
 

1:1 

 

Nagyobb méretarány 
 

Nagyobb mint az objektum 
 

2:1,  5:1,  10:1, 20:1, 50:1 
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A méretarány a következőképpen reprezentálhtó:    (A rajzlapon :  B valódi méret) 
 

 
 

 
 

Egy objektum ábrázolásához egy korlátozott rajzlap területén nagyítani vagy kicsinyíteni 

szükséges, hogy az a rajzlapon kényelmesen elférjen. 
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A tervezőnek dokumentálnia kell a rajz méretarányát a felirat mezőben. Ha a rajz egy részének 

méretaránya különböző, az alkalmazott méretarányt fel kell tüntetni az alkatrész mellett.   
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04   Vonal típusok és céljaik 
 
 

-Dashed 

.  - -

 

KS  B 0001  Mechanical Drafting   megszabja, hogy a vonal 

ö 0.13, 0.18, 0.25, 0.35, 0.5, 0.7, 1.0, 1.4, 

2.0mm,  a rajz m ő ő ő 

Á

ökö  

❏ Vonaltípusok és leírás 
 

Vonaltípus Leírás 

 

Folyamatos vonal  

 

Szaggatott vonal  

 

Láncolt vonal  

 

 
Láncolt dupla szaggatott vnal 

 
 

❏ Vonaltípusok és vastagságok 
 

Név  Vonaltípus 
Vastagság 

(mm) 

 

 
 
Leírás 

 

Látható vonal 

(objektum vonal) 
0.5  ~ 0.7  Egy objektum külső formáját reprezentálja

 
 

 

Takart vonal 
 

0.3  ~ 0.4 
 

Egy objektum rejtett éleit reprezentálja
 

 

Közép vonal 
 

0.1  ~ 0.25 
 

Egy objektum közepét reprezentálja
 

 

Fantom vonal 
 

0.1  ~ 0.25 
 

Egy objektum virtuális részét reprezentálja
 

Kiterjesztett vonal 0.3  ~ 0.4  
Méreteknél használt, szekcionált élekhez, mutató vonalakhoz és 

sraffokhoz Pr
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❏ Vonal típusok és funkciók 

 
 

Típus Vonaltípus Egyedi név 

 
Vastag Objektum vonal  / látható vonal 

 
 

 
Folytonos 

vonal 

 
 

 
Vékony 

Méretvonal,  mutató vonal 

 
 

Sraff 

 

 
Section  Line 

 

 

Vastag 
Szaggatott    

vonal 

 
Takart vonal 

Vékony 
 

 
Láncolt vonal Vékony Középpont vonal 

 
Láncolt dupla 

szaggatott 

 
Vékony   Fantom vonal 
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❏ Vonaltípusok prioritása 

 

Ha több vonal átfedi egymást, a következő prioritási sorrend működik: 

 Visible Line / Látható vonal 

 Hidden Line / Takart vonal  

 Cutting Plane Line / Kivágás vonala 

 Center Line / Középpont vonal 

 Line of Gravity /  Súlypont vonala 

 Dimension Line / Méretvonal 
 
 

Akkor alkalmazza ezt a prioritást, amikor több mint egy vonal átfedi egymást:  Látható vonal > Takart vonal 

> Kivágás vonala > Középpont vonal. A szövegnek és a szimbólumnak magasabb prioritása van 

mint a vonalaknak,  ezért szakítsa meg a vonalat és  először szúrja be a szöveget vagy a  

szimbólumot. 
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05 Rajzolás lépései 
 

 

5.1 Rajzolási folyamat sorrendje 
 
 

Minden rajzolásnak négy lépése van: 

 

Lépés  
Idő 

(Százalék) 

 

Részletek 

 

1  Rajz beállítás 5% 
Rajz méret,  méretarányok,  mértékegység, 

pontosság,  fóliák 
 

2  Rajzolás 40%  
Nézetek elrendezése, 
Rajz közép/objektum vonalak 

 

3  Rajz kiegészítés 50%  
Sraff, kiegészítések, méretek   és 

darabjegyzék 
4  Rajz ellenőrzése  5% Átnézés 

 

 
 

Az alábbi folyamata összegzi a rajzolás folyamatát a CADian-ban. 
 
 

❶ Válasszon ki egy objektumot 

❷ Állítson be egy rajzlapot 

•  Rajzlap mérete és határai,  mértékegység és méretarányok szerint 

•  Rajz keret és központi jel 

•  Fóliák,  színek és vonaltípusok beállítása 

•  Szöveg és méretstílusok beállítása 
 

❸ Nézetablakok beállítása, alap és középvonal rajzolása 

❹ Objektum látható vonalainak megrajzolása 

❺ Sraff, kiegészítések és méretek beszúrása 

❻ Feliratmező és az alkatrész lista megrajzolása 

❼ Rajz ellenőrzése 
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5.2 Méretarányok alkalmazása a rajz elemekhez 
 
 

Rajz elemekhez alkalmazott méretarányok listája. 
 
 

Rajz 

elemek 

 

Típus  Alkalmazott méretarány 

 

 
1  Lap megadás 

Outline 

 
Középpont jel 

 
Megszorozza a mértearány reciprokával. (2:1  =  0.5,  1:2 = 2) 

 
Látható vonal 

 

 
2  Megjelenítés 

Takart vonal 

 
Fantom vonal 

 
Középpont vonal 

 
Vonaltípus méretarány alkalmazás, 

rajzolásnál teljes méretű lépték. 

 
Méretvonal 

 
 

 
3  Méretezés 

Méret 

segédvonal 

 
Nyíl 

 
Méretszöveg 

 
Egy rajz többszörös mérete, a léptéktényező reciprokával. 

 
4  Sraff Sraff vonal Megszorozza a mértearány reciprokával. 

 
Normál  szöveg 

 

 
5  Szöveg 

Kiegészítések 

 
Anyag lista 

 
Egy rajz többszörös mérete, a léptéktényező reciprokával

 
Cím 

 

6  Szimbólum Befejező jel  
Egy rajz többszörös mérete, a léptéktényező reciprokával 

 

 
Az a különbség a CADian-ban való rajzolás és a hagyományos rajzolás között, hogy méretarányt 

alkalmazunk az objektumhoz és a rajzlap beálltásokhoz (keret, határok). 
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5.3 Rajzolási szabályok a CADian-ban 
 

 
 

❏ Az objektum méretaránya 1:1, ha  a CADian korlátlan síkot biztosít. 
 

 
 

❏ Gépészeti rajzban, az összes vonaltípust alkalmazhatjuk, de nem alkalmazhatjuk az 

összes vonalvastagságot.   0.25mm a z  alapértelmezett vonalvastagság, amellyel 

objektumot rajzolunk. A vonalvastagságot a folyamat utolsó részében alkalmazzuk. A 

plottolásnál a különböző színeket a különböző fóliákon használjuk.  
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06   Rajz beállítás 
 

 

6.1 A mértékegység és a pontosság beállítása 
 
 

Tradícionálisan,  egy objektum hossza a rajzon mm-ben van ábrázolva a gépiparban. Ezért a rajzon lévő 

minden hossz milliméterben van, amely azt jelenti, hogy a mértékegységet el lehet hagyni amikor 

méretezünk. Azonban a szögeknek van mértékegységük, mint 20∘ .  A mértékegységek különböző 

ipari területeken és különböző országokban változnak.  

Itt van egy általánosan használt hossz  mm -ben kifejezve  a valós környezetben 

mértékegység nélkül.  

•  A betonvas hossza 2,400 . 

•  Állítsa be a tűrést, úgy mint 0.01 . 

•  Az összes hossz a rajzban milliméterben van. 

•  Ezért nincs arra szükség, hogy beszúrjuk a mértékegységet. 

•  Azonban, a szög egységét be kell szúrni.. 

•  A súly kg -ban  van kifejezve. 

 
A pontosság foka nagyon fontos. A számjegyek száma jelentős a tizedespont alatt, a pontosság 

fokát jelenti. Ha a rajzbeállítás tizedesjegyre van beállítva(0.1, 1/10), de az aktuális rajz százados 

pontossággal van kifejezve(1/100), akkor a költségek legalább ötszörösével nőnek mint az 

eredeti költség. 
 

 

Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

Basic  Design  &  Drafting  03 

161 

 

 

 
 

 
 

 
 

 
 

 
 

 

 
 

6.2 Mértékegységek parancs 
 

 

Habár a CADian munkatér egy virtuális 3D tér határok nélkül,  egy objektumot pontosan lehet 

megrajzolni 2D-ben. A pontosság maximalizálásához a mértékegység beállítása döntő lehet.  Az 

alapértelmezett mértékegység a mm, a pontosság foka a rajztól függ. Hamár a pontosság foka 

be van állítva, a koordináták és a méretek automatikusan követik a kiválasztott pontosságot.   

UNITS parancs beállítja a típusát és a pontosság fokát a hossz méretekre és a fokokra.   

 
Menu  Format(M)  ➤ Units...(U) 

Toolbar 

Ribbon Home ➤ Format ➤ Units... 

Command  UNITS(  OR 'UNITS  ) 

❏ A hossz típusának és pontosságának beállítása 

 
 

➀ Állítsa be a hossz típusát (Length Type) mint  tizedes Decimal . 

➁ Állítsa be a pontosságot (Precision) a hosszra  (Length) és a szögre (Angle). 

➂ Állítsa be a méretarányát a rajznak és szúrja be a blokkokat. A beszúrási lépték a blokkok 

eredeti mértékegységeinek aránya vag y hivatkozik az aktuális rajz mértékegységeire.  Pr
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6.3 Rajz méretarány 
 
 

CADian  korlát nélküli 2D síkot ad a rajzhoz. Ezért az objektumot teljes méretben Full-Size 

Scale(1:1) lehet megrajzolni. Óriási épületet vagy parányi microchipet teljes méretű arányban 

lehet megrajzolni a maximális pontosság végett az objektum aktuális méreteivel. CADian-ban, a 

méretarányt a plottolásnál, a teljes méretű méretarányt a modelltérben alkalmazzuk. Ez innovatív 

megoldás professzionális tervezőkdek de kezdő felhasználóknak is.  
 

A multban a tervezőknek munden alkatrészt skálázni kellett, hogy jól elférjenek az A3 vagy A1 

rajzlapon. Ha a rajz a nagyobb méretarányban van, a tervezőknek szorozni kell a valós értéket a 

méretarány tényezőjével, egy kisebb méretarányú rajzban a valós értéket osztani kell  

méretarány tényezőjével.  

A legtöbb CADian felhasználó metrikus típusú hosszt alkalmaz a rajzban, amely 1mm, 1cm, 1m, 

1km mértékegységeket jelent. Valójában mm vagy m a tradicionális tervező egység. Például, a 

legtöbb gépészeti vagy építészeti tervező használ mm egységet, és a kerttervezők, 

építőmérnökök m egységet használnak.  
 

Ha a CADian mértékegysége mm-ben van, és a tervező a rajz egységként cm-t alkalmaz.  Rajzol 

egy ajtót 100 egységben és egy íróasztalt 75 rajzegységben.  Ezek cm-ben vannak. Ha a 

méretarány nincs kiigazítva amikor plottól, 1 cm egy 1mm-ként lesz megmutatva, mivel a 

mértékegység mm-ben van.  

Más szavakkal, a rajz méretarány  

1/10  mint 1 rajz egység  (cm-ben) és 

1rajz egység (mm-ben) amikor plottol. 
 

Ezért, mielőtt plottolná a rajzot,  10:1 

méretarányt kell használni, hogy  10 

rajzegységet állítson elő (10cm = 

100mm) és így 1mm legyen a 

rajzlapon. Pr
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6.4 Rajzhatárok 
 

CADian korlátlan 2D síkot és 3D nyújt, hogy teljes méretarányban rajzoljon az összes 

objektum számára.  

A tervezőnek először be kell állítania a rajzhatárokat, mielőtt elkezdené a munkát.  Mikor 

befejeznek egy rajzot, bemutatja más osztályoknak vagy más vállalatoknak,  a befejezett rajznak 

az ipari szabványt kell követnie. Általában, a rajzhatárok megadása arajzlap méretéhez a 

méretarány reciprokának a szorzatával kerül megadásra.  
 

Tehát, először a rajzegység beállítása gyorsítja a rajzolási folyamatot az engedélyezett területre 

korlátozva az objektumokat.  Ez akkor is hasznos, amikor kötegelt üzemmódban (Batch  

Plotting) nyomtatunk ki számos rajzot.  
 
 
 

 

Itt vannak a LIMITS  parancs általános funkciói: 
 

 

•  Háló határ. 

•  Az entitások részére engedélyezett terület a rajzhoz. 

•  A Zoom határok/összes terület. 

•  Terület beállítások a Plot parancsban. 
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6.5 Határok (LIMITS) parancs 
 
 

A háló határainak beállításai az aktuális modellen/ elrendezésen. 
 

 
 

Menü Format(O)  ➤ LIMITS(L) 

 
Eszköztár 

 
Szalag 

 
Parancssor LIMITS 

 
 
 

 
 
 
 
 

 

A rajz határainak beállítása 
 
 

 
  Állítsa be a rajzhatárokat és aktivitásokat. 

 

 
Command:  _LIMITS 

 

Limits  are  off:    ON/<Lower  left  corner>  <0.0000,  0.0000>: 

Upper  right  corner  <12.0000,  9.0000>:  420,297 Pr
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Command:  _LIMITS 

 

Limits  are  off: ON/<Lower  left  corner>  <0.00, 0.00>:  ON 
 

 
Most,  be van állítva a rajzhatár a méretaránnyal , mint1:1, A3(420x297). 

 
 
 

  Rajzoljon egy kört a határon kívül. 
 
 
 

Command:  _CIRCLE 
 

2Point/3Point/TanTanRad/TTT/Arc/Multiple/<Center  of  circle>:    -100,0 

(Selected  point  is  outside  limits.  Please  select  another  point.) 

A kiválasztott pont a határon kívül van.  Kérem, válasszon egy mások pontot. 

2Point/3Point/TanTanRad/TTT/Arc/Multiple/<Center  of  circle>: 
 

 
 

❏ LIMCHECK rendszer változó 

 

A határon kívüli objektumok létrehozását vezérli. 
 

 
 
 

Beállítás Leírás 

 
ON Az objektumk megrajzolhatók a határokon kívül.  

OFF Az objektumk nem megrajzolhatók a határokon kívül. 
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6.6 MVSETUP  parancs 
 
 
 

Mértékegység típus (Units Type), Méretarány (Scale Factor) és a papírméret (Sheet Size) 

beállítása, és rajzoljon határként egy négyszöge.  Használja az 

MVSETUP parancsot különféleképpen mutatja a prompt,  függ az aktív modelltértől/rajztértől. 
 

 
 

Command:  MVSETUP 
 

Enable  paper  space? [No/Yes]  <Y>:  N 

Enter units type  [Scientific/Decimal/Engineering/Architectural/Metric]:  M 
 

 
Metrikus méretarány 

================= 

(5000)  1:5000 

(2000)  1:2000 

(1000)  1:1000 

(500)    1:500 

(200)    1:200 

(100)    1:100 

(75) 1:75 

(50) 1:50 

(20) 1:20 

(10) 1:10 

(5) 1:5 

(1) FULL 

 

 
Enter the  scale  factor:  1 

 

Enter the  paper  width:  420 
 

Enter the  paper  height:  297 
 

 

Command:  _ZOOM 

Zoom:  In/Out/All/Center/Dynamic/Extents/Previous/Scale/Windows/OBject 

<real  time>:  _a 
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Készítsen egy A3(420x297)  rajzlapot teljes méretaránnyal a következőképpen.  
 

 
 

 
 

 
 
 

Határok beállítása a skálázott rajzhoz 

 

 
A rajzlap mérete, amelyhez a méretarányt a következő módon számítjuk ki.   

 

Rajzegység = Méretarány x Rajzlap méret 
 
 
 

❏ Méretarány 1:100,  és a rajzlap határok beállítása A1 (841x594)  mm-ben. 
 

 

•  Vízszintes hossz: 100  x 841mm  = 84,100mm 

•  Függőleges hossz:  100  x 594mm  = 59,400mm 
 
 

Command:  _LIMITS 

Limits  are  off:    ON/<Lower  left  corner>  <0.0000,  0.0000>: 

Upper  right  corner  <12.0000,  9.0000>:  84100,59400 
 
 

 
Command:  _LIMITS Pr
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Limits  are  off:  ON/<Lower left  corner>  <0.0000,  0.0000>:   ON 

Command:    F7  <Grid  ON> 

Command:  ZOOM 

Zoom:    In/Out/All/Center/Dynamic/Extents/Left/Previous/Scale/Right/Window/ 

OBject<real  time>:  A 

 

 
 

 

❏ Kicsinyítés 2:1  és állítsa be a rajzhatárokat mint A3(420x297). 
 

 

•  Vízszintes hossz: 0.5 x 420  = 210 

•  Függőleges hossz:  0.5 x 297  = 148.5 
 
 

Command:  _LIMITS 

Limits  are  off:    ON/<Lower  left  corner>  <0.0000,  0.0000>: 

Upper  right  corner  <12.0000,  9.0000>:  210,148.5 
 
 

Command:  _LIMITS 
 

Limits  are  off:    ON/<Lower  left  corner>  <0.0000,  0.0000>:   ON 

Command:    F7  <Grid  ON> 

 
 
 

Command:  ZOOM  Pr
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Zoom:    In/Out/All/Center/Dynamic/Extents/Left/Previous/Scale/Right/Window/ 
 

OBject<real  time>:  A 
 

 
 

 
 

 
 

 
 

Rajzlap beállítások,  vázlat és plot rajzok 
 

 
 

A rajzon lévő objektum egy apartman lesz,  a hossza  60m(60,000mm)  x 40m(40,000mm) 

és a nyomtatandó lap mérete A1(841X594). Méretarány  1:100. 
 
 

  Használja a LIMITS parancsot a rajzhatár beállításához. 

A rajzhatár (0,0),  (841x100,  594x100) lesz. 

 

 

  Használja a RECTANGLE parancsot, hogy megrajzolja a rajzlap határvonalát a lenti kép 

szerint és a LINEPr
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paranccsal rajzolja meg a határvonalak központ jelét.   
 

 
 

 

  A LINE parancs használatával rajzolja meg a  'Felirat mezőt'  vagy a 'Darabjegyzéket'  

a lenti kép szerint. 

 

 

  Használja a DRAW vagy a MODIFY parancsot az 1:1 mérataránnyal való tervezéshez. 
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  Állítsa be a méretet és a szöveg magasságát. 

A következőt jelenti, állítsa be a méret magasságát és a szöveget, amely megjelenítésre 

kerül a nyomtatott rajzban.   
 
 
 

  A PLOT parancs használata a kinyomtatáshoz. 
 

Állítsa be a méretarányt 1:100  és a nyomtatási határok A1((0,0),  (84,100,  59,400))  az ablak 

opcióból. Ezután, állítsa be az előnézetet és  kattintson az OK   gombra. 
 
 
 

 
 

 
 

Ugorjon tovább, ha nem értette eddig, próbálja meg ismét, miután többet tanult a CADian-ról. Pr
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A rajzlap és a komponensek  beállítása 
 
 
 

A rajzlap mérete A3(420 x 297) a méretarány 1:10.  Rajzolja meg a keret  és a középjelet. 
 
 

1.  Rajzlap beállítása, hogy 1:1 méretaránnyal dolgozzunk. 

2. A keret mérete (1:10). 

Szélessége = 420mm  x 10  - (2 x 10mm  x 10) = 4,000mm 

Magassága = 297mm  x 10  - (2 x 10mm  x 10) = 2,770mm 

3. Határok  - (0,0),  (4200,2970) 

4. Fólia beállítása 

5. Vonaltípus aránya (LTSCALE)  = 10 

6. Szöveg magasság (TEXTSIZE)  = 3mm  x10 = 30mm 

7.  Sraff minta arány(HPSCALE)  = 10 

8. Méret stílus arány(DIMSCALE) = 10 
 
 

  Nyisson meg egy új rajzot  és állítsa be a rajz határokat A3 méretre.  
 

 
Command:  '_LIMITS 

Limits  are  off:    ON/<Lower  left  corner>  <0.0000,  0.0000>: 

Upper  right  corner  <12.0000,  9.0000>:  4200,2970 

 
Command:  LIMITS 

 

Limits  are  off:    ON/<Lower  left  corner>  <0.0000,  0.0000>:   ON 

 
Command:  ZOOM 

Zoom:    In/Out/All/Center/Dynamic/Extents/Left/Previous/Scale/Right/Window/ 

OBject<real  time>:  A Pr
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  Keret megrajzolása 
 

 
Command:  _RECTANGLE 

Chamfer/Elevation/Fillet/Rotate/Square/Thickness/Width/ 

<Select  first  corner  of  rectangle>:  100,100 
 

Specify  other  corner  point or [Area/Dimensions/Rotation]:  4100,2870 
 
 

 
 

 
 

  Rajzolja meg a négy középpontot keleti, nyugati, déli és északi oldalán a keretnek. (SB = 

Space Bar) 
 

 
Command:  _LINE 

ENTER to  use  last  point/Follow/<Start  of  line>  mid  (SB)  Snap  to  MID  of:  P1 
 

Angle/Length/<End  point>:  @-100,0 
 

Angle/Length/Follow/Undo/<End  point>: 
 
 

Command: 

Start  of line:  mid  (SB)  Snap  to  MID  of:  P2 
 

Angle/Length/<End  point>:  @100,0 
 

Angle/Length/Follow/Undo/<End  point>: Pr
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Command: 

Start  of line:  mid  (SB)  Snap  to  MID  of:  P3 
 

Angle/Length/<End  point>:  @0,100 
 

Angle/Length/Follow/Undo/<End  point>: 
 
 

Command: 

Start  of line:  mid  (SB)  Snap  to  MID  of:  P4 
 

Angle/Length/<End  point>:  @0,-100 
 

Angle/Length/Follow/Undo/<End  point>: 
 

 
  Használja a LINE parancsot a Feliratmező  megrajzolásához  vagy a darabjegyzékhez . 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  Mértékegység beállításához [Format]  ⇨ [Units] 

kattintás a legördüló menün. 
 

 
 Állítsa be a hosszt és a szög típusá , mint Decimal. 

 Állítsa be a pontosságot, mint '0'. 
 

 Kattintson a Direction   gombra,  hogy 

nyugtázza és állítsa be a standard  szöget. Pr
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  A Linetype méretarány beállítása 
 
 
 

Command:  LTSCALE 
 

Enter new  value  for  LTSCALE  <1.0000>:  10 
 

 

Egy másik módja az, hogy kattintson  a [Format] ⇨ [Line Type] a legördülő 

menüben és [Show Details] gomb a 'Global  Scale Factor' beállításához  '10'-re. 

 

 
 

 

  Állítsa be a szöveg, a sraff és az objektum méretének méretarányát,  

 

 
•  Szöveg méret (TEXTSIZE) = 3mm x10 = 30mm 

 

 
 

Command:  TEXTSIZE 
 

Enter new  value  for  TEXTSIZE  <0.2000>:  30 Pr
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•  Méretezés méretarány (DIMSCALE) = 10 
 

 
 

Command: DIMSCALE 
 

Enter new  value  for  DIMSCALE  <1.0000>:  10 
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•  Sraff minta  méretarány(HPSCALE) = 10 

 

 
 

Command:  HPSCALE 
 

Enter new  value  for  HPSCALE <1.0000>:  10 
 
 
 

 

 
 
 

 
  Mentse a rajzfájl nevét, mint A3-10-Formpart.  dwg. 

Ha sablon fájlként szeretné használni,  mentse el a nevét mint A3-10-Formpart.  dwt. Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

178 

 

 

 
 

 

 
 
 

Exercise  10  Szerkessze meg a határokat és a kontúrvonalakat az A3-as lenti rajznak.  
 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

Basic  Design  &  Drafting  03 

179 

 

 

 
 

 

 
 
 

Exercise  11  Szerkessze meg a határokat és a kontúrvonalakat az A4-es lenti rajznak. 
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04 
 

 

Ívelt formák rajzolása 
 

 
 
 
 
 
 
 

A következő fogalmakat tárgyaljuk meg ebben a fejezetben: 

•  Rajzi segédeszközök 

•  Ívelt objektumok rajzolása 
•  Egyenes objektumok rajzolása 
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01 Rajzi segédeszközök 
 
 

Az alakok pontos megrajzolásához,  a felhasználónak be kell állítani a helyes segédeszközöket.  A következő 

táblázat több segédeszközt mutat meg.  
 
 

 
Icon Name Description 

 
                         SNAP Korlátozza a kurzor mozgását  egy kijelölt intervallumban.                                                    

                                       GRID Megjeleníti  a  hálót a rajzterületen 

                      ORTHO       
Bekapcsolja a merőleges módot,  amely korlázozza a rajzolási      irányokat 

csak a függőleges és a vízszintes irányokba.                                                                         

                       POLAR Bekapcsolja a  Polar  nyomkövetést. 

 
ENTITY  SNAP Bekapcsolja a tárgyrasztert, amely a  kurzort a legközelebbi  

tárgyraszter pontba mozgatja. 

 
                    OTRACK 

Bekapcsolja a tárgyraszter követést. 

 
 

                           LWEIGHT Bekapcsolja a vonalvastagságot a kiosztott  vonalvastagságokhoz. 

 
 

Model  Space A papírtérről a modelltérre kapcsol és fordítva . 
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1.1 Háló (GRID)  parancs 
 
 
 

Időt takarít meg, és növeli a tervezés hatékonyságát, ha a felhasználó megjeleníti a  Hálót (GRID) 

és a  Rasztert (SNAP), valamint beállíthatja a szöget és a kiosztást. 
 

 

 
 

 
A Háló (GRID) pontok négyszög mintával, mint a fenti kép, amelyen a rajzterület van bemutatva,  

a Határok (LIMITS)  parancs beállításával. Ez csak a rajzolásban segít a felhasználónak. 
 

A Háló segít az objektumok elrendezésében és láthatóvá teszi a távolság beállítást; viszont nem 

lesz kinyomtatva.  

A Hálót a Raszter móddal kell használni (SNAP). A Raszter mód korlátozza a szálkereszt 

mozgását szeparált távolságokra. Amikor a Háló mód be van kapcsolva, a kurzor 

hozzákapcsolódik egy láthatatlan négyszög hálóhoz, amelyet Raszter elérésnek nevezünk. A 

Raszter fontos a pont precíz kijelöléséhez, ehhez mutató eszközt vagy koordináta értéket bevivő 

eszközt alkalmazva.   

 
 
 

Menü Format(O)  ➤ Drafting  settings(I)... 

 
Eszköztár  

 

Szalag Home ➤ Format  ➤ Drafting  setting... 

Parancssor GRID 
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Command:  GRID 

Grid  is  off:  ON/Snap/Aspect/<Grid  spacing (x  and y = 0.5000)>:  1.0 
 

 
Option Description 

 
Grid  Spacing Új Háló távolság érték beállítás.                 

ON Háló megjelenítés 

OFF Háló elrejtése 

 

Snap 
Beállítja az új térköz értéket 

 

Aspect A Háló  értékének beállítása  X és Y irányokban 

 
 

 

 
 

 
Grid  ON/OFF  and Set  Snap  & X,  Y  Spacing  Value. 

 
 
 

Command:  GRID 

Grid  is  on:  OFF/Snap/Aspect/<Grid  spacing (x  and y = 1.0000)>:  OFF 
 
 

Command:  GRID 

Grid  is  off:  ON/Snap/Aspect/<Grid  spacing (x  and y = 1.0000)>:  ON 
 
 

Command:  GRID 

Grid  is  on:  OFF/Snap/Aspect/<Grid  spacing (x  and y = 1.0000)>:  S 
 
 

Command:  GRID 

Grid  is  on:  OFF/Snap/Aspect/<Grid  spacing (x  and y = 1.0000)>:  A 

Horizontal  spacing <1.0000>:  2.0 

Vertical  spacing <1.0000>:  2.0 Pr
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Háló beállítások   –  Rajzbeállítások dialógus panel 
 
 

 
  A lenti képhez hasonlóan,  helyezze az egér kurzort a Hálóra a státusz soron   és jobb 

egérgomb kattintás, majd kattintás a Beállításra (Settings). 
 

 
 

 

  Gépelje be a háló x és y távolságot a Grid területen a Raszter és Háló ((Snap and Grid) 

fülön a Draft Settings  dialógus ablakban. 

Jelenleg a háló távolság 10mm-re van állítva. 
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1.2 Raszter (SNAP) parancs 
 
 

A Raszter különösen fontos, amikor a felhasználó  alakot rajzol meghatározott kiosztással vagy 

szögben.  A Raszter korlátozza a kurzor mozgását a távolság vagy szög beállításával. A Háló 

megjelenítéssel, a felhasználónak a Rasztert aktiválnia kell. 
 

 
 
 

Menü Format(O)  ➤ Drafting  settings(I)... 

 
Eszköztár 

 

Szalag Home ➤ Format  ➤ Drafting  settings....  ➤ Snap and Grid 

 
Parancssor SNAP 

 

 
 
 

Command:  SNAP 

Snap is  on (x  and y=0.5000):  OFF/Rotate/Style/Aspect/<Snap  spacing>:  5 
 
 
 
 
 

Beállítás Leírás 

 
Snap Spacing Új Raszter intervallum beállítása megadott értékkel. 

 
ON Raszter mód engedélyezése ezzel a beállítással.   

OFF Raszter mód kikapcsolása.  Maradnak az aktuális beállítások.  

Rotate A Raszter háló elforgatás szögének beállítása 

Style 
Meghatározza a Raszter háló stílusát     a   Standard     és az 

izometrikus között. 
 

Aspect Beállítja a távolságot  X és Y irányban. 
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❏ Izometrikus mód (Stílus beállítás) 

 
 

Command:  SNAP 

Snap is  on (x  and y = 0.5000):  OFF/Rotate/Style/Aspect/<Snap  spacing>:  S 

Isometric/<Standard>:  I 

Vertical  spacing <0.5000>: 
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1.3 Polaráris  követés 
 
 

Poláris követés (Polar Tracking) a megadott szögben  önnálóan dolgozik. Ha a poláris követés 

aktivált, a  CADian megjeleníti az  elmozdulást és a szöget, ahogy a kurzor mozog.   
 

Menü Format(O)  ➤ Drafting  Settings(I)... 

Eszköztár   

Szalag Home ➤ Format  ➤ Drafting  settings....  ➤ Polar  Tracking 
 

Parancssor DSETTINGS 
 

 

 
 

 

 

 
 

Használja az F8-at az ortogonális mód kezeléséhez.  Az ortogonális mód csak négy szögirányt 

engedélyez. A F10 használatának elkerüléséhez, amely lehetővé teszi a felhasználónak, h o g y  

irányítsa a z  ortogonális módot és különböző irányokba rajzoljon a szöget inportálva.  
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Polárkövetés használata 

 

Mint a lenti képen,  a parallelogrammának  van egy  60  fokos szöge. 

 

 
 

Azért, hogy egy vonalat rajzolni tudjunk, amely ugyan olyan, mint a parallelogramms jobb 

oldalán van, használnia kell a tárgyraszter követést és polár követést (Object SNAP Tracking 

and Polar Tracking). Mint már tudja, az ortogonális módoz csak akkor lehet használni, 

amikor 0, 90, 180  és 270  fokot kell rajzolni. Következésképpen,  a polár koordináta 

követést 60 fokos szögre kell állítani a rajzoláshoz.  
 

Klikk  (Polár koordináta követés) gomb a státusz soron és jobb egérgomb kattintás 

hogy beállítsa a legördülő menüben.. Ezután, kattintson a 'Polar  Coordinate Track' fülre. 
 

  Válassza ki a 30-at a legördülő ablakban a szög növekményekből.  Ez a beállítás lehetővé 

teszi, hogy kilenc szöget állítson be  0,  5, 10, 15, 18, 22.5, 30, 45  és 90  fokos 

tartalmakkal. 
 

 
 

 

A szögek hozzáadásához,  jelölje kattintson         Gépelje 

45  fokot, és  tegye ugyanezt a 135,  225  és a 345  fokra. 
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  Poláris koordináta követő funkciók a tárgyraszter követő tulajdonságaival.  A 

tárgyraszter-követő beállítás 'Object Snap Track Setting' mező a dialógus ablak jobb 

oldalán,  válassza ki a Követés poláris szögbeállítások használatát  'Track using all polar 

angle settings'. 
 

 

 Válassza ki az Abszolútot  a  Poláris szög mérése  "Polar Angle measurement' mezőben és 

kattintson az  'Ok' gombra, hogy lezárja a dialógus panelt.   
 

 

  Futtassa a LINE parancsot, mint a lenti képen.  Ezután, mozgassa a kurzort közel a    P1 

parallelogramma pontjához és amikor a tárgyraszter végpont jel megjelenik,  mozgassa jobbra, 

hogy beállítsa a vonal kezdőpontját a P2-őt  Mozgassa a kurzort megint a P3-hoz és 

amikor a tárgyraszter végpont jele megjelenik, mozgassa a kurzort ismét, hogy beállítsa 

a P4-et, amelynek a polár koordinátája 22<60. 
 

 
 

Amikor az egérgombot a P1-hez közel viszi,  ortogonális pontozott vonal megy át a 

megjelenített ponton, és ugyanezt kell alkalmazni a P3-ra is.  Ha be van állítva a  

Polaráris szög mérés, mint Abszolút, az csak azt fogja engedélyezni a felhasználónak, 

hogy 0, 30,  60... fok legyen a végpontból.   
 

Végeredményképpen, mielőtt beállítja a P4-et, ha elmozgatja az egérgombot 0 foktól a 

90 fokig, a pontozott vonal csak 0, 30, 45, 60, 90  fokos irányokban lesznek 

megjelenítve. 
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1.4  Tárgyraszterek beállítása 
 
 

A tárgyraszter lényeges eszköz a CADian-ban, hogy pontosan kiválaszthassuk az entitások 

kezdőpontját, végpontját, felezőpontját, metszéspontját vagy érintőjét. 
 
 
 

Menü Format(0)  ➤ Drafting  setting...(I) 

 
Eszköztár  

 

Szalag Home ➤ Format  ➤ Drafting  setting    ➤ Object  Snap 

 
Parancssor OSNAP 

 

 

 
 
 

❏ Tárgyraszter beállítás eszközei 
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❏ Tárgyraszter módok 

 

 
 

 
Endpoint-végpont, Midpoint-felezőpont, Center - középpont, Node - csomópont, Quadrant - negyedelő 

Intersection - metszéspont, Insertion - beillesztési pont,  Tangent - érintő, Nearest - szomszédos, 

Perpendicular -  merőleges, Extension - meghosszabbítás, Apparent Intersection - látszólagos 

metszéspont, Parallel - párhuzamos  
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❏ Tárgyraszter eszköztár 

 

 

❏ Tárgyraszter előugró menü 

Kattintson a jobb egérgombra az üres rajzterülten a 'Shift' billentyű lenyomva tartásával, hogy 

megjelenítse a tárgyraszter legördülő menüt. Kattintson arra az opcióra amelyet tárgyraszternek 

szeretne,ezután kattintson az objektum raszter pontjára a rajzon.   
 

 
 

❏ Státusz sor 
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❏ AutoSnap beállítások 

A lenti képhez hasonlóan, a felhasználó optimalizálhatja az AutoSnap és AutoTrack  

tulajdonságokat a Rajzolás fül beállításainál. 

 

 
 
 

AutoSnap igazítások az 'AutoSnap  beállításoknál',  'AutoSnap  jelölés nagysága'  és az 

apertura mérete az 'Aperture  Size' beállításával. 
 

 

•  AutoSnap megjelenítés beállításait a jelölő négyzetek alapján teheti meg.   

 

 
 

•  MAGNET (Mágnes) kezelése a jelölő doboz jelölésével.  Ha ez aktivált, a 

mágnes a raszterpontra ugrik,  amely a kijelölt keresztpont.Pr
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•  Megjeleníti az AutoSnap rasztertippek beállításait a jelölő négyzet alkalmazásával. 

•  AutoSnap  Marker alapértelmezésben ki van kapcsolva. Jelölje be az AutoSnap céldoboz 

jelölő négyzetét a  (Display AutoSnap aperture box)  megjelenítéséhez. Ha kiválasztott egy 

pontot a tárgyraszter segítségével, a szálkereszt vonalának a céldoboz kereténél kell lennie, hogy 

a CADian megtalálja a pontot.  AutoSnap céldoboz fontos, amikor először tanulja a tárgyrasztert. 

•  Használja a csúszkát a céldoboz  (Aperture  Size) méretének beállításához. 

 

 

A céldoboz (Aperture)   és a szálkereszt céldoboza különböző.  A céldoboz (Aperture)   csak 

akkor jelenik meg, amikor a tárgyraszter mód aktivált. A szálkereszt céldoboz (Marker box) 

akkor jelenik meg, amikor a Select Objects: prompt be van kapcsolva. A céldoboz  (Aperture) 

mérete pixelben van megadva, a következő képek nem valós méretűek. 

 
 
 

 
 

Mozgassa el a csuszkát jobbra, hogy nagyobbra vegye az AutoSnap jelölő nagyságot ( AutoSnap  

Marker Size). A nagyobb méretet könyebb látni a nagyfelbontású képernyőn.  
 
 
 

 
 
 

Az alapértelmezett szín az AutoSnap  Marker részére a zöld.  A szín megváltoztatásához,  

kattintson a szín (Colors) gombra az AutoSnap beállítás területen. Pr
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Válasssza ki a "2D Model Space"-t a Kontextus (Context) ablakból  és az  "2D AutoSnap 

Marker"-t az Interfész elemeiből   (Interface Elements) a Rajz ablak színei (Drawing  

Windows Color) dialógus ablakból. Használja a szín lista legördülő menüjét a jobb oldalon. 

Klikk OK az alkalmazáshoz. 
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❏ AutoTrack (Automatikus követés) 

 

 

AutoTrack  beállítások területén lehet beállítani a z  AutoTrack  funkciókat. 

 

 

 
•  Poláris követési vektor megjelenítése (Display polar tracking vector) kapcsolja apolar  

követő vektort. 

•  Követési vektor teljes képernyős megjelenítés (Display  full-screen tracking vector)  

kapcsolja a polár követést a rajzterület határáig.  Ha ez a beállítás nem jelölt, a polár  

követés csak a kitűzött pontok és a kurzor között lesz megjelenítve. 

•  AutoTrack eszköztipp megjelenítése (Display  AutoTrack Tooltip)  megjeleníti az 

ideiglenes eszköztippeket az automatikus követésnél.  

A Követési pont kijelölése (Alignment Point Acquisition) alatti területen, határozhatja meg 

hogyan rögzíti a pontokat használva azokat, mint referencia a követéshez.  
 
 
 
 
 

•  Automatikus jelöléssel rögzít minden pontot az AutoTracking-hez, ahonnan a  tárgyraszter indul. 

•  Jelölje be a 'Shift  to  acquire'  amely a shift gomb lenyomását igényli azért, hogy  

leszúrja a pontot az objektum követéshez és a tárgyraszterhez (Object Tracking and 

Object Snap). Ha túl sok tárgyraszter van bekapcsolva, használja ezt az opciót, hogy 

elkerülje azt, hogy szükségtelen rasztereket ragad meg.  

•  Az AutoTrack Vector szín módosításához, kattintson a Színre (Color) az AutoSnap 

beállítási területen.  Ezután válassza a 2D  Model Space-t a  Kontextusban, és  a "2D  

AutoSnap Marker" az Interfész elemek közül  a Drawing Windows Color dialógus 

ablakban. Használja a szín lista legördülő menüjét a jobb oldalon, Kattintson az OK-ra az 

alkalmazáshoz.  
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❏ Apertura parancs 
 

 

Tárgyraszter apertura méretének beállítása pixel egységet használva. 
 

 
Menü 

Eszköztár 

Szalag 

Parancssor APERTURE 
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A tárgyraszter csak akkor reagál, amikor egy pont metszi vagy belül van a tárgyraszter aperturán. 

APBOX   rendszerváltozó kapcsolja a tárgyraszter apertura megjelenítését. 
 

APERTURE parancs állítja be a tárgyraszter aperturát.  Amint az érték növekszik, az apertura mérete 

szintén növekszik. A méret beállítása lehet a Drafting Tap  és az  Option dialógus ablak alatt. 
 
 

Command:  APERTURE 

Selection  area  for  entity  snap (1-50  pixels)  <5>:  10 
 

 
 
 
 

 
 

 
 
 

Tárgyraszter apertura beállítása az APERTURE paranccsal különbözik az  Objektum 

kiválasztás doboztól (Pickbox). PICKBOX parancs állítja be az Objektum kiválasztás doboz 

(Object Selection Box) méretét. Pr
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Exercise  12  Rajzolja meg a következőt használja a Háló/ Raszter Grid/Snap 

funkciót és a  Vonal (LINE) parancsot 
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Exercise  13  Rajzolja meg a következőt használja a Háló/ Raszter Grid/Snap 

funkciót és a  Vonal (LINE) parancsot 
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❏ Fólia beállítások a CAD rajzokban 

 
Fólia                   Vonaltípus                 Szín                    Vonalvastagság                               Neve 

 
OL                   Folytonos                        Blue                      0.8mm              Kontúr 

 
VL                  Folytonos                   Green                       0.5mm                Látható 

 HL                   Rejtett2                      Yellow                        0.35mm           Takart 

CL                 CENTER2                        Red                     0.18mm           Közép 

IL                 PHANTOM2                    Pink                      0.18mm          Fantom 

 
FL  Folytonos White 0.18mm  

Sraff, méret 

vonal 
 

 

SL                CENTER                           Green                       0.5mm             Felület 

 
DL                CENTER                           White                     0.18mm               Síkmetsző 

 

RS                Folytonos                        Cyan                    0.26mm           Finishing  Symbol 

 
 
 

 
 

<Minta fólia beállítások> 
 
 

❏ Javasoljuk, hogy készítsen különböző fóliákat mindegyik gyakorlathoz, a fenti ábrához hasonlóan. 

Hivatkozás a fenti táblázatra. Több részletes informácó a [6. fejezet:  Fólia és entitás tulajdonság] Pr
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02 Görbült objektumok rajzolása 
 
 

Ez a fejezet olyan parancsokat mutat be, amely különböző entitásokat könnyen és pontosan rajzol 

meg a Curved formával.  
 
 

 
Icon Command Description 

 
CIRCLE /Kör/ Kör rajzolása kölönböző opciókkal. 

 
 

ARC   /Ív/ Ív rajzolása kölönböző opciókkal. 
 

 
ELLIPSE  Ellipszis rajzolása. 

 
           PLINE /vonallánc/ 2D vonallámc,  amely egy vonalból és egy ívből áll. 

                PEDIT Vonalláncok szerkesztése  és 3D Háló. 

SPLINE Egy  NURBS alapú Spline rajzolása. 
 
 

SPLINEDIT Spline-ok szerkesztése. 
 
 

DONUT Kitöltött körgyűrű rajzolása. 
 

 
SOLID Rajzoljon egy kitöltött háromszög / négyszög testet. 

 

 

FILL Kitöltés,  olyan mint a sfraff / Hatch/,  2D test  és vastag vonalláncok. 
 
 

RECTANGLE  Téglalap rajzolása   vonallánccal. 
 
 

POLYGON Sokszög rajzolása vonallánccal. Pr
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2.1 A  kör parancs 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 
 
 

 

 

Használja a Kör /CIRCLE/ parancsot különböző kör objektumok többféle módon való 

megrajzolásához. A CADian-ban a kör megrajzolásának alapvető módja, hogy beállítjuk a 

középpontot és a sugarat.   

 

 
Menü Draw(D)  ➤ Circle(C)  ➤ Center,  Radius 

 

Eszköztár  

 

Szalag HOME ➤ Draw ➤ Circle  ➤ Center,  Radius 

 
Parancssor   CIRCLE 

 
 
 

•  Klikk Kör (Circle) ikon a kirepülön a [Ribbon]  ⇨ [Draw]  fül. 

•  Gépelje CIRCLE vagy C a parancs sorba. 

 
 
 

 
Command: _CIRCLE 

2Point/3Point/TanTanRad/TTT/Arc/Multiple/<Center  of  circle>:  P1 

Diameter/<Radius>:  P2 
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Icon Option Description 

 

Középpont-sugár  

 

 Középpont -átmérő  

 

Két pont  

 

Három pont  

 

Érintő-érintő-sugár  

 

 
 

Érintő-érintő -érintő 
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Exercise  14  Rajzolja meg a következőt a  Kör / CIRCLE/ parancs használatával. 
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Exercise  15  Rajzolja meg a következőt a  Kör / CIRCLE/ parancs használatával. 
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2.2  Ív  parancs 
 

Az ív /ARC/ formálásához a kezdőpont és a végpont összekapcsolása. Továbbá, a felhasználó 

rajzolhat ívet a sugár /Radius/, szög /Angle/ és távolság /Distance/ értékeinek kombinálásával. 

 
Menu Draw(D)  ➤ Arc(C) ➤ 3  Point 

 
Toolbar  

 

Ribbon HOME ➤ Draw ➤ Arc ➤ 3  Point 

 
Command ARC 

 

 

•  Klikk  Ív (Arc) ikon a kirepülő eszköztáron [Ribbon]  ⇨ [Draw]  fülön. 

•  Gépelje azt, hogy 'ARC' vagy ' A' a parancs soron. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Command:  _ARC 

Center/<Start  of  arc>:  C 

Center  of  arc:  P1 

Start  point:  P2 

Angle/Length  of  chord/<End   point>:  P3 Pr
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Ikon Opció Leírás 

 

3Pont  

 

Kezdő,  Közép,  Vég                                             

 

Start,  

Kezdő,  Angle                                               

 

Start,   

 

Center,  Length                                             

 

Start,  

End,  Angle                                                  

 

Start,   

 

End,  Direction                                              

Start,  End,  Radius 
 

 

Center,  Start,  End 

  

 

Center,  Start,  Angle

 C

Center,  Start,  Length       

 
 

Tangent  Arc Pr
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Rajzolja meg a következő ajtót  az ARC parancsot használva 
 

 
 

  Rajzolja meg a következő falat és ajtókeretet. 
 

 

  Rajzolja meg az ajtót az ARC parancs használatával. 
 

 
Command:  _ARC 

Start  of  arc or  [Center]:   C  <------------ Center option 

Center  of  arc:  C 

Start  point:  S 

Angle/Length  of  chord/<End   point>:  E 
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Rajzolja meg a következőt, vonal és az ARC parancsot használva 

 

 
 

  Aktiválja az Orthogonal  (Merőleges)  és Entity  Snap (Tárgyrasztert)  a lenti képnek megfelelően. 
 

 
 
 

 
 

 

  Kattintson a LINE parancsra. 
 
 

Command:  _LINE 

Start  of  line:  P1 

Angle/Length/<End  point>:  P2 

Angle/Length/Follow/Undo/<End  point>: 
 
 

  Kapcsolja ki az orthogonal (merőleges) módot és használja az ARC parancsot. 
 

Command:  _ARC 

ENTER  to  use last  point/Center/Follow/<Start  of  arc>:  P2 

Angle/Center/Direction/End/Radius/<Second  point>:  P3 

End point:  P4 
 

 

  Kapcsolja be az orthogonal-t  és kattintson a LINE parancsra. 
 

Command:    _LINE 

Start  of  line:  P4 

Angle/Length/<End  point>:  P5 

Angle/Length/Follow/Undo/<End  point>: Pr
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2.3 Ellipszis /ELLIPSE/  parancs 
 
 
 

Ellipszis egy mértani alakzat amely a major (nagy)  és 

minor (kis) tengelyekből áll a jobb oldali képnek 

megfelelően. Általában, rajzolja meg a nagy tengely 

végpontjának kijelölésével vagy a kis tengely és adja meg a 

másik tengely hosszát.   
 

. 
 
 
 

Menü Draw(D)  ➤ Ellipse(E)  ➤ Center(C) 

 
Eszköztár 

 
Szalag Home ➤ Draw ➤ Ellipse  ➤ center 

 
Parancssor ELLIPSE 

 
 
 

•  Klikk  (Ellipse) ikon a szalag menü kirepülő eszköztár és  Rajz (Draw) fül. 

•  Gépeljen ELLIPSE vagy EL a parancssorba. 
 
 
 
 
 
 
 

 

 
Command:  _ELLIPSE 

Arc/Center/<First  end of  ellipse  axis>:  P1 

Second of  axis:  P2 

Rotation/<Other  axis>:  P3 Pr
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Rajzoljon ellipszist a középpont használatával. 
 
 
 
 
 
 
 
 
 
 
 
 

Command:  _ELLIPSE 

Arc/Center/<First  end of  ellipse  axis>:  C 

Center  of  ellipse:  P1 

Endpoint  of  axis:  P2 

Rotation/<Other  axis>:  P3 
 
 

 
Rajzoljon egy elliptikus ívet 

 

 
 

Command:  _ELLIPSE 

Arc/center/<First  end of  ellipse  axis>:  A 

Center/<First  end of  ellipse  axis>:  P1 

Second end of  axis:  P2 

Rotation/<Other  axis>:  P3 

Parameter/<Start  angle  of  arc>:  30 

Paratmeter/Included/<End  angle>:  180 

Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

214 

 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
❏ Izometrikus kör rajzolása 

 

 

❶ Izometrikus beállítások 
 

 

Command:  SNAP 

Snap is  off   (x and y=0.5000):  ON/Rotate/Style/Type/Aspect/<Snap  spacing>:  S 

Isometric/<Standard>:  I 

Vertical  spacing <0.5000>:  10 

Commang:  GRID 

Grid  is  off:  ON/Snap/<Spacing  in  y direction  (isometric,  y = 0.5000)>:  ON 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

❷ Vezérlés és rajz kurzor  az izometrikus nézetben. 
 
 

 Nyomja megaz F5 vagy Ctrl-E  gombot, hogy megjelenítse a kurzort, mint a lenti képen. 

Ezután, használja a Line parancsot, hogy megrajzolja a kocka bal oldali izometrikus oldalát. 

Nyomja megaz F5 vagy Ctrl-E  gombot, hogy megjelenítse a kurzort, mint a lenti képen. 

Ezután, használja a Line parancsot, hogy megrajzolja a kocka fenti izometrikus oldalát.   

Nyomja megaz F5 vagy Ctrl-E  gombot, hogy megjelenítse a kurzort, mint a lenti képen. Ezután, 

használja a Line parancsot, hogy megrajzolja a kocka jobb oldali izometrikus oldalát.Pr
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❸ Ellipszis rajzolása izometrikus nézetben. 
 

 

Command:  _ELLIPSE 

Arc/Center/Isocircle/<First  end of  ellipse  axis>:  I 

Center  of  circle:  P1 

Diameter/<Radius  of  circle>:  P2 
 
 
 
 

❹ A fenti leírás szerint, rajzoljon egy ellipszist a felső izometrikus síkon és a jobb izometrikus 

síkon  a lenti kép szerint. 
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2.4 POLYLINE (Vonallánc) parancs 
 
 

POLYLINE (Vonallánc) parancs szegmenseket köt össze, például, Line (Vonal) és Arc (Ív), hogy 

egy entitást alkosson, mint a lenti képen.  A felhasználó beállíthatja a szegmensek vastagságát, 

ha szükséges. 
 

 
 

 

Polyline-t (Vonalláncot) a következő alkalmazói programokban lehet használni. 
 

 

•  Topográfiai térképek, izobár vonalak, tudományos alkalmazói programok diagramjai 

•  Huzalozási ábrák és  nyomtatott áramköri kártyák 

•  Cső diagramok 

•  Projekt diagramok és 3D testmodell kontúrok 

•  Vágó vonalak a CAM modellben. 
 

 

Különböző formák tervezése, mint (Rectangle), (Polygon), (Donut),  (Boundary) 
 

és (Revision Cloud) mint LWPOLYLINE objektum típus. 

 
MenÜ Draw(D)  ➤ Polyline(P) 

Eszköztár 

Szalag Home ➤ Draw ➤ Polyline 

 
Parancssor PLINE 

 

 
 

•  Klikk [Draw]  (Rajz) ⇨ [Polyline] (Vonallánc) a legördülő menün. 

•  Válassza a Polyline (Vonallánc) a Draw (Rajz) fülön a szalag menün. 

•  Gépelje a PLINE vagy PL a parancssoron. 
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Command:  _PLINE 

ENTER  to  use last  point/Follow/<Start  of  polyline>:  P1 

Arc/Distance/Follow/Halfwidth/width/<Next  point>:  P2 

Arc/Distance/Follow/Halfwidth/width/Undo/<Next  point>:  A 

angle/CEnter/Close/Direction/Halfwidth/Line/Radius/Secondpt/Width/Undo/ 

<End  of  arc>: 
 

 
 

❏ Parancs opciók 

 
Vonal mód Leírás 

 

Ív                                        Hozzáad egy ív szegmenst  a vonallánchoz.    

 Távolság                           Kiterjeszt  az utolsó pont irányából egy adott távolságra.  

Követés                           Követés az utolsó végpontból. 

Félvastag Fél vastagságra állítja a vonalláncot.  

Vastag Beállítja a vonallánc vastagságát. 

Visszavonás                    Eltávolítja az előzőleg hozzáadott  vonallánc szegmenst . 

 
 

Ív mód Leírás 
 

Szög Beállítja a szögét a vonallánc ív szegmensének. 

 CEnte Beállítja a középpontját a vonallánc ív szegmensének. 

Zár Összeköti az utolsó pontot a kezdőponttal, hogy zárt objektum. 

Irányítás Beállítja az irányát a vonallánc ív szegmensének. 

Félvastag Fél vastagságra állítja a vonalláncot.  

Vonal Hozzáad egy vonal szegmenset a vonallánchoz.   

Sugár Beállítja a sugarát a vonallánc ív szegmensének. 

Secondpt Egy vonallánc ív szegmenst rajzol  3 pont felhasználásával.   

Vastag Beállítja a vonallánc vastagságát. 

Visszavonás   Eltávolítja az előzőleg hozzáadott  vonallánc szegmenst . Pr
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Rajzolja meg a következő objektumot a  POLYLINE  (Vonallánc) paranccsal. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Command:  _PLINE 

ENTER  to  use last  point/Follow/<Start  of  polyline>:  P1 

Arc/Distance/Follow/Halfwidth/Width/<Next  point>:  P2 

Arc/Distance/Follow/Halfwidth/Width/Undo/<Next  point>:  A 

Angle/CEnter/Close/Distance/Halfwidth/Line/Radius/Secondpt/Width/Undo/ 

<End  of  arc>:  P3 

Angle/CEnter/Close/Distance/Halfwidth/Line/Radius/Secondpt/Width/Undo/ 

<End  of  arc>:  L 

Arc/Distance/Follow/Halfwidth/Width/Undo/<Next  point>:  P4 

Arc/Distance/Follow/Halfwidth/Width/Undo/<Next  point>:  C 
 
 

 
 Rajzolja meg a következő objektumot a  POLYLINE  (Vonallánc) paranccsal. 
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Command:  _PLINE 

ENTER  to  use last  point/Follow/<Start  of  polyline>:  P1 

Arc/Distance/Follow/Halfwidth/Width/<Next  point>:  P2 

Arc/Distance/Follow/Halfwidth/Width/<Next  point>:  W 

Starting  width<0.0000>:  3.0 

Endting  width<30.0000>:  0 

Arc/Distance/Follow/Halfwidth/Width/<Next  point>:  P3 

Arc/Close/Distance/Follow/Halfwidth/Width/<Next  point>: 
 
 
 

 

 
 
 
 

 

2.5 Vonallánc szerkesztése (PEDIT  parancs) 
 

 
 

Szerkessze meg a Polyline (Vonallánc) és 3D Polygon (3D Sokszög) keveréket. PEDIT parancsot 

általában vonal konvertáláshoz a 2D vonallánc, ív 2D vonallánchoz, vonallánc  B-spline 

csatlakoztatásához használjuk. 

 

 
Menu   Draw(D)  ➤ Polyline(P) 

Toolbar  

Ribbon Home ➤ Draw ➤ Polyline 

 
Command PLINE 

 
 
 

•  Klikk [Modify] (Módosítás) ⇨ [Object] (Objektum) ⇨ [Polyline] (Vonallánc) a legördülő menüben. 

•  Klikk Modify  (Módosítás)   kirepülő eszköz a s z a l a g o n , ezután (Vonallánc szerkesztés). 

•  Típus PEDIT vagy PE a parancssoron. Pr
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❏ 2D Vonallánc (Polyline) szerkesztés 

 

Command:  _PEDIT 

Multiple/Select  polyline  to  edit:  P1 

Edit  polyline:  Edit  vertices/Close/Decurve/Fit/Join/Linetype-mode/Reverse/Spline/ 

Taper/Width/Undo/<eXit>:  (Enter  an option) 
 
 

 
 

 
 

Opció Leírás 

 
Vertex szerkesztés Vonallánc vertexek szerkesztése. 

 
Zár/Nyit  Zár egy nyitott vonalláncot és fordítva. 

 
Kihajlít (Uncurve) Kiegyenesít egy begörbített vonalláncot vonalánccá vonal szegmensekből.   

Illeszt (Fit) Vonal szegmensekből álló vonalláncot konvertál gőrbült vonalláncá. 

Kapcsol (Join) Kapcsol vonallánc-vonal,  vonal-ív  stb.  hogy egyedileg kapcs. obj. legyen. 

Vonaltípus-mód Beállít egy vonaltípust  a közeli vonal szegmensekhez  egy vertex körül. 

Fordít (Reverse) Megfordítja a vertexek sorrendjét a vonalláncban.  

Spline Egyenes vonalláncot konvertál   simított splin-á.  

Kúposít (Taper) Beállítja a kezdő és végpont vastagságát a  vonalláncnak.   

Vastagság (Width) Beállítja a vastagságát a  vonalláncnak.  Pr
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Vertex 

     Opciók 
Leírás 

 

Következő/Előző Elmozgatja a vertexen  az X jelet  a következő/előző  vertexhez. 

 
Szög (Angle) Beállítja a szöget a szegmensek között. 

 
Break   

Törli az összes vertexet és szegmenst   két kiválasztott vertex között,   és 

visszatér a szerkesztés módba. 
 

Beszúrás (Insert) Hozzáad egy vertexet a jelenleg kiválasztott vertex mellé.    

Mozgatás (Move) Elmozgatja a kiválasztott vertexet egy másik pozícióba. 

 Regen Regenerálja a vonalláncot 

SElect Kiválaszt egy vertexet, hogy szerkesszen a szegmensen.    

Straighten Kiegyenesíti a vonalláncot   két kiválasztott vertex között. 

Vastagság (Width)
  

A következő vonallánc szegmens kezdő és végpont vastagságát szerkeszti a 
vertex után. 

 

eXit Kilép a vertex szerkesztés módból. 
 

 
 
 

❏ Vonal, ív vagy spline szerkesztése 
 

 

A következő prompt megjeleníti, azt az entitást amit a felhasználó kiválasztott, amely 

tartalmazhat vonalat, (Line) ívet (Arc) vagy spline-t.   
 
 

Multiple/Select  polyline  to  edit:  P1 

The entity  selected  is  not  a  polyline.  Turn it   into  one? <Y> 
 

 
❏ 3D vonallánc szerkesztése 

A következő prompt azt jeleníti meg, amikor 3D vonalláncot kell kiválasztani. 
 
 

Multiple/Select  polyline  to  edit:  P1 

Edit  polyline:  Edit  vertices/Close/Decurve/Reverse/Spline/Undo/<eXit>: 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

222 

 

 

 
 

 
 

 
  

 

 
 

 
 

 
 

Előtte Utána 
 
 

❏ Sokszög háló szerkesztése 
 

A következő prompt jeleníti meg, amikor a sokszög háló kiválasztásra kerül.  
 
 

Multiple/Select  polyline  to  edit:  P1 

Edit  polyline:  Edit  vertices/Desmooth/Smooth/Mclose/Nclose/Undo/<eXit>: 
 

 

 
 

 
 

PLINEGEN  rendszerváltozó 
 

 
Állítsa be a  vonaltípus (Linetype) mintát, hogy alkalmazni lehessen az összes vonallánc 

szegmens közepén, és határozza meg, hogy a minták hogyan legyenek leírva a rövid 

szegmensek részére,  ahol szaggatott vonalat nem lehet rajzolni.  Ha az utóbbi eset történik,   a 

vonalak tovább terjeszkednek a végponton, amely a takart minta létezését mutatta. Pr
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Vonalláncok esetében,  meg lehet határozni ha mintát használunk csak a szegmens közepén 

alkalmazzuk vagy folytonosan. 

PLINEGEN  rendszerváltozó beállítása. 

 
PLINEGEN 

változó Leírás 
 

 0 Tömör vonallánc rajzolás  a végén, közel a vertexekhez.   
 

1 Folytonosan alkalmazott vonaltípus (Linetype)  minták  figyelmen 

kívül hagyva a vertexeket. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

 

2.6 Téglalap (RECTANG)  parancs 
 
 
 

Használva a téglalap ( RECTANGLE)  parancsot,  rajzoljon téglalap alakú zárt vonalláncot a két szembelévő 

pont kiválasztásával. Lehetséges a hossz, a szélesség, a terület és elforgatási paraméter beállításával. 

Továbbá a felhasználó beállíthatja az él típusát vagy használhatja a  lekerekítés (Fillet) és a letörés  

(Chamfer) parancsot. 

 
 

 
 
 

Menü Draw(D)  ➤ Rectangle 

 
Eszköztár  

 

Szalag Home   ➤ Draw ➤ Rectangle 

 
Parancssor RECTANG 
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•  Klikk R ajz  [Draw]  ⇨ Téglalap [Rectangle]  a legördülő menün. 

•  Válassza a  ikont  a  Rajz (Draw)  fülön a szalag menün.  

•  Gépelje a RECTANG  vagy  REC a parancssorba. 
 

 

Command:  _RECTANG 

Chamfer/Elevation/Fillet/Rotate/Square/Thickness/Width/ 

<Select  first  corner  of  rectangle>:  P1 

Specify  other  corner point:  P2 
 
 

 
 

 

 
 

Opció Leírás 
 

Letörés/Chamfer Beállítja a távolságokt a letörés opcióhoz. 

 Felemelés/Elevation  Beállítja a téglalapp felemelését . 

Lekerekítés/Fillet Beállítja a letörés sugarát 

Forgatás/Rotate Megrajzol egy téglalapot, amelyet egy adott szöggel elforgat.   

Négyszög/Square  Megrajzol egy négyszöget, amelynek oldalhossza a megadott érték.  

Vastagság/Thickness  Beállítja a téglalap vastagságát. 

Szélesség/Width Beállítja a téglalap szélességét.Pr
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❏ Néhány téglalap van a  RECTANG  parancs néhány beállításával. 
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2.7 Sokszög /POLYGON/   parancs 
 

 
 

Sokszög rajzolása vonallánccal. 

 
Menü         Rajz/Draw(D)  ➤ Sokszög/Polygon(Y)  

Eszköztár  

    Szalag       Kezdőlap/Home ➤ Rajz/Draw ➤ Sokszög/Polygon 

 
Parancssor       S o k s z ög / Polygon 

 

 

•  Kattintson a  legördülő Sokszögre  a szalagon  ‘Rajz /Draw  fül  és válassza   (Polygon). 

•  Gépelje a POLYGON  vagy  POL a parancs soron. 
 

Command: _POLYGON 

Polygon:  Multiple/Width  of  line/<Number  of  sides>  <4>:  5 

Specify  center  of  polygon  or  [Edge]:  P1 

Enter  an option  [Inscribed  in  circle/Circumscribed  about  circle]  <C>: 

Specify  radius  of  circle:  P2 
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2.8 SPLINE  parancs 
 
 
 

Spline pontokból készült egyhe ív.  Beállíthatja az ív szögét és engedélyezheti a pontokat. SPLINE 

parancs speciális típusú ívet készít,  NURBS(Nonuniform Rational B-splines). 
 

 
 

 
Az spline-t olyan formák létrehozásához használjuk, mint repülőgép szárnyak vagy  turbinalapát. 
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  Menü Rajz/Draw(D)  ➤ Spline(S) 

 
Eszköztár  

 

Szalag Kezdőlap/Home ➤ Rajz/Draw ➤ Spline 

 
Parancssor SPLINE 

 

 
 
 

Command:  _SPLINE 

Object/<First  point  for  spline>:  P1 

Second point:  P2 

Close/Fit  tolerance/<Next  point>:  P3 

Close/Fit  tolerance/<Next  point>:  P4 

Close/Fit  tolerance/<Next  point>: 

Select  starting  tangent  point: 

Enter tangent  for  ending  point: 
 

 
Beállítás Leírás 

 
 

Objektum  Convert  2D or  3D spline  fitted  polylines  to  splines. 

Spline első pontja Válassza ki az spline kezdő pontját. 

Második pont Válassza ki az spline második pontját.  

Következő pont Válassza ki az spline következő pontját.  

Zár Összekapcsolja az utólsó pontot az első ponttal   a  zárt spline-hoz.  

Tolerancia beállítás Beállítja a max. beállítható távolságot,  mindegyik spline vertextől.  

Kezdő érintőpont Beállítja az spline kezdő érintő pontját 

Vég érintőpont Beállítja az spline vég érintő pontját Pr
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Tolerancia beállítás spline-hoz 

 
:  _SPLINE 

 
Object/<First  point  for  spline>:  P1 

Second point:  P2 

Close/Fit  tolerance/<Next  point>:  P3 

Close/Fit  tolerance/<Next  point>:  P4 

Close/Fit  tolerance/<Next  point>:  P5 

Close/Fit  tolerance/<Next  point>: 

Select  starting  tangent  point: 

Enter  tangent  for  ending  point: 
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2.9  Spline szerkesztése (SPLINEDIT) parancs 
 
 
 

Spline vagy spline  formátum szerkesztése a  PEDIT parancs használatával. 
 

 

 
 

 

Menü Modify(M)  ➤ Edit  Spline 

 

Eszköztár  

 

Szalag Home ➤ Modify  ➤ Edit  Spline 

 
Parancssor SPLINEDIT 

 
 
 

Command: _SPLINEDIT 

Select  spline:  P1 

Enter  an option  [Fit  data/Close/Move  vertex/Refine/rEverse/ 

Convert  to  polyline/Undo]: 
 
 
 

 
Opció Leírás 

 
Zár/Close Összeköti a két végpontot, hogy egy simított zárt spline-t  készítsen. 

 

Nyit/Open
  

Eltávolítja az utolsó szegmenst,  amelyet azért rajzolta, hogy összekösse a végpontot a 

kezdő ponttal, és ezzel nyitottá tegye a zárt spline-t. 
 

Finomít/Refine Spline  kontroll  pontok,  módosítja a kiemelési sorrendet,  és módosítja az spline-t. Pr
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Opció Leírás 

 
 
 
 
 
 
 
 
 
 
 

Fit  Data 

Illesztő adatok szerkesztése különféle beállítások használatával 

Add Illesztőpontot ad az spline-hoz. 

Close Összeköti a két végpontot, hogy egy simított zárt spline-t  készítsen. 

Open  
Eltávolítja az utolsó szegmenst,  amelyet azért rajzolta, hogy összekösse a végpontot a 

kezdő ponttal. és ezzel nyitottá tegye a zárt spline-t. 

Delete Eltávolítja az illesztő pontokat, hogy olyan vonalat készítsen, amely átmegy a 

megmaradt vertexeken.   
   

Move Az illesztőpontot elmozgatja egy új pozícióba.  

Purge  Törli az spline illesztő adatokat  a rajz adatbázisból. 

Tangents A kezdő és végpontban érintőket szerkeszt. 

toLerance Újrarajzolja az spline-t egy új tolerancia értékkel.   

eXit Visszatér az előző prompt-hoz. 

 
 
 
 

 
Move Vertex 

Vertexeket mozgat egy spline-on. 

Next  A következő vertexhez mozgat. 

Previous  Az előző vertex-hez mozgat. 

Select 

point 
Kiválaszt egy vertexet, hogy a segmensen szerkessze.  

 

eXit Visszatér az előző prompt-hoz. 

rEverse  Megforditja a vertex irányát. 

Convert  to Polyline Az spline-t vonallánccá konvertál.  A precíz érték meghatározza, hogy milyen pontosan illeszkedik a 

vonallánc  az spline-hoz.   
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2.10  Gyűrű (DONUT) parancs 

 

<Sample  of  Editing  Spline> 

 

 
 

DONUT parancs zárt vonalláncot használ vastagsággal, egy kör megrajzolásával testtel kitöltve. 
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                                               Körgyűrűk rajzolása 

Menü Draw(D)  ➤ Donut(D) 

 
Eszköztár 

 

Szalag Home ➤ Draw ➤ Donut 

 
Parancssor DONUT 

 

 
Command: _DONUT 

2Point/3Point/RadTanTan/<Inside  diameter  of  donut>  <0.5>:  10 

Outside  diameter  of  donut  <1.0>:  20 

Center  of  donut:  P1 

Center  of  donut: 
 
 

 
 

 
 

2.11 Kitöltés (Fill) parancs 
 

 
 

Kiigazítása sraffal,  2D test vagy  vastag vonallánc objektumokkal kitöltve. 
 

 
 
 

Menü 

 
Eszköztár 

 
Szalag 

 
Parancssor FILL/Kitöltés Pr
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Command:  FILL 

FILLMODE  is  currently  on:  OFF/Toggle/<On>: 
 
 
 

Opció Leírás 
 
 

ON/Be  
Bekapcsolja a kitöltés módot.  A 3D kitöltés megjelenítéséhezI,  a 

Z tengelyt párhuzampos állásba kell hozni az aktuális nézet 

irányával, és a takart vonalak nem lesznek visszatartva.   

 
 
 
 

 OFF/ Ki 

Kikapcsolja a kitöltés módot.  Csak az objektum kontúrja lesz 

megjelenítve.     Amikor a Fill/ Kitöltés mód    Switched/ Bekapcsolt, a 

REGEN  parancs  megváltoztatja az objektumok megjelenítését. A a Fill/ 

Kitöltés mód nem befolyasolja a vonalvastagság megjelenítését. 

 
Toggle Bekapcsol  ON-ra az  OFF-ról,  és fordítví. 
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03 Lineáris  objektum rajzolása 
 
 

A következő táblázat bevezeti azokat a parancsokat  amely lehetővé teszi, hogy könnyen rajzoljon lineáris 

formákat, különböző egyenes variációkat használva.   
 

Ikon 
Lineáris Objektum 

parancsok 
Leírás 

 

INFLINE Egy végtelen vonalat rajzol. 
 

 
RAY Egy végtelen vonalat rajzol az egyik oldal felé egy kiválasztott pontból.  

 

 
FREEHAND Szabadon megrajzol egy vonal szegmenst. 

 

 
MLSTYLE Meghatároz,  szerkeszt és kezeli a Többszörös vonal stílust  

(Multiline  Style). 

 
MLINE Két párhuzamos vonalat rajzol. 

 

 
MLEDIT Szerkeszti a Többszörös vonalat (Multi  Lines). 
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3.1 Végtelen (INFLINE)  parancs 
 

 
 

Végtelen vonal (INFLINE) egy konstrukciós ( Construction) vonal, amelyet a felhasználó 3D 

környezetben használ. Ez segédvonal a 3D-ben vagy 3D modellezésben. Hasznos a vízszintes, 

függőleges vagy ferde vonalak rajzolásánál, amelyek 2D vetületek rajzolásán alapulnak, vagy 

trigonometrikus ábrák használatánál.  
 

 
 

 
Menü Draw(D)  ➤ Infinite  line 

 
Eszköztár  

 

Szalag Home ➤ Draw ➤ Infinite  line 

 
Parancssor XLINE 

 

 

•  Klikk (INFLINE) végtelen vonal  ikon a (Draw) Rajz  panelen  a szalag menün. 

•  Klikk (INFLINE) végtelen vonal  ikon a Rajzolás 2D (2D Draw  Toolbar) eszköztáron. 

•  Gépeljen INFLINE -t a parancssorba. 

 
 

Command:  _INFLINE 

Infinite  line:  Bisect/Horizontal/Vertical/Angle/Offset/<Point  along  line>:  P1 

Direction:  P2 

Direction: Pr
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Opció Leírás Példa ábra 

 
 
 
 

Point  along  line  
Végtelen vonal átmegy két 

kiválasztott ponton. 

 
 
 
 
 
 
 

Bisect  
Megrajzol egy kiválasztott 

objektum kettéosztott vonalán. 

 
 
 
 
 
 
 

Horontal  
Vízszintes vonalat rajzol,   amely 

áthalad két kiválasztott ponton. 

 
 
 
 
 
 
 

Vertical 
Függőleges vonalat rajzol,   amely 

áthalad egy kiválasztott ponton. 
 

 
 
 
 
 
 

Angle 
Végtelen vonalat rajzol   egy adott 

szögben egy kiválasztott pontnál. 
 

 
 
 
 
 

Offset  Párhuzamos  vonalat rajzol egy 

kiválasztott referencia pontból.      

- Eltolás 

   Távolság 

- Áthaladó pont Pr
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Végtelen vonal rajzolás 

 
Klikk gomb  a státusz soron(Tool  bar). 

 

  Klikk (Infinite line) parancs  ikon a szalag menün,  Kezdőlap [Home] fül Rajz [Draw]  

panel  és válasszon ki két pontot, mint a lenti képen.  

 

 
Command:  _INFLINE 

Infinite  line:  Bisect/Horizontal/Vertical/Angle/Offset/<Point  along  line>:  P1 

Direction:  P2 

Direction: 
 
 

 
 
 

  Rajzoljon  xline-t a Vertical(V) beállítás szerint. 
 

Nyomja meg az Enter gombot, hogy a  futassa megint az  INFLINE  parancsot. 
 

 
Command: 

Infinite  line:  Bisect/Horizontal/Vertical/Angle/Offset/<Point  along  line>:  V 

Location:  P1 

Location:  P2 

Location:  P3 

Location: 
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  Rajzoljon  xline-t az  Angle(A) beállítás szerint, mint a lenti képen. 

 
 

 
 

Command: 

Infinite  line:  Bisect/Horizontal/Vertical/Angle/Offset/<Point  along  line>:  A 

Reference/<Enter  angle  (45)>:  30 

Location:  P1 

Location:  P2 

Location:  P3 

Location: 
 
 

 
 

 
 

  Rajzoljon  xline-t az  Offset(O) beállítás szerint, mint a lenti képen. 

 
 

 
Command:  _INFLINE 

Infinite  line:  Bisect/Horizontal/Vertical/Angle/Offset/<Point  along  line>:  O 

Through  point/<Offset  distance  for  parallel  infinite  line>  (Through):  10 

Select  entity  for  parallel  infinite  line:  E1 

Side  for  parallel  infinite  line:     P1 

Select  entity  for  parallel  infinite  line: 
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3.2 Sugár (RAY)   parancs 
 

 
 

A Sugárnak (Ray) hasonló tulajdonságai vannak, mint a Végtelen vonalnak.  Ez  végtelen vonal egy 

kezdőpontból indítva szabadon választott irányban. Hivatkozási vonalként használják 3D környezetben.  

 

 
 

Menu Draw(D)  ➤ Ray(R) 

Toolbar 

Ribbon Home ➤ Draw ➤ Ray 

 
Command RAY 

 

 

•  Klikk (Ray) Sugár ikon  a Rajz  (Draw)  panelen  a Kezdőlap (Home)  fülön  a szalag menün. 

•  Gépeljen RAY -t  a parancssorba.  

 
Command:  _RAY 

Infinite  ray:  Bisect/Horizontal/Vertical/Angle/Offset/<Start  of  Ray>:    P1 

Direction:  P2 

Direction:  P3 

Direction:  P4 

Direction: 
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3.3 FREEHAND  vagy SKETCH  parancs 
 
 
 

Szabadon rajzolhat vonalat vagy ívet a való élet skicc rajzolásához hasonlóan. A skicc hasznos amikor 

szabálytalan határvonalat vagy digitalizálásnál nyomkövetést rajzol. Adja meg a növekményt és az objektum 

típusra az engedélyt (vonal, vonallánc vagy spline) mielőtt skiccelne.  

 
Menu  Draw(D)  ➤ Freehand 

 

Toolbar  

 

Ribbon  Home ➤ Draw ➤ Freehand 

 
Command  SKETCH 

 
 

 

•  Válassza (Draw Freehand) a R a j z  ( Draw) panelen a Kezdőlap ( Home) szalag menün. 

•  Gépelje be a FREEHAND (Szabadkéz) vagy SKETCH a parancs soron. 
 

 
Command:  _FREEHAND 

 

Freehand: Length  of  segments <0.1000>:  5 

Press  ENTER to  end/Pen down/(Begin...)  P 

Press  ENTER to  end/Quit/Pen  down/Erase/Write  to  drawing/:(Sketching...)  P 

Press  ENTER to end/Quit/Pen  Up/Erase/Write to drawing/Connect/Straight to 

cursor/:(Paused...)  P 

Press  ENTER to  end/Quit/Pen  down/Erase/Write  to  drawing/:(Sketching...) 

Writing  freehand  sketch  to  drawing... 

163  lines  recorded. 
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3.4 MLSTYLE parancs 
 
 

Multiple  Line  (Többszörös vonal) jól jön, amikor a felhasználó apartman falat rajzol.  

Multiple  Line  (Többszörös vonal) használatához a felhasználónak először definiálni 

kell a  Multiple  Line  stílusát a MLSTYLE  parancs használatával. 
 

MLSTYLE  parancs létrehoz, szerkeszt vagy menedzseli a Multiple  Line  objektumot, amelyet a 

többszörös párhuzamos vonallal lett kialakítva.   
 

 
 

Menü  Format(O)  ➤ Multiline  Style...(M) 

Eszköztár 

Szalag  Home ➤ Format ➤ Multiline  Style... 

Parancssor     MLSTYLE 

 
Amikor egy Multiple Line Style (Többszörös vonal stílus) kerül meghatározásra, a felhasználó 

létrehozhat Multiple Line (Többszörös vonal) objektumot az MLINE parancs használatával. A 

Multiple Line elemek használatához, a felhasználó  a megszokott szerkesztő parancsot 

használhatja., mint a Multiple Line szerkesztő parancs vagy a Multiple Line Style parancs. Az 

MLEDIT parancs használatos a Multiple Line szerkesztéshez valamint a további eszközök. 
 

 

•  Add/Remove (Hozáad/Eltávolít)csúcs 

•  Az él láthatóságának beállítása 

•  Metsződés stílus beállítása a többi többszötös vonallal 

•  Intervallum nyitás vagy zárás Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

Draws  curved  shapes  04 

243 

 

 

 
 

 
 
 

 
Többszörös vonal stílus (MultiLine Style) meghatározás 

 
 

 
  Az MLSTYLE parancs megjeleníti a következő dialógus panelt. 

 

 
 

 
  Klikk az Új (New) gombra, hogy egy új stílust adjon meg a stílus nevének begépelésével, 

mint a 3-LINE  és kattintson a  Folytatás (Continue) gombra . 
 

 
 

  Klikk  Hozzáadás (Add)  gombra a megjelenített dialógus ablakon. Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

244 

 

 

 

 
 

 
 

 

➀ A hozzáadott vonalat állítsa be, mint RED  miközben a legördülő menüben 

kiválasztotta a színt.  

➁ Klikk Vonaltípus (Line  Type) legördülő gomb és Vonaltípus (Add  Line Type) hozzáadás. 

Válassza ki a "CENTER2" a Vonaltípusok betöltése vagy újra töltése (Load or Reload 

Linetypes) dialógus panelben és klikk Ok gombra. 

 

 
 

➂ Állítsa be az első és a harmadik vonal  párhuzamos eltolását 1.5 és – 1.5  külön-külön. 
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➃ Jelőlje be a jelölő keretet a vonal Kezdő (Start)  és Vég (End)  mezőben. 

 KliKk az Ok gombra. 
 

 
 
 

  A stílus aktiválásához, válassza ki a  3-LINE-t  a  Stílus (Style) listából és kattintson az 

Aktuálissá tétel (Set Current) gombra a jobb felső sarokban.  
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  Az előnézeti területen, az imént megadott többszörös vonal stílus képe megjelenik.  

Ezután klikk az Ok gombra, hogy befejezze a definíciót.   

 
 

 
 
 
 
 
 

Többszörös vonalstílus szerkesztése 
 

A felhasználó nem szerkesztheti a MLSTYLE-t amelyet aktuálisan használnak a rajzban.  Azért, hogy 

szerkeszthesse a MLSTYLE-t,   ezt el kellene végezni bármelyik  MultiLine előtt,   amely specifikusan az   

MLSTYLE-hoz tartozik a megrajzolás előtt a rajzban. 

 
 
 
 

 
 

 
 
 
 
 
 
 

 

3.5 MLINE parancs 
 

 
 
 

Többszörös vonal rajzi beállítások. 
 
 
 

Menü Draw(D)  ➤ Multiline(U) 

 
Eszköztár  

 

Szalag  Home ➤ Draw ➤ Multiline 

 
Parancssor MLINE 

 
 
 
 

Command:  _MLINE 

Current  settings:  Justtification  =  Top, Scale  =  1.0000,  Style  =  3-LINE 
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Specify  start  point  or [Load style/Justification/Scale/STyle]:  J 

Enter justification  type  [Top/Zero/Bottom]  <Top>:  Z 

Current  settings:  Justification  =  Zero, Scale  =  1.0000,  Style  =  3-LINE 

Specify  start  point  or [Load style/Justification/Scale/STyle]:  P1 
 
 

 
Next  point:  P2 

Specify  next  point or [Undo]:  P3 

Specify  next  point or [Close/Undo]:    P4 
 

Specify  next  point or [Close/Undo]: 
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❏   Igazítás parancsopciók 

 
 
 
 

 
 
 
 

 

3.6  MultiLine szerkesztés (MLEDIT parancs) 
 
 
 

Többszörös vonal (Multiple  Line) objektumok  metsződés szerkesztés,  töréspont és vertex. 
 

 
 
 

Menü Modify(M)  ➤ Edit  Multilines... 
 

 
Eszköztár 

 

Szalag  Home   ➤ Modify  ➤ Edit  Multiline... 

Parancssor MLEDIT Pr
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Command:  MLEDIT 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Válassza az ‘Open  Tee’  opciót a Többszörös vonal módosító eszközök (Multilines  Edit  Tools)  

dialógus panelben. 
 

 
Többszörös vonal első kiválasztás:  P1 

Többszörös vonal második kiválasztás: P2 
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Exercise  16  Példa rajz - egy iroda földszintje. 
 
 

 

 
 

 

<  Egy iroda földszintjének példája  > 
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  Rajzolja meg a középvonalat, mint lent,  az ábrára hivatkozva. 
 

 
 
 

 Klikk [Format] ⇨ [Multiline Styles] a legördülő menüben, hogy új Multiline Style(PTN) határozzon meg. 
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  Fal rajzolás Multiline  Style    –   PTN használatával a központo vonal körül, ezután 

rajzolja meg az ajtót. 
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  Felosztás megrajzolása Multiline Style –  PTN használatával a középvonal körül, ezután 

szerkesszen az MLEDIT parancs használatával. 
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Exercise  17  Példa rajz - egy iroda földszintje. 
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Exercise  18  Egy ház földszintjének rajza 
 

 

(Külső fal 350, belső fal 200, tetőpárkány éle  600) 
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Exercise  19  Draw a floor  plan  of a house. 
 

 

(Külső fal 350, belső fal 200, tetőpárkány éle 775) 
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Exercise  20  Egy ház földszintjének rajza 
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Kiválasztás és objektum szerkesztés 
 

 
 
 
 
 
 
 

A következő fogalmakat tárgyaljuk meg ebben a fejezetben: 

•  Kiválasztás szett 

•  Fogó szerkesztés 

•  Párhuzamos,  metsz  és  elér
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01 Kiválasztás szett 
 

 

Általában,  a rajzban lerajzolt formát objektumnak nevezzük, továbbá bármely dolog amely lerajzolásra 

került rajz parancs használatával az a rajzelem vagy entitás.  Mindegyik entitásnak saját tulajdonsága 

van. 
 

Entitás vagy objektum módosításához a Modify (Módosítás) parancsot használjuk  a CADian-ban. A 

felhasználónak meg kell érteni az entitás vagy objektum kiválasztás különböző módjait.  A Modify 

(Módosítás)  parancsnak általában egy kiválasztás szettre (Selection  set) van szüksége . 
 

CADian a felhasználók részére különféle beállításokról és eszközökről gondoskodik  amelyek segítenek 

kiválasztani csak a kívánt entitásokat vagy objektumokat.  
 

Amint megértette ezeket a beállításokat, hatékonyabban fog tudni dolgozni.  
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1.1 Objektum kiválasztás opciói 
 
 
 

Command:  SELECT 
 

Select  entities  to display  grips:  ? 

Select  entities:    ALL/Add/Remove/Previous/Last/Window/Crossing/Outside/ 

WPolygon/CPolygon/OPolygon/WCircle/CCircle/OCircle/Box/POint/Fence/Implied/ 

AUto/Multiple/Single/PROperties/Dialog/Undo: 
 

 
Opciók Leírás 

 

All (Összes)  

 

Add(Hozzáad)  

 

Remove  (Eltávolít) 
Eltávolítja a kiválasztott objektumokat az aktuális kiválasztási készletből. Tartsa lenyomva a 

Shift billentyűt, hogy kiválassza egyik objektumot a másik után.  

 
Previous (Előző) A legutóbbi kiválasztási készlet kijelölése. 

 
Last (Utolsó) Kiválasztja a legutóbb rajzolt látható objektumot. 

 

Window (Ablak)  

 

 
 
 

Crossing (Keresztező) Pr
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Opció Leírás 

 
Outside                Azokat az objektumokat választja ki, amelyek kívül vannak a négyszögön. 

 

WPolygon                                               

 

CPolygon                                                

 
OPolygon              Azokat az objektumokat választja ki, amelyek kívül vannak a sokszögön. 

 
WCircle                Azokat az objektumokat választja ki, amelyek kívül vannak a körön. 

 
CCircle                 Azokat az objektumokat választja ki, amelyeket metsz vagy belül vannak a körön. 

 
 

 
Box 

Azokat az objektumokat választja ki, amelyeket metsz vagy belül vannak egy  

tartományon két kiválasztott ponttal létrehozva. Ha a dobozt megrajzoltuk jobbról 

balra haladva,  keresztezőként fog viselkedni, és  ha a dobozt megrajzoltuk balról 

jobbra haladva,  ablakként fog viselkedni

 

POint Azokat az objektumokat választja ki, amelyek tartalmazzák a kiválasztott pontot                                                      

 

Fence  

 

Implied 

 

AUto 
Egyszer pikkelés  objektumokon belülre/kivülre, a doboz első sarka opció lesz a 

kiválasztott. AUto és  Add (Hozzáad) alapértelmezett opciók. 
 

Multiple Kiválasztott objektumok megtartása a parancs folytatásával.  

Single Objektumok kiválasztása egyiktől a másikig. 

PROperties 
 

Dialog 
 

Undo  A legutóbbi objektum kiválasztás hozzáadásának visszavonása a kiválasztási készletben. 
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1.2 Objektumok kiválasztása kattintással 
 

 
 

A leghatékonyabb módja egy entitás vagy objektum kiválasztásának mindegyikre való rákattintással. 

Egyszerűen mozgassa a kurzort az entitásra és kattintson a bal egér gombbal. 

 

Ha a felhasználó futtatja a  (ERASE)  szerkesztő parancsot,  és a következő történik. 
 

 
Először, a kurzor megváltoztatja a Pick box-ot. 

 

Másodjára,  a kiválasztott objektumok promptja megjelenik a parancs soron. 
 

 
 

Command:  _ERASE 

Select  entities  to delete:    P2 

Opposite  corner: P3  Entities  in  set:  2 
 

Select  entities  to delete: 
 

 
 
 

 
 
 
 

Ebben a két esetben,  CADian promptban kéri a felhasználót, hogy válasszon ki egy vagy két entitást.  

Objektum kiválasztásához, tegye a kiválasztott dobozt az objektumra és kattintson a bal egér gombbal. 

Amikor egy objektum kiválasztott,  pontozott vonalként jelenik meg és a parancssor kiírja ‘Entities in set:1.’ 

A többi kiválasztásához, lásd ‘Select  entities’ prompt a parancs soron.  Ezután,  a felhasználó további 

objektumokra kattint, hogy az objektumot hozzáadja a kiválasztási szetthez vagy gépelje be a kiválasztási 

opciót további objektum kiválasztáshoz és nyomjon Enter-t vagy Space billentyűt a kiválasztás 

befejezéséhez. Amikor a felhasználó kiválasztott egy vagy több objektumot a  (Objektum kiválasztás 

promptban) ‘Select  object’  prompt’,  Sokkal hatékonyabban tudja létrehozni a kiválasztási szettet. A 

kiválasztási szet hasznos amikor a rajz nagy vagy bonyolult lett mert ez fontos koncepció a CADian-ban. Pr
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1.3 Ablakos kiválasztás 
 

 
 

Ha a felhasználónak objektumokat kell kiválasztani egy kiválasztási szett létrehozásához, ez valójában 

kényelmetlen;  azonban,  a  CADian gondoskodik a felhasználó részére többszörös kiválasztási opcióról, 

amely lehetővé teszi, hogy gyorsan több objektumot tudjon kiválasztani.    
 

A  ‘Window(W)’ kiválasztás futtatásához gépelje be a  ‘W’-t  a  ‘select  objects’  (objektumok 

kiválasztása) promptba.  A Window  opció kéri a felhasználót, hogy jelöljön ki átlósan két pontot, mint a  

RECTANGLE (Téglalap) parancsnál.  Amikor az elképzelt ablak két ponttal meghatározásra került,  

azok az objektumok amelyek teljes mértékben belekerültek az ablakba, ezek fogják képezni a 

kiválasztási szettet, ahogy a lenti kép mutatja.    

 
 

 
 

1.4 Metsző ablakos kiválasztás 
 

 
‘Cross(C)’  opció fut majd, amikor  ‘C’ -t  gépel a  ‘Selection  set’ (Kiválasztási szet) promptba, ez egy 

másik módszere a ‘Window(W)’  beállításának. A futó  ‘Cross(C)’ opció ugyanaz mint a ‘Window(W)’  

opció, viszont ez az opció tartalmazza mindegyik objektumot amelyek érintkeztek az ablakkal, mint a 

lenti képen.   
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1.5 Belefoglalt ablakos kiválasztás 
 
 
 

A felhasználó gépelhet  ‘W’  vagy  ‘C’  az entitást kiválasztó szet promptba, amelyet  Window  vagy 

Cross dialógus doboznak nevezünk, de ez elég ritkán van.  Ezek a parancsok általában úgynevezett 

implicitek, amelyet a CADian biztosít. 

Kattintson egy ideiglenes pontot a rajzterületen. A CADian feltételezi azt, hogy a felhasználó ablakot 

akar meghatározni,  végezze el a promptot és használja a klikkelt pontot mint első pontja az ablaknak, 

amelyet megadott.  Ha a felhasználó továbbmozgatja a kurzort  jobb oldal felé, ez úgy tesz mintha 

ablakos kiválasztó keret lenne.  Másrészről,  metsző ablakos kiválasztás lesz, ha a kurzort bal oldal felé 

mozgatja az első ponttól kezdve.  Kérem nézze meg a lenti képet. 

 
 

 
 

 
 
 
 
 
 
 
 
 
 

1.6 Kiválasztás bekerítés szerint 
 

 
Bekerítés ‘Fence(F)’ opció megengedi a többszörös szegmens vonalakat mint a  Vonallánc (Polyline) 

parancs. Az objektumokon amelyeken a bekerítés (Fence) áthalad, azok kiválasztásra kerülnek. Gépelje 

be az  ‘F’-et  az objektum kiválasztás promprba, hogy behívja a bekerítés opciót.   
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1.7 Visszavonás (Undo) opciók 
 
 
 

Gyakran, néhány kiválasztott objektumot, amelyet a felhasználó nem akar a kiválasztási szettbe foglalni, 

azokról a Visszavonás (Undo) parancs gondoskodik a kiválasztás alatt, hogy törölje az utoljára 

kiválasztott objektumot.   
 

A felhasználónak csak  ‘U’-t kell gépelnie az objektumok kiválasztás  (Select  objects)  promptba, hogy 

eltávolítsa az utóljára kiválasztott objektumokat.    
 
 

 
Command:  _LINE 

Start  of line:  P1 

Angle/Length/<End  point>:  P2 

Angle/Length/Follow/Undo/<End  point>:  P3 

Angle/Length/Follow/Close/Undo/<End  point>:  U 

Angle/Length/Follow/Undo/<End  point>: 
 

 
 

 

 

 

1.8 Összes objektum kiválasztása 
 

Az összes ‘ALL’  opcióhoz  gépelje az ‘ALL’-t   objektumok kiválasztás  (Select  objects)  promptba. Ez 

ki tudja választani az összes objektumot az aktuális rajzban és nem szükséges kattintás.  Az 

elrendezésben lévő objektumok, amelyek zároltak (Locked) vagy fagyasztottak (Frozen) nem lesznek 

kiválasztva, de a rajzban lévő objektumok, amelyek Off-ok (Ki), kiválasztásra kerülnek. 

 
 

Command:  _MOVE 
 

Select  entities  to move:  ALL 

Entities  in  set:  3 

Select  entities  to move: 

Specify  base   point  or [Displacement] 

<Displacement>:  P1 

Specify  second point  or <use  first  point  as 

displacement>:    P2 
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1.9 Sokszögű ablak kiválasztás 
 

 
Sokszög ablak  (Window  Polygon, WP) opció  amelyet gépelve így nevezünk  ‘WP’  kiválasztás  (Select  

objects)  promptba, ez hasonló a (Window(W))  kiválasztási opcióhoz, ez inkább hasonlít a  szabálytalan 

sokszögre és nem egy téglalaphoz. 
 

Mint a Window  opció ez olyan objektumokat tartalmaz amelyek teljes egészében bent vannak, és 

legalább három pont kell a kiválasztáshoz.   

 

 
 

 

 

1.10 Metsző sokszög kiválasztás 
 

 
Metsző sokszög  (Crossing Polygon (CP)) kiválasztási opció, amelyet gépelve így nevezünk  (CP)  kiválasztás  

(Select  objects)  promptba, hasonlít a  (Crossing(C))  kiválasztás opcióra,  ez inkább hasonlít a  

szabálytalan sokszögre és nem egy téglalaphoz. 

 

Mint a Crossing  opció ez olyan objektumokat tartalmaz, amelyek teljes egészében bent vannak vagy érintik, 

és legalább három pont kell a kiválasztáshoz.   
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1.11 Előző kiválasztás behívása 
 
 
 

CADian mindig tárolja az előzőleg megadott kiválasztási szettet. Ezt vissza lehet hívni egy másik parancs 

használatával továbbá szerkeszthező is, amely nagyon hasznos. 
 

Ez a ‘Previous(P)’ Előző opció, behívása a (P) gépelésével a promptba.  
 

 
 

 

 

 

1.12 Utolsó objektum kiválasztása 
 
 
 

(L)   opció hasonló tulajdonságokról gondoskodik mint a Previous(P)  opció.  Futassa a a legutóbb 

készített látható objektumok kiválasztásához.  Az objektumnak az aktuális rajzban kell lennie  és nem 

Fagyasztott (Frozen) vagy kikapcsolt (Off). 

 
 
 
 
 

 
A kiválasztási szettnek léteznie kell, hogy használható legyen a ‘Last’  vagy a ‘Previous’  opciók.  Ha egy   

kiválasztási szett nem létezik,  a következő üzenetet fogja mutatni.   Ebben az esetben, a felhasználónak 

készíteni kell egy új opciót, hogy egy új kiválasztási szettet hozzon létre.    

 
 

Command:  _MOVE 
 

Select entities to move: P 

Select entities to move: L 

Entities  in  set:  0 

Select  entities  to  move: 
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1.13 Objektumok hozzáadása és eltávolítása 
 

 
 

A CADian gondoskodik a kiválasztási szettbe történő hozzáadásról vagy eltávolításról. Amint tudja,  

kattintson közvetlenül az objektumra, vagy futtassa az előzőekben tárgyalt opciókat a kiválasztási szetthez 

történő hozzáadáshoz.   

 
A felhasználó eltávolíthatja az objektumokat a kiválasztási szettből  a Shift Picking technika 

használatával. Ha a felhasználó rákattint a kiemelt  (highlighted)   objektumokra a  ‘Shift’   gombot 

lenyomva tartva,  a rákattintott objektum  eltávolításra kerül a kiválasztási szettből.  És, ha a felhasználó 

futtathatja elhúzva a Window parancsot, mialatt lenyomva tartja a ‘Shift’  billentyűt több objektumot 

eltávolíthat el a kiválasztási szettből.  Ha a felhasználó nem használja a Shift Picking parancsokat, akkor 

futtathatja a parancssort. 
 

 

 
 

 
Ha a felhasználó objektumokat akar eltávolítani és komplikált a kiválasztás, használja a ‘Remove(R)’  

opciót.  Gépeljen ‘R’-t az Objektum kiválasztás promptba. 
 

 
Select  Objects  : R 

↲  

Delete  Objects  : P1 

Found  1, Delete  1, Total 1 
 

 
 

Kattintson az objektumokra a fentebb leírt módszert használva  az objektumok eltávolításához a 

kiválasztási szettből.  Amikor megvan,  gépeljen  ‘A’-t  az objektum kiválasztás  promptba, hogy 

visszatérjen az ‘ADD módhoz.’ 
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02   Fogó szerkesztése 
 

 

2.1 Fogó áttekintése 
 

 
 

CADian-ban a fogóknak tulajdonságaik vannak.  A fogó egy kis négyszög , amelyeket a kiválasztott 

objektum mutat meg.  Arra használjuk, hogy gyorsan nyújtsunk, mozgassunk, forgassunk, skálázzunk és 

tükrözzünk vele.    
 

Amikor az entitás már kiválasztott és a parancs nem fut, kék fogó pontok jelennek meg.  Ezután, mozgassa az 

egér kurzort és válassza ki a fogó pontot, hogy aktiválja a  Grip parancsot. 

 

 
 
 

Amikor az entitás kiválasztásra kerül mialatt a parancs nem fut, kék fogó pontok kerülnek megjelenítésre, 

mint a lenti képen. Ez azt jelenti, hogy amikor a fogó pontokra kattintunk, kész van arra, hogy végrehajtsa 

azt a műveletet, amely már be van állítva.   
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2.2 Entitás fogó 
 

 
 

Entitás fogó támogatja az entitások szerkesztésének új módszerét a rajzban. Amint a felhasználó rákattint a 

fogó pontra, ez aktivizálódik mint a lenti képen, amint a pont vörösre vált.   

 

 
 

 
 

Információ jelenik meg az aktiválódott fogóról a parancssoron.    
 

 
Command: 

** Stretch  ** 

Select  stretch  point  or [Base  point/Copy/Undo/eXit]: 
 
 
 
 

A parancs csoport első parancsa alapértelmezésben a nyújtás (stretch), ez a parancs függ a kiválasztott 

entitás fogó ponttól és ennek használatától.    

 
 
 
 
 
 
 

 
Téglalap kiválasztás  Aktiválódott fogó       Új pont kiválasztás 

 

 
Például,  amikor egy kör középpontja van kiválasztva, a nyújtás parancs lehetővé teszi a mozgatás 

parancsot. Másfelől,  ha a kör kerületén választunk ki fogó pontot,  akkor szerkeszteni tudjuk a kör 

sugarát. Pr
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Hasonlóan, ha rákkatintunk egy fogó pontra, amely egy egyenes közepén van,  a mozgatás parancs 

aktiválódik.  Másfelől, ha rákkatintunk egy fogó pontra, amely egy egyenes végén van, a nyújtás parancs 

fog aktiválódni.    

 
 

2.3 Fogó törlése 
 
 
 

A fogó tulajdonságok törléséhez nyomjon egy ESC billentyűt. 
 

Ha a Radír (Erase) parancsra kattintott, amikor a fogó doboza meg 

 

jelent,  a kiválasztott objektum törlésre kerül.  

 
 

 
 

 

2.4 DDGRIPS  parancs 
 
 

 
Menü Tool(T)  ➤ Options(OP) 

 

 
Eszköztár 

 

Szalag Home ➤ Tool ➤ Options  ➤ Selection 

 
Parancssor DDGRIPS 
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• Fogó méret: ( Grip Size)  a fogók méretének megjelenítését kezeli. 

• Fogó engedélyezés (Enable  grips) : Amikor egy objektumot kiválaszt megjeleníti a fogókat.  Ha a 

felhasználó rákattint, a rendszer hatékonyan csökkenti.  Végeredményként, a  felhaszálónak akkor kell 

rákattintania, amikor valóban szükség van rá. 

• Fogó engedélyezése blokkon belül (Enable grips within blocks) : Azt kezeli, hogyan 

legyenek a  fogók megjelenítve egy blokkban, miután kiválasztotta.  

• Fogó sugó engedélyezés (Enable grip tips)  : Megjeleníti a fogók speciális sugóit amikor 

a kurzorral köröz a fogó fölött, olyan saját objektumnál amely támogatja fogó sugókat. 

• Objektum kiválasztási korlát a fogók megjelenítéséhez (Object selection limit for display 

of grips): a fogók megjelenítését korlátozza, ha a  kezdő kiválasztási készlet több mint a 

megadott objektumszám.  Az érvényes tartomány  1 től  32,767 az alapértelmezett 100. 

•  Fogó szín (Grip color) : Különböző fogó státuszokhoz és elemekhez színt jelöl ki, azt 

jelenzi, hogy beállítja a fogój szín tulajdonságait.  Pr
ó
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Következésképpen, a fogó pontokat  raszter pontként használhatjuk. 
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03 Párhuzamos,  Metsz és Elér 
 

 
Fontos parancsokat vezet be az alakok szerkesztéséhez. 

 
Ikon Parancs Leírás 

 

           TRIM  Lemetszi az objektumot a metszésponton túl.  

 

           EXTEND  A kiválasztott objektum éleit addig terjeszti ki, míg más entitással nem találkozik. 

 

OFFSET 
Concentrikus kört,   párhuzamos vonalat vagy párhuzamos görbét rajzol a 

kiválasztott objektumtól bizonyos távolságra.  
 

           BREAK Megtöri az objektumot két kiválasztott pont között. 

 
FILLET Egy tárgy szélén enyhe görbét készít. 

              CHAMFER Egy tárgy szélét ferdén levágja 

 

 

3.1 Párhuzamos (OFFSET)  parancs 
 

 
 

Párhuzamos (OFFSET) parancs az egyik leggyakrabban használt eszköz a tervezés során.  A felhasználó 

ponton (távolságon) keresztül léptet be, kiválasztva egy objektumot és párhuzamosan  lemásolja a 

kijelölt távolsághoz.  
 

A másolt objektum a kijelölt irányba lesz megrajzolva a felhasználó által megadott távolságra. A 

párhuzamos  (Offset) parancsot a Vonal (Line), Kör  (Circle), Ív (Arc), Ellipszis (Ellipse), 2D vonallánc 

(2D polyline), Sugár (Ray) és 2D spline elemekhez használhatja. 

 

 
Menü   Modify(M)  ➤ Offset(S) 

Eszköztár  

Szalag Home ➤ Modify  ➤ Offset 

 
Parancssor OFFSET Pr
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Command:  _OFFSET 

Offset:  ENTER for Through  point/<Distance>:  5 

Undo/<Select  entity>:  P1 

Both  sides/<Side  for  parallel  copy>:  P2 
 

Undo/<Select  entity>: 
 

 
Opció Leírás 

 
Offset  Distance Megrajzol egy entitást bizonyos távolságra a  kiválasztott objektumtól.                  

Through  Point Megrajzol egy új párhuzamos entitást a kiválasztott ponton keresztül.  

Erase  Törli az eredeti objektumokat miután végrehajtotta az  Offset  parancsot. 

 

Layer  
Eldönti,  hogy a párhuzamos másolat az eredeti objektum fólíáján vagy a jelenleg aktuális 

fólián legyen. 
 
 
 

Command:  _OFFSET 
 

Offset:  ENTER for Through  point/<Distance>:  T 

Undo/<Select  entity>:  P1 

Through  point:  P2 
 

Undo/<Select  entity>: 
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3.2 Metsz (TRIM) parancs 
 
 

A felhasználó a metsző objetumokat felhasználhatja, mint vágó objektumokat egy objektum vágásához.  

Az objektum vágásához először válassza ki a vágó entitásokat. Ezután nyomja meg az enter billentyűt, 

hogy kiválasszon egy objektumot, amelyen végre akarja hajtani a metszést (Trim).  Az összes entitás 

használatához mint vágó entitásokhoz nyomja meg az enter-t az első objektum kiválasztás ‘Select  

objects’  promptnál. 
 

 
 
 

Menü Modify(M)  ➤ Trim(T)  

 

Eszköztár  

 

Szalag Home ➤ Modify  ➤ Trim 

 
Parancs  TRIM 

 
 

 
Command:  _TRIM 

Select  cutting  entities  for  trim  <ENTER  to  select  all>:  P1 

Entities  in  set:  1 
 

Select  cutting  entities  for  trim  <ENTER  to  select  all>: 

[Fence/Crossing/Project/Edge/eRase/Undo]/<Select  entity  to trim  or shift-select  to  extend>: 

P2 

[Fence/Crossing/Project/Edge/eRase/Undo]/<Select  entity  to trim  or shift-select  to  extend>: 

P3 

[Fence/Crossing/Project/Edge/eRase/Undo]/<Select  entity  to trim  or shift-select  to  extend>: 
 

 
 
 
 
 

 
 

             Előtte         Utána
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Opció Leírás 

 
Fence  Válassza ki az összes entitást, amelyet felfűz a metszéshez. 

 

 

Crossing   
Válassza ki az összes entitást a metszéshez,  amelyek belül vannak vagy metszi a virtuális 

négyszög.  

 
Project  Állítsa be a vetületi nézetet, amelyet használni fog a  metszéshez. 

 

 
 

Edge   
Meghatározza , vajon nyírhatnak-e egy objektumot vagy nem, felhasználva egy 

másik objektum bennefoglaló élét.  
 

 

eRase   
Törli a kiválasztott objektumokat.  Ez az opció fontos a szükségtelen objektumok 

törléséhez, mert ezt nem fejezi be a TRIM  (Metsz) parancs. 
 

 
 
 
 

Rajzolja meg a következő objektumot. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  Hasonlóan mint a lenti kép,  rajzoljon merőleges közép vonalakat véletlen hosszakkal.  Rajzolja 

meg a bal oldali közép vonalat és használjon a Párhuzamos (Offset) parancshoz  100-at, hogy 

megrajzolja a jobb oldali merőleges közép vonalat. Szintén,  rajzoljon egy ferde közép vonalat, 

amelynek a hossza 100 és a szöge 15 fok a jobb merőleges közép vonaltól. 
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  Hasonlóan mint a lenti kép,  rajzoljon köröket 40-es átmérővel,  és 30-as sugárral a merőleges 

közép vonalak metsződéseiben és a dőlt közép vonal végpontjában.   

 

 
 

 
 A lenti képhez hasonlóan,  használjon szaggatott vonalú tárgy rasztert, hogy megrajzolja a 

merőleges és a ferde szaggatott vonalat. 
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  Hasonlóan mint a lenti kép,  rajzoljon egy érintő kört 50-es sugárral. 
 

 
 

  Használja a Metsz (TRIM) parancsot a következő ábra befejezéséhez. 
 

 
Command:  _TRIM 

 

Select  cutting  entities  for  trim  <ENTER  to  select  all>: 

[Fence/Crossing/Project/Edge/eRase/Undo]/<Select  entity  to trim  or shift-select  to  extend>: 

P1 

[Fence/Crossing/Project/Edge/eRase/Undo]/<Select  entity  to trim  or shift-select  to  extend>: 

P2 

[Fence/Crossing/Project/Edge/eRase/Undo]/<Select  entity  to trim  or shift-select  to  extend>: 

P3 

[Fence/Crossing/Project/Edge/eRase/Undo]/<Select  entity  to trim  or shift-select  to  extend>: 

P4 

[Fence/Crossing/Project/Edge/eRase/Undo]/<Select  entity  to trim  or shift-select  to  extend>: 

P5 

[Fence/Crossing/Project/Edge/eRase/Undo]/<Select  entity  to trim  or shift-select  to  extend>: 

P6 

[Fence/Crossing/Project/Edge/eRase/Undo]/<Select  entity  to trim  or shift-select  to  extend>: 

P7 

[Fence/Crossing/Project/Edge/eRase/Undo]/<Select  entity  to trim  or shift-extend  to  select>: 

P8 

[Fence/Crossing/Project/Edge/eRase/Undo]/<Select  entity  to trim  or shift-select  to  extend>: 

P9 

[Fence/Crossing/Project/Edge/eRase/Undo]/<Select  entity  to trim  or shift-select  to  extend>: Pr
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3.3 Elér (EXTEND) parancs 
 

 
 

Megnyújtott entitások találkoznak más entitások vonalaival.  Egy objektum eléréséhez,  először válassza ki 

a határoló objektumokat. Ezután, nyomja meg az entert és válasszon ki egy objektumot az eléréshez. Az 

összes objektum mint határolóvonal használatához nyomjon entert az első ‘Select  objects’  promptban. 
 
 

 
 

 
 

Menü  Modify(M)  ➤ Extend(D) 

 

Eszköztár  

 

Szalag Home ➤ Modify  ➤ Extend 

 
Parancssor EXTEND Pr
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Command:  _EXTEND 

Select  cutting  entities  for  trim  <ENTER  to  select  all>:  P1 

Entities  in  set:  1 
 

Select  cutting  entities  for  trim  <ENTER  to  select  all>: 

[Fence/Crossing/Project/Edge/eRase/Undo]<Select  entity  to  trim  or shift-select  to  extend>: 

P2 

[Fence/Crossing/Project/Edge/eRase/Undo]<Select  entity  to  trim  or shift-select  to  extend>: 
 
 
 
 

 
 

              Előtte        Utána 
 
 

 

 
 

 

3.4 Megtörés (BREAK) parancs 
 
 
 

A felhasználó a megtörést használhatja az  Ív (Arc), Kör (Circle), Elipszis (Ellipse), Vonal (Line),  

Vonallánc (Polyline),  Sugár (Ray) és Végtelen vonalhoz. A megtörés a kiválasztott entitás két megadott 

pontja között van.    
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Menü  Modify(M)  ➤ Break(K) 

 

Eszköztár  

 

Szalag  Home ➤ Modify  ➤ Break 

 
Parancs  BREAK 

 
 

 

❏ Alapértelmezett (Távolság)  Megtör (Break)  

 
Command:  _BREAK 

Select  entity  to break:  P1 

First  break  point/<Second  break  point>:  P2 

 

 
 

(Előtte) Before BREAK                (Utána) After BREAK 
 
 

 
❏  Opció (ugyanaz a pont) Megtör  - (the Same Point) Break 

 
 

Command:  _BREAK 

Select  entity  to break:    P1 
 

First  break  point/<Second  break  point>:  F 

First break  point  P2 

Second  break  point:  P3  (the  same  position  as  P2) 
 
 

 
 

  Before BREAK (Törés előtt)     After BREAK (Törés után)   When Selected (Kiválasztáskor)  
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3.5 Lekerekít (FILLET)  parancs 
 

 
A Lekerekít parancs (Fillet) két objektumot ívvel köti össze egymásssal, egy speciális sugárral. Először 

beállítja a sugarat, és ezután a két objektumot.  

 

Menü    Modify(M)  ➤ Fillet(F) 

Eszköztár  

Szalag  Home ➤ Modify  ➤ Fillet 

 
Parancssor  FILLET 

 
 

 
Command:  _FILLET 

Current  settings:  mode  =  TRIM,  radius  =  0.0000 
 

Fillet:  Undo/Polyline/Radius/Trim/Multiple/<Select  first  entity>:  R 

Fillet  radius  <0.0000>:  20 

Current  settings:  mode  =  TRIM,  radius  =  20.0000 

Fillet:  Undo/Polyline/Radius/Trim/Multiple/<Select  first  entity>:    P1 

Select  second line  or shift-select  to  apply  corner:  P2 
 

 
 

 
 

Opció Leírás 

Polyline Lekerekíti 2D vonallánc vertexénél, ahol a két vonal szegmens találozik. 

Radius Sugarat állít be a lekerekítéshez. 
 

Trim Hogy törölje-e az továbbérő entitásokat a FILLET parancs végrehajtását követően.  
 

Multiple Lekerekítés (FILLET) parancsot többször alkalmaz. 
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3.6 Letör (CHAMFER) parancs 
 

 
 

A letörés “Chamfer” egy művelet, amellyel levágjuk az élét valamilyen szöggel az objektumnak, hogy 

egy éles élet lesímítson, vagy egy bizonyos pontos távolságra lemetszen amikor más részekkel párosít.    

A felhasználó a letörést különböző inputokkal állíthatja be; ugyanaz a távolság (the same distance),  

különböző távolság (different distances), vagy távolság szöggel.   
 

 

 
 
 

Menu  Modify(M)  ➤ Chamfer(C) 
 

 
Toolbar 

 

Ribbon  Home ➤ Modify  ➤ Chamfer 

 
Command  CHAMFER 

 
 

 
Command:  CHAMFER 

Current settings:  mode  =  TRIM,  dist1 =  0.0000,  dist2  =  0.0000 
 

Select  first  line  or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]:  D 

Chamfer  mode  now  set  to Distance  option. 

Chamfer  distance  on  first  entity  <0.0000>:  3 
 

Chamfer  distance  on  second entity  <3.0000>: 

Select  first  line  or [Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple]:  P1 

Select  second line  or shift-select  to  apply  corner:  P2 Pr
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Opciók 
  

Leírás 

 

Polyline 
 

Él letörés  egy teljes 2D vonalláncon.  

 

Distance 
 

Beállítja az élletörés távolságot.  

Angle Beállítja az élletörés távolságot  egy szög beléptetésével. 

 
Trim Meghatározza, hogy az élek vágva legyenek az élletörés vonal után. 

 

mEthod   
Meghatározza, hogy a Letörés parancs két távolságot használjon, vagy  egy 

távolság és egy szög mint input.  
 

Multiple Letörés  parancsot többször alkalmaz. 
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Exercise  21  Rajzolja meg a következő  objektumot Letörést és Lekerekítést használva. 
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Exercise  22  Rajzolja meg a következő  objektumot Letörést és Lekerekítést használva. 
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Exercise  23  Rajzolja meg a következő  objektumot Letörést és Lekerekítést használva. 
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Exercise  24  Rajzolja meg a következő  objektumot Letörést és Lekerekítést használva. 
 
 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

Selection  set  and  Edit  05 

291 

 

 

 

Exercise  25  Rajzolja meg a következő  objektumot Letörést és Lekerekítést használva. 
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Exercise  26  Rajzolja meg a következő  objektumot Letörést és Lekerekítést használva. 
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Exercise  27  Rajzolja meg a következő  objektumot Letörést és Lekerekítést használva. 
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Exercise  28  Rajzolja meg a következő  objektumot Letörést és Lekerekítést használva. 
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Exercise  29  Rajzolja meg a következő  objektumot Letörést és Lekerekítést használva. 
 
 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

 
 

CADian 2012 

296 

 

 

 

Exercise  30  Rajzolja meg a következő  objektumot Letörést és Lekerekítést használva. 
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06 
 

 

Fólia és entitás tulajdonság 
 

 
 
 
 
 
 
 

A következő fogalmakat tárgyaljuk meg ebben a fejezetben: 

•  Fólia fogalmak és alkalmazások 

•  Szín fogalmak és alkalmazások 

•  Vonaltípus fogalmak és alkalmazások 

•  Vonalvastagság  fogalmak és alkalmazások 

•   Entitás tulajdonságok fogalmak és alkalmazások 
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Bevezetett parancsok  a fólia (LAYER)  és tulajdonságok  (PROPERTY) használatához. 
 
 

 
Ikon Parancs Leírás 

 
           LAYER A fóliákat és a fólia tulajdonságokat kezeli. 

 

           COLOR Beállítja az új entitások színét. 

               LINETYPE Meghatározza vagy szerkeszti a vonaltípust. 

 
LTSCALE                      Vonal típus méret beállítása. 

 

 

LWEIGHT 
Aktuális vonalvastagság  beállítása,  vonalvastagság megjelenítés opciók és mértékegységek.  

 

 
 

CHANGE  Objektum tulajdonságok módosítása 
 
 

CHPROP                 Objektum tulajdonságok módosítása. 

 

 
PROPERTIES Objektum tulajdonságok megjelenítése és szerkesztése. 

 

 
 

MATCHPROP  
Kiválasztott objektum tulajdonságot másol és a másikhoz alkalmazza és ahhoz illeszti.   
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01 Koncepciók és fólia alkalmazások 
 

 
Az ábrákat különböző filmekre rajzolva, majd ezeket átfedve egy filmnek látszanak. Ez a szimbólum amely 

filmként szerepel, ezt fóliának nevezzük a CADian-ban. 
 

Az első, a második és a harmadik fólia a látható vonalakat, méreteket és címfeliratokat rögzíti külön-

külön.  Ha a felhasználó elhagyja a harmadik fóliát a Fólia tulajdonság kezelőből (Layer  Property 

Manager),  ez azt jelenti, hogy a harmadik fólia  kikapcsolt (OFF) állapotban van.  Végeredményként, 

mint a lenti képen,  csak az első és a második fólián lévők lesznek megjelenítve a rajzterületen. 

 

 
 

 

 
 
 

A fólia fontos eszköz a CADian-ban, és arra is alkalmazhatja, hogy a rajzelemek szabványos vonal 

típusát, színét vagy vonalvastagságát megadja.  A felhasználó felhasználhatja a fólia (LAYER) 

parancsot, hogy hozzáadjon vagy töröljön egy új fóliát, és aktiválja az aktuális fóliához.   És más további 

tulajdonságok a következőképpen: fólia tulajdonság beállítás, fóla be és kikapcsolás (Layer ON/OFF), 

fagyasztás /olvasztás (Freeze/Unfreeze),  lezárás/ kinyitás (Lock/Unlock), plottolási stílus megadása, és a 

plottolás be és kikapcsolás.  
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Fólia alkalmazási előnyök a rajzban: 
 

 

•  Több különböző típusú entitás könyebb kezelése. 

•  Az a lehetőség, hogy ideiglenesen elrejtsen szükségtelen objektumokat, ha a rajz bonyolult. 

•  A szerkesztési folyamat gyorsítása a kiválasztott objektumok zárását követően,  amelyek csak megjelennek 

a rajzban. 

•  Az elkészült rajz plottolása bizonyos objektumokhoz beállított vonal vastagsággal és színekkel   

•  Az entitások a zárt fóliákon egy külső hivatkozású rajzon (xref) nem szerkeszthetők: a fontos 

információk védettek, amikor más munkacsoportokkal online dolgozik ugyanazon a rajzon. 
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1.1 Fólia parancs 
 
 
 

Fólia és fólia tulajdonság kezelés. 

 
Menü Format(O)  ➤ Layer(L) 

Eszköztár 

Szalag  Home ➤ Format ➤ Layer 

 
Parancs  LAYER 

 

 
 

•  Klikk Formátum [Format]  ⇨ F ó l i a  [Layer]  a legördülő menüben. 

•  Gépeljen LAYER  vagy  LA  a parancssoron. 
 

 
Command:  -LAYER 

Current  Layer:    "0" 

Enter an  option  [?/Make/Set/New/Rename/ON/OFF/Color/Ltype/LWeight/MATerial/ 

Plot/Freeze/Thaw/LOck/Unlock/Description/rEconcile]: 
 
 
 

Opció Leírás 

 

? (Show  lists) 
Megjelenít egy listát, amely mutatja a nevet, állapotot, szín számot, vonal típust és vonal 

vastagságot és jelzi hogy, ha a fólia egy másik rajz külső hivatkozása.    
 

 

Make  
Létrehoz egy új fóliát és beállítja aktuális fólianak. Az új entitások a létrehozott fóliára lesznek 

majd rajzolva. 

 
 

Set 

Beállítja az új aktuális rajzot. Ha nincs aktuális rajz, akkor nem készít.  Hogyha van egy  OFF 

rajz,  ez  ON -ra lesz átkapcsolva  és az aktuális rajzra lesz állítva. A lefagyasztott rajz  (Frozen) 

nem lesz aktuális rajzzá beállítva.   

 

New Létrehoz egy új fóliát. 

 
Rename  Átnevez egy létező fóliat a rajzon. Pr
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Opció Leírás 

 
ON A kiválasztott fólia látható a rajzon és plottolható.  

 
OFF A kiválasztott fólia nem látható a rajzon és nem plottolható 

 Color Entitások színének megváltoztatása a fólián. 

LineType Entitások vonal típusának megváltoztatása a fólián. 

LineWright Entitások vonal vastagságának megváltoztatása a fólián. 

 

MATerial Anyag hozzáadás a fólián. Az anyag bizonyára használható a rajzon. 

 

 

Plot  
Beállítja a fóliát a plottoláshoz.  A fólia be van kapcsolva (ON). Kikapcsolt fóliák (OFF) és 

fagyasztott fóliák nem plottólhatók, még akkor sem, ha plottoltra van állítva.   
 

 

Freeze  
Lefagyaszt egy fóliát, hogy elrejtse annak entitásait. Egy lefagyasztott 

fóliát nem lehet regenerálni/plottolni.   

 

Thaw  
Kiolvasztja egy lefagyasztott fólia megjelenítést.  A fóliát regenerálni/plottolni lehet.  

 
LOck Lezárja a fóliát és   korlátozza az entitás szerkesztését. 

Unlock Kikapcsolt fólia bekapcsolása, szerkeszthetővé teszi. 

Description Beállítja egy létező fólia leírását. 

rEconcile Korrigálatlan fóliák korrigálatlan fólia tulajdonságainak beállítása. 
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Ikon Funkció Leírás 

 
Fólia szűrő 

tulajdonságok 
Megjeleníti a fólia szűrő tulajdonságok dialógus ablakot.

 
 

Group  Filter Csoportosítja a kiválasztott rajzokat, amelyek egy szűrőhöz lettek hozzátéve.    

 
Layer  States 

Manager 

Megjeleníti a fólia státusz kezelőt, amely  elmenti  az aktuális beállításokat elnevezett 

fóliként.  

 

New Layer  Beállítja az új aktuális fóliát. 
 

Create  and  Freeze 

New Layer  
Létrehoz egy új rajzot és lefagyasztja  az összes meglévő nézetablakból. 

 
 

Delete Törli a kiválasztott fóliát. 

 
Set  to  Current Beállítja a kiválasztott fóliát mint aktuális fólia.    

 
Refresh Pásztázza az összes elemet, hogy frissítse a fóliát.  

 
 

Settings 

Megjeleníti a fólia beállítás dialógus ablakot.  

 
 

 

 
 

 

1.2 Fólia állapotok kezelése 
 

 
 

Az ok amiért a fóliát használjuk, egy fontos tulajdonság, hogy kezelhetjük a meglévő objektumok 

láthatóságát. Ezt könnyen megtehetjük a fóliák használatával. 
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A bemutatott ikonok a fólia státusztát mutatják a táblázatban.   

 
Ikon               Funkció                                                            Leírás 

 
          ON                               A fólián lévő entitások láthatók,  ha a fólia nem fagyasztott. 

             OFF                              A fólián lévő entitások láthatatlanok,  de betölthetők.  

           Thaw                            Egy fagyasztott fóliát olvaszt. 

         Freeze                          Az entitások a lefagyasztott fólián láthatatlanok és nem  regenerálhatók. 
 

 
         Unlock                          Kinyit egy lezárt fóliát. 

 

 

          Lock  
Ha a fólia zárt,  a fólián lévő entitások nem kiválaszthatók,  és nem 

szerkeszthetők. 

 
 

 

 
 

 

1.3 Új fólia létrehozása és megnevezése 
 
 
 

 
 

❶ Klikk Formátum [Format]  ⇨ Fólia [Layer]  a legördülő menün. 
 

Mint a fenti képen,  klikk  (Új fólia) ikon a Fólia tulajdonság menedzseren, hogy nevet adjon az új fóliának.   
 

❷ Gépelje be a kívánt nevet a név fülön.  Ha nem nevezi meg, automatikusan lesz elnevezve  ‘Layer1’, 

‘Layer2’,  ‘Layer3’,  …….  Nincs korlát, annyi fóliát hozhat létre amennyit szeretne.  Pr
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❸ Elrendezés neve  ‘CL’  amely egy központi egyenesből áll (Center  Line). 
 

 
 

 
 

 
 
 

1.4 Színek beállítása a fólián 
 

 
 

255 szín egyikére pikkelhet a Szín kiválasztás ‘Select  color’  dialógus ablakban, és választhatja ki mint 

fólia szín. Amikor a szín beállításra került, a fólián megrajzolt entitások felveszik ezt a szín 

tulajdonságot. Ez a koncepció ‘ByLayer’,  ezt tovább fogjuk tárgyalni, mivel kimondottan fontos a 

tervezésnél.  Nyílván a felhasználó módosíthatja az entitás szín tulajdonságát.  

 

 

❶ Klikk , hogy beállítsa a  ‘CL’  fólia színét, miután klválasztott a   ‘CL’  fóliát. Pr
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❷ Mint a lenti képen, válassza ki a kívánt  (RED) színt  és nyomja meg az  ‘Ok’  gombot. 
 

‘CL’  fólia megjelenítésre kerül a ‘Layer  Property  Manager’ -be. 
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1.5 Egy fólia vonaltípusának beállítása 
 
 
 

❶ A ‘CL’  fólia vonaltípusának beállításához,  válassza ki a CL fól iá t  és kattintson a   a 

vonaltípus alatt. 
 

 

❷ Klikk ‘Explore’ (Browse - tallózás)  gombra a ‘Line  Type’ dialógus ablakban,  és válassza ki a 

‘CENTER2’-t  a ‘Line Type Load’ dialógus dobozba,  ezután klikk az ‘Ok’ gombra. 
 
 

 
 

 

 
 

 
 

❸ ‘CL’  fólia vonal típusa  ‘CENTER2’ -re lesz beállítva mint a lenti képen. Pr
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1.6 Aktuális fólia beállítása 
 

 
 

Az aktuális fólia a Nulla fólia, amely fólia a   jelel van előtte ellátva. 

Válassza ki a  ‘CL’-t,  ezután, dupla kattintás vagy klikk (Beállítás mint aktuális fólia) ikon a 

felső szinten. Ezután mint a lenti képen,  a jel megjelenik a fólia név előtt  (CL.) 
 

 
 

 

Most már az aktuális fólia átváltott ‘CL-re.’  Ha a felhasználó nem végez más módosítást,  az entitások 

amelyek mostantól rajzolva lesznek  a ‘CL’ fólia fogja tartalmazni  a vonaltípusát és színét a 

‘CENTER2’-t  és a RED-et. 
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1.7 Be,  fagyaszt,  fólialezárás és vonalvastagság beállítás 
 
 
 
 

 
 
 

❏  ON/OFF - Set  to display objects on  drawing area’s layer in ‘Layer Property Manager’ 

pallette or  not. 

 
•  Ha ez Be (On),  megjelenít a rajzterületen,  és nem, ha  Ki  (Off.) 

•  Ha a felhsználó a Be-re ( On) kattint,  átvált  Ki (Off) státuszra (Váltó kapcsolás). 

•  Ki (Off) fólia nem lesz megjelenítve a rajzterületen és nem 

plottolható.  
 

 
A fólia Be/ki (ON/OFF) tulajdonsága hasznos a 3D tervezési környezetben, amikor a felhasználó több 

fóliával dolgozik bonyolult ábrákon, lehetővé teszi, hogy azokat a részeket lássa csak, amelyek 

számára szükségesek.  

 

❏ Fóliát fagyaszt (Freeze) - vagy  olvaszt  (Unfreeze). 
 

 

•  Klikk egyszer  (Unfreeze) Olvaszt,  ezután  átkapcsol Fagyasztásra 

(Freeze)  (Váltó kapcsolás). 

•  Amikor a fólia  (Freeze),  ehhez a fóliához tartozó entitások, nem jelennek meg a rajzon és nem 

plottolhatók.  
 

 
Zoomoláshoz, eltoláshoz (PAN), további munka sebességhez, objektum kiválasztási idő és 

regenerálási idő javításhoz a felhasználó a fóliákat fagyaszthatja. A fagyasztott fólia nem plottolható, 

nem renderelhető, és nem regenerálható. A fólia hosszú ideig történő elrejtéséhez, egyszerűen 

fagyassza le a fóliát. Másrészről,  amikor a felhasználó gyakran be és kikapcsolja, (kerülje el ezt a 

szituációt amikor a rajz regenerált)  mi az ON/OFF beállítást használjuk. A felhasználó a fóliát 

fagyaszthatja az összes nézetablakban, az aktuális nézetablakban vagy a fólián lévő újonnan írt 

nézetablakban. Pr
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❏ Fólia Lezárás (Lock) –   vagy  Felnyitás (Unlock). 

 

•   Felnyitás [Unlock] 

•   Lezárás [Lock] 
 

 
Kattintson egyszer a felnyitásra, hogy lezárásra kapcsolja.  Az entitások a lezárt fólián megjelenítésre 

kerülnek a rajzterületen, de a felhasználó nem tudja módosítani azokat, és még kiválasztani se lehet azokat.   

 

❏ Vonalvastagság (Lineweight)  –   Fólia vonalvastagság beállítás.  

 

•  Kattintson egyszer az alapértékre (default). 

•  Válassza ki a kívánt vonalvastagság értéket (0.50mm)  a Vonalvastagság (Lineweight)  dialógus 

ablakban   és kattintson az OK gombra. 
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1.8 Fólia törlése 
 

 
 

A fólia törléséhez a ‘Layer  Property  Manager’ palettából, válassza ki a nevet és kattintson  Fólia 

törlése (Delete layers)  ikonra a felső szinten.    
 

Ha a törlendő fólia tulajdonságok között van egy olyan tulajdonság, amelyet az alábbi kép tartalmaz, 

akkor a fóliát nem lehet törölni.  (aktuális fólia, objektumot tartalmaz, x-ref függő fóliák) 

 

 
 

 
 

 
 

1.9 Fólia eszközök 
 
 

Mint a lenti kép,  több különféle fólia használja és kezeli a segéd parancsokat a Formátum [Format] ⇨ 

Fólia eszközök [Layer tools] legördülő menüben.  Néhány ilyen segéd parancsot már  leírtunk a Fólia  

(LAYER) fejezetben, amint tudja a nevükre pillantva.   
 

Ezek a parancsok Makró típusként futnak, hogy kényelmesen használhatók legyenek amikor használja a  

Fólia (LAYER)  parancsot. 
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❏ Fólia beállítás gépészeti rajzon 

 
Layer  LineType Color LineWeight Name 

 
 

OL 
 

Continuous 
 

Blue 
 

0.8mm 
 

Kontúr 

 

VL 
 

Continuous 
 

Green 
 

0.5mm 
 

Látható vonal 

 

HL 
 

HIDDEN2 
 

Yellow 
 

0.35mm 
 

Takart vonal 

 

CL 
 

CENTER2 
 

Red 
 

0.18mm 
 

Közép vonal 

IL PHANTOM2 Pink 0.18mm Fantom vonal 
 

FL Continuous White 0.18mm  
Vékony vonal 

(méret,  sraff) 

 

SL 
 

CENTER 
 

Green 
 

0.5mm 
 

Felszín vonal 

 

DL 
 

CENTER 
 

White 
 

0.18mm 
 

Vágósík vonal 

 

RS 
 

Continuous 
 

Cyan 
 

0.26mm 
 

Finishing  Mark 
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02   Koncepciók és szín alkalmazások 
 

 

2.1 Szín áttekintése 
 

 
 

Segít a felhasználónak az objektumok láthatóságának csoportosításábann amikor a rajzi entitásokhoz 

színeket alkalmazunk. Színt lehet beállítani entitáshoz vagy magához a fóliához. 

 
 

Az entitáshoz való szín beállításnak két módja van. 
 

 

•  ByLayer –   Fólia színének beállítása. 

•  Individual  color  –   Color parancs használata. 
 

 
Fólia szín beállítása a  ByLayer-el. A felhasználó könnyen megkülönböztetheti az objektumokat 

különböző fóliákkal. 
 

 
 

 
 

A felhasználó különböző tulajdonságokat tud hozzáadni a COLOR parancs használatával, hogy beállítsa az 

entitásokat ugyanazon fólián különböző színekkel. Az entitások színének megadása a Color kiválasztása a 

Color index, True  Color,  Color scope fülek a ‘Select  color’  dialógus ablakban. 
 

A felhasználó nyomtathatja a rajzlapot vonal típusként, vonalvastagság megjelenítés alkalmazásával is.  Pr
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2.2 Szín parancs 
 

 
 

Új objektumok színének beállítása. 

 
Menü  Format(O)  ➤ Color(C) 

Eszköztár 

Szalag  Home ➤ Format ➤ Color 

 
Parancs  COLOR 

 

 
 

•  Klikk Formátum [Format]  ⇨ Színek [Color]  a legördülő menün. 

Válassza ki a kívánt színt a ‘Select  color’  dialógus ablakban és kattintson az ‘Ok’  gombra. 
 

 
 

•  Gépeljen -COLOR  vagy COL a parancssorba. Parancs:  -COLOR 

Szín az új entitásokhoz        [Truecolor/COlorbook]  <BYLAYER>:  1 vagy  RED 
 

 

Azok az objektumok amelyek mostantól lesznek megrajzolva  be lehet állítani a színeit. Pr
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03   Koncepciók és vonaltípus alkalmazások 
 

 

3.1 Vonaltípus áttekintés 
 

 
 

Vonaltípust használunk az objektukok láthatóságának megkülönböztetésére. A KS rajz szabványok 

szerint, a vonalaknak ugyanaz a vastagságuk és formájuk ellenére különböző nevük van a használattól 

függően.  Végeredményben, a felhasználó különböző vonaltípust használhat, különböző felhasználáshoz.   

(Dimension Line- méretvonal, Hatching line -sraff vonal, Hidden Line - takart vonal, Cutting Line - törés vonal) 
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Vonaltípus 
 

Megjelenés 
 

Leírás 
 

Látható vonal  
 

 

Az objektum kontúrjait mutatja, használata vastag vonallal.  

 

Takart vonal  
 

Az objektum takart vonalait mutatja, vékony, vékony szaggatott vonallal.   
 

Közép vonal  
 

 

Az objektum közepét mutatja használata vékony szaggatott vonallal. 

Fantom vonal 
       Virtuális objektumot mutat   vagy egy alkatrész várható vonalát használata 

dupla szaggazott vonallal. 
 

Törés vonal      Az objektum metszeteit mutatja   használata vékony vonallal. 

 
Metszet vonal Általánosan használt a sraffokhoz vékony vonallal.  

 

 
  Méret vonal 

 

Használata méretezéshez vékony vonallal. Ezt meg lehet törni a méret 

   beszúrásával és a méret segédvonalak közzé kell rajzolni. 
 

Méretsegéd vonal      Használata méretezéshez vékony vonallal.  

 
Mutató vonal      Használata  speciális megjegyzések,  méretezéshez  és referenciákhoz. 

 
 

 

Méret segédvonal ⇨ súlypont vonal ⇨ középvonal ⇨ vágósík vonal ⇨ takart vonal ⇨ látható vonal.  A 

prioritás sorrendje.  Ha a látható vonal és a közép vonal átfedik egymást, akkor csak a látható vonalat kell 

megrajzolni, mert ez a fontosabb.    

 
 

 
 
 

3.2 Vonaltípus (LINETYPE) parancs 
 
 
 

Vonal típus felvétele és beállítása aktuális vonaltípussá. 
 

 
 
 

Menü  Format(O)  ➤ Line  Type(N) 

 

Eszköztár  

 

Szalag  Home ➤ Format ➤ Line  Type 

 
Parancs LINETYPE Pr
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A vonaltípus egy ismételt minta, szaggatott vonallal (3mm), ponttal vagy üres helyekkel (1mm), egyenes vagy görbe 

vonalként megjelenítve.  Használja a LINETYPE parancsot a különböző vonaltípus betöltéséhez, beállításához 

vagy módosításához.  Betöltheti a vonaltípust amikor elkezdi a projektjét hogy később újrafelhasználja.  
 

A használható vonaltípusok megtekintéséhez, töltse be a rajzon vagy jelenítse meg a vonaltípus listát a 

LIN fájlba elmentve. CADian az ICAD.LIN fájlban két megadott vonaltípus fájlról gondoskodik. 

 

 
 
 

A nem hivatkozott vonaltípus eltávolításához,  használja a  PURGE parancsot  vagy törölje a ‘Line  

Type Manager-ben’. 
 

 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

318 

 

 

 
 

 

 
 

3.3 Aktuális vonaltípus beállítása 
 

 
 

Mint a következő ábrán, az aktuális vonaltípust lehet látni a Tutaldonság (Properties)  eszköztáron  vagy 

a Tulajdonság  panelon. A felhasználó könnyen módosíthatja az aktuális vonaltípust másik stílust 

választva a legördülő menüben. 
 

 
 

 

 
 

 
Ha az aktuális vonaltípus a ‘ByLayer’-re van állítva,  a megrajzolt objektum vonaltípusa az aktuális fólia 

vonaltípusát fogja követni.  
 

Ha az aktuális vonaltípus a ‘ByBlock-ra van állítva, a megrajzolt objektum,  a CONTINUOUS 

(Folytonos) vonaltípust használja míg egy blokba van csoportosítva. Ha egy blokk beszúrásra kerül a 

rajzba, az objektum az aktuális vonaltípus beállítását fogja követni.  
 

A felhasználó nyiltan kijelölhet egy másik vonaltípust a kijelölt vonaltípusokból az aktuális fóliához 

bizonyos objektumok részére. A vonaltípus nem alkalmazható néhány entitáshoz, ilyen a szöveg, a pont a 

nézetablak és a sraff. Pr
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3.4 Objektumok vonaltípusainak megváltoztatása 
 

 
 
 

Amikor egy objektumot átmozgatunk egy másik fóliára, a vonaltípus beállítás egy fólián megváltozik, 

vagy egy objektum vonaltípusa újradefiniálásra kerül, az objektum vonaltípusa megváltozik.    

 

 
Három módja amikor a vonaltípus megváltozik: 

 

 

•  Objektum mozgatása egy másik fóliára. Az objektum vonaltípus beállítása   ‘ByLayer’-re van 

állítva. Ezután az objektum az új fólia kijelölt vonaltípusát fogja követni.    

•  A fólia vonaltípusának újradefiniálása amelyiken a kívánt objektum tartózkodik.  A vonaltípus 

beállítás az objektum részére ‘ByLayer’ legyen.  Amikor a vonaltípus beállítás a fólián 

szerkesztésre kerül, az összes entitás a “ByLayer”  vonaltípussal automatikusan frissül a fólián az 

új vonaltípusra.   

•  Az objektum vonaltípusának nyílt átdefiniálása.  Legördülő menü használata a   Tulajdonságok 

‘Properties’ eszköztáron vagy a  ‘Properties’  panelen,  egy speciális vonaltípus kijelölés,  mint a  

DASHED (Szaggatott), mint inkább a  ‘ByLayer’. 
 

 
Amikor a vonaltípus beállításra kerül egy meghatározott vonaltípusra  a ‘Properties’  eszköztáron,  a  

‘ByLayer’ mellett,  az összes entitás a rajzterületen a kiválasztott vonaltípussá válik.  
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3.5 LTSCALE (Vonaltípus mérték) parancs 
 
 
 

A felhasználó különböző mértéket használhat mindegyik vonaltípushoz.  Még ugyanazon vonaltípusnak is 

lehet különböző mértéke.  
 

1.0  az alapértelmezett LTSCALE(Vonaltípus mérték) érték a rajz beállításhoz. Ahogy az érték csökken, az 

ismételt minták száma nőni fog az egy egységnyi hosszon. Például, ha a  LTSCALE  0.5-re lett állítva,  kétszer 

annyi minta van mint az 1.0 értékűnél.  Ezért kisebb léptéket használjon rövidebb vonal szegmenshez, 

amelyet nehéz megjeleníteni szaggatott vonal stílusban. 

 

 
 

 
 

 
 

Linetype  Manager megjeleníti a globális  méték tényezőt és a jelenlegi mérték tényezőt.  
 

 
•  Globális mérték tényező megváltoztatja az összes entitás vonaltípus mértékét a rajzban a LTSCALE 

rendszerváltozó módosításával. 

 

•  Az aktuális mérték tényező állítja be az új entitások mértékét a CELTSCALE rendszerváltozó értékének 

módosításával. 

 

 
*  A CELTSCALE  és a  LTSCALE  érték szorzata a jelenleg mutatott vonaltípus mérték.    Pr
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Menü Format(O)  ➤ Line  Type(N) 

 

Eszköztár  

 

Szalag Home ➤ Format ➤ Line  Type 

 
Parancssor LTSCALE 

 
 
 
 

Command:  LTSCALE 
 

Enter  new  value  for  LTSCALE  <1.0000>:  2.0 
 
 

 

•  Klikk [Format]  ⇨ [Linetype]  a legördülő menüben. 
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04  Vonalvastagság koncepciók és alkalmazások  
 

 

4.1 Vonalvastagság áttekintése 
 

 
Vonalvastagság a rajzban, nem csak egy grafikus objektum, hanem egy megadott értékű speciális szöveg 

típusok. Vonalvastagság használatával a felhasználó részletes különbségeket tud megjeleníteni, mint a 

méretvonal vagy a háló. A kész rajzon lehetnek plot objektumok vonalvastagság értékeket alkalmazva. 
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A kész rajzon lehetnek plot objektumok, a rajzi szabványokat követve, mint a lenti képen. 
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4.2 LWEIGHT  parancs 
 

 
 

Aktuális vonaltípus beállítása,  megjelenítése és mértékegysége. 

 

Menü  Format(O)  ➤ Lime  Weight(W) 

Eszköztár 

Szalag  Home ➤ Format ➤ Line  Weight 

 
Parancssor LWEIGHT 

 

•  Klikk [Format]  ⇨ [Line  weight]  a legördülő menün. 

•  Gépeljen LWEIGHT  a parancs sorba. 

 
 

 

❶   Ellenőrizze a mértékegység beállítását a  ‘UNITS’  parancs Vonalvastagság-beállítások (Lineweight  Setting) 

dialógus ablakban. 

❷   Jelölje be a  Vonalvastagság megjelenítést  (Display  Lineweight). 

❸   Állítsa be mozgatással  ‘Adjust  Display Scale’  csúszkát. 
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05  Entitás tulajdonság koncepció és alkalmazása 
 

 

5.1 Entitás tulajdonság áttekintése 
 

 
 

A rajzban megtervezheti az objektumait, majd átszerkesztheti az entitás tulajdonságokat, mint a fólia, vonal 

típus, szín és vonalvastagság, hogy íly módon megjelenítve plottolhassa ki azokat.    
 

A fólia konstrukciók a rajzi információk különböző típusú csoportjai átlátható módon átfedik egymást.  

Az írt objektumoknak hasonló tulajdonságaik vannak, mint szín, vonal típus és vonalvastagság. Ilyen 

tulajdonságot feltételezhetően tartalmaznak a tervezett rajzban lévő objektumok vagy speciálisan egyedileg 

kell beállítani.   
 

A színek használata megkülönböztati a hasonló elemeket és a vonal típussal megláthatjuk milyen elemeket 

rajzoltak. A vonalvastagság megmutatja az objektum méretét a vastagsággal, amelyet így könnyű vizualizálni.  

Könnyű kezelni a rajzi információkat, ha fóliát és fólia objektumokat hoz létre.   
 

Az összes entitásnak vagy objektumnak tulajdonságaik vannak, mint a fólia, szín, vonal típus és nyomtatási 

stílus. Más tulajdonságok az egyedre jellemzőek, például, a körnek van sugara, a vonalnak van hossza és 

szöge.    

 
 

Általában osztott tulajdonságok beállítása az objektum fóliákkal lehetséges, de beállíthatjuk ezeket 

magunk is. 
 

 
•  ByLayer : Azt jelenti, hogy a fólia beállítás tulajdonságait követi. Amikor az objektum tulajdonságát  

ByLayer-re változtatjuk, ez a fólia tulajdonságát követi.  Például, egy vonal a 0-ás fólián 

van, ezután vörös színe lesz, ha a vonalnak van színe, valamint a ByLayer és a Layer  0 

színe vörös színre lesz állítva.  

 

•  ByBlock : Nem tudja módosítani a beszúrt blokk színét, vonal típusát vagy vonalvastagságát. 

Azonban, ha a blokkhoz a ByBlock tulajdonságok vannak hozzáadva, akkor 

módosítható. 

 

•  Ha a tulajdonságnak speciális értéket ad meg,  az változni fog. Például, ha a vonal színét módosítjuk Layer 

0-án kék színre,  ezután ez kék lesz, még akkor is, ha a  Layer 0 színe vörös. 
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5.2  Entitás tulajdonságok megjelenítése és módosítása 
 
 
 

A rajzban, az összes objektum aktuális tulajdonságát meg lehet jeleníteni és szerkeszteni a következő 

módon.   

 

•  Nyissa meg a tulajdonságok palettát (Properties),  nézze meg a kiválasztott objektum tulajdonság 

beállítását és szerkesztését.    

•  Nézze meg a "Layer  control and property" beállítását  a Layer  dialógus ablakban,  és a "Line,  line 

type, lineweight, and  plot  style control"  dialógus panelben és annak szerkesztését.   

•  Használja a LIST parancsot, hogy megnézze a szöveg ablak információt.   

•  Használja az ID parancsot, hogy megjelenítse a koordináta helyet. 
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5.3 CHANGE vagy a CHPROP parancs 
 
 
 

Szerkessze a kiválasztott entitás tulajdonságokat. 
 

CHANGE vagy a CHPROP parancsot bonyolult a TTY-base paranccsal használni.  Újabban, az emberek  

a PROPERTIES  parancsot gyakrabban használják a GUI környezetben. 
 

 
 
 

Menü Modify(M)  ➤ Change 
 

 
Eszköztár 

 

Szalag  Home ➤ Modify  ➤ Change 

 
Parancssor  CHANGE,  CHPROP 

 

 

•  Gépeljen CHANGE  vagy CHPROP a parancssorba.  

Command:  CHANGE 

Select  entities  to change:  P1 

Entities  in  set:  1 
 

Select  entities  to change: 
 

Specify  change point  or [Properties]:  P 

Enter property  to  change[Color/Elev/LAyer/LType/ltScale/LWeight/Thickness/ 

Material/Annotative]: 

 
 

 
Command:  CHPROP 

Select  entities  to change:  P1 

Entities  in  set:  1 
 

Select  entities  to change: 

Enter property  to  change [Color/Elev/LAyer/LType/ltScale/LWeight/Thickness/ 

Material/Annotative]: Pr
ó
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Option Description 

 

Color A kiválasztott entitás színének módosítása. 

 

Elevation  
A kiválasztott entitás kiemelésének módosítása. 

LAyer  
A kiválasztott entitás fóliájának módosítása. 

LType 
A kiválasztott entitás vonaltípusának módosítása. 

LtScale A kiválasztott entitás vonal mérték módosítása.. 

  LWeight A kiválasztott entitás vonalvastagság módosítása.. 

 

Thickness 
A kiválasztott entitás vastagság módosítása. 

Material Csatolt objektum anyagkivásztás módosítása. 

 

Annotative Kiválasztott objektum kiegészítőinek módosítása. 

 

 
 

 
 
 

5.4 Tulajdonság (PROPERTIES) parancs 
 
 

Megjeleníti az entitás tulajdonságát a tulajdonság palettában és szerkeszti az összes tulajdonságot. 
 

 
 
 

Menü  Modify(M)  ➤ Properties...(P) 

 

Eszköztár  

 

Szalag Home ➤ Modify  ➤ Properties... 

Parancssor  PROPERTIES 

 
 

 

•  Klikk [Modify]  ⇨ [Property]  a legördülő menüben. Pr
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5.5 MATCHPROP  parancs 
 
 
 

Használja a Match Property eszközt az objektum egy vagy  több tulajdonságának egy másik objektumra 

történő másolásához. A következő objektum tulajdonságokat tudja a felhasználó másolni: szín, fólia,  

vonaltípus mérték, vonalvastagság,  nyomtatási stílus,  nézetablak tulajdonság, és 3D vastagság. 
 

Speciális tulajdonságot ne másoljon, használja a beállítás opciót, elkerülve a tulajdonság másolását.    

 
Menü   Modify(M)  ➤ Match  Properties(M) 

Eszköztár  

Szalag Home ➤ Modify  ➤ Match  Properties 

 
Parancssor  MATCHPROP Pr
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•  Klikk (Match Property)  a Vágólap  (Clip  board) panel  a Szalag  (Kezdőlap)  fülön. 
 

 
 

Command:  '_MATCHPROP 

Select  Source  Object:  P1 

Current  active  settings:    Color  Layer  Ltype  LtScale  Lineweight  Thickness  Pstyle Dim Text 

Hatch  Polyline  Viewport  Table Material  Shadow  display  Multileader 
 

Select  destination  object(s)  or [Settings]:  S 
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Exercise  31  Rajzolja meg a következő objektumot  fóliákat és vonaltípusokat használva. 
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Exercise  32  Rajzolja meg a következő objektumot  fóliákat és vonaltípusokat használva. 
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Exercise  33  Rajzolja meg a következő objektumot  fóliákat és vonaltípusokat használva. 
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Exercise  34  Rajzolja meg a következő objektumot  fóliákat és vonaltípusokat használva. 
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Exercise  35  Rajzolja meg a következő objektumot  fóliákat és vonaltípusokat használva. 
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Exercise  36  Rajzolja meg a következő objektumot  fóliákat és vonaltípusokat használva. 
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Exercise  37  Rajzolja meg a következő objektumot  fóliákat és vonaltípusokat használva. 
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07 
 

 

Objektumok módosítása 
 

 
 
 
 
 
 
 

A következő fogalmakat tárgyaljuk meg ebben a fejezetben: 

•  Másolás, mozgatás, tükrözés és entitások kiosztása 

•  Entitás szerkesztés 

•  Lekérdezési parancsok 
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01 Másolás, mozgatás, tükrözés és kiosztás entitásai 
 

 
Parancslista az entitások módosításához. 

 

 
Ikon Parancs Leírás 

 

 

          MOVE Elmozgatja az objektumot  adott irányban és adott  távolságra. 

 

          COPY  Objektumot másol egy megadott irányban, egy adott távolsággal arrébb. 

            MIRROR Lerajzolja egy kiválasztott tárgy tükrözött másolatát. 

          ROTATE A kiválasztott objektumot elforgatja. 

 

         SCALE A méret arányt megtartva,  a kiválasztott objektum éretét növeli/csökkenti.  

            ARRAY Kiválasztott objektumot felhasználva mintát hoz létre testreszabott  beállítással. 

 

 
 

1.1 Mozgat (MOVE) parancs 
 

 
 

Elmozgatja az objektumot adott irányban  egy beállított értékkel. 

 
Menü   Modify(M)  ➤ Move(V) 

Eszköztár  

Szalag Home ➤ Modify  ➤ Move 

 
Parancs  MOVE 

 
 

•  Klikk [Modify] (Módosítás)  ⇨ [Move] (Mozgat) a legördülő menüben. 

•  Klikk (Move) ikon  a Szalagon a Modify (Módosítás)  panelen. 

•  Gépelje a MOVE  vagy  M -e t  a parancssoron. Pr
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Command:  _MOVE 

Select  entities  to  move:  E1 

Entities  in set:  1 
 

Select  entities  to  move: 

Specify  base   point  or [Displacement]  <Displacement>:  P1 

Specify  second point  or <use  first  point  as  displacement>:  P2 
 
 

 
 

 

❏ Opció 

 

 
Displacement (D) (Elmozgatás): Input koordináta értéke a vektornak, az érték beállítása a relatív 

hosszal és iránnyal.  

 
 

 

1.2 Másolás (COPY) parancs 
 

 
 

Másolatot készít megadott irányban és beállított távolságra  az eredeti objektumtól. 
 

 
 
 

Menü  Modify(M)  ➤ Copy(Y) 
 

 
Eszköztár 

 

Szalag Home ➤ Modify  ➤ Copy 

 
Parancssor  COPY Pr
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•  Klikk [Modify] (Módosítás)  ⇨ [Copy] (Másolás) a legördülő menüben. 

•  Klikk (copy)  ikon  a Szalagon a Modify (Módosítás)  panelen. 

 

 
 
 

Command:  _COPY or CO 

Select  entities  to  copy: E1 

Entities  in set:  2 
 

Select  entities  to  copy: 

Current  settings:    Copy mode  =  Multiple 

Specify  base   point  or [Displacement/mOde]  <Displacement>:  P2 

Specify  second point  or <use  first  point  as  displacement>:  P3 
 

Specify  second point  or <Exit>: 
 
 

 
 

 
❏ Opció 

 

 
 

Opció Funkció 

 

Displacement Relatív távolság és irány beállítása koordináták használatával. 

 

 
mOde 

 

Single A kiválasztott entitást egyszer másolja. 

 

Multiple COPY  parancs folyamatosan ismétlődik. 
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1.3 Tükröz (MIRROR) parancs 
 
 
 

Másolatot készít egy beállított tengely másik oldalára két pont beállításával. 

 
Menü   Modify(M)  ➤ Mirror(I) 

Eszköztár  

Szalag  Home ➤ Modify  ➤ Mirror 

 
Parancssor  MIRROR 

 

 
 
 
 

•  Klikk [Modify] (Módosítás)    ⇨ [Mirror] (Tükröz) a legördülő menüben. 

•  Klikk (Mirror) ikon  a Szalagon a Modify (Módosítás)  panelen. 

•  Gépeljen MIRROR  vagy  MI -t  a parancssoron. 
 

 
 

Command:  _MIRROR 

Select  entities  to mirror:  P1 

Entities  in  set:  1 
 

Select  entities  to mirror: 

Start  of  mirror  line:  P2 

End  of  mirror  line:  P3 
 

Delete the  original  entities?  <N> 
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A legtöbb gépész alkatrész tükör mintás.  A felhasználónak egyszerűen csak a felét kell megterveznie, majd 

megralálni a tükrözés tengelyét és használni a Mirror parancsot  a másik fél megrajzolásához. 

 

 
 

 

MIRRTEXT  rendszerváltozó 

 

 
Általában,   amikor szöveg,  sraff,  attribútumok és attribútum definíciók nem tükrözhetők, 

amikor a tükrözés már elkészült, ezért módosítani kell az elrendezését a MIRROR  parancs után,    a 

MIRRTEXT rendszerváltozó 1-re állítással. 

 

 
Command: MIRRTEXT 

Enter  new  value  for  MIRRTEXT  <OFF>:  1 
 

Command: MIRRTEXT 

Enter  new  value  for  MIRRTEXT  <ON>:  0 
 
 
 
 
 
 
 
 
 

MIRRTEXT  befolyásolja a TEXT,  az ATTDEF  vagy az  MTEXT  parancsot,  és más szövegeket,    

attribútumként vagy attribútum változóként megadottakat. Ha a blokk blokk attribútumot tartalmaz,  

ennek szövege és száma fejjel lefelé lesznek amikor a blokk tükrözésre kerül, figyelmen kívül hagyva a  

MIRRTEXT  rendszerváltozó értékét. 
 

MIRRHATCH  befolyásolja azokat az objektumokat, amelyek sraffot tartalmaznak GRADIENT  vagy a HATCH 

paranccsal.  A sraff irányát igazítani lehet egy egyszerű módon a MIRRHATCH  rendszerváltozóval. 
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1.4 Forgatás (ROTATE) parancs 
 
 
 

Objektum sarokpontjának elforgatása a referencia pontjával. 
 

 
 
 

Menü  Modify(M)  ➤ Rotate(R) 

 

Eszköztár  

 

Szalag  Home ➤ Modify  ➤ Rotate 

 
Parancssor  ROTATE 

 

 
 

•  Klikk [Modify] (Módosítás)   ⇨ [Rotate] (Forgatás) a legördülő menüben. 

•  Klikk (Rotate) a Szalagon a Modify (Módosítás)  panelen. 

•  Gépeljen ROTATE  vagy  RO -t a parancssoron. 
 

 
Command:  _ROTATE 

Select  entities  to rotate:  E1 

Entities  in  set:  1 
 

Select  entities  to rotate: 

Rotation  point:  P1 

Copy/Base angle/<Rotation  angle>:    P2  or -45 
 
 

 
❏ Opciók 

 

 
Opciók Leírás 

Rotation  Angle Beállítja, hogy hány szöggel lesz egy objektum elforgatva  a vízszintes vonal fölé.  

Base  Angle Megrajzolja az objektum másolatát, amelyet referenciaként lehet 

használni egy megadott szöggel.Pr
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1.5 Lépték (SCALE) parancs 
 

 
 

Kiválasztott objektum felfelé vagy lefelé történő méretezése. 

 
Menü  Modify(M)  ➤ Scale(L) 

Eszköztár 

Szalag Home ➤ Modify  ➤ Scale 

 
Parancssor  SCALE 

 

 
 

•  Klikk [Modify] (Módosítás)  ⇨ [Scale]  (Lépték) a legördülő menüben. 

•  Klikk (Scale)  a Szalagon a Modify (Módosítás)  panelen. 

•  Gépeljen SCALE  vagy  SC - a parancssoron. 
 
 

Command:  _SCALE 

Select  entities  to scale:  P1 

Entities  in  set:  1 
 

Select  entities  to scale: 

Base  point:  P2 

Base  scale/Copy/Reference/<Scale  factor>:    P3  or 1.5 
 
 

 
 

 

 
 

Select entities 0.5Scale Result Pr
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1.6 Kioszt (ARRAY) parancs 
 
 
 

A Kioszt parancs másolja a kiválasztott objektumot  általános mátrix 

mintával. 
 

 
 

 
 

 
 

Másolja a kiválasztott objektumot kör mintának megfelelő forgás tengellyel.    
 

 
 
 
 

Menü  Modify(M)  ➤ Array 

 

Eszköztár  

 

Szalag  Home ➤ Modify  ➤ Array ➤ Rectangular  Array 

 
Parancssor ARRAY Pr
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•  Klikk [Modify] (Módosítás)   ⇨ [Array] (Kioszt)  a legördülő menüben. 

•  Klikk [Array]  a Szalagon a Modify (Módosítás)  panelen. 

 
 

 
Command:  _ARRAY 

Select  entities  to array:   P1  Entities  in  set:  1 
 

Select  entities  to array: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Cancel/Modify/<Allow>: Pr
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ba
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Poláris kiosztás 

 

 
 

  A következő párbeszéd ablak mutatja azt, amikor az MLSTYLE  parancs fut. 
 

 
 
 
 

Command:  _ARRAY 

Select  entities  to array:   P1  Entities  in  set:  1 
 

Select  entities  to array: 

Specify  center  point of  array:   C1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Cancel/Modify/<Allow>: Pr
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Exercise  38  Rajzolja meg a következő objektumot a MIRROR és  az ARRAY használatával. 
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Exercise  39  Rajzolja meg a következő objektumot a MIRROR és  az ARRAY használatával.. 
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Exercise  40  Rajzolja meg a következő objektumot a MIRROR és  az ARRAY használatával. 
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Exercise  41  Rajzolja meg a következő objektumot a MIRROR és  az ARRAY használatával. 
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Exercise  42  Rajzolja meg a következő objektumot a MIRROR és  az ARRAY használatával. 
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Exercise  43  Rajzolja meg a következő objektumot a MIRROR és  az ARRAY használatával. 
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02 Entitás szerkesztése 
 

 
Parancs lista az entitások módosításához. 

 

 
 
 

Ikon Parancs  Leírás 

 
        JOIN Egyenes és ívelt objektumok egyesítése  egy entitássá. 

 

        LENGTHEN Egyenes objektumok hosszának módosítása vagy egy ív szögének. 

STRETCH Objektumok nyújtása, amelyek metszik a   kiválasztó ablakot. 

          EXPLODE Komplikált objektum szétvetése kisebb elemekké.   

 
DDPTYPE  Megjelenítési stílus beállítása és a pont objektumok mérete. 

 
POINT Megrajzol egy pont objektumot. 

 
DIVIDE Kiválasztott entitást szétoszt egyenlő n részre, elhelyezi a pont objektumokat v. blokkokat.  

 

MEASURE  
Elhelyezi a pont objektumokat v. blokkokat u.a. a helyen a kiválasztott entitáson egy 

adott hosszal.      
 

 

         BOUNDARY  Vegyen egy részt vagy vonallánc részt egy zárt objektumból.   

 
         REGION Zárt objektumokat csoportosít  egy adott területen körbevév, hogy egy régiót 

hozzon létre.  

           REVCLOUD Revízió buborékot rajzol vonalláncot használva. 

 

 

WIPEOUT  
Egy kitöröl (wipeout) entitást rajzol, amely befedi a többi entitást, 

bekapcsolja/kikapcsolja a törlő objektum keret megjelenítését.   Pr
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2.1 Egyesít (JOIN) parancs 
 

 
 

Két hasonló entitást eggyé csatol. Általában, két egyenest vagy ívet tudunk összekapcsolni.  A két 

egyenesnek egy egyenesre esőnek (kollineáris) kell lennie vagy párhuzamosnak, a két ívnek ugyanolyan 

sugarúnak és középpontúnak. Két elválasztott végpont között ez a parancs egyenest húz a pontok közzé.  

Íveknél, csatlakoztatni lehet az első kiválasztott objektumból az óramutató járásával ellentétesen. A 

következő objektumokat tudja egyesíteni.  

 

 
Objektum 

 
1  ARC /   Ív 

 
2  Elliptical  ARC /Elliptikus ív 

 
3  LINE / Vonal 

 
4  POLYLINE / Vonallánc 

 
5  SPLINE 

 

 
 
 

Menü  Modify(M)  ➤ Join(J) 
 

 
Eszköztár  

 

Szalag Home ➤ Modify  ➤ Join 

 
Parancssor  JOIN 

 
 

 

•  Klikk (Join) Egyesít  a Szalag /Módosítás panelen. 

•  Futassa [Modify] Módosítás ⇨ [Join] Egyesít parancsot a legördülő menüben. 
 

 
Command  : _JOIN 

Select  source  object:  P1 

Select  lines to  join to  source:  P2  Entities  in  set:  1 
 

Select  lines to  join to  source: 

1  line  joined  to  source 
 

Before After 
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2.2 Hosszabb (LENGTHEN) parancs 
 

 
 

Objektumok hosszát szerkeszti, és az ív közötti szöget. 
 

 
 

 
 

Menü  Modify(M)  ➤ Edit  Length(G) 

Eszköztár  

Szalag Home ➤ Modify  ➤ Edit  Length 

 
Parancssor  LENGTHEN 

 
 

 
Command:  _LENGTHEN 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>: 
 

 
 

❏ DYnamic : Aktiválja a DY módot.  Szerkessze egy entitás hosszát a végpont megragadásával.  A 

másik végpont nem fog mozdulni. 

 
 
 

Command:  _LENGTHEN 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>:  P1 

Current  length:  394.4318 
 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>:  DY 

Mode/<Select  entity  to  change>:  P2    P3 

Mode/Undo/<Select  entity  to  change>: Pr
ó

ba
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Command:  _LENGTHEN 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>:  P1 

Current  length:  115.5998, included  angle: 96 
 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>:  DY 

Mode/Undo/<Select  entity  to  change>: P2    P3 

Mode/Undo/<Select  entity  to  change>: 
 
 
 
 
 
 
 
 
 
 
 
 
 

❏ DElta : Objektum hosszát szerkeszti vagy ív szögét  figyelembe véve a növelt érték beállítást a 

kiválasztási ponttól a legközelebbi végpontig mérve. Ha az érték pozitív, akkor az 

objektum növekszik, és ellenkezőleg a negatív érték esetén.    

•  Növekmény hossz: Objektum hosszát szerkeszti a növekmény értékének tekintetében. 

 

 
Command:  _LENGTHEN 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>:  P1 

Current  length:  271.6964 
 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>:  DE 

Angle/<Enter  length  increment  (0.0000)>:  20 

Mode/Undo/<Select  entity  to  change>: P2 
 

Mode/Undo/<Select  entity  to  change>: Pr
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•  Szög : A kiválasztott ív szögét szerkeszti. 
 

 
Command:  _LENGTHEN 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>:  P1 

Current  length:  146.0213, included  angle: 121 
 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>:  DE 

Angle/<Enter  length  increment  (0.0000)>:  30 

Mode/Undo/<Select  entity  to  change>: P2 
 

Mode/Undo/<Select  entity  to  change>: 

 

 
 

 

❏ Percent: Nyújtja vagy zsugorítja egy objektum hosszát a teljes hosszához nézve százalékos értékkel. 

 

 
Command:  _EDITLEN 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>:  P1 

Current  length:  79.6045 
 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>:  P 

Enter percent  length  <100.0000>:  150 

Mode/Undo/<Select  entity  to  change>: P2 
 

Mode/Undo/<Select  entity  to  change>: Pr
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❏ Total : Az objektum hosszát szerkeszti egy rögzített pont  és az abszolút végpont kiválasztásával. 

•  Teljes hossz  : Az objektum hosszát igazítja egy adott hosszhoz  egy kiválasztott pont 

legközelebbi végpontjából.  

 

 
Command:  _EDITLEN 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>:  P1 

Current  length:  119.4067 
 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>:  T 

Angle/<Enter  total  length  (119.4067)>:  300 

Mode/Undo/<Select  entity  to  change>: P2 
 

Mode/Undo/<Select  entity  to  change>: 

 

 
 

 

•  Angle : Beállítja a kiválasztott ív szögét. 

 

Command:  _EDITLEN 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>:  P1 

Current  length:  176.0213, included  angle: 145 
 

Edit  length:  DYnamic/DElta/Percent/Total/<Select  entity  to list  length>:  T 

Angle/<Enter  total  length  (176.0213)>:  270 

Mode/Undo/<Select  entity  to  change>: P2 
 

Mode/Undo/<Select  entity  to  change>: 
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2.3  Nyújt (STRETCH) parancs 
 
 
 

Az objektumot megnyújtja, amely metsződik a kiválasztó ablakkal vagy sokszöggel.  Azok az 

objektumok amelyeket részben tartalmaz az ablak, nyújtásra kerülnek, de azok amelyeket teljes 

egészében tartalmazza csak mozgatva lesznek.  

 

 

 
 
 

Menü  Modify(M)  ➤ Stretch(H) 

Eszköztár  

Szalag Home ➤ Modify  ➤ Stretch 

 
Parancssor STRETCH 

 

 
 
 

Command:  _STRETCH 

Select  objects  to  stretch  by crossing-window  or crossing-polygon... 

Select  objects:  P1 

Opposite  corner: P2  Entities  in  set:  1 
 

Select  objects: 

Specify  base   point  or [Displacement]  <Displacement>:  P3 

Specify  second point  or <use  first  point  as  displacement>:  P4 
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Objektum kiválasztás STRETCH paranccsal 
 

 
 

Metsző ablak módszer használatával válassza ki az entitásokat a nyújtáshoz.   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

❏ Nyújtás fogókkal 
 

      A felhasználó szabadon nyújthatja az objektumot a fogó pontra kattintva és áthúzva azt egy másik pozícióba.  
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2.4 Szétvet (EXPLODE) parancs 
 

 
 

Szétveti az elemeket egy komplex objektumban. 

 
Menü    Modify(M)  ➤ Explode(X) 

Eszköztár  

Szalag Home ➤ Modify  ➤ Explode 

 
Parancssor  EXPLODE 

 
 
 

Command:  _EXPLODE 

Select  objects  to  explode:   P1  Entities  in  set:  1 
 

Select  objects  to  explode: 

 

 
 
 
 

Komplex  Objektum          Szétvetett  objektum    Komplex  Objektum Szétvetett  objektum     
 

2D vonallánc  és 

2D vonallánc  vonalvastagsággal 
Vonal,  ív Mutató vonal Vonal ,  szöveg

 

 
3D vonallánc Vonal Háló 3D felület 

3D szilárdtest Régió  Bekezdéses szöveg Szöveg Kiegészítők 

 - Többszörös vonal Vonal, ív Kör,  ív

 Elliptikus ív Polyface  Mesh  
Pont,  vonal, 

 
 

Felület modell Régió, ivelt vonal 

 
Régió Line,  Arc, Spline Pr
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2.5 DDPTYPE  és POINT  parancs 
 

 
 

Pont objektum készítése pont stílus beállításával.   

 
Menü Format(O)  ➤ Point  Style(P) 

Eszköztár  

Szalag Home ➤ Format ➤ Point  Style 

 
Parancssor  DDPTYPE 

 
 

Menü Draw(D)  ➤ Point(O) 

Eszköztár 

Szalag Home ➤ Draw ➤ Point  ➤ Single  Point 

 
Parancssor POINT 

 
 

 

•  Klikk [Format]  ⇨ [Point Style]  a legördülő menün,  jelölje ki a kívánt pont stílust a ‘Point  Style’ 

dialógus ablakban és nyomjon  [Ok] gombot. 
 

 
 

 

•  Klikk [Draw]  ⇨ [Point]  ⇨ [Single  Point]  a legördülő menün. Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

366 

 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 
 

•  Válasszon             (point) pontot a Szalag Rajz ( Draw ) fülén. 

•  Gépeljen Point  vagy  PO a Parancssoron. 

 
Command:  _POINT 

Settings/Multiple/<Location  of  point>:  P1 
 

 

 
 

 

 

 
Tárgyraszter beállítás a  ponthoz (Point(Node)) 

 
 

A pont objektum nagyon hasznos mint referencia pont amikor parancsokat hajtunk végre, amely 

kapcsolatban állnak más entitásokkal, ilyen az Eltolás (Offset). 
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2.6 Feloszt (DIVIDE) parancs 
 
 
 

Szétosztási pont (Array Point)  vagy blokk   megadott távolságra egy ideiglenes entitáson.    
  

 
 

Menü Draw(D)  ➤ Point(O)  ➤ Divide(D) 

Eszköztár  

Szalag Home ➤ Draw ➤ Point  ➤ Divide 

 
Parancssor  DIVIDE 

 
 
 

•  Klikk [Format] ⇨ [Point  Style...]  a legördülő menün és válassza a mint pont stílus a ‘Point  Style’ 

dialógus ablakban. 

•  Klikk [Draw]  ⇨ [Point]  ⇨ [Divide]  a parancs futtatásához a legördülő menün. 
 
 

Command:  _DIVIDE 

Select  entity  to divide:  : P1 
 

Number  of  segments or [Block]:  12 Pr
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❏ Divide (Feloszt) (blokk beszúrás egy entitáson)  

 

 
Meg kell adni a blokkot az aktuális rajzban és illeszteni szükséges.  Először adjuk meg a blokk nevét ‘5-

polygon.' (Hivatkozva a 8-as fejezetre, blokk használat). 

 

 
 

Command:  _DIVIDE 

Select  entity  to divide:  : P1 
 

Number  of  segments or [Block]:  B 
 

Enter name  of  block  to insert:  5-polygon 
 

Align  blocks  with entity?  <Y>: 

Number  of  segments: 10 
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2.7   Beoszt (MEASURE) parancs 
 

 
 

Kiosztás blokk vagy pont objektumok az objektumon megadott távolságra egy entitáson.  
 

 
 

Menü  Draw(D)  ➤ Point(O)  ➤ Measure(M) 

Eszköztár  

Szalag Home ➤ Draw ➤ Point  ➤ Measure 

 
Parancssor  MEASURE 

 

 
•  Klikk [Format] Formátum ⇨ [Point Style] Pontstílu s  a legördülő menün és   mint 

pont stílus a  ‘Point  Style’dialógus ablakban. 

• Klikk [Draw]  Rajz ⇨ [Point] Pont  ⇨ [Divide] Feloszt a legördülő menün, hogy meghívja a parancsot. 
 

 
Command:  _MEASURE 

Select  entity  to measure:  P1 
 

Segment  length or [Block]:  40 
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❏ Szegmens hossz 

 

 
Kiosztás pont objektumok a lehközelebbi végpontból kezdődnek egy pontból, ahonnan kiválasztotta egy 

magadott távolságra az objektumot.   
 

Zárt vonalláncnál, attól a ponttól kezdődik, ahonnan először volt rajzolva. 

Körnél, a raszter forgatási szögtől kezdődik.  Ha a taszter forgatási szög nulla,  akkor a jobb negyedtől 

kezdődik. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Command:  _MEASURE 

Select  entity  to measure:  P1 
 

Segment  length or [Block]:  B 
 

Enter name  of  block  to insert:  5-polygon 
 

Align  blocks  with entity?  <Y>: 

Number  of  segments: 30 

 

 

 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

Modify  the  Object   07 

371 

 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

2.8 BOUNDARY  parancs 
 

 
 

Használja a Határvonalat (BOUNDARY), hogy egy határvonal szettet állítson össze. Határvonal szet segít a 

felhasználónak  az entitások határvonal területeket megerősíteni. Amikor a felhasználó bonyolult rajzot 

készít, lehetővé válik részére, hogy gyorsan határoló vonalláncot rajzoljon.  

 

Menü Draw(D)  ➤ Boundary  Polyline... 

Eszköztár  

Szalag Home ➤ Draw ➤ Boundary  Polyline... 

 
Parancssor BOUNDARY,  BPOLY 

 
 
 
 

Command  : _BOUNDARY 

Specify  internal  point:  P1 

Selecting  everything  visible... 

Was  found  17  objects. 

Analyzing  the  selected  data... 

The  boundary  has  been  found. 

Specify  internal  point: 

BOUNDARY  created  1  polylines. 
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2.9 Lemez (REGION)  parancs 
 

 
 

A Region  (Lemez) parancs 2D zárt vonallánccá módosítja a rajzot, amely 2D felülethez hasonlít.   
 
 
 

 
 

 

Másrészről,  a határvonalnak van hasonló tulajdonsága a 3D szilárdtesttel. Használhatjuk a határvonalat, 

hogy sík felületet készítsünk körkörös ívekkel.  3D szilárdtestet is tudunk építeni.  

 

Menü  Draw(D)  ➤ Region(N) 

Eszköztár  

Szalag Home ➤ Draw ➤ Region 

 
Parancssor REGEN 

 
 

 
Command:  _REGION 

Select  objects:  P1  Entities  in set:  1 
 

Select  objects: 

1  loops  extracted.  1  Regions  created. 
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Határvonal az egy zárt 3D határvonal, amelynek fizikai tulajdonságai vannak mint a középpont vagy 

tömegközéppont. Összekapcsolhat több határvonalat egyedül álló határvonalat többszörös határvonallá.    
 

Határvonalat használhat a következő esetekben. 

 

•  MASSPROP  használata tervezési információk kivonatolásához, mint a terület vagy középpont.  

•  Sraff vagy gradiens használata. 

•  Egyedi objektumok összekapcsolás komplex objektumok készítéséhez  Boole műveletek 

felhasználásával.  

 
Használhatja a REGION ( Lemez)  parancsot határvonal készítéséhez, valamint zárt objektumot 

konvertálhat határvonallá.  Ezután használja a BOUNDARY  parancsot a határvonal (Boundary) 

készítéséhez, mint objektumot zárt határvonalként.  Határvonalakat csatlakoztathat összeadással, 

eltávolítással vagy metszéssel.    

 
❏ Objektumok összekapcsolása egyesítéssel (UNION): 

 
 

Kiválasztás Eredmény 

❏Objektumok kapcsolása kivonással  (SUBTRACT): 

 
 

Kiválasztás Eredmény 
 

❏Objektumok összekapcsolása metszet használatával ( INTERSECT): 

 
 

                        Kiválasztás Eredmény 
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Exercise  44  Gyakorlat  REGION,  BOUNDARY parancsok. 
 

 
 

❶ Rajzolja meg a lenti ábrát az ARC és az  ELLIPSE parancsok használatával. 

 

❷ Változtassa a DELOBJ rendszer változó értékét 1-re. 

 
 

Command:  DELOBJ 
 

Enter new  value  for DELOBJ <3>:  1 
 

 
Ha a DELOBJ rendszerváltozó értéke1-re van állítva, REGION parancs törli az objektumokat a parancs 

végrehajzása után. 

 
 

❸ Klikk [Draw]  ⇨ [Region] a legördülő menüben,  ezután válassza ki a jobb ellipszis entitást. 

 
 

 

❹Változtassa a DELOBJ rendszer változó értékét 0-ra. 

Ha a DELOBJ rendszerváltozó értéke 0-ra van állítva, REGION parancs nem törli az objektumokat a 

parancs végrehajzása után. 

 
 

❺ Klikk [Draw]  ⇨ [Region] a legördülő menüben. Pr
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Command:  REGION 

Select  Objects:  ALL 

9  found 

Entities  in  set:  9 
 

Select  Objects: 

Cannot  create  Region  due  to  following  endpoints  not  co-incident: 

5.57,3.16 

8.69,4.08 

4.81,4.91 

6.82,3.90 

5.35,5.95 

4.85,4.15 

7.78,5.59 

4.81,5.65 

8.37,3.26 

7.11,5.93 

1  loops  extracted. 

1  Regions  created. 
 

 

 
 

REGION parancs nem befolyásolja a már létező lemez entitásokat.  A fenti ábráról,  a középen lévő 

entitások nem válnak lemezzé mert nem érintik egymást.  A parancs csupán komplikált zárt görbének 

tekinti azokat.   
 

REGION parancs nem elemzi az ilyen komplikált zárt görbéket. Ezen entitásokkal való lemez készítéshez,  

használja a  BOUNDARY  parancsot. 

 
 

❻ Klikk [Draw]  ⇨ [Boundary  Polyline] a legördülő menüben. Pr
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K l i k k  objektum típus a ‘Boundary  Creation’ dialógus ablakban. Válassza 
 

(Pick points),  ezután pikkeljen bármelyik pontra az objektumon belülre középen,  ezután üssön ENTER-t. 

 
Command:  _BOUNDARY 

Select  internal  point:  P1 

Selecting  everything  visible.... 

Was  found  11  objects. 

Analyzing  the  selected  data 

The  boundary  has  been  found. 

Specify  internal  point: 
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2.10 REVCLOUD (Revízió buborék) parancs 
 
 
 

Revízió buborékot hoz létre vonallánc segítségével.  Akkor használjuk amikor befejeztük a rajzot, egyéb rajzi 

jelölésekhez. 

 

Menü  Draw(D)  ➤ Revision cloud(V) 

Eszköztár  

Szalag Home ➤ Draw ➤ Revision  cloud 

 
Parancssor REVCLOUD 

 
 
 
 

Command:  _REVCLOUD 

Minimum  arc  length:0.5000 Maximum  arc  length:0.5000 Style:  Normal 

Specify  start  point  or [Arc length/Object/Style]  <Object>: 

Guide Crosshair  along  cloud  path 
 
 
 

Opció Funkció 

 
Ív hossz Beállítja az ív hosszat a  revízió buborékhoz. 

 
Objektum Kiválaszt egy objektumot, hogy a revízió buborékhoz konvertálja. 

Stílus Beállítja a revízió buborékhoz a stílust 
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Revízió buboréká konvertálás 

 
 

 
  Rajzoljon vonalláncot mint a lenti képen. 

 

 
 
 

  Konvertálja a vonalláncot revíziós buborékká. 
 
 
 

Command:  _REVCLOUD 

Minimum  arc  length:0.5000 Maximum  arc  length:0.5000 Style:  Normal 
 

Specify  start  point  or [Arc length/Object/Style]  <Object>:  A 

Specify  minimum  length  of  arc  <0.5000>:  10 

Specify  maximum  length  of  arc  <0.5000>: 
 

Specify  start  point  or [Arc length/Object/Style]  <Object>: 

Select  object:  P1 

Reverse  direction [Yes/No]  <No>: 
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2.11 WIPEOUT  Parancs 
 
 
 

WIPEOUT parancs egy kép típusú objektum.  Rajz részletének maszkolásához használjuk. 
 

 
 

 
 

Például,  a felhasználó szöveget akar hozzáadni egy komplex rajzi részlethez.  Wipeout  lehetővé teszi a 

felhasználónak, hogy könnyen olvassa a szöveget maszkoló területtel a szöveg a mögött.   

WIPEOUT egy üres területtel átfedi az objektumokat. A felhasználó egy sokszög területet hoz létre az 

aktuális rajz színnel.  Most a terület tisztítva lesz. A felhasználó megjelenítheti a Wipeout területet, hogy 

szerkessze és kikapcsolja a nyomtatásnál.    
 

 
 
 

Menü  Draw(D)  ➤ Wipeout(W) 

 

Eszköztár  

 

Szalag Home ➤ Draw ➤ Wipeout 

 
Parancssor WIPEOUT 

 
 
 
 

Command:  _WIPEOUT 

Specify  first  point  or [Frames/Polyline]  <Polyline>:  P1 

Specify  next  point:  P2 

Specify  next  point or [Undo]:  P3 

Specify  next  point or [Close/Undo]:  P4 
 

Specify  next  point or [Close/Undo]: Pr
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Opció Funkció 

 
First  point Válassza ki az első pontját a Wipeout  objektumnak.  

Next  point Válassza ki a második pontját a Wipeout  objektumnak. 

Frame  Határozza meg, hogy a Wipeout objektum éle látható vagy nem.  

Polyline Átkonvertál egy zárt vonalláncot Wipeout  objektummá. 

Close Összeköti egy Wipeout pbjektum kezdőpontot a végponttal  annak lezárásához. 
 

 
 
 

WIPEOUT a következő három tulajdonságról gondoskodik. 

 
•  Wipeout  objektum tervezése. 

•  Zárt vonallánc konvertálása  Wipeout objektummá. 

•  Wipeout  keret láthatóságának beállítása. 
 

 
Frame (Keret) opció lehetővé teszi a felhasználó számára, hogy be/ki kapcsolja (On/Off) az összes 

objektum Wipeout megjelenítését az aktuális rajzban. Nem lehetséges a Frame (Keret) vizualitását 

kezelni egyedileg, ez azt jelenti, hogy amikor a (Frame) Keret ki van kapcsolva (Off), Wipeout nem 

kiválasztható. 

 
A Wipeout mozgatásához vagy módosításdához, ki kell kapcsolni a Frame-et. 

 
 

A kívánt tervezési terület eléréséhez,  jó ha használja a Wipeout-ot a szöveg írás után.  Futtassa a Wipeout 

parancsot, hogy megmutassa a szöveget  a  wipeout-ban. 
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03 Lekérdezési parancsok 
 

 
Itt van a lekérdezési parancsok listája. 

 

 
 
 

Icon Command  Description 

 
DIST Megméri a távolságot  és a  szöget  két kiválasztott pont között. 

 
 

AREA Kiszámítja a területet és a kerületet  a kiválasztott lemeznek (Region). 
 

 

MASSPROP Kiszámítja a fizikai jellemzőket (Mass  Property) a 3D testhez és lemezhez. 

 
LIST Megjeleníti a kiválasztott objektum tulajdonság listáját. 

 
IDPOINT Megjeleníti a kiválasztott objektum az UCS (Felhasználói) koordinátákat. 

 
 
 
 

3.1 Távolság (DISTANCE) parancs 
 

 
 

 Megméri a távolságot  és a  szöget  két kiválasztott pont között. 
 

 
 
 

Menü  Tools(T) ➤ Inquiry(Q)    ➤ Distance(D) 

 

Eszköztár  

 

Szalag Home ➤ Tools ➤ Inquiry  ➤ Distance 

 
Parancssor DIST 

 
 
 

 

•  Klikk [Tools]  Eszközök ⇨ [Inquiry] Lekérdezés  ⇨ [Distance]  Távolság legördülő menüben. 

•  Gépelje DIST  vagy  DI a Parancssoron. Pr
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Command:  _DIST 

Starting  point  for  distance:  P1 

End  point:  P2 
 

 
Distance  =  119.2502,   Angle in  XY  Plane  =  0,   Angle from  XY  Plane  =  0 

Delta  X  =  119.2502,   Detla  Y  =  0.0000,    Detla  Z =  0.0000 
 
 

 
 

 
 

 
 
 
 
 

3.2 Terület (AREA) parancs 
 
 
 

Kiszámítja egy objektum vagy oldal területét és kerületét.  Két módja van,  egy pont vagy egy objektum 

használatával. 

 

Menü   Tools(T) ➤ Inquiry(Q)    ➤ Area(A) 

Eszköztár  

Szalag  Home ➤ Tools ➤ Inquiry ➤ Area 

 
Parancssor AREA 

 

 

•  Klikk [Tools] Eszközök ⇨ [Inquiry] Lekérdezés  ⇨ [Area]  Terület a legördülő menüben. 

•  Gépeljen AREA -t (Területet) a Parancssorba. Pr
ó
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Command:  _AREA 

Entity/Add/Subtract/<First  point>:  P1 

<Next  point>:  P2 

<Next  point>:  P3 

<Next  point>:  P4 
 

<Next  point>: 
 

 

Area  =  11431.6848 sq.  units,  Perimeter  =  484.4296 
 

 
 

 

 

 
Vegyük egy objektum területét. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Command:  _AREA 

Entity/Add/Subtract/<First  point>:  A 

Adding:  Entity/Subtract/<First  point>:  E Pr
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ba
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Adding  area<Select  entities>: 

Area  =  995  sq.  units,  Perimeter  =  141 

Total  area  =  995  sq.  units 

Total  length  =  141 
 

Adding  area<Select  entities>: 
 

Adding:   Entity/Subtract/<First point>: S 

Subtracting:  Entity/Add/<First point>: E 

Subtracting  area<Select  entities>: 

Area  =  176  sq.  units,  Circumference  =  47 

Total  area  =  818  sq.  units 

Total  length  =  94 

Subtracting  area<Select  entities>: 

Subtracting:    Entity/Add/<First  point>: 

 
 

 

 
 
 
 
 
 

 

3.3 Fizikai jellemzők (MASSPROP) parancs 
 
 
 

 Kiszámítja a fizikai jellemzőket a 3D testhez és lemezhez. 
 

 
 
 

Menü Tools(T) ➤ Inquiry(Q)    ➤ Mass  properies(M) 

 

Eszköztár  

 

Szalag  Home ➤ Tools ➤ Inquiry    ➤ Mass  properies 

 
Parancssor MASSPROP 

 

 

•  Klikk [Tools] Eszközök ⇨ [Inquiry] Lekérdezés  [Mass  Properties] Fizikai jellemzők a  

legördülő menüben. Pr
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Rajzolja meg a következő sokszöget  a PLINE parancs felhasználásával, és készítsen Lemez (Region)  

objektumot a REGION parancs használatával. 
 

 
 

 
 

Command:  _MASSPROP 

Select  entities:  P1  Entities  in  set:  1 
 

Select  entities: 

---------------------REGION  --------------------- 

Handle:    258 

Current  space:    Model 

Layer:    Bndary 

Color:    BYLayer 

Linetype:    ByLayer 

Line  weight:    BYLAYER 

Area:    2895599.9090 

Perimeter:    7948.3320 

Bounding  Box: 

X: 720.1321  --  2710.1321 

Y: 436.2989  --  2426.2989 

Centroid: 

X:    1715.1321 

Y:    1431.2989 

Moment  of  inertia 

X:    6.6044E+012 

Y:    9.1904E+012 

X:    7.1083E+012 

Product  of  inertia 

Scroll/<ENTER  to view next  screen>: Pr
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XY:    7.1083E+012 

Radii  of  gyration: 

X:    1510.2475 

Y:    1781.5469 

Principal  of  moments  and  X-Y-Z  directions  about  centroid: 

along 

I:    672448140450.679690   along    [1.000000  0.000000 999.990000] 

J:    672448140450.658330   along    [0.000000  1.000000 999.990000] 

Write analysis  to  a  file?  [Yes/No]  <N>: 
 

 
 

 

 
 

 

3.4 Lista (LIST)) parancs 
 

 
 

 Megjeleníti a kiválasztott objektum tulajdonság listáját. 
 

 
 

Menü Tools(T) ➤ Inquiry(Q)    ➤ List  Entity  Info (L) 

 

Eszköztár  

 

Szalag Home ➤ Tools ➤ Inquiry    ➤ List  Entity  Info 

 
Parancssor LIST 

 

 
 
 

•  Klikk [Tools] Eszközök ⇨ [Inquiry] Lekérdezés  ⇨ [List  Entity Info] a legördülő menüben. 

•  Klikk (List)  ikon  a Home (Kezdőlap) fülön,  Property (Tulajdonság) panelen. 

•  Gépeljen LIST vagy LI  - t  a Parancssoron. 
 

 
Command:  _LIST 

SCroll/SOrt/Tracking/<Select  entities  to  list>:  P1 

Entities  in  set:  1 
 

SCroll/SOrt/Tracking/<Select  entities  to  list>: Pr
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-------------------- CIRCLE  ----------- 

Handle:    175 

Current  space:    Model 

Layer:    0 

Color:    BYLayer 

Linetype:    ByLayer 

Line  weight:    BYLAYER 

Center  point:    X=170.3734    Y=37.0270    Z=0.0000 

Radius:    42.2255 

Circumference:    265.3108 

Area:    5601.4422 
 

 
 

 

 

3.5 Koordináta (ID) parancs 
 

 
 

Egy hely abszolút koordinátáit jeleníti meg. 
 

 

Menu  Tools(T) ➤ Inquiry(Q)    ➤ ID  Coordinates 

 
Toolbar 

 
Ribbon  Home ➤ Tools ➤ Inquiry  ➤ ID  Coordinates 

 
Command  ID 

 

 

• Klikk [Tools] Eszközök ⇨ [Inquiry] Lekérdezés  ⇨ [ID  Coordinates] a  legördülő menüben. 

• Gépeljen ID - t  a Parancssorba. 
 

 
COmmand:  '_ID 

Select  point  to  identify  coordinates:  P1 

X  =  15  Y  =  106  Z =  0 Pr
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Exercise  45  Rajzolja meg a következő objektumot. 
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Exercise  46  Rajzolja meg a következő objektumot. 
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Exercise  47  Rajzolja meg a következő objektumot. 
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Exercise  48  Rajzolja meg a következő objektumot. 
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08 
 

 

Szöveg, sraff és blokk beszúrása 
 

 
 
 
 
 
 
 

A következő fogalmakat tárgyaljuk meg ebben a fejezetben: 

•  Szöveg szerkesztés 

•  Sraff 

•   Blokk 
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01 Szöveg szerkesztése 
 
 

Parancs lista amelyek szöveg entitásokat szúrnak be/ szerkesztenek a rajzban, és bizonyos entitások 

hozzárendelt adatait jelenítik meg.  
 

 
Ikon Parancs Leírás 

 
 

STYLE 

Beszúr, szerkeszt vagy szövegstílust rendel hozzá.  A felhasználók új fontot 

használhatnak  a szövegekhez, új betűstílust rendelve az aktuális szövegstílushoz.      

A szövegstílus tartalmazza a betű stílust, méret, forgatási szög,  irány és más betű 

tulajdonságokat.

 
TEXT  or DTEXT  Beszúr egy egysoros szöveget. 

 

MTEXT  
Többsoros szöveget szúr be , amely számos egysoros szöveget tartalmaz. A 

felhasználók  beállíthatják a betűstílust, elrendezést  vagy a határokat  a belső 
szerkesztőt használva. 

 
DDEDIT 

Egysoros szöveget szerkeszt,  szöveg méret, attribútum definíciók és keret vezérlő 

funkciók. 

 
 

MTEDIT Bekezdéses szöveg szerkesztése 
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1.1 A szöveg  áttekintése 
 
 
 

Mióta CADian egy CAD program,  a rajz objektumok részére hatékony eszközökről gondoskodik, de 

viszonylag gyengébb funkciói vannak a beszúráshoz/szerkesztéshez mint a szövegszerkesztő 

programoknak. A múltban, CADian az MS-DOS alatt nem tudott díszes betűstílusokat beszúrni, mert csak saját   

SHP/SHX  vektor fontokat használt. Most már a CADian be tudja olvasni a  Microsoft Windows  TrueType  

fontokat (TTF). Azonban,  ha túl sok  TTF objektum van a  rajzban,  a fájl méret nagyobb lesz,  lelassítja 

a feldolgozás sebességét. 
 

Amikor szöveg objektumot szúr be,  szabványok vannak ennek követéséhez, olyan mint a KS Standard  

A0107 ‘karakterek a rajzoláshoz. 

 

 
A rajzi karaktereknek a következőket kell kielégíteniük: 

•  Könnyen olvasható. 

•  A karakterek nagysága és mérete arányos. 

•  Alkalmas legyen mikrofilm felvitelére. 

•  Kínai karakterek “The  Table of Chinese  Characters in Common  Use”. 

•  Koreai karakter álló függőleges négyzet Single-Line Gothic betűtípust használ (whgtxt.shx)  vagy 

ugyanezen betűtípus 15° dőlésszöggel. 

•  Az arabszám és betűrend ferde (dőlt)  J-típust vagy B típust használ. A dőlés 15°-os ferdeségű és 

jobb irányba mutat. 

•  A karakter mérete a karakter magasságában van kifejezve. 

•  5 karakter mérete  2.24,  3.15,  4.5,  6.3,  9.0mm. 

•  Javasolt, hogy a karakter vastagsága  a méret  1/9  része legyen.  Például, 0.35mm-es vastagság 

használatos  a 3.15mm-es karakter méretnél. 
 
 

A CADian-ban a szöveg beszúrása előtt, a felhasználónak meg kell adnia a szövegstílust  (Text  

Style(Style)), amikor elkezdi a szöveg entitás beszúrását, ezután  a CADian több különböző parancsról 

és eszközről gondoskodik amelyekkel szerkeszthetik a szöveg entitásokat.  
 

Amikor új szövegstílust  (Text  Style) adunk meg, a felhasználó testreszabja a saját stílusát a ‘STANDARD’  

stílus mellett.  A felhasználó megadhat számtalan szövegstílust. Ha, azonban túl sok szövegstílus van a 

rajzban, a fájl mérete nagyobbá válik. Pr
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❏ Egysoros  szöveg  

 

 
TEXT/DTEXT  parancs hasznos a rövid karaktersorhoz, amelyekhez nem szükséges bekezdéses (több  

soros) szöveg.  Az egysoros szöveg általánosan használt a cimkékhez.   

 
 

❏ Bekezdéses szöveg 

 

 
MTEXT parancs a hosszú és komplikált szövegekhez alkalmas. A felhasználó beállíthatja a bekezdéses 

szöveg doboz határait. A határ vég nélkül bővíthető.    
 

Eltekintve a számos oszlopoktól, minden sor az egysoros szövegként formálható, ezeket mozgatni, 

forgatni, törölni, másolni, tükrözni és méretarányukat lehet változtatni.   
 

Több szerkesztési opció van a Többsoros szöveghez mint az Egysoros szöveghez. Például, aláhúzást 

használhatnak, betűstílusokat, színeket vagy méret beállításokat egy szóhoz vagy egy kifejezéshez a 

Többsoros szöveg paragrafusán belül.  

 
 

❏ Megjegyzés szöveg 

 

 
Megjegyzés szöveg (Annotation  Text)  használatos a megjegyzésekhez és  címkékhez a rajzban. 

Megjegyzés szöveg megjegyzés szövegstílus magadásával használható.  
 
 
 

A következő objektumok alakíthatók át  Megjegyzés szöveggé.  (megjegyzés tulajdonságokkal) 
 
 
 

  

Objektum 
  

Objektum 

 

1 
 

Sraff 
  

2 
 

DTEXT  &  MTEXT 

 

3 
 

Méret 
  

4 
 

Tűrés 

 

5 
 

Blokk 
  

6 
 

Attribútum 

 

7  Leader  Line (Mutató vonal)  és Multi-Leader  Line 
(MLEADER  parancs használata) 
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1.2 Stílus (STYLE) parancs 
 

 
 

Írja, szerkeszti  vagy jelzi a szövegstílust. 

 
Menü  Format(O)  ➤ Text  Styles...(S) 

Eszköztár  

Szalag Home ➤ Format ➤ Text  Styles... 

 
Parancssor  

 
 

 

•  Klikk [Format]  (Formátum) ⇨ [Text  Styles  Manager]  (Szöveg stílus kezelő) a legördülő menüben. 

•  Gépeljen STYLE -t a Parancssorba. 
 

 

 
 
 

Opció Leírás 

 
Current  Text  Style Megjeleníti az aktuális szövegstílust. 

 

 
Styles 

A rajzban megjeleníti a megadott stílusok listáját. Az ikon jelzi, 

hogy a stílus feliratozás jellegű. Pr
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Opció Leírás 

Style List  Filter Meghatározza, hogy  a stílusok vagy a használatban lévő stílusok lesznek megjelenítve.  
 

Preview Megjeleníti a minta szöveget, amelyet azonnal alakalmaz amegváltoztatott betűstílushoz vagy  

effektusokhoz 
 

 
 
 
 

Font 

 

Betűstílust szerkeszti a sílus részére. 

 
Font Name  Kilistázza az összes regisztrált  TrueType fontokat  és az  SHX fontokat  amelyek a 'Fonts' mappában vannak. 

    

 Font  Style Beállítja a betűstílust,  olyan mint az Italic,  Bold  stb. 

Use  Big  Font Használhat Big  Font-ot, amelyet az  ázsiai  nyelvbe használnak.  Csak az SHX  fájl formátum 

megfelelő a Big Fonts-hoz. 
Fonts.  

 
 
 
 

Size 

 

Egy stílus méretét szerkeszti 

 

Annotative Szöveg beállítás kommenthez. 

 

Height Beállítja a szöveg magasságot. 

Igazítja a szöveg 

orientációt    az Beállítja a szöveg orientációt egy rajzterületen illesztve a lap elrendezéshez.           

elrendezéshez 

 
 
 
 
 
 

Effects 

 

Beállítja a betűstílus tulajdonságot,  mint a méret, szélesség faktor,  dőlés szög  valamint a betűstílus orintáció. 

 

Upside down  A szöveget fentről lefelé fogja megjeleníteni. 

 

Backwards  A szöveget visszafelé jeleníti meg. 

 

Vertical A szöveget függőleges irányban jeleníti meg. 

 

Width  factor Beállítja a közt a szöveg között. 

 

Oblique  angle Beállítja a dőlés szöget a stílus részére. 

 

Set  Current Beállít egy kiválasztott stílust az aktuális stílushoz.   

 

New Új szövegstílust hoz létre.. 

 

Delete Törli a nem használt stílusokat. 

Rename  Átnevezi a kiválasztott stílust. 
 

Apply Alkalmazza a módosított beállításokat. 
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TrueType font és rajz font 
 

 
A TrueType font nem CADian font. Ez egy típusa a Windows rendszer fontjainak. 

 

CADian  font 'Big Font'-nak elnevezve a vektor fontok koncepciójába illik. Ezt nevezhetjük rajz fontnak 

is. A Big Font-ok kevésbé szépek mint a rendszer fontok, de nem befolyásolja ezeket a rendszer 

gyorsasága, mivel ezek összehasonlíthatóan kicsik az .SHX fájlban. 
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1.3 TEXT vagy DTEXT parancs 
 

Egysoros szöveget hoz létre. 

 
Menü  Draw(D)  ➤ Text(X) 

Eszköztár 

Szalag  Home ➤ Draw ➤ Text 

 
Parancssor TEXT 

 
 

 

•  Klikk [Draw]  (Rajz) ⇨ [Text]  ⇨ [Single  Line  Text]  (Egysoros szöveg) a legördülő menüben. 

•  Gépeljen TEXT vagy DTEXT -et  a  Parancssorba. 
 

 
 

Command:  _DTEXT 
 

Specify  start  point  of  text  or [Justify/Style]:  J 

Text:  Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR/ 
 

<Start point>:  BL 

Specify  bottom-left  point  of text:  P1 
 

Specify  height <2.500>:  12 
 

Specify  rotation  angle  of  text <0>: 
 

 
 
 

❏ Szöveg sorkiegyenlítés opció. 
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Egysoros szöveg beszúrása 
 

  Klikk [Format]  (Formátum) ⇨ [Text Style] (Szövegstílus) a legördülő menüben. 
 

Klikk  ( Ú j )  gomb a ‘Text  Style’ (Szövegstílus) dialógus ablakban. 

Léptessen be egy nevet az új sílus számára, ezután kattintson az ‘OK’-ra. 

 
 

 
  Állítsa be a Font beállítást a lentihez hasonlóan, ezután kattintson az ‘Apply’-ra (Alkalmaz-ra) 

 

 
 

 
  Válassza ki a ‘DIMTXT’  a listán, ezután klikk ‘Set  Current’ (Aktuálissá tétel) és klikk ‘Close’ 

(Bezárás)  gombra 

 

 
 

 
 

  Kattintson a ‘Single Line Text’ (Egysoros szöveg)  az ‘Annotation’ (Feliratozás) fülön a 

Szalagon. Válassza ki egy szöveg kezdőpontját a rajzba, ezután írja ‘CADian  Text’  a következő 

módon. 

 
 

 
Command:  _DTEXT 

Specify  start  point  of  text  or [Justify/Style]:  P1 
 

Specify  height <2.500>:  12.5 
 

Specify  rotation  angle  of  text <0>: 
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Igazítás Kezdő pont   Ábra 

 

Align                     Beállítja a magas. és a szöveg írányt                           

 

Fit A szöveget illeszti a megadott részben.  
 

Center A vízszintes közepe a szövegnek.   

Middle 
Vízszintesen és függőlegesen is közepe 

a szövegnek. 

Right                      Az alapvonal jobb oldala.                                   
 
Top 

Left                           A szöveg bal felső sarka.                                           
 

Top Center            A szöveg felső közepe..                                        
 
Top 

Right                            A szöveg jobb felső sarka..                                           
 

Middle  Left           A szöveg bal oldali közepe.                                     
 

Middle  Center        Szöveg közeprészének közepében.                                  
 

Middle  Right          A szöveg jobb oldali közepe.                                   
 

Bottom  Left            A szöveg bal alsó sarka.                                     
  

Bottom  Center       A szöveg alsó közepe.                                    

 

Botton  Right           A szöveg jobb alsó sarka. 
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1.4 MTEXT parancs 
 
 
 

Bekezdéses szöveget hoz létre.  A belső szövegszerkesztőben a felhasználó írhat több, mint egy MTEXT 

paragrafust, vagy használja a Parancssor promptot.  A felhasználó beszúrhat ASCII szöveget is, vagy   

RTF formátumú elmentett fájlt. 
 

 
 
 

Menü Draw ➤ Text  ➤ Multiline  Text 

 
Eszköztár  

 

Szalag Home ➤ Draw ➤ Text  ➤ Multiline  Text 

 
Parancssor  

 
 

 

•  Klikk [Draw] (Rajz) ⇨ [Text]  ⇨ [Multiple  Text] (Bekezdéses Szöveg) a legördülő menün. 

•  Gépeljen MTEXT  a Parancssorba. 
 

 
 

Command:  _MTEXT 

Multiline  Text:    First  corner  for block  of  text:  P1 

Justification/Line  spacing/Rotation/Style/Height/Direction/Width/Columns 

<Opposite  corner  for  block  of  text>:  P2 
 
 

❶ Ha két pontját bekattintja az átlónak, ahová a szöveget szeretné írni,  mint a lent képen, a Szalag menü 

Text Editor (Szövegszerkesztő) füle szerint, a Belső szöveg szerkesztő megjelenik a rajzterületen.   
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Internal  Text Editor (Belső szövegszerkesztő) az alábbi elrendezést követi. 

 

 
 

❷ Mint a lenti képen,  gépeljen be több sort. 

 
 

 

 
❸ Klikk a "Multiple  Line – Close to  end"  - Bezárás a végéhez. 
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1.5 Szöveg szerkesztése (DDEDIT) parancs 
 

 
 

A szöveg amelyet a TEXT, MTEXT vagy MLEADER-rel írtak, szerkeszteni, elmozgatni, forgatni, 

törölni, másolni lehet mint más objektumot. 
 

A szöveg módosítható a következő két módszerrel. 
 

 

•  DDEDIT parancs  –   Szerkesztő dialógus panel vagy  Belső szövegszerkesztő 

•                 PROPERTIES  (Tulajdonságok)–   Szöveg tulajdonságok szerkesztése a 

Tulajdonságok palettában. 
 

 
DDEDIT parancs szerkeszti az egysoros szöveget (Single Line Text), méret szöveget (Dimension 

Text), a tulajdonság megadása és feladatkezelőt (Property Definition and   Function Control 

Frame). 

 

 
Menü  Modify  ➤ Object  ➤ Edit  text... 

Eszköztár   

Szalag Home ➤ Modify  ➤ Object  ➤ Edit  text... 
 

 
Parancssor  

 

•  Klikk [Modify] (Módosítás)  ⇨ [Object]  (Objektum)⇨ [Edit  Text...] (Szöveg mósosítása) a legördülő menün. 

•  Gépelje DDEDIT a Parancssorba. 
 
 

Command:  _DDEDIT 

Select  an  annotation  object  or [Undo]:  P1 
 

Select  an  annotation  object  or [Undo]: 
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1.6  MText szerkesztés (MTEDIT parancs) 
 
 

Bekezdéses (Multiple Text) szöveget szerkeszt.  Bekezdéses szöveg ( Multiple Text) fül megjelenítés a 

Szalagon vagy belső szövegszerkesztő a kiválasztatott bekezdéses objektum formátumának vagy tartalmának 

szerkesztéséhez.  
 

 
 
 

Menu 

Toolbar 

Ribbon 

Command  MTEDIT 

 

 

•  Gépeljen MTEDIT  a Parancssorba vagy kattintson kétszer a bekezdéses szöveg objektumra  

Command:  MTEDIT 

Select  a  MTEXT  object:  P1 
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❏ Karakter entitás beszúrás 

 

 
 

Parancs kód 
 

Leírás 
 

Példa input 
 

Példa 

 

%%O 
 

Sort húz a vonal fölé. 
 

%%oHole 
 

 
%%U 

 
Sort húz a vonal alá. 

 
%%uHole 

 
 

%%D 
 

Fok jel 
 

45%%d 
 

 

%%P 
 

Tűrés jel 
 

20%%p5 
 

 

%%C 
 

Átmérő jel 
 

%%c30 
 

 

%%% 
 

Százalék jel 
 

45%%% 
 

 

%%%nnn 
 

ASCII  kód 
 

%%100 
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Exercise  49  Kövesse az utasítást a szöveg beszúrásához. 
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Exercise  50  Kövesse az utasítást a szöveg beszúrásához. 
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Exercise  51  Kövesse az utasítást a szöveg beszúrásához. 
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Exercise  52  Kövesse az utasítást a szöveg beszúrásához. 
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Exercise  53  Kövesse az utasítást a szöveg beszúrásához. 
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Exercise  54  Kövesse az utasítást a szöveg beszúrásához. 
 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

414 

 

 

 
 

 
 

 
 
 

 

02   Sraff 
 

 

2.1 A sraff áttekintése 
 

 
 

A CADian több mint 50 ipari szabványos sraff mintáról gondoskodik a különböző anyagok/alkatrészek 

jobb azonosításához és a rajzok olvashatóságához. A CADian 14 mintát ad, amely az ISO(International  

Standards  Organization)  szabványt követi.  Ezekhez az  ISO  mintákhoz,  A felhasználó kijelölhet toll 

vastagságot, amely meghatározza a vonalvastagságot. A sraffozás a rajzolás egyik fontos szempontja, 

amikor az objektum metszeti síkját mutatja.  A sraffozásnak számos szabálya van, amelyek a 

következők: 

 

•  A sraff vonalhoz vékony folytonos vonalat használjon. 

•  A sraff dőlése 45°-os szögben. 

•  A sraff vonalak közötti közök beállítása,  a metszet méretétől függően. 

•  Azonos sraffstílust használjon hasonló objektumok metszeteihez. 

•  Ha több metszet találkozik, módosítsa a sraff mintát, vagy az irányt a jobb észrevehetőség miatt. 

•  Vágja meg a sraff vonalat, ha szöveg vagy szimbólum fedi át a sraff területet. 
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2.2 HATCH,  BHATCH parancs 
 

 
 

A kiválasztott objektum zárt terület kitöltése sraffal, testtel vagy átmenettel (gradiens). 

 
Menü  Draw ➤ Hatch 

 
Eszköztár  

 

Szalag Home ➤ Draw ➤ Hatch 

 
Parancssor , BHATCH 

 
 

 

•  Klikk [Draw] (Rajz) ⇨ [Hatch] (Sraff) a legördülő menün. 

•  Gépeljen HATCH -et a parancs soron. 
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❏ Típus és minta 

 

 

•  Típus (Type) –   Beállítja a minta típusát. 

•  Minta (Pattern)  –  Listázza a meglévő mintákat, amelyeket használni lehet. 

•  Példa –   Az előnézeti kép megjelenítése. 
 
 

 
 

 

❏ Szög és lépték (Angle and  Scale)  –   Beállítja a kiválasztott sraffminta szögét és léptékét. 
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❏ Sraffozás kezdőpontja (Hatch Origin) –   Beállít egy pozíciót a sraff minta elkezdéséhez. 

 

 
❏ Előnézet (Preview) –  Zárja a dialógus panelt és megjeleníti a jelenleg megadott 

határt az aktuális sraff vagy térköz értékekkel. 

 

❏ Határvonalak (Boundaries)  –   Meghatározza a sraff vonalakat. 

•     (Hozzáad: Pontok kijelölése)  - Kiválaszt egy zárt alakzaton belül a rajzon. 

 

•    (Hozzáad: Objektumok kijelölése) - Meghatározza a határvonalat, amely 

összeállítja a kiválasztott objektumok zárt területét.   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

•  (Határok eltávolítása (Remove boundaries)) - Eltávolítja az előzőleg hozzáadott összes 

objektumot a határvonal definícióból.  
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❏ Beállítások (Option) – Beállítja az általánosan használt sraff és kitöltés opciókat. 

 

•  Leírás (Annotative) – Megadja azt, hogy a sraffozás feliratozási. 

•  Asszociatív (Associative) – Meghatározza, hogy a sraffozás vagy kitöltés asszociatív legyen vagy nem. 

•  Különálló sraffozások (Create separate  hatches)  –  Azt vezérli, hogy egy vagy több sraff 

objektum jöjjön létre több különálló zárt határvonal esetén. 

•  Megjelenítési sorrend (Draworder)  – Megjelenítési sorrend hozzárendelése a sraffozáshoz vagy 

kitöltéshez. 

 

 
❏ Tulajdonságok öröklése(Inherit Properties) – A kiválasztott sraff objektumok sraff vagy kitöltés 

tulajdonságainak használata, a kijelölt határvonalak sraffozásához vagy kitöltéséhez. 

 

 
❏ Szigetek –   Sraff mód beállítása, objektum kitöltése a legszélső határig. 

 

•  Sziget keresés (Island  detection)  –   Belső zárt határok, más néven szigetek érzékelését kezeli. 

 

❏ Határvonalak megtartása (Boundary retention) – Az ideiglenes sraffozási határvonalakat határvonal 

objektumokká alakítja és a rajzhoz adja azokat. 
 

 
 
 
 

❏ Határvonal készlet (Boundary set) – Meghatároz objektum készletet, amelyet elemez, amikor létrehoz egy 

határvonalat egy megadott pontból.  
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❏ Hézag tűrése (Gap tolerance) –  Beállítja a maximum határokat, amelyet figyelmen kívül lehet 

hagyni, amikor az objektumot sraff határvonalként használja.   

 

 

 
 
 

Sraff beszúrás 
 

 
 

  Rajzolja meg a lenti formát. 
 

 
 
 

Klikk  (Sraff, (Hatch)) a Rajz (Draw) panelen a Szalag csíkon.  Állítson be egy sraff 

mintát ( Hatch Pattern) as ‘ANSI31’ a Sraffozás és átmenet  (Hatch  and  Gradient) dialógus 

panelen. 
 

 
 

 
  A P1 kiválasztásához a rajzterületen,  klikk Hozzáad: Pontok kijelölése (Add:  Pick points)  a 

Sraffozás és átmenet  (Hatch  and  Gradient) dialógus panelen. Pr
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Klikk gombon  az előnézethez,  ENTER  az alkalmazáshoz.  

Klikk (Hatch)  a Rajz (Draw) panelen a Szalag csíkon. 

 

Click (Inherit  properties) Tulajdonságok öröklése a Sraffozás és átmenet  dialógus panelen,  then  

válassza ki a már megrajzolz sraffmintát (ANSI31). 
 

 
Click 

 

 

(Add: Pick points) Hozzáad: Pontok kijelölése, s válassza a  P2-t. 

  

 

 

 
 

Command:  _HATCH 

Specify  internal  point:  P1 

Selecting  everything  visible... 

Was  found  1  objects. Analyzing  

the  selected  data... The  

boundary has  been  found. 

Specify  internal  point: 
 
 

 
 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

  ENTER  a sraffozás befejezéséhez. Pr
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2.3 Sraff szerkesztés  (HATCHEDIT) parancs 
 

 
 

Meglévő sraff vagy kitöltés módosítása. 

 
Menü  Modify  ➤ Edit  Hatch 

 

Eszköztár  

 

Szalag Home ➤ Modify  ➤ Edit  Hatch 
 

 
Parancssor  

 
 

 
Command:  _HATCHEDIT 

Select  hatch  object:  P1  (Válassza ki a sraff mintát a rajzban) 

Select  hatch  object: 
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Exercise  55  Rajzolja meg a következőt a HATCH parancsot használva. 
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Exercise  56   Rajzolja meg a következőt a HATCH parancsot használva. 
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Exercise  57  Rajzolja meg a következőt a HATCH parancsot használva. 
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03 Blokk 
 

 
A bemutatott parancsokkal komplex objektumokat rajzolhatunk. 

 

 
Ikon Parancs Leírás 

 

        BLOCK A kiválasztott objektumokkal Block objektumot készít.. 

 

WBLOCK 
Elmenti a kiválasztott objektumokat vagy elmenti a blokk konvertáláshoz egy külön 

rajzfájlba.  
 

         BASE A blokk részére beállít egy alap (Base) pontot a beszúráshoz.  

           INSERT Beszúr egy blokkot vagy egy rajzot az aktuális rajzba. 

REFEDIT Külső referenciát szerkeszt vagy blokk definíciót  az aktuális rajzban. 

 
         ATTDEF Attribútum meghatározást szúr be egy blokkba egy adat elmentéséhez. 

ATTREDEF Újradefiniál egy  Block  definíciót és frissíti a linkelt attribútumot. 

            ATTDISP Beállítja az összes blokk attributum láthatóságot  a rajzban. 

 
DDATTE  & 

ATTEDIT 
Megváltoztatja egy blokk attribútum definícióját.

 

 
        EATTEDIT 

Egy blokk hivatkozás átribútumát szerkeszti. 

ATTEXT  Attribútum szöveg adatot kivonatol,  amely egy blokktól egy fájlhoz van linkelve. 

          BEDIT Megnyit egy blokk objektumot a  Block  Editor  módban. 

 

 
XREF  Megnyitja a Külső hivatkozás menedzsert  (External Reference  Manager).. Pr

ó
ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba
426 

 
 

Insert  text,  hatch  and  block   08 

 

 

 
 

 

 
 

3.1 Blokk áttekintés 
 

 
 

Blokk használatával, gyakran használt objektumot vagy alakot mentünk el, mint egy fájlt a nevének 

megadása után, majd ezt a névre keresve könnyen beszúrjuk amikor újat készítünk.    Következésképpen, 

blokkot használhat, hogy időt takarítson meg ugyanolyan blokk vagy rajz megrajzolásához.  
 

A blokk egy csoport vagy komplex objektum a CADian-ban, amellyel könnyen alakíthatjuk a rajzunkat.  

Amikor megad egy blokkot, beállítja a beszúrási pontot, eltávolít objektumokat a blokkból vagy nem, 

konvertálja a blokkot az aktuális rajzba vagy nem. Amikor blokkot ad meg, beállítja a beszúrási pontot, 

vagy átviszi az objektumokat blokkba, vagy nem, vagy  konvertálja a blokkot az aktuális rajzban, vagy 

nem.  

 

 

 
 

 
 

Blokk készítés a következő módokon lehet a CADian-ban. 
 

 

•  Objektumok összekapcsolása és blokk definiálás az aktuális rajzban  (belső blokk). 

•  Blokk szerkesztő használata, dinamikus módja a blokk megadásának az aktuális rajzban. 

•  Rajz fájl készítés és egy másik rajzba való beszúrása a jövőben. 

•  Rajz fájl készítés ahol több blokk definíció van  és blokk könyvtár használata. Pr
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3.2 Blokkok vonaltípusának és színeinek szerkesztése 
 
 
 

A beszúrt blokk entitások megőrzik az eredeti tulajdonságokat,  átörökli a tuljadonságokat az eredeti 

fóliáról vagy átörökli az aktuális rajz tulajdonságait. Általában amikor a blokk beszúrásra kerül, a blokk 

színe, vonaltípusa és vonalvastagsága nem változik, az aktuális rajz/fólia beállításait figyelmen kívül 

hagyva.   

 

 
Azonban, a blokk megörökölheti az aktuális tulajdonságokat. Ennek az entitásnak úszó 

tulajdonságai vannak.  
 

 
 
 

•  A blokk nem örökli meg a tulajdonságokat az aktuális beállításokból.  Az elemek a blokkban 

szintén nem követik  az aktuális beállítást. Ebben az esetben, az a javaslat, hogy be kell állítani az 

egyedi entitások tulajdonságait a blokkban. Ezek az elemek nem használják a ‘ByBlock’  vagy  

‘ByLayer’  (Fóliaszerint) tulajdonságot. 

•  Az elemek egy blokkban öröklik az aktuális fólia tulajdonság beállításokat.  Ebben az esetben,  

blokk elemeket rajzol  ‘0’ fóliára, és beállítja azok tulajdonságait, mint  ‘ByLayer’. 

•  Egy blokk bizonyos objektum tulajdonságokat megörökli, amelyeket explicit módon definiálnak.  

Ha nincs explicit módon definiált objektum, a blokk elemek az aktuális tulajdonság beállításokat 

követik. Ebben az esetben, az elemek részére javasolt a ‘ByBlock’ szerintí beállítás. 

 
 

 
 

Hogy fenntartsa a következőt... Fólia a rajzoláshoz  Szín tulajdonság beállításhoz 

 
Az eredeti tulajdonságokhoz  
hozzátapasztani Összes fóliát a (0) mellett Összes tulajdonság a   

ByBlock vagy  ByLayer mellett 

 
Tulajdonságok öröklése a Fóliától  (0) Fólia  ByLayer 

 
Örökli a blokk tulajdonságokat,   

ezután követi a Fólia tulajdonságokat Összes Fólia
  

ByBlock Pr
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3.3 Blokk típusok 
 
 

❏ Belső blokk 

 

 
Általában, a belső blokkot blokknak nevezzük. A belső blokk az amelyet a felhasználó be tud szúrni a 

rajzba  (DWG) amely tartalmazza a blokk definíciókat.  Minden rajz fájlban, van rejtett adat terület, 

amelyet   blokk definíciós táblának (Block Definition Table) nevezünk. 
 

Az összes blokk definíció elmentésre kerül a blokk definíciós táblába (Block Definition Table) majd 

összeépül a blokkal, valamint az összes kapcsolódó információval.   
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❏ Külső blokk 

 

 
Amikor használja a ‘WBLOCK’  parancsot  a blokk megadásához, úgy menti el mint rajz(DWG) fájl.  

Jelentése, az elmentett rajz blokként használható.  Megépíthet úgy egy rajzfájlt, hogy azt blokként használja.   
 

Íly módon történő blokk építés könnyen kezelhető. Elmenthető egy mappába mint egyedi rajzfájl vagy 

csoport. 

 

 

 
 
 

A következő táblázat összehasonlít egy belső és egy külső blokkot.   
 
 
 

 
 

Belső blokk  
 

Külső blokk 

 

Parancs megadás 
 

BLOCK  
 

WBLOCK 

 

Parancs a beszúráshoz  
 

INSERT  

 

Elmentés 
 

blokk táblázat  
 

DWG rajzfájl 

Betölthető csak az aktuális rajzba  minden rajzfájlhoz 

 
 
 

CADian gondoskodik  DesignCenter  parancsról a felhasználó számára, hogy kezelje a blokkot, és 

különböző blokkot használjon. DesignCenter parancs később magyarázatra kerül ebben a kézikönyvben.  
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3.4 BLOCK  parancs 
 
 
 

Blokk megadása a kiválasztott objektumokkal. 

 
Menuü Draw ➤ Block ➤ Make... 

Eszköztár   

Szalag Home ➤ Draw ➤ Block ➤ Make... 

 
Parancssor  

 

 
 
 

 
 

 
 

Opció Leírás 

 
 

 
Név 

Jelőlje ki a blokk nevét.  A neve maximum 255 karakter lehet, és szöveget, számot, ürest és 

speciális karaktereket tartalmazhat, amelyek nincsenek más célból a programba vagy az op. 

rendszerben. A blokk neve és definíciója elmentésre kerül az aktuális rajzba.   Pr
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Opció Leírás 

 

A bázis pont a blokk beszúrási pontja. Ez egy hivatkozási pont a felhasználónak ,amikor a blokk 

beszúrásra kerül a rajzba.  Az alapértelmezett pozíció  Origin(0,0,0). 

 

 
 

Bázis pontok 

•  Megadás a képernyőn  –  Bázis pont kiválasztás a rajzon miután a dialógus panel bezárul. 

•   (Pick  point)  - Ideiglenesen bezárja a dialógus ablakot,  hogy kijelölje a bázis pontot. 

 
- X  : Kijelöli az  X  koordinátát a bázis pontnak. 

- Y  : Kijelöli az  Y  koordinátát a bázis pontnak. 

- Z : Kijelöli az  Z koordinátát a bázis pontnak.

 

 
  Beállítások 

Blokk beállítások szerkesztése. 

•  Blokk egység  -  Beállítja a mértékegységeket a blokk hivatkozáshoz. 

•  Hiperkapcsolat - Megnyitja a dialógus panelt, hogy kapcsoljon egy linket egy blokk hivatkozással.   

 

 

Megnyitás blokk szerkesztőben Az aktuális blokk definíció megnyitása  a blokk szerkesztőben. 
 

 
 
 
 
 
 
 

 Objektumok 

Entitások kiválasztása a blokk fefinícióhoz való konvertálásához.  3 beállítás van, arról hogyan 

foglalkozzunk  az objektumokkal a blokkba szúrást követően. 

•  Képernyőn való megadás - Entitások kiválasztása a rajzban  miután a dialógus panel bezárul. 

•  (Objektum kiválasztás) -Ideiglenesen bezárja a dialógus ablakot , hogy kiválassza aaz entitásokat.  

Definiálás.  Miután kiválasztotta az entitásokat,  üssön az ENTER-re hogy visszatérjen a dialógus panelhez. 

•   (Gyors kiválasztás) -Megnyitja a gyors kiválasztás dialógus panelt, hogy megadja a kiválasztást.   

•  Megtart -Blokk megadás után, megtartja a kiválasztott objektumokat, mint külön objektumok. 

•  Blokká konvertál – Blokk megadás után, kiválasztott objektumokat blokk másolattá konvertálja. 

•  Törlés – Blokk megadás után, törli a kiválasztott entitásokat a rajzból. 

 
 
 

Viselkedés 

Beállítja egy blokk definíció magatartását. 

•  Magyarázat  –   Kijelöli a blokkot, mint magyarázó. 

•  Egységes mérték  - Meghatározza azt, hogy a blokk hivatkozás skálázása egyenletes. 

•  Szétvetés engedélyezése  – Meghatározza azt, hogy a blokk hivatkozás a szétvetéshez engedélyezett. 

 

Leírás Rövid leírást ad a létrehozott blokkról.   
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Belső blokk létrehozása. 

 
 

 
  Rajzolja le a következő formát. 

Rajzoljon objektumokat a ‘0(nulla)’  fóliára,  rajzoljon méreteket a ‘DIM’  fóliára. Ezután, 

állítsa a ‘DIM’ fóliát kikapcsoltra (OFF). 
 

 
 
 

  Válassza ki a  (Make) a ‘Block’  panelből  a  ‘Home’ (Kezdőlap) fülön. 

 
Léptesse be az új blokk nevet ‘Door’ a Name (Név) dobozba a Block Definition dialógus ablakba. 

 

 
 
 

  Klikk (Pick point)  kijelölés (P1) mint beszúrási pont. 
 
 

 

Klikk (Select objects),  az  ‘Objects’  területen,  válassza ki az entitásokat a blokkhoz.  

Válassza P2, P3,  P4, P5, P6, jelölje  ‘Retain’  ezután kattintson az ‘OK’-ra. 
 

 
 

 
 

  Állítsa be a következőket a dialógus panelen,  ezután kattintson az ‘OK’-ra. 

•  Block unit (Blokk mértékegység)  –   Milliméter –   Millimeters 

•  Scale  uniformly (Egyenletes lépték) 

•  Allow exploding (Szétvetés engedélyezés) Pr
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Most már a belső blokk, "Door" nevű létrehozásra került a rajzban. 

 

 
 

  Mentse el a rajzot ‘BLOCK-INSERT’ fájl névként. 

 
 

 

3.5 WBLOCK  parancs 
 

 
 

Elmenti a kiválasztott objektumot vagy blokká konvertálja egy kijelölt rajzfájlhoz. A ‘Write  Block’ dialógus 

panel gondoskodik a kényelmes beállításokról, hogy elmentse az aktuális rajz egy részét és a megadott blokk 

definíciót rajz fájlként egy merevlemez mappába.  

 

Menü  Draw ➤ Save  Block  to  Disk 

 
Eszköztár  

 

Szalag Home ➤ Draw ➤ Save  Block  to  Disk 

 
Parancssor  Pr
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Opció Leírás 

 
Blokk Meglévő ( Internal  Block) belső blokkot  külső blokká (External  Block) konvertálja. 

 
Teljes rajz Elmenti az egész rajzot egy külön  DWG fájl formátummá, hogy külső blokká konvertálja. 

 
 
 

 
Opció Leírás 

 
Objjektumok  

Válassza ki az objektumokat  és állítsa be a bázis pontot a külső blokká konvertáláshoz 

bizonyos entitásokhoz a rajzban.    

Bázis pont Lásd  BLOCK  Option  Table. 

Objektum beállítások Lásd  BLOCK  Option  Table. 

 

 
 

 
Állomás 

Mértékegység kijelölés,  fájl név útvonallal a külső blokhoz. 

•  Fájl név és útvonal  –  Állítsa be a fájl nevet és az útvonalat a külső blokkhoz. 

•    - Nyissa meg az alapértelmezett böngészőt a blokk elmentéséhez.    

•  Mértékegység beszúrás  - Egy új fájl betöltése a DesignCenter-ből vagy állítson be 
mértékegység értéket az automatikus skálázáshoz, ha egy külső blokk került beszúrásra a 
rajzba, amely különböző mértékegységet.Válassz a mértékegység nélkülit (Unitless-t), ha 
nem használja az automatikus skálázást. 
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Külső blokk készítés 

 
 

 
  Rajzolja le a következő formát. 

Rajzoljon objektumokat a ‘0(nulla)’  fóliára,  rajzoljon méreteket a ‘DIM’  fóliára. Ezután, 

állítsa a ‘DIM’ fóliát kikapcsoltra (OFF). 
 
 
 

 
 

 
  Üsse be a ‘WBLOCK‘-ot  a Parancssoron. 
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   Klikk gomb  jobb oldalára a File névnek és útvonal a  ‘Write  Block’ dialógus panelbe. 
 

Üsse be a fájl nevet mint ‘Finishing  Mark’,  ezután kattintson a ‘Save’ -re. 
 

 
 

  Klikk (Pick point),  kijelölési pont ‘P1’ mint beszúrási pont a rajzban. 

 

Klikk (Select objects),  az  ‘Objects’  területen,  hogy kiválassza az entitásokat egy  

blokknak. Válassza P2, P3,  P4, jelölje  ‘Retain’  ezután kattintson az ‘OK’-ra. 
 

 
 
 
 

 
  Állítsa be a következőket a dialógus panelen,  ezután kattintson az ‘OK’-ra.Pr
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•  Blokk mértékegység  –   Milliméter 

 

 
 
 
 
 

  Mentse el a rajzot  ‘BLOCK-WINSERT’  fájlnévként. 
 

A külső blokk, ‘Finishing  Mark.dwg’  létrehozása megtörtént a megadott elérési útvonalon. 
 
 

 
 

 

3.6 BASE  parancs 
 
 
 

Állítsa be az aktuális rajz beszúrási pontját.  A hivatkozási pont  0,0,0(kezdőpont), ha ‘WBLOCK’  

parancsot használ a teljes rajz elmentéséhez blokként vagy éppen rajzként.  
 

A rajzot kényelmes módon lehet blokként használni, ha a BASE parancsot használja a hivatkozási pont 

beállításához. A BASE parancsot vetítési parancsként is lehet használni. A hivatkozási pont az aktuális 

Felhasználó koordináta rendszerrel (UCS) van megadva. Ha beszúrja az aktuális rajzot egy másik rajzhoz 

vagy hivatkozik rá, az ilyen hivatkozási pont beszúrási ponttá válik.  Pr
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Menü 

 

 
Eszköztár 

 

Szalag Home tabe  ➤ Block  panel  ➤Base  Point 

 
Parancssor BASE 

 
 
 
 

 
Command:  _BASE 

Base  point for  inserting  this  drawing  <0.000000,0.000000,0.000000>:  P1 
 
 
 
 
 

 

 
 

 
 
 
 
 
 
 

3.7 INSERT  parancs 
 
 
 

BLOCK  vagy  WBLOCK  parancsokat arra használjuk, ha elkészült vagy elmentett blokkokat szúrunk be a 

rajzba. Leginkább a blokk könyvtárból való blokk beszúrást preferálják.    

 

 
A blokk könyvtár lehet egy rajzfájl, amely elmenti a kapcsolt blokk definíciót vagy mappát, amely 

tartalmazza a kapcsolt rajz fájlt. Mindegyiket beszúrhatja blokként.   Pr
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Ezen módon blokk felhasználást standardizálva segít különböző felhasználóknak, hogy könnyen elérjék a blokkot.   
 

 
 
 

Menü Insert  ➤ Insert Block... 

 

Eszköztár  

 

Szalag   Home ➤ Insert ➤ Insert Block... 

Parancssor  
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Opció Leírás 
 

 
 
 

 
Név 

Léptesse be a blokk nevét vagy egy rajzét a beszúráshoz. 
•  Böngészés  –  Nyissa meg a standard  fájl kiválasztási dialógus panelt, hogy 
kiválasszon  egy rajzfájlt vagy egy blokkot abeszúráshoz. 

•  Útvonal  –  Elérési útvonal beállítása a blokkhoz. 

•  Mértani adatok használata  –  rajzot szúr be, mértani adatokra hivatkozva. 

•  Előnézet : Megjeleníti a kiválasztott blokk előnézetét a beszúráshoz. 

 
 
 
 

Beszúrási pont 

Megadja a beszúrási pontot a blokkhoz. 

•  Megadás képernyőn  - Egy blokk beszúrási pontjának kiválasztása a  rajzon. 
•  Koordináták beléptetése: Egy blokk beszúrási pontjának X, Y és Z kordinátáinak kézi 

inputjai.   
 

 
Lépték 

Beállítja a léptékét egy beszúrt blokknak. 

•  Megadása képernyőn  –  Lépték beállítása a blokknak mutató eszközzel. 

•  Egyenletes lépték  –  Beállít egy egyenletes léptéket az    X,  Y és Z koordinátáknak. 

 

 
  Elforgatás 

Beállítja az elforgatási szöget a beszúrt blokknak,  az aktuális UCS-t véve. 

•  Megadása képernyőn  – A blokk elforgatásának beállítása a blokknak mutató eszközzel. 

•  Szög  –  Beállítja egy blokk elforgatási szögét.. 
 

 
 

Blokk egység 

Megjeleníti az egység beállítást a blokk részére. 

•  Egység  –  Megmutatja az  INSUNITS  értéket egy beszúrt blokk részére. 

• Tényező   Megmutatja az egység tényezőt,   az aktuális rajz egységével számolva és az 

INSUNITS  értéke a blokknak. 
 
 

 
Szétvetés 

Szétvet egy blokkot és beszúrja az elemeket megtartva a blokk kinézetét. Ha a Szétvet 

(Explode) opció van kiválasztva, akkor csak az Egyenletes lépték (Uniform Scale) tényezőt 

lehet kijelölni. Blokk elemek, amelyek a 0 fóliára rajzoltak, azok a fóián maradnak.   

Entitások ByBlock Color fehér lesz. Entitások ByBlock vonaltípussal CONTINUOUS      

vonaltípus lesz kijelölve. 
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Belső blokk beszúrása 

 

 
 

  ‘BLOCK-INSERT.DWG’ megnyitás 
 

 
 

  Üssön ‘INSERT’-t  a parancssoron. 
 

Üsse be a ‘DOOR’-t  a  Name mezőbe  az ‘Insert’  dialógus panelbe,  ezután kattintson ‘OK’-t. 
 

 
 

 
 
 

Command:  _INSERT 

Specify  insertion  point  or [Basepoint/Scale/X/Y/Z/Rotate]:  P1 
 

Specify  scale  factor  for  XYZ  axes  <1>:  1.0 
 

Specify  rotation  angle  <0>: 
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Külső blokk beszúrása 

 
 
 
 
 

  Nyissa meg a  ‘BLOCK-WINSERT.DWG’-t,  ezután rajzolja meg a négyszöget. 
 

 
 

 
  Üssön ‘INSERT’-t  a parancssoron. 

 

Kattintson ‘Browse’ -ra az  ‘Insert’  dialógus ablakban,  ezután válassza a  ‘Finishing  

Mark.dwg’  fájlt.  Állítson be más dolgokat is és kattintson az  ‘OK’-ra. 
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Command:  _INSERT 

Specify  insertion  point  or [Basepoint/Scale/X/Y/Z/Rotate]:  P1 
 

Enter X  scale  factor,  specify  opposite  corner,  or [Corner/XYZ]  <1>: 0.5 
 

Enter Y  scale  factor  <use  X  scale  factor  (1)>:  0.5 
 

Specify  rotation  angle  <0>:  90 
 
 

 
 

 
  Szúrjon be további blokkokat ezen a módon. 
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3.8 REFEDIT  parancs 
 
 
 

Átszerkesztheti a hivatkozást vagy a blokk definiálást az aktuális rajzban. Ideiglenesen szétveti az 

objektumot és lehetővé teszi a szerkesztést. Ilyen szétvetett objektum szettet munka szettnek nevezünk, a 

felhasználó ismét elmentheti a hivatkozás vagy blokk definíció módosítását követően.  
 

 
 
 

Menü  Tools ➤ Edit  Reference  In-Place 

 
Eszköztár  

 

Szalag Home ➤ Tools ➤ Edit  Reference  In-Place 

 
Parancssor REFEDIT 

 

 
 
 
 

 Blokk szerkesztés REFEDIT  parancs használatával 

 
 

 
Blokk szerkesztés,  neve ‘Door’,  mint lentebb: 
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  Üsse be ‘BEDIT’  a Parancssoron. 
 

Válassza ki a ‘Door’-t  az  ‘Edit  Block Definition’ dialógus panelen a szerkesztéshez.  A 

blokk megnyílik szerkesztési módban.  Most már szerkeszthető, mivel az összes elem 

külön áll mint egyedi objektum.     
 

 
 
 

  Törje meg a vonalat a lenti ábra szerint. 
 

 

 
 
 

 
Command:  _BREAK 

Select  entity  to break:  P1 
 

First  break  point/<Second  break  point>:  F 

First break  point:  P2 

Second  break  point:  P2 Pr
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    Törölje ki a megtört vonal szegmens jobb oldalát. 
 

 
 

 
  CSatlakoztassa a hiányos részt a  ‘LINE’  paranccsal. 

 

 
 

 
  Üsse be a ‘BCLOSE’-t a Parancssoron. 

 

 
 

Command:  _BCLOSE 
 

Enter  option  [Save/Discard  reference  changes]  <Save>: 
 

 
  Léptesse be az ‘INSERT’-t a Parancssoron. 
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  Válassza ki a blokkot, ‘DOOR’  és kattintson az ‘OK’-ra a beszúráshoz.   
 

 
 

Command:  _INSERT 

Specify  insertion  point  or [Basepoint/Scale/X/Y/Z/Rotate]:  P1 
 

Specify  scale  factor  for  XYZ  axes  <1>:  1.0 
 

Specify  rotation  angle  <0>: 
 

 
 

 
 
 

A szerkesztett blokk beszúrásra kerül a rajzba. 
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Exercise  58  Módosítsa a következő  M10 csavart  egy külső és belső blokkra. 
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04   Blokk Attribútum 
 

 

4.1 Blokk attribútum áttekintés 
 
 

A blokk nem csak egy grafikusan vizualizált ábra, hanem lehet szöveges adat is, amelyet 

attribútumnak nevezünk a CADian-ban. Az attribútum egy bővített tulajdonság, de  általában grafikus 

ábrák elmentésére használjuk.  Attribútumot használunk szövegek vagy számok rögzítéséhez. 

Végeredményben a blokk használata a megadott attrbútummal egy mérnöki adatbázisként viselkedik.  
 

Attribútum használatához, először készítsük el az attribútum megadásását.  Az attribútum 

tulajdonságok tartalmazzák a cimkét (Nevet megkülönböztető tulajdonságokkal), prompt,  érték, 

szöveg formátum,  szöveg hely és opciók (láthatóság,  állandóság, ellenőrzés, kezdeti értékadás). 

Attribútum készítésénél válassza ki az attribútum megadását mint blokk definíciót. Ha megadja az 

attribútumot a blokkhoz, promptot ad a szöveghez, amelyet attribútumnak fog kinevezni, akárhányszor 

beszúr egy blokkot. Az attribútum értéke különböző lehet, ha másolja mindegyik blokkot Azért hogy 

különböző attribútumot használjon, egyedileg állítsa be mindegyik attribútumot és foglalja bele a blokkba.  
 

Ha az attribútum megadása közben szerkeszteni szeretné, használja a  PROPERTIES (Tulajdonság) 

parancsot vagy dupla kattintással szerkessze, mielőtt blokkot készítene.  Szerkesztheti a fület, a 

promptot és az alapértelmezett értékeket.  

A blokk attribútum nagyon hasznos mint hozzáadott blokk tulajdonság. A blokk attribútum elmenti az 

adatokat, hogy a tervezéshez felhasználhassuk.  Bizonyos adatokat megadhatunk állandó értékkel, 

vagy módosítani lehet, amikor a felhasználó beszúrja a blokkot. Kivonatolhatja az attribútum 

információkat a rajzban, használhatja táblázatban vagy adatbázisban, hogy például darabjegyzéket 

készítsen.  
 

A blokknak lehet kettő vagy több attribútuma, ha az attribútum cimkék között különbség van. Amikor 

beszúr egy blokkot a prompt megjelenik, hogy beléptesse az attribútum értéket. Elrejtheti az 

attribútumot, ami azt jelenti, hogy nem jelenik meg a rajzban és nyomtatáson.   

Azonban az attribútumot el lehet menteni a rajzfájlba és nem lehet kivonatolni, az ATTEXT parancs 

használatával. 

Amikor a prompt megkérdezi a felhasználót, hogy válasszon objektumokat és ezeket megjelenítve 

hozzáaadja a blokk definícióhoz, amely tartalmazva az összes attribútumot, amelyet blokként akar 

létrehozni egy kiválasztási szettben.    A kiválasztott attribútumok sorrendje megerősíti a prompt 

sorrendet, amelyet megjelenít az attribútum információban a blokk beszúrásánál.  
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Általában a prompt sorrendje ugyanaz a sorrend, amellyel az attribútumokat kiválasztotta, amikor definiálta 

a blokkot.  Azonban,  ha a kiválasztott attribútum Cross(C) vagy Window(W) kiválasztást használ, a 

prompt sorrend ellentétes azzal a sorrenddel, amikor az attribútumot megadta.  
 
 
 

 
 
 

 
 

Név 
 

Méret 
 

Gyártó 
 

Modell 
 

Ár  (KRW) 

 

Desk 
 

1200x800 
 

Elite  Furniture 
 

51-793W 
 

80,000 

 

Chair 
 

800x600 
 

Elite  Furniture 
 

34-902A 
 

38,000 

 

Desk 
 

1200x800 
 

Elite  Furniture 
 

52-444W 
 

120,000 

Chair 800x600 Elite  Furniture 34-902B 65,000 

Closet 12000x80000 Elite  Furniture X-52-44 150,000 
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4.2 ATTDEF  parancs 
 
 
 

A blokk tulajdonságait adja meg szöveg használatával vagy blokk számmal. Ezután nehéz a 

tulajdonságokat módosítani;  ezért,  a koncepciót tisztán kell megérteni és megtervezni a 

tulajdonságok megadását. Hat módja a tulajdonságok megadásának.  
 

 
 
 

Menü  Draw ➤ Block ➤ Define  Attributes... 

 

Eszköztár  

 

Szalag  Home ➤ Draw ➤ Block ➤ Define  Attributes... 

Parancs ATTDEF 

 

'Property  definition'  dialógus panel megjelenik amikor az  ATTDEF parancsot használja. A 

beállítások megjelennek, amikor az 'ATTDEF' -et begépeli a parancssor promptba. 
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Opció Leírás 

 
 
 
 
 
 
 
 

Mode 

 

Opciók beállítása a blokk attribútumoknak, amikor az attribútumok beszúrásra kerülnek  

 

 Invisible  
Nem jeleníti meg az attribútum értékét  a blokk beszúrása után. ATTDISP  módosítja a  beállítást 

 

Constant  Hozzárendel egy  konstans  (numerikus)  értéket a Blokk  attribútumhoz. 

 

Verify Megjeleníti a promptot, hogy ellenőrizze, a  Blokk  attribútum értéke  korrekt vagy nem 

 

Preset  Alapértelmezett atribútum megadása a blokkok részére 

Lock   Zárja az attribútum pozíciót  a blokk hivatkozásban.  Amikor nem zárolt az attribútum 

mozgatható, szerkeszthető  és a többszörös vonal határ igazítható.  

Multiple lines  Bekezdéses szöveg lehet  az attribútum definícióban.  Ha az opció jelölt, a felhasználó 

megadhat határvonalat az attribútumnak.   

   
 
 
 
 

 
Attribute 

 

Attribútum adatok beállítása 

 

Tag   
Megkülönbözteti az attribútumokat. Karaktereket tartalmaz üres nélkül. Kisbetűs karakterek 

nagybetűs karakterek lesznek. 

Prompt  Promptot rendel hozzá, amely megjelenik, amikor a blokk az attribútummal beszúrásra 

kerül.  Attribútum cimke megjelenítésre kerül mint prompt, ha nincs alapértelmezett promt   
beállítva. Ha Constans mód be van kapcsolva, a prompt opció megjelenik 

 

Default Hozzárendeli az alapértelmezett attribútum értéket. 

Megjeleníti a dialógus doboz mezőt. A mezőt be lehet szúrni részben  vagy  egy teljes Attr. 

értékként. 

 
 
 
 
 

Insertion 

Point 

Attribútum beszúrási pont hozzárendelés. A felhasználó koordinátákat tud hozzárendelni vagy pontot kiválasztani a 

rajzban, ezután megadhatja a pozíciót az attribútumnak a mutató eszközzel a kapcsolt objektumhoz.   

Specify Megjeleníti a promptot  amikor a dialógus doboz lezárt. Pozíció megadása az attribútum részére 

On-screen a kapcsolt objektumhoz mutató eszköz használatával.   
 

X: Hozzárendeli az X  koordinátát  a beszúrási ponthoz. 

 

Y: Hozzárendeli az Y  koordinátát  a beszúrási ponthoz. 

 

Z:  Hozzárendeli az Z  koordinátát  a beszúrási ponthoz. 

 
 
 
 

Text 

Settings 

 

Igazítás beállítás,  szöveg stílus,  attribútum szöveg magassága és elforgatása. 

 

Justification Attribútum szöveg igazítás beállítása. 

 

Text  style  
Beállítja az alapértekmezett szöveg stílust az attribútum szöveg alkalmazásához. Jelenleg 

betöltött szöveg stílusokat  (TextStyles) megjelenítik a listában. 
 

Annotative 
 A beállított attribútum magyarázó szöveges.  Ha a blokk szintén magyarázó,  az 

attribútum a blokk irányát fogja követni.  Pr
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Opció Leírás 

 
 
 

 
Test  Settings 

Text height  Beállítja a szöveg magasságot az attribútum szöveghez. A felhasználó vagy 

belépteti az értéket, vagy kijelöli a magasságot a mutató eszközzel.   

 

Rotation  
Beállítja az elforgatás szögét az attribútum szöveghez. A felhasználó vagy 

belépteti az értéket, vagy kijelöli a magasságot a mutató eszközzel. 

Boundary  Beállítja a határvonal korlátozott hosszát a Többszörös vonal dobozba  mielőtt  

width automatikusan megváltozik a következő vonalhoz, ha a szöveg túl hosszú. 

Align  below previous  attribute A cimkét jobbra igazítja, mielőtt megadja az attribútumot.  Ha a cimke nem 

nem megadott, ezt az opciót figyelmen kívül kell hagyni.  

 
 
 

 
Egy blokk attribútum megadása 

 
 

 
  Rajzolja meg a táblázatot teljes méretarányban. 

 
 
 

 
 

 
 
 
 

* Javasolt, hogy szervezze meg az attribútum megadását, mielőtt beszúrná az 

attribútumokat a táblázatba és készítsen blokkot.  Pr
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Szám
. 

 

Attribútum 
 

Cimke 
 

Prompt 
 

Alapérték 
 

Mód 

 

1 
 

Modell név 
 

MODEL 
 

None. 
 

TBL-001 
 

Constant 

 

2 
 

Szín 
 

COLOR 
 

Table Color? 
 

RED 
 

Verity 

 

3 
 

Mére

t 

 

SIZE 
 

Table Size? 
 

600 
 

Preset 

4 Kisker. ár U_COST Retail  Cost of  Table? 100,000 Verify 

 
5 

 
Gyárt. költség 

 
F_COST 

 
Factory  Cost of Table? 

 
60,000 

Invisible 

Preset 

6 Gyártó MAKER Table  Manufacturer? Elite  Furniture Verify 

 

 
 

  Vagy belépteti az ATTDEF (Define Attribute) parancsot a Parancssoron vagy válassza 

     a [Draw]  ⇨ [Block] ⇨ [Define Attributes] a legördülő menüben. 

"Attribute  Definition" dialógus panelt megmutatja mint lentebb.  Először,  adja meg a  

"Modell nevét" bejelölve a "Constant" opciót, amíg ez nem változik. Léptesse be a 

"MODEL" -t a cimke részére az attribútum területen. menjen a 'Prompr'-ra  és léptesse be 

a  TBL-001-et alapértelmezésben. Kattintson az OK-ra és állítsa be az attribútum 

pozícióját P1-re a rajzon.   
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  Hívja megint a ATTDEF parancsot, hogy megadja a második  attribútumot. Mivel a "Color"  

elég gyakran megváltozik, jelölje a "Verify" opciót a Mode területen. 
 

     Léptesse be a  "COLOR"-t a (Tag) cimke részére,  "Table  Color?" a "Prompt"  és "RED"  

az alapértelmezésben  (Default).  Jelölje be a "Align below previous attribute 

definition" annak pozíciójába. 
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  Hívja megint a ATTDEF parancsot, hogy megadja a harmadik  attribútumot. A méret 

(Size)  gyakran változik.  Jelölje a "Preset"  opciót a Mode területen. 

Léptesse be a méretet (SIZE)  a cimkéhez (Tag),  "Table  Size?" a Prompt-ba  és 600 az 

alapértelmezett. 
 

 
 

 
Jelölje be a 'Align  below previous attribute definition' annak pozícióján, és ezután OK. 

 

 
 

 

  Adja meg a negyedik attribútumot ugyanezen módon. 

Retail  Cost   szintén gyakran változik.  Szintén Verify   opció. 

Léptesse be az U_Cost a cimkéhez (Tag),  ' Retail  Cost of Table'  a Prompt-ba  és 

100.000 az alapértelmezett.Pr
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Jelölje be a 'Align  below previous  attribute definition' annak pozícióján, és ezután OK. 

 
 

 
 

 

    Adja meg az ötödik attribútumot ugyanezen módon. 

"Factory  Cost"  ritkán változik.  Ezt az attribútumot el kell rejteni más emberek előtt. 

Jelölje az 'Invisible' (Láthatatlan) és Preset opciókat a Mode területen. 

Léptesse be az F_COST a cimkéhez (Tag),  "Factory  Cost of Table?" a Prompt-ba  és 

60.000 az alapértelmezett. Pr
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 Jelölje be a 'Align  below previous  attribute definition' annak pozícióján, és ezután OK. 

 
 
 
 
 
 
 
 
 
 

Most már van 5 megadott táblázatos attribútum. Következő, adjon meg egy blokkot, 

amely attribútumokat tartalmaz. 

 

 
 

  Vagy belépteti a "Block"-ot a Parancssoron vagy válassza  a [Draw]  ⇨ 

[Block] ⇨ [Define Attributes] a legördülő menüben. 

 
 

 
 

"Block  Definition"  dialógus panel megjelenik. Pr
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Léptesse be a blokk nevét "Table",  azután jelölje ki a  P1-et  mint beszúrási pontot 

rákattintással. 
 

(Pick point). Klikk  (Select objects) objektumok kiválasztása a blokkhoz, ezután 

pikkeljen P2, P3. Majd, folytassa a kiválasztást (1) ~ (5) attribútumig. 
 

 

Jelölje be a  Delete (Törlés) opciót és kattintson OK-ra az alkalmazáshoz. Az entitások ki 

lesznek törölve a rajzon és egy Internal Block, neve 'Table',  amelynek 5 attribútuma van 

létrehozásra került. 
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  Szúrja be a blokkot a rajzba. 
 
 
 
 

 
Command:  _INSERT 

Specify  insertion  point  or [Basepoint/Scale/X/Y/Z/Rotate]:  P1 

Specify  scale  factor  for  XYZ  axes  <1>:  1.0 
 

Specify  rotation  angle  <0>: 

Enter attribute  values: 

Retail  Cost of  Table?  <100,000>: 

Verify  attribute  values. 

Retail  Cost of  Table?  <100,000>: 

Table Color?  <RED>: 

Verify  attribute  values. 
 

Table Color?  <RED>: 
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4.3 ATTREDEF  parancs 
 
 

Blokk újradefiniálása és frissítése a kapcsolt tulajdonsággal. Az új tulajdonság beállítja a meglévő és 

az előző blokk hivatkozást, felhasználva az alapértelmezett és előző értékeket külön-külön.  Törli a 

megelőző tulajdonságot amelyet nem tartalmaz az új blikk definició.  

Ezt a parancsot akkor használjuk amikor a rajz kész, miután a blokk már megadott és beszúrt, hogy ezt 

követően hozzáadjunk vagy eltávolítsunk tulajdonságot vagy módosítsuk azt.  
 
 

Menü 

Eszköztár

SSzalag 

Parancssor ATTREDEF 

 
 
 
 
 
 

 
ATTREDEF (Attribútum     újra megadás)     parancs eltávolítja az összes formátumot  vagy bizonyos 

mósosított formátumokat,   megadása az   ATTEDIT   vagy  EATTEDIT   paranccsal.   Eltávolíthat a 

kapcsolt adatokat egy blokkba,  és befolyásolhatja a  Dynamic  Block-ot  vagy Blockkokat,  amelyet más 

CAD programba készítettek. 

 
 
 
 
 

Blokk attribútum újra megadása 
 

 
 

  Beszúr 3   "táblázat' blokkot.  "Táblázat"  blokknak 5 modell attribútuma van, szín, méret,  

kisfogyasztói ár, és termelői ár (Color, Size, Retail Coat, Factory Cost). 

Adjunk hozzá még egy további attribútumot, gyártó (Manufacturer). 
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  Válassza ki a [Modify]  (Módosítás)  ⇨ [Explode] (Szétvet) a legördülő menüben. Válassza 

a bal Block Reference-t, hogy megjelenítse az eredeti attribútum cimkéket.  
 

 
 

 

  Használja az ATTDEF parancsot, hogy megadja a 'Manufacturer'-t. 

 

 
 

 

  Üsse be az 'ATTREDEF'-et a parancs soron. 
 

 
Command:  ATTREDEF 

 

Enter name  of  the  block you  wish  to  redefine:  TABLE 

Select  objects  for  new  Block...  P1 

Opposite  corner: P2  Entities  in set:  1 
 

Select  objects  for  new  Block... 

Select  Insertion  point for  new  Block:  P3 
 
 
 

 
  Az összes "Tábla"  blokk hivatkozás automatikusan frissül, mint lentebb.  
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4.4 ATTDISP  parancs 
 
 

Általában a blokk tulajdonság láthatóságát állítjuk be a rajzba.   

 
Menü  View  ➤ Display  ➤ Attribute  Display  ➤ On 

 

 
Eszköztár 

 

Szalag  Home ➤ View  ➤ Display  ➤ Attribute  Display  ➤ On 

 
Parancssor ATTDISP 

 
 

 
Command:  ATTDISP 

Attribute  display  mode:    ON/OFF/Normal/<Normal>: 
 
 
 
 

Opció Leírás 

 
ON Megjeleníti az összes tulajdonságot.  

OFF Elrejti az összes tulajdonságot. 

Normal  
Megtartja a láthatósági beállításokat mindegyik attribútumhoz.  Attribútum az  Invisible

 (láthatatlan) móddal nem jelenik meg.  
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4.5 DDATTE  vagy ATTEDIT parancs 
 
 
 

Ezt a parancsot ahhoz használjuk, hogy a rajzban a tulajdonság blokkok tulajdonságait módosítsuk 

egyedileg a rajzban. Speciálisan az ATTEDIT parancs tudja a tulajdonságokat módosítani, részben és 

egészében. 
 
 
 

 
 

 
❏ Tulajdonságok szerkesztése, mint a hely, magasság vagy stílus.   

 
 
 

Command:  -ATTEDIT 
 

Edit  attributes  one  at  a  time?  <Y>: 

Edit  attributes  of  which  blocks?  <*>: 

Edit  attributes  with  these  names  <*>: 

Edit  attributes  with  this  text  <*>: 

Select  a  block with  attributes:  E1 

Entities  in  set:  1 
 

Select  a  block with  attributes: 

2  attributes were  selected. 

Position/Angle/Text/Style/Color/Height/Layer/Next/pRev/Quit/<Next>: Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

Insert  text,  hatch  and  block   08 

465 

 

 

 
 

 
 

 
 

 
 

 
 

 

 
 

4.6 EATTEDIT parancs 
 
 
 

Tulajdonságokat szerkeszti, olyanokat mint a tulajdonságok értéke, szöveg opciók, vagy blokk 

hivatkozás attribútum.  
 

 
 
 

Menü Modify  ➤ Object  ➤ Attribute  ➤ Edit  Attribute... 

 
Eszköztár  

 

Szalag Home ➤Modify  ➤ Object  ➤ Attribute  ➤ Edit  Attribute... 

Parancssor  EATTEDIT 

 

 
A tulajdonságok módosításához,  válassza a [Modify(M)] (Módosítás) ⇨ [Object(O)]  (Objektum) 

⇨ [Attribute(A)] (Attribútumok) ⇨ [Edit  Attribute(E)] (Attribútum módosítása) legördülő menüt. 

Válassza a blokk hivatkozást, amellyet szerkeszteni akar, ezután az 'Advanced Attribute Editor" 

dialógus panel megjelenik. 

Az  'Attribute' fülön a dialógus panelen, válassza ki azt az értéket amelyet módosítani akar, 

ezután kattintson az  'Apply' gombra és  'Ok' a lezáráshoz. 

Ez több fejlettebb módosító eszközről gondoskodik mint a DDATTE parancs. 
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4.7 BATTMAN (Block  Attribute Manager) parancs 
 
 

A kiválasztott blokk tulajdonságok megadását kezeli az aktuális rajzban.  

 

Menü   Modify  ➤ object  ➤ Attribute  ➤ Block  Attribute    Manager... 

Eszköztár   

Szalag Home ➤ Modify  ➤ object  ➤ Attribute  ➤ Block  Attribute    Manager... 

 
Parancssor BATTMAN 

 

 
 

Egy blokk tulajdonságait szerkeszti vagy eltávolítja azokat és promptot rendel hozzá amikor 

beszúrjuk a blokkot. Megjeleníti a szerkesztési sorrendjét a tulajdonság értéknek a blokk 

beszúrása közben. A kiválasztott blokk tulajdonságát megjeleníti a tulajdonság lista. 

Alapvetően, a cimke,  a prompt,  alapértelmezett érték, a mód és kiegészítő tulajdonság 

attribútum megjelenik a tulajdonság listában. Válogatott kiválasztási érték a tulajdonság 

attribútumok meghatározásához, amelyet meg akar határozni a listán.   
 

 

 
BATTMAN használat (Block  Attribute Manager) parancs 

 
 

 

   Az attribútumok szerkesztéséhez, válassza ki a [Modify] (Módosítás)  ⇨ [Object] (Objektum)⇨ 

[Attribute] (Attribútumok) ⇨ [Block Attribute Manager] (Blokk attribútum kezelő) a Block Attribute 

Manager dialógus panel megnyitásához. 
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Opció Leírás 

 

Select Kiválasztja a blokkokat. amelyeknél a felhasználó attribútumot szeretne  szerkeszteni. 

 

Block Listázza az összes blokkot,  amely attribútumot tartalmaz.   

 

Attribute  List Megmutatja mindegyik attribútm beállításait a blokkban.   

 

Found  in  drawing Megmutatja, hogy hány blokk másolat van jelen az aktuális rajzban. 

Found  in 

model  space  Megmutatja, hogy hány blokk másolat van jelen az aktuális modell nézetben vagy a papírterekben.
 
 

 

Sync   
Aktualizálja a szerkesztett beállításokat az összes blokk másolatnál. Sync nem befolyásolja az 

attribútum értékeket, amelyek az attribútumhoz vannak rendelve.    

Move Up  
Fel-le mozgatja a kurzort a listában.  A felhasználó újra rendezheti a listát  ezen gombok 
használatával. 

Move Down 

 

Edit 
Megnyitja az Edit Settings  dialógus panelt attribútumok szerkesztéséhez.  Az Attribute fül opciói balra  

lehetővé teszik, hogy  ki-be kapcsolja vagy új értékeket állítson be a cimkéhez, prompthoz vagy az 
alapértelmezett értékhez.  

Eltávolítja a kiválasztott attribútumot a Block Definícióből.   Ha az  "Apply   changes  to   existing 

Remove  references’ opció engedélyezett,  az attribútum eltávolításra kerül  az összes blokkból, amely 

tartalmazza az attribútumot  Ha csak egy attribútum van a blokkban,  ezt nem lehet eltávolítani. 

Settings Megnyitja  Block  Attribute  Settings-t,  amely  testreszabja,  hogyan legyen listázva az Attribute  Data  a 

listed  in BATTMAN-nél. 
 

 

  Válassza ki a negyedik attribútumot,  'COLOR', ezután kattintson az 'Edit'-re (szerkesztés). 

Jelölje az 'Auto  preview changes' a bal alsó sarokban és jelölje az 'Invisible'  a Mode területen. 

'Color'  attribútum láthatatlanná válik. Az attribútum értékeket szerkeszteni lehet a Data 

területen jobb oldalt. 
 

 
 

   A 'Text  Options' fül gondoskodik a szöveg beállításokról az attribútum részére,  ilyen 

mint a Text  Styles (szöveg stílus), Justification (igazítás), Height (magasság),  Rotation 

(elforgatás),  Width (szélesség) és Oblique angle (Ferdeszög). 
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  A 'Properties' fület használva, a felhasználó szerkesztheti a blokkhoz a fóliát, vonaltípust, 

színt és a vonalvastagságot.  
 

 
 

 

  Klikk 'Settings' (Beállítás) a 'Block  Attribute Manager' dialógus panelben. 

A 'Block Attribute Settings' dialógus panelben a megjelenített listában beállításokat 

alkalmazhatunk. 
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4.8 ATTEXT parancs 
 
 
 

Kivonatolja a tulajdonság adatokat az attribútum blokkból a rajzon a fájlhoz. 
 
 
 
 

Menü 

Eszköztár 

RSzalag 

Parancssor ATTEXT 

 
 

 
Kivonatolja az attribútum szövegeket és számokat amely az attribútum blokkban van megadva, 

és elmenti mint adat(TXT) fájl. A parancs használatához  lenni kell Template File-nak. Attól 

függően, hogy milyen tartalmat adott meg ebben a fájlban, határozza meg a kivonatolt 

attribútum adatokat. Ezt a fájl kiterjesztést egyszerűen létre lehet hozni notepad-del és a 

kiterjesztés.txt.  Három további  .txt  fájl létrehozás lesz  a fenti fájl leírás szerint. Pr
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ATTEXT(Attribute  Extract)  parancs használata 

 
Szúrjon be 3 blokkot különböző attribútum értékekkel a rajz területen. 

 

 
 

  Készítsen Notepad fájlt az adat kivonatoláshoz. Mentse el mint BLK-TPL.txt .  a bal oszlop 

a TAG (Cimke) és a másik oszlop az adat a kivonatoláshoz. Rendezze, ha az adat szám (N) 

vagy karakter(C), ezután adjon meg Integer/Decimal számokat. 
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  Üsse be az ATTEXT parancsot az "Extract  Attributes" (Attribútum 

kiemelése) dialógus panel megnyitásához. 
 

 

 Klikk "Select" és pikkeljen az összes attribútum blokkra  a rajzban. 

 Select Extract in CDF Format. 

Klikk "Browse" (Tallóz)  a "Template  File" (Sablon) jobb oldalán,  ezután válassza 

a Notepad fájlt a , -részből "BLK-TPL.txt". 

Klikk "Browse" (Tallóz)    az "Output  File" (Kimeneti) jobb oldalán, ezután rendeljen hozzá 

útvonalat és üsse be a nevet mint 'CDF.  txt'. 

 
  Adat kiemelés az "Extract"  (Kiemel) gombra nyomással. 

A kivonatolt Notepad  fájl a következőképpen fog kinézni.  

 

 
 

  Más adat formátumokkal való kivonatolás (SDF, DXF) az ATTEXT paranccsal. 
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Exercise  59 Konvertálja a csavarokat külső blokkba az attribútumaival. 
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05   Külső hivatkozás 
 

 

5.1 Külső hivatkozás áttekintése 
 
 
 

Elektromos huzalozás diagram megtervezéséhez szükség van a struktúrára vagy az alaprajzra. 

Abban az esetben könnyű megtervezni az elektromos huzalozási diagramot, ha elhelyezi a 

struktúrát és az alaprajzot mint hátteret. Ezt az eszközt külső hivatkozásnak (XREF) nevezzük.  

Használhatja az  ATTACH,   OVERLAY,   BIND,  DETACH,   RELOAD, UNLOAD vagy a RENAME  

és a módosító PATH-t az aktuális rajzon. 
 
 

Külső hivatkozás tulajdonságok 
 
 

•  Az aktuális rajz csak a külső hivatkozás mutatóját a nevet és útvonalat tartalmazza.  

•  Az aktuális rajz mérete nem növekszik a külső hivatkozásokkal. 

•  Automatikusan frissül, amikor az aktuális rajzot megnyitják. 

•  Hozza saját vonal típusát,  fóliát,  szöveg stílust stb. 

•  Ha a külső hivatkozás blokká válik, azután beleágyazódik az aktuális rajzba. 

•  Nem lehet a rasztereket kezelni (snap). 

•  Nem lehet egyedileg szerkeszteni az aktuális rajzban. 

•  Ki lehet nyomtatni. 

•  El lehet különíteni az aktuális rajztól. 

•  A mutatóját szerkeszteni lehet. 

•  Ismételten be lehet tölteni az aktuális rajzba. 

•  Be lehet ágyazni. 

•  Nyírható (trim), csak a megjelenített 

 részt. Pr
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5.2 XREF  parancs 
 
 
 

Megjeleníti a külső hivatkozás palettát. XREF parancs megnyitja a külső hivatkozás palettát 

amikor a  paletta deaktivált. Amikor a külső hivatkozás paletta aktivált, de rejtett, futtassa az 

XREF parancsot a paletta megnyitásához. Ha egy ideiglenes külső pontra kattint a külső 

hivatkozás pallettánál, az láthatatlan lesz.  

 
Menü  Insert  ➤ External  Reference... 

Eszköztár   

Szalag Home ➤ Insert ➤ External Reference... 

 
Parancssor  EXTERNALREFERENCE 

 

 
 
 

 
 

 

A külső hivatkozás paletta összeállítja, megjeleníti és kezeli a külső hivatkozás rajzokat, a csatolt  DWF,  

DWFx, DWFX vagy DGN  alátét rajzokat vagy a behozott raszter fájlokat. A DWG,  DWF, DWFx és a 

raszter fájlokat meg lehet nyitni a külső hivatkozás palettából. Pr
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5.3 XATTACH  parancs 
 
 
 

Szúrjunk be DWG  fájlt mint külső hivatkozás (XREF).  A külső hivatkozás fájlt a dialógus panel 

megjeleníti. 'Attach  External Reference'  (Külső hivatkozás csatolása) dialógus panel  megjelenik 

amikor a DWG fájlra kattint. 

 

 
 

 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

476 

 

 

 
 

 

 
 

5.4 Külső hivatkozás fóliák 
 

 
 

 
 

Amikor a külső hivatkozás rajz van a fóliához csatolva; 

 

 
•  Minden külső referencia fólia neve minősítve lesz | szimbólummal. 

Például, a HOUSE|WALL,  HOUSE neve a külső hivatkozás rajznak és  a  

WALL   a fólia neve. 

•  XREF azt jelenti, hogy a külső hivatkozás alárendelt objektum. 

•  Kezelni tudja a külső hivatkozás fóliáknak ON/OFF állaptait. 

•  0 fólia az aktuális rajz 0 fóliáján létezik.    

•  Külső hivatkozás fóliákat nem lehet létrehozni a hivatkozott rajzból. Pr
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The  follow ng  concepts are  d scussed in  h s  chapter: 

D mens on  Ove v ew 

D mens on  S y e 

Linea   Dimension 

Radial D mension 

O he   Dimensioning Commands 

Annotations w th Leade 

 
 

 
 

 

 
 
 
 
 

09 
 

 

Méretezés 
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01    Méretezés áttekintés 
 
 

Miután a forma megrajzolása kész, rögzítjük a megrajzolt alagzat méretét. A méret tisztán megadja a 

tervező tervezési szándékát az embereknek, akik a rajzot megnézik, ezért határozottan kell a méreteket 

megadni, de nem átfedéssel.  Helyes eszközök használatával módja van ezeket megrajzolni a CADian-ban.  
 
 

A CADian két eszközt kínál a méretezéshez. 
 

 

•  Méretezés parancs 

•  Méretezés változó 

 
Méretezés parancsokat használjuk az aktuális méretek felvételéhez az alakzaton és a méretezés 

változót használjuk a méretezés stílus megadásához.  

A méret egy komplex objektum, amely méretvonalból, méret-segédvonalból és méret szövegből áll, amelyet 

különböző méretezés parancsok és változók határozzák meg. A méret stílus támogatja a felhasználó 

által megtervezhető méret megjelenítést.  
 

Az összes méretelem asszociatívként  működik. Ha szétveti a méret objektumot a méret tulajdonságokat 

nem lehet alkalmazni vagy nem lehet ennek  stílusát kezelni. Ne vesse szét a méret objektumot, 

hacsak nincs szüksége rá.  
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A méret felvétel nem csak megjeleníti az alakzat méretét, de rendezi a megvalósítás sorrendjét is. 
 
 

A következő két mód van, hogy felvegye a méreteket a CADian-ban.   

 
 

•  Meghatározza a méret stílust és személyesen begépeli a Dimension  (Méret) parancsot a 

parancssorba.  

•  Gépelje be a DIM vagy DIM1 és használja a Dimension  parancsot a méret felvételéhez 

Dimension  Record Mode-ban miközben változtatja a méret változókat (Dimension  

Variables), amikor szükséges. 

 
CADian különböző méretező eszközről gondoskodik, amellyel a felhasználó gyorsan felveheti 

az alakzatok méreteit. A méretezés majdnem teljesen automatizált a CADian-ban. 

A reláció méretezés vonalból nyílból és szövegből áll össze, és méret paranccsal kezeljük. CADian 

méret egy speciális blokk, amelyet szerkeszteni lehet, és eltávolítani amennyiben szükséges.   
 

 

 
 

Méret kategóriák: 
 

 

•  Hosszirányú méretezés 

•  Sugár méret 

•  Szög méret 

•  Koordináta méretezés 

•  Ív hossz méretezés 

•  Méret mutatóvonallal 
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1.1 Méretezési szabályok 
 
 

•  Méretvonalak és a méret-segédvonalak vékonyak,  folytonos vonalak. 

•  A nyíl 1    3 mm méretű, amely a méretvonal véghez van hozzáadva. 

•  A méret segédvonal túlérése  2  3 mm a méretvonal fölött. 

•  1.5mm hézag van a  látható vonal és a méret segédvonal között.  

*   Megjegyzés - nincs hézag, ha a méret segédvonal a középpontból van rajzolva. 

•  Általában, a méretszöveg mérete 3.15  6.3 mm, de legtöbbször  3.15mm. 

•  A méretszöveg  úgy 1 mm-re van a méretvonal fölött. 

•  Két méretvonal közötti hézag 8 ~  10mm hosszan. 

 
 

 

1.2 Kiegészítő méret szimbólumok 
 
 

Ha egy objektumot az előnézettel lehet teljesmértékben kifejezni,  a tervező nem rajzolja meg 

a rajz többi részét. Helyette a következő méretezési szimbólumokat használja a rajz 

helyességéhez.  
 

 

Szimbólum 
 

Leírás 
 

  Szimbólum 
 

Leírás 

 

 

Átmérő  

 

Gömb átmérő 

 

 

Sugár  

 

Gömb sugár 

 

 

Vastagság  

 

Négyszög oldala 

 

 

Letörés  (45°) 
 

 
 

 

Ív hossz 

 

 

Reference  Dimension  

 

Alap méretezés szimbólum 
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02   Méretstílus 
 

 

2.1 Méretstílus áttekintés 
 
 
 

A rajzon lévő összes méretvonal és irány vonal a méretstílussal van meghatározva és igazítva. 
 

A méretstílus egy méretezési eszköz, amely igazítja a méretvonalat, méret-segédvonalat, a nyíl 

stílusát és méretét, a szöveg elhelyezést és méretét, arányát, a mértékegység és tűrés illesztését.  

Használja a méretstílust, hogy gyorsan beállítsa a kívánt méretezési formátumot és fenntartsa 

az állandó méreteket az összes projekt részére.  
 

 
•  Alkalmazza a 'Current  Dimension style'  (Aktuális méretstílus) beállítást, amikor felveszi a 

méretet.  

•  Szerkessze a méretstílus beállítását, hogy automatikusan frissítse az összes méretet, 

amelyik ezt a stílust használja.    

•  Állítsa be  a 'Dimension  sub-style' (Méret al-stílust), hogy alkalmazza az egyéni 

méretstílust, amely független az aktuális méretstílustól.    

•  Ideiglenesen felülírja a méretsílust szükség esetén.   
 

 
 

2.2 Méretstílus parancs 
 
 
 

DIMSTYLE parancs  használja a  'Dimension  Style  Manger'  (Méretstílus kezelő) dialógus 

panelt, hogy új méretstílust hozzon létre, beállítsa az aktuális méretstílust. 
 

 

Új méretek használatához alkalmazza az Aktuálissá tételt (Set Current) a Méretstílus kezelőben 

(Dimension  Style  Manager).  Amikor megnyitja az új rajzot, az támogatja a   'Standard',  'ISO-

25',  'Annotation' amely  segít  új  stílusok létrehozásában.  Az alapértelmezett stílus ISO-25, 

hacsak nem egy másik stílust nem tesz aktuálissá.    Pr
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❏ Méretstílus parancs elérése 

 
 

 

Menü Format  ➤ Dimension  Style... 

 

Eszköztár  

 

Szalag Home ➤ Format ➤ Dimension  Style... 

Parancssor DIMSTYLE 

 

 

❏ Méretstílus kezelő 

 

 

 
 

 

❏ Méretstílus opciók 

 

 
 

Option 
 

Description 
 

 

Aktuális méretstílus 
 

Megjeleníti az aktuális méretstílus nevét.  A méretek ezen stílus szerint lesznek rajzolva. 
 

 

 

Stílusok 
 

Megjeleníti a megadott méretstílusok listáját. 
 

 

Lista 
 

Beállítjuk, hogy hogyan jelenjen meg a stílus lista. 
 

 

Előnézet 
 

     Megjeleníti a minta alakzat alkalmazott beállításait mindegyik stílushoz. 
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Opciók Leírás 

 

 

Set  Current  
Beállítja a kiválasztott stílust a listából az aktuális stílushoz.   

 
New Megnyitja a Create  New Dimension  Style  dialógus panelt, hogy új méretstílust készítsen. 

Modify Megnyitja a Modify Dimension Style dialógus panelt, a kiválasztott stílus szerkesztéséhez. 

Override  Megnyitja az Override  Current  Dimension  Style  dialógus panelt, amely ideiglenesen 
átdefiniálja az aktuális stílust. 

 

Compare  
Megnyitja a  Compare  Dimension  Style  dialógus panelt amely megjeleníti az összes 

stílus tulajdonságot  a két méretstílus összehasonlításához.   

 
 
 

❏ Méret alstílus készítés 
 

 

❶ Válassza ki a stílust, amelyet alstílusként szeretne létrehozni a Méretstílus kezelőben és 

kattintson a  az  'New' (Új) gombra. 

❷ Válassza ki a stílus típust, amelyet alstílusként szeretne használni   'Use   For' (Használat) 

listából a 'Create   New Dimension  Style' (Új méretstílus létrehozása)  dialógus ablakból és 

kattintson a 'Continue' (Folytatás)  gombra. 
 

❸ Válassza ki a releváns fület  a 'New  Dimension Style'  dialógus panelben, szerkesszen és 

adja meg az alstílus méretet és kattintson az 'Ok'  gombra. 
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❏ Méretstílus összehasonlítás 

 

 
Klikk  "Compare(C)"  (Összehasonlítás) gomb a Méretstílus  dialógus panelben és jelöljön ki két 

méretstílust az ősszehasonlításhoz. Ezután  "Compare  Dimension Styles"   (Méretstílusok 

összehasonlítása) dialógus panel megjelenik, amellyel összehasonlíthatja a méretstílusok összes 

tulajdonságait.  
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Méretstílus beállítása  (Performance  Test  Standard  for the  Certified  Technician) 

 
 Klikk (Dimension  Style) ikon a 'Dimensions'  (Méret) panelre, 'Annotate'  fül szalagon . 

 

 Klikk  "New"  (Új) gomb a "Dimension  Style  Manager"  Méretstílus kezelő dialógus 

panelen. 
 

 Léptesse be az új stílus nevét, MY-STD, a  'Create  New Dimension  Style'  dialógus 

dobozban, klikk  'Continue' (Folytatás). 
 

 
 

  Menjen a   'Lines'  fülhöz,  állítsa be az opciókat, mint lentebb. 
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  Menjen a  'Symbols  and Arrows'  (Szimbólumok és nyilak)-hoz,  állítsa be az 

opciókat, mint lentebb. 
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  Menjen a  'Text'  (Szöveg)-hez,  állítsa be az opciókat, mint lentebb. 
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  Menjen a  Fit   (Illesztés)-hez,  állítsa be az opciókat, mint lentebb. 

 
 

 
 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

Dimensioning   09 

489 

 

 

 

 
 

  Menjen a  Primary  Units   (Mértékegységek)-hez,  állítsa be az opciókat, mint lentebb. 
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  Menjen az  Alternate Units   (Alternatív egységek)-hez,  állítsa be az opciókat, mint 

lentebb. 
 

 
 

  Menjen a  Fit   (Illesztés)-hez,  állítsa be az opciókat, mint lentebb.  
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2.3 Méret változók 
 
 

Méret változók estközökkel támogatják azt, hogy a méret objektumok megjelenését kezelni tudja. Használhatja 

a DIMSTYLE  parancsot, de szerkesztheti a  beállítást a  Command:(Command   Mode)  vagy 

Dimension:(Dimension  Mode). 
 

 

❏ DIMTOFL változó 

 

 
Parancs:  DIMTOFL 

 

Léptesse be az új értéket a DIMTOFL  <OFF>:  0 
 
 

 
 

❏ DIMTOH,  DIMTIX változó 

 

 
Parancs:  DIMTOH 

 

Léptesse be az új értéket a DIMTOH  <ON>:  1 

Parancs: 
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2.4 DIMOVERRIDE  parancs 
 
 
 

A rendszerváltozó átírását állítja be a kiválasztott mérethez. Átírja a jelölt kiválasztott méret 

rendszer változóját, vagy a kiválasztott méret átírását távolítja el, és visszaállítja az idevágó 

méretstílust, amely a kiválasztott méret objektumhoz lett meghatározva.  
 

 
 
 

Menü  Dimensions  ➤ Override 
 

 
Eszköztár 

 

Szalag  Home ➤  Dimensions  ➤ Override 

 
Parancs  DIMOVERRIDE 

 
 
 
 

 
Command:  _DIMOVERRIDE 

 

Enter dimension  variable  name  to override  or [Clear  overrides]:  DIMCLRD 

DIMCLRD  is  now <BYBLOCK>.    New value:  1 

Enter dimension  variable  name  to override: 

Select  dimensions  to change: P1 

Entities  in  set:  1 
 

Select  dimensions  to change: 
 

 
 

 
 

 
 
 

Parancs:  DIMOVERRIDE  Pr
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Enter dimension  variable  name  to override  or [Clear  overrides]:  DIMTXT 

DIMTXT  is  now  <3>.    New value:  5 

Enter dimension  variable  name  to override: 

Select  dimensions  to change: P1 

Entities  in  set:  1 
 

Select  dimensions  to change: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Command:  DIMOVERRIDE 
 

Enter dimension  variable  name  to override  or [Clear  overrides]:  DIMTAD 

DIMTADis  now <1>.    New value:  0 

Select  dimensions  to change: P1 

Entities  in  set:  1 
 

Select  dimensions  to change: 
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2.5 DIM/UPDATE  parancs 
 
 
 

DIM/UPDATE parancs alkalmazza az aktuálisan beállított méretstílust a rajzban,  elmenti vagy 

helyreállítja a méret felvétel rendszerváltozót, amint kiválasztotta a méretstílust.  Ezt a 

parancsot szintén használhatja a méretstílus szerkesztéséhez. A méretstílus nem 

automatikusan frissül eltérően a szövegstílushoz.  UPDATE parancs használható a méretek 

megerősítéséhez az aktuális szöveg stílushoz. 

 

 
Menü  Dimensions  ➤ Update 

 
Eszköztár  

 

Szalag Home ➤Dimensions  ➤ Update 

 
Parancssor  -DIMSTYLE 

 

 
 
 
 

Méretek frissítése és újra definiálása  
 

 
 

  Klikk Override  (Felülbírálás) a  Dimension  Style   Manager (Méretstílus kezelő) dialógus dobozban. 
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  Állítsa be a méretvonalat és a méret-segédvonalat kékre  a 'Lines' (Vonalak) fülön. 
 

 
 

  Állítsa be a nyíl méretét 5-re a 'Symbols  and Arrows' (Szimbólumok és nyilak ) fülön. 
 

 
 

  Állítsa be a 'Text  color'-t  kékre, 'Text  height'  (Szöveg magasságot) 5.0-re  a Text 

appearance  területen, és állítsa be a 'Vertical'  mint  Centered,  'Offset  from dim 

line'  2.0 a Text elhelyezés területen. 
 

 
 

  Klikkelés az 'OK'-ra és visszatérés a   'Dimension  Style  Manager'  dialógus dobozhoz. 

<Style  overrides>   létrehozva,  és mostmár ez az aktuális méretstílus. 
 

 
 

Klikk 'Close' (Bezár), hogy kilépjen a  Dimension   Styles  Manager -ből (Méretstílus 

kezelőből). 
 
 
 

  Klikk (Apply Style)  ikon az  'Annotate'  fülön 'Dimensions'  panelen, ezután 

kattintson a méretekre. 
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Kódok a rajzi szimbólumokhoz 
 
 

 
Kód Leírás Példa Input Példa ábra 

 
 

%%u 
 

Vonalat rajzol egy szöveg alá 
 

%%uCAD 

 

%%d 
 

Szöget rajzol 
 

50%%d 

 

%%p 
 

Tűrés jel 
 

%%p50 

 

%%c 
 

Átmérő 
 

%%c50 

 

%%% 
 

Százaleék jel 
 

50%%% 

 
 
 

 
Kód Leírás Példa Input Példa ábra 

 
%%O Vonalat rajzol egy szöveg fölé %%oHole 

 
%%U Vonalat rajzol egy szöveg alá %%uHole 

 
%%D Fok jel  45%%d 

 
%%P Tűrés jel 20%%p5 

 
%%C Átmérő jel %%c30 

 
%%% Százalák jel 45%%% 

 
%%%nnn ASCII  kód %%100 
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03   Hosszméret 
 
 

Amikor a tervezett alakzat minden irányban elkészült,  mielőtt felvennénk a méreteket,  

figyelembe kell venni a gyártási módokat,  megvalósítási sorrendet és a mozgatási állapotot a 

bázisvonal megrajzolásához.  Ha van egy pont, amely bázis a gyártáshoz vagy építési 

folyamathoz, rögzítsük a méreteket ehhez a ponthoz.    
 

Vannak méretek  (a) megjeleníti a méretet és (b) megjeleníti a helyet.   Amikor a két méretet 

felvesszük  ez  a  (c)-hez fog hasonlítani. Az összes méret felvételre került. 
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3.1 Hosszméret parancs   
 
 

Hosszméret rajzolás vízszintesen, függőlegesen vagy elforgatott méretvonallal.    
 

 
 

 
 

Menü  Dimensions  ➤ Linear 
 

 
Eszlöztár 

 

Szalag Home ➤  Dimensions  ➤ Linear 

 
Parancssor  DIMLINEAR 

 

 

•  Szalag alatt ‘Annotate’(Feliratozás)  fül  ‘Dimension’  panel,  Klikk ‘Linear’ (Hosszirányú) kirepülő és klikk 

(Hosszirányú méretezés)  ikon. 
 

 
Command:  _DIMLINEAR 

ENTER to select  entity/<Origin  of  first  extension  line>:  P1 

Origin  of  second extension  line:  P2 

Angle/Mtext/Text/Orientation  of  dimension  line/Horizontal/Vertical/Rotated:  P3 Pr
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❏ Opciók 

 
 

•  Bekezdéses szöveg  -  Belső szövegszerkesztő megjeleníti, ahol a méret szöveget 

szerkeszteni lehet. Hozzáadva a fejlécet és a láblécet, gépelje be az egyiket a kettőből a 

méret létrehozás előtte vagy után.  Speciális karakterek gépeléséhez, használjon kontroll 

kódot vagy unicode-ot. 

 

 
•  Text -  Gépeljen új méret szöveget a parancssorba . 

 

•  Angle  (Szög)-  Szerkessze a méretszöveg fokát. 

 

 
•  Horizontal/Vertical/Rotation  (Vízszintes/függőleges/forgatás)-  Létrehoz vízszintes, függőleges 

vagy elforgatott hosszméretet.   
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3.2 Igazított méret parancs   
 
 

Igazított méret parancs használata dőlt méretek használatához.   
 

 
 

Menü  Dimensions  ➤ Aligned 

 
Eszköztár  

 

Szalag Home ➤ Dimensions  ➤ Aligned 

 
Parancssor DIMALIGNED 

 

 
 

•  Klikk [Dimension] (Méretezés) ⇨ [Aligned] (Illesztett) a legördülő menüben vagy 

kattintson a  Linear (Hosszírányú méretezés) kirepülőre a szalag menün, 

   'Annotate'  (Feliratozás) fül a  'Dimension' (Méretezés) panelen és az    (Aligned)  ikon. 

 
 

Command:  _DIMALIGNED 

ENTER to select  entity/<Origin  of  first  extension  line>:  P1 

Origin  of  second extension  line:  P2 

Angle/Mtext/Text/<Location  of  dimension  line>:  P3 
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3.3 DIMJOGLINE parancs 
 
 

Dőlt vonalat hozzáad vagy eltávolít a hossz vagy igazított méretnél.   
 

 
 

Menü  Dimension  ➤ Jogged  Linear 

 
Eszköztár  

 

Szalag  Home ➤ Dimension  ➤ Jogged  Linear 

 
Parancssor  DIMJOGLINE 

 
 

 

•  Gépelje DIMJOGLINE parancssorba. 

 
 
 

Command:  _DIMJOGLINE 

Select  dimension  to  add  jog  or [Remove]:  P1 

Specify  jog  location  (or  press  ENTER):  P2 
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3.4 Koordináta méret parancs 
 
 

Vízszintes vagy függőleges koordináta méretet ír. 

 
Menü Dimensions  ➤ Ordinate 

 

 
Eszköztár 

 

Szalag Home ➤ Dimensions  ➤ Ordinate 

 
Parancssor DIMORDINATE 

 

 
 

•  Klikk [Dimension] (Méretezés)  ⇨ [Ordinate] (Koordináta) a legördülő menüben. 

•  Klikk  "Linear" (Hosszirányú mértezés) kirepülő eszköztár a szalagon  "Annotate"  

(Feliratozás) tab  "Dimension" (Méretezések) panel és  ikon. 
 

 
 

Command:  _DIMORDINATE 

Select  point  for  ordinate  dimension:  P1 

Text/Angle/X  datum/Y  datum/<Leader  endpoint>: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

Megjegyzés)  Használja a UCS (Felhasználói koordináta rendszer) parancsot, hogy 

megadja a   kezdő és koordináta méretet. Pr
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3.5 DIMCONTINUE  parancs 
 
 
 

További méreteket hoz létre automatikusan  felhasználva a legutóbb létrehozott hossz, 

szög vagy koordináta méretet,  vagy a kiválasztott méret bázispontját.  A méreteket 

automatikusan elrendezi. 
 
 
 

Menü Dimensions  ➤ Continue 

 
Eszköztár  

 

Szalag Home ➤ Dimensions  ➤ Continue 

 
Parancssor DIMCONTINUE 

 

 
 
 

•  Klikk  'Linear'  (Hosszirányú mértezés) kirepülőre  a szalagon   Annotate  (Feliratozás) 

fülön  Dimension (Méretezés) panelen és   (Linear)   ikon. 
 

 
 

Command:  _DIMLINEAR 

ENTER to select  entity/<Origin  of  first  extension  line>:  P1 

Origin  of  second extension  line:  P2 

Angle/Mtext/Text/Orientation  of  dimension  line/Horizontal/Vertical/Rotated:  P3 
 
 

 

•  Klikk   ikon a szalagon  'Annotate' fülön Dimension (Méretezés)  panel. 

 
 

Command:  _DIMCONTINUE 

Continue: ENTER to select starting dimension/Undo/<Origin of next extension  line>:  P1 

Continue: ENTER to select starting dimension/Undo/<Origin of next extension  line>:  P2 

Continue: ENTER to select starting dimension/Undo/<Origin of next extension  line>:  P3 
 

Select  dimension  to  continue: Pr
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Command:  _DIMCONTINUE 

Select  dimension  to  continue:  D1 

Continue: ENTER to select starting dimension/Undo/<Origin of next extension  line>:  P1 

Continue: ENTER to select starting dimension/Undo/<Origin of next extension  line>:  P2 

Continue: ENTER to select starting dimension/Undo/<Origin of next extension  line>:  P3 
 

Select  dimension  to  continue: 
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3.6 DIMBASELINE  parancs 
 
 

Méretezéshez használja a bázisvonalast, hogy méretsorozatot rajzoljon egy bázisvonalhoz.    
 

 

 
Állítsa be újra az alapértelmezett hézagot a bázidvonal méretek között  a [Dimension  Style   Manager]   

(Méretstílus kezelő) ⇨ [Select]  ⇨[Baseline  spacing (DIMDLI   System Variable)]. 

 
 

Menü  Dimension  ➤ Base  line 

 
Eszköztár  

 

Szalag Home ➤ Dimension  ➤ Base  line 

 
Parancssor DIMBASELINE 

 

 
 

•  Klikk [Dimension]  (Méretezés) ⇨ [baseline]  (Bázisvonalas méretezés) a legördülő menüben. 

•  Klikk Continue  a szalagon  'Annotate' (Feliratozás)  fül  'Dimension' (Méretezés)  és  ikon. 

 
 

Command:  _DIMLINEAR 
 

ENTER to select  entity/<Origin  of  first  

extension  line>: Select  entity  to 

dimension:  E1 

Angle/Mtext/Text/Orientation  of  dimension  line/Horizontal/Vertical/Rotated:  P0 Pr
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Command:  _DIMBASELINE 

Baseline: ENTER to select starting dimension/Undo/<Origin of next extension line>:  P1 

Baseline: ENTER to select starting dimension/Undo/<Origin of next extension line>:  P2 

Baseline: ENTER to select starting dimension/Undo/<Origin of next extension line>:  P3 

Baseline: ENTER to select starting dimension/Undo/<Origin of next extension line>:  P4 

Baseline: ENTER to select starting dimension/Undo/<Origin of next extension line>:  P5 

Baseline: ENTER to select starting dimension/Undo/<Origin of next extension line>: 
 

Select  dimension  for  baseline: 
 
 

 
 

 

Command:  _DIMBASELINE 

Baseline: ENTER to select starting dimension/Undo/<Origin of next extension line>:  P1 

Baseline: ENTER to select starting dimension/Undo/<Origin of next extension line>:  P2 

Baseline: ENTER to select starting dimension/Undo/<Origin of next extension line>:  P3 
 

Select  dimension  for  baseline: 
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04 Átmérő és sugár méretek 
 

 

4.1 Átmérő méret parancs 
 
 

Körhöz vagy ívhaz adja meg az átmérő méretet. 

 
Menü Dimension(N)  ➤ Diameter(D) 

Eszköztár  

Szalag Home ➤ Dimension  ➤ Diameter 

 
Parancssor DIMDIAMETER 

 

 
 

•  Klikk [Dimension]  (Méretezés) ⇨ [DIAMETER]  (Átmérőméret) a legördülő menüben. 

•  Klikk  'Linear' (Hossz-ir.) kirepülőre a szalagon Annotate (Feliratozás) fülön és  (Átmérő) ikon. 

 
 

Command:  _DIMDIAMETER 

Select  arc  or circle:  P1 

Angle/Mtext/Text/<Location  of  dimension  line>:  P2 
 

 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

508 

 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

4.2 Sugár méret parancs   
 
 

Körhöz vagy ívhez adja meg a sugár méretet. Megméri a sugarát a kiválasztott körnek vagy 

ívnek és megjeleníti a sugár jelet a méretszöveggel a kiválasztott kör vagy ív előtt. Könnyen 

áthelyezheti a sugár méretet a fogó használatával.  

 
Menü Dimension(N)  ➤ Radius(R) 

Eszköztár  

Szalag Home ➤ Dimensions  ➤ Radius 

 
Parancssor  DIMRADIUS 

 

 

• Klikk 'Linear'  (Hosszirányú mértezés) kirepülőre  a szalagon   Annotate  (Feliratozás) fülön  és  

(Radius) ikon. 

 
 
 

Command:  _DIMRADIUS 

Select  arc  or circle:  P1 

Angle/Mtext/Text/<Location  of  dimension  line>:  P2 
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Exercise 60  Rajzolja meg a  következő objektumokat és szúrja be a méreteket. 
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4.3 Szögméret parancs 
 
 
 

Szögméret használata alakzat méréséhez a méret felvételéhez. Megméri a szögét a kiválasztott 

objektumnak, vagy mér a három pont között. Ív, kör és vonal objektumokat lehet kiválasztani.  
 

 
 

Menü  Dimension(N)  ➤ Angular(A) 

 

Eszköztár  

 

Szalag Home ➤ Dimensions  ➤ Angle 

 
Parancssor DIMANGULAR 

 
 

 

•  Klikk [Dimension] (Méretezés) ⇨ [Angle]  ( S z ö g )  a legördülő menüben. 

•  Klikk  'Linear' (Hosszir.) a szalag menün  Annotate  (Feliratozás ) panel és  (Szög) ikon. 
 

 
 

Command:  _DIMANGULAR 

Press  ENTER to  specify  angle/<Select  line,  arc,  or circle>:  P1 

Other  line  for angular  dimension:  P2 

Angle/Text/<Location  of  dimension  line>:  P3 
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4.4 DIMARC  parancs 
 
 

DIMARC parancsot használjuk egy vonallánc ív szegmens ívének vagy távolságának megméréséhez.  Ezt a 

parancsot gyakran használjuk egy kábel hosszának megméréséhez.     
 

 
 

Menu  Dimension(N)  ➤ Arc length(H) 

Toolbar  

Ribbon  Home ➤ Dimensions  ➤ Arc length 

 
Command  DIMARC 

 
 

 
Command:  _DIMARC 

Select  arc  or polyline  arc  segment:  P1 

Partial/Leader/Angle/Text/<Location  of  dimension  arc>:  P2 
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4.5 DIMJOGGED  parancs 
 
 

Megméri a kör vagy ív tört sugarát. Elképzelt középpontot hoz létre és felvételezi a tört sugarat. 

 
Menü Dimension(N)  ➤ Jogged(J) 

Eszköztár  

Szalag Home ➤ Dimensions  ➤ jogged 

 
Parancssor DIMJOGGED 

 
 

 

•  Klikk  (Jogged) (Megtört) ikon a szalagon  'Annotate'  (Feliratozás) panel. 

 
 
 

Command:  _DIMJOGGED 

Select  arc  or circle:  P1 

Specify  center  location  override:  P2 

Angle/Mtext/Text/<Location  of  dimension  line>:  P3 

Specify  jog location:  P4 
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05 További méretezés parancsok 
 

 

5.1 QDIM parancs 

 
 

 
 

QDIM parancsot használja a méret sorozatok gyors létrehozásához vagy szerkesztéséhez. Ez 

különösen hasznos a bázisalapú méretekhez, folytonos méretekhez, körök vagy ívek sorozatához.  

 

Menü  Dimension(N)  ➤ Quick Dimension(Q) Eszköztár

  

Szalag Home ➤ Dimensions  ➤ Quick  dimension 

 
Parancssor QDIM 

 

 

•  Klikk Quick  Dimension  (Gyors méretezés) ikon a szalagon ‘Annotate’ (Feliratozás)  fül 

‘Dimension’ (Méretezések) panel. 
 
 
 

Command:  _QDIM 

Select  geometry  to Dimension:  P1Entities  in  set:  1 
 

Select  geometry  to Dimension: [Continuous/Staggered/Baseline/  

Ordinate/Radius/Diameter/datumPoint/Edit/seTtings] 

<Continuous>:  P2 
 

 
 
 

Command:  _QDIM 

Select  geometry  to Dimension:  P1Entities  in  set:  1 
 

Select  geometry  to Dimension: 

[Continuous/Staggered/Baseline/Ordinate/Radius/Diameter/datumP

oint/Edit/seTtings] 

<Continuous>:  R Pr
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5.2 DIMCENTER  parancs 
 

 
 

Függ a méretvonal stílus beállítás értéktől, a közép jelet vagy vonalat automatikusan létrehozza 

tekintettel az átmérő vagy sugár méretre.   Csak akkor lehet létrehozni, ha a méretvonal létezik a körön, 

Szintén használhatja a parancsot, hogy kézzel készítsen középvonalat és jelet. Használja a középpont 

jeleket a Symbols and Arrows (Szimbólumok és nyilak) fülön  a ‘Dimension  Style Modify’ (Méretstílus 

módosítás) dialógus panelen, hogy beállítsa a nézetét középvonal és jel méretét. Használhatja a  

‘DIMCEN’  méret rendszerváltozót is. 

 

 
 

 
Menu  Dimension(N)  ➤ Center  Mark(M) 

Toolbar  

Ribbon Home ➤ Dimensions  ➤ Center  Mark 

 
Command  DIMCENTER Pr
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Command:  _DIMCENTER 

Select  arc  or circle:  P1 

 

 
 

 
 

 
 

A ‘Dimension Style’  dialógus panelben 

 ‘Symbols and Arrows’  (Szimbólumok és nyilak) fülön ‘Center marks’ (Középpont jel) területen, állítsa 

be mint lent a képen, és futassa a parancsot.  

 

 
 

 
 
 

5.3 Tűrés parancs 
 

 
 

Mérettűrések beállítása. A geometriai tűrés megjeleníti a hézag (menetemelkedés tűrés)  emelkedést, 

profil, alak, helyzet és kifutás tűrést. A menetemelkedés illesztés kerete tartalmazza az összes 

információt. 
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Tűrés érték 

Tűrés anyag terjedelem 
1. 2.  és  3. 
Bázis hivatkozás 

 

 

Opcionális átmérő szimbólum 

Geometriai tulajdonság szimbólum 

Anyag bázis állapot 

 
 
 
 

Menü Dimension(N)  ➤ Tolerance(T) 

 

Eszköztár  

 

Szalag Home ➤ Dimensions  ➤ Tolerance... 

Parancssor  TOLERANCE 

 

 

•  Klikk Tűrés... ikon  a szalagon  ‘Annotate’ (Feliratozás) fül   ‘Dimension’ (Méretezések) panel. Pr
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•  Symbol : A ‘Geometric  Tolerance’ dialógus panelben kattintás a fekete négyzetre a "Sym" (Jel) területen. 

Ezután,  a szimbólum dialógus doboz megjelenik, mint a lenti kép mutatja. 
 

 
 
 

 
Geometriai karakterisztika jelek 

 
Jel Karakterisztika Típus Jel Leírás Típus 

 

Pozíció tűrés 

      Helyzet
               Síklapúság 

Alak 

         Egytengelyűség                     Helyzet                              Circularity                           Alak 

           Szimetria                             Helyzet                                         Egyenesség                         Alak 

          Párhuzamosság              Helyzet                                  Felület profil                      Alak 

 

        Merőlegesség                            Helyzet                                             Vonal profil                       Alak 

 

         Hajlásszög                                 Helyzet                                                                Radiális                       Ütés 

 
Hengeresség   Alak    Teljes homlokütés  Ütés Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

518 

 

 

 
 

 
 

 
 

 
 

 

 
•  Tolerance  1 (Tűrés 1): Beállítja az 1. tűrés értékét. 

 

 

•  Tolerance 2 (Tűrés 2): Beállítja az 1. tűrés értékét. 

 

 

•  Datum 1 (Bázis 1): Standard bázis hivatkozást készít. 

 

 
•  Datum 2 (Bázis 2): Standard bázis hivatkozást készít 

 

•  Datum 3 (Bázis 3): Standard bázis hivatkozást készít 

 

 

•  Height (Magasság) : Beállítja a kivetített tűrés zóna értéket. 

 

 
 
 

•  Projected tolerance zone  (Kivetített tűrés zóna): Beszúrja a kivetített zóna jelet a tűrés zóna érték után. 

 

•  Datum identifier (Bázis azonosító): Megkülönböztető bázis jeleket készít kararterekkel. 
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06   Méret szerkesztése 
 

 
DIMEDIT és DIMTEDIT parancsot használja a méret szövegének elhelyezésének beállításához.    

 

 

6.1 Méret szövegek szerkesztése 
 

 
 

‘Multiline Text(M)’ (Bekezdéses szöveg) és ‘Text(T)’ (Szöveg) méretezés opciók parancs lehetővé teszi, 

hogy módosítsa a szöveget, amely a méretvonalon jelenik meg. 
 

‘Text(T)’  gondoskodik az egysoros szövegbevitelhez,   a ‘Multiline  Text(M)’  (Bekezdéses szöveg) 

opció  támogatja a  tulajdonságokkal bővített formatálható méretszöveget.  Ilyen opciókat használunk a 

mért távolságok módosításához vagy megjegyzés hozzáadását a mérethez.    
 

 
 

 
 

Command:  _DIMRADIUS 

Select  arc  or circle:  P1 

Angle/Mtext/Text/<Location  of  dimension  line>:  T 

Dimension  text  <18>: 

Angle/Mtext/Text/<Location  of  dimension  line>:  M 

Angle/Mtext/Text/<Location  of  dimension  line>: 
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6.2 Méretszöveg szerkesztés parancs 
 
 
 

Méretszöveg szerkesztés parancsot használjuk az egyedi méretszöveg elhelyezés módosításához.   Ez a 

parancs dinamikusan beállítja a szöveg helyét vagy más nemhasznált helyre mozgat. Például, For 

example,  a kép szövege dinamikusan el lett mozgatva jobb oldalra. Ezután a szöveg elmozgatásra kerül  

a szög opcióval.  

 

 
 

 
 

Menü  Dimension(N)  ➤ Edit  Dimension  Text(X) 

Eszköztár  

Szalag Home ➤ Dimensions  ➤ Edit  Dimension  Text 

 
Parancssor  DIMTEDIT 

 
 
 

Command:  DIMTEDIT 

Select  dimension:  P1 

Specify  new  location  for  dimension  text  or /Left/Right/Center/Home/Angle: 
 
 

❏ Opciók 

 

•  Új hely megadása a méretszövegnek : Ragadja meg a méretszöveget és dinamikusan mozgassa. 

 

 

•  Left(L) (Bal) : Csak a hosszirányú,  sugár  és átmérő méreteknél. 

 
 

 

•  Right(R) (Jobb) : Csak a hosszirányú,  sugár  és átmérő méreteknél.Pr
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•  Center(C) : Elmozgatja a méretszöveget  a méretvonal közepéhez. 

 
 
 

•  Home(H) (Alaphelyzet) : Elmozgatja a méretszöveget  az alapértelmezett helyhez.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 

•  Angle(A) (Szö g) : Megváltoztatja a méretszöveg szögét. 
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6.3 Méret szerkesztés parancs 
 
 

 Méretszöveg szerkesztés parancsot használjuk a méretszöveg és a méret segédvonal szerkesztéséhez. 

Például, a méretszövegnek adható fej és lábléc szöveg. 
 

 
 
 
 
 

Menü Dimensions  ➤ Jogged 
 

 
Eszköztár 

 

Szalag Home ➤  Dimensions  ➤ Jogged 

 
Parancssor DIMEDIT 

 
 
 
 

Command:  _DIMEDIT 

Enter type  of  dimension  editing:    Home/New/Rotate/Oblique/<Home>: 

 
❏ Opció 

 

 

•  Home(H) (Alaphelyzet) : Elforgatja a méretszöveget az alaphelyzetbe . 

 
 
 

•  New(N) ( Ú j ) : A méretszöveget szerkeszti belső szövegszerkesztővel. 
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•  Rotate(R) (Forgat): Méretszöveget elforgatja. 

 
 
 

•  Oblique(O)  (Ferde): Beállítja a hosszirányú méret segédvonalat dőlt szögben. 

 
 
 

Ez az opció hasznos, amikor izometrikus nézet méreteit rajzolja.  Használja az ALIGN parancsot és 

szerkessze a tört szöget ahogy akarja.  Beállítás szöget jelent, mint 30,  330,  90  a szabványos méret 

irányokhoz. 
 

Ha pontos munkát végez izometrikus nézetben.   A hatékonyság végett használja az izometrikus nézet 

raszterpontokat/hálót.  
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6.4 Méret szerkesztés 
 
 
 
 

Válassza ki a méret objektumot és a fogó pontot, hogy megjelenítse a kurzor menüt, mint a lenti képen.   
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6.5 Mutató (LEADER)  parancs 
 
 

Rajzoljon jelölő vonalat, amely összeköti a kommentet a csúccsal. Ha lehetséges használja a DIMLEADER 

parancsot a jelölő vonal létrehozásához 
 
 
 

Menü Dimension(N)  ➤ Leader(E) 

 

Eszköztár  

 

Szalag Home   ➤ Dimensions  ➤  Leader 

 
Parancssor DIMLEADER 

 
 

 
Command:  LEADER 

Specify  leader  start  point:  P1 

Specify  next  point:  P2 

Specify  next  point or [Annotation/Format/Undo]  <Annotation>:  P3 
 

Specify  next  point or [Annotation/Format/Undo]  <Annotation>: 

Enter first  line  of  annotation  text  or <options>:  Corner  of 

Enter next line  of annotation  text:  Building 
 

Enter next line  of annotation  text: 
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Exercise  61  Rajzolja meg a következő objektumot és szúrja be a méreteket. 
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Exercise  62  Rajzolja meg a következő objektumot és szúrja be a méreteket. 
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Exercise  63  Rajzolja meg a következő objektumot és szúrja be a méreteket. 
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Exercise  64  Rajzolja meg a következő objektumot és szúrja be a méreteket. 
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Exercise  65  Rajzolja meg a következő objektumot és szúrja be a méreteket. 
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Exercise  66  Rajzolja meg a következő objektumot és szúrja be a méreteket. 
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Exercise  67  Rajzolja meg a következő objektumot és szúrja be a méreteket. 
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Exercise  68  Rajzolja meg a következő objektumot és szúrja be a méreteket. 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

 
 

CADian 2012 

534 

 

 

 

Exercise  69  Rajzolja meg a következő objektumot és szúrja be a méreteket. 
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Exercise  70  Rajzolja meg a következő objektumot és szúrja be a méreteket. 
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Exercise  71  Rajzolja meg a következő objektumot és szúrja be a méreteket. 
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Exercise  72  Rajzolja meg a következő objektumot és szúrja be a méreteket. 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

 
 

CADian 2012 

538 

 

 

 

Exercise  73  Rajzolja meg a következő objektumot és szúrja be a méreteket. 
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10 
 

 

Kirajzoltatás 
 

 
 
 
 
 
 
 

A következő fogalmakat tárgyaljuk meg ebben a fejezetben: 

 •  Kirajzoltatás 

 •  Rajzkezelések összefoglalása 
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01    Kirajzoltatás 
 

 
Miután a rajz elkészült, a felhasználónak ellenőriznie kell, és a méretarányt alkalmaznia, hogy pontosan ki 

tudja nyomtatni a papírra.  Továbbá meg kell adni a formátumot és a nyomtatás beállításokat, hogy 

módosítsuk a rajz megjelenését nyomtatásnál.   
 

Ha egy nagy projektben dolgozik, valószínűleg ki kell nyomtatnia a rajzot különböző megjelenésben és 

elrendezésben. Például létrehozhat egy rajzlapot, a tulajdonságok beállításánál használja a nyomtatási 

léptéket, nyomtatási területet, vagy a nyomtatási stílus táblázatot.   
 

A rajz nyomtatásához, meg kell értenie a nyomtató eszköz tulajdonságait. Az általános nyomtató eszköz 

a CADian-ban a Plotter, de számos felhasználó használ Laserjet vagy Inkjet nyomtatót. 
 

A nyomtató kényelmes és gyors, de nem tudja pontosan kinyomtatni a skálázott rajzot; ezért a printert csak 

ellenőrzésre használjuk mialatt tervezünk, vagy a végén.  Ha be akarja állítani a léptéket a nyomtatáshoz 

pontos mérettel, plottert kell használnia és nyomtassa ki fekete-fehérben.  
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1.1 Plotter kapcsolása és eszközmeghajtó installálás 
 
 

Azért, hogy használni tudja a nyomtatót vagy a plottert, először kapcsolja az eszközt és installálja az 

eszközmeghajtót (driver). Ha kérdése lenne, forduljon a nyomtató kézikönyvéhez.  
 

 

 
 

 
 

 

 
 

 

1.2 Oldalbeállítás (PAGESETUP) parancs 
 
 
 

A CADian-hoz használní kívánt nyomtatót hozzá kell kapcsolni és be kell állítani, úgy mint lapbeállítás 

elrendezés, nyomtató, papír méret stb. Szintén be kell állítani a kiválasztott nyomtató tulajdonságokat, 

mint a papír és nyomtatási irány.     

 
 

•  Klikk File ⇨ Print (Nyomtatás) a legördülő menüben. Pr
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Opció Funkció 
 

 

Set  Current  
Beállítja a kiválasztott  Lapbeállítást, mint aktuális Lapbeállítást. Az aktuális elrendezést 

nem  lehet beállítani, mint aktuális Oldalbeállítás.  
 

 

Add 
Hozzárendel egy nevet az új oldalbeállításhoz és megnyitja‘Add  Page  Setup’ (Oldal-

beállítás hozzáadása) dialógus panelt, hogy megadjon különböző beállítást és opciót. 

 
Modify Megnyitja a ‘Modify  Page  Setup’ (Módosítás oldalbeállítás) dialógus panelt, amely 

szerkeszti az aktuális beállításokat a kiválasztott oldalbeállításhoz.    

 
Delete Törli a kiválasztott oldalt.  

Name  Listázza a megadott oldalakat. 
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1.3 Rajzok plottolása 
 
 
 

PLOT parancs plottolja a rajzot a plotterre vagy print fájlba.  Interaktívan a CAD-ben a PRINT és a PLOT 

használható . Általában, a szöveget a nyomtatón nyomtatjuk ki, a vektor grafikát a plotteren. Valójában 

nincs nagy különbség a nyomtató és a plotter között, mostanában már sok nyomtató támogatja a vektor 

grafikát.  

 
 
 

Menü File(F)  ➤ Print(P) 

 

Eszköztár  

 

Szalag Home ➤ File  ➤ Print 

 
Parancssor PLOT 
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❏ Oldal beállítás 

 

 

•  Name (Név): Kiválasztja az elmentett oldalt a listában. 

•  Add button (Hozzáad gomb) : Hozzáadja az oldalbeállítást  felhasználva az aktuálisan beállított értékeket. 

 

 

❏ Nyomtató 

 

 

•  Name (Név): Kiválasztja a nyomtatót vagy a plottert. 

•  Properties  button (Tulajdonságok gomb): Megjeleníti a Plotterkondiguráció szerkesztőt, hogy 

megtekintse az aktuális nyomtató port, eszköz és medium összeállítások beállításait.  

 
 
 

 
 

 
 ❏ Paper Size:  A papír méretének beállítása. 

 

 

❏ Print  Scale (Nyomtatás léptéke) 

 

 

•  Fit to  paper  (Papírlapra illeszt): A kiválasztott papír méretre állítja a léptéket és megjeleníti az arányt. 

•  Scale  (Lépték): Megadja a plottolás pontos léptékét. 

•  Units (Mértékegység): Beállítja a mértékegységet mint hüvelyk vagy mm . 

 

 

❏ Print  Area (Nyomtatási terület) 

 

 

•  What to  print  (Amit nyomtat): Beállítja a nyomtatási területet a nyomtatáshoz. Pr
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- Limits (Határok) : Kinyomtatja az aktuális területet, amit az objektumok foglalnak.   
 

- Window (Ablak) : Egér használatával nyomtatási terület kiválasztása. 
 

- Extents (Terjedelem): Csak a kijelölt korlátozott területet nyomtatja. 
 

- Display (Megjelenítés): Csak a megjelenített területet nyomtatja. 
 

 
 

❏ Print   Offset (Nyomtatás eltolása) 

 

 

•  X : Beállítja a plot kezdőpontját X irányban. 

•  Y : Beállítja a plot kezdőpontját Y irányban. 

•  Center on page (Középre igazítás): Automatikusan számítja az X és Y értéket, hogy a plottot a 

lap közepére igazítsa.  
 

 

❏ Print Style Table (Nyomtatási stílus tábláza) 

 

 
Beállítja, szerkeszti vagy létrehozza az új nyomtatási stílus táblázatot. 

 

 

•  Name (Név): Megjeleníti a nyomtatási stílus táblázatot és a nyomtatási stílus táblázat listáról 

gondoskodik, amelyet azonnal lehet használni. 
 

•  (Edit) :  Megjeleníti a nyomtatási stílus tábla szerkesztőt és a felhasználó megnézheti  vagy 

módosíthatja az aktuálisan kiválasztott nyomtatási stílus táblázat plot stílust.   
 

 
 

 

❏ Shaded Viewport Options (Árnyékolt nézetablak beállítás) : Beállítja, ahogy az árnyalt nézetablakot és 

renderelt nézetablakot, majd kinyomtatja és véglegesíti a megjelenítés felbontását és a dpi-t.  Pr
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❏ Layout Tab Options (Elrendezés fül beállításai): Beállítja a vonalvastagság léptékét, beállítja a nyomtatási stílust, 

kinyomtatja az utolsó rajzterületet, vagy elrejti a rajzterület entitást.  
 
 

❏ Print  Options (Nyomtatási beállítások): Beállítja a vonalvastagság sorrendet, nyomtatási stílus, nyomtatás 

háttérben  vagy  objektumok nyomtatása. 

 
 
 

❏ Drawing Orientation  (Rajz elrendezés):  Beállítja a papír elrendezést. 
 
 

 

❏ Előnézet 
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1.4 Nyomtatási stílus (CTB,  STB) 
 

 
 

A gyártási rajzot fekete fehérben kell kinyomtatni vonalvastagságot alkalmazva a KS rajzszabvány 

szerint.  
 

Használjon  PLOT  STYLE-t a nyomtatáshoz különböző vonalvastagság és szín fajtával. Ilyen plot 

stílushoz használhat CTB és STB fájlokat. 

 
•  CTB : Color-Dependent  Plot Style Tables - Szín függő plot stílus táblák 

•  STB : Named  Plot Style  Tables - Elnevezett plot stílus táblák 

 

 
Más szavakkal,  CTB egy plot stílus színnel nyomtatva,  STB egy nyomtatási stílus objektumokkal 

kinyomtatva. 
 

 
 
 

❏ Nyomtatási stílus elérése 

 
 

Menü File(F)  ➤ Print  Styles  manager 

 

Eszköztár  

 

Szalag Home ➤ File  ➤ Print  Styles  manager 

 
Parancs STYLESMANAGER Pr
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❏ CTB  fájl használata 
 

 
CTB színnel beállítja a plot stílust. Például, beállíthatja a RED(Color_1) mint vékony vonal,  a 

GREEN(Color_3) mint vastag vonal, a CTB beállításhoz duplán kattintson, mint fent látni fogja és klikk 

a  ‘Modify’ (Módosítás) gombra a jobb oldalon.    
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Nyomtatási stílus terület ‘Print  Style Table Editor’  (Nyomtatásistílustáblázat-kezelő) 

dialógus panel bal oldalán 255 színt jelenít meg valamint a  Properties (Tulajdonság) 

területet, amely beállíthatja azt, hogy hogyan legyenek ezek kinyomtatva.  
 

‘A  'Color’ (Szín),  ‘Screening’ (Telítettség),  ‘Lineweight’ (Vonalvastagság) elemeket be 

kell állítani a kívánt nyomtatás szerint. 
 

 

•  Color (Szín): Beállít egy színt a nyomtatáshoz. 

•  Screening (Telítettség): Szín telítettség  lehet 0-tól 100-ig. Például,  ha rápikkel a 

RED-re  és  100-ig állítja, ez vörös lesz, de fehér lesz, ha a telítettség 0 lesz. 

Jelentése, a telítettség jelenti azt, hogy mennyi tintát használjon a kiválasztott 

színből.   

•  Lineweight: (Vonalvastagság) Beállítja azt, hogy milyen vastagon lesz kinyomtatva. 

 
 
 

 
 
 

Ha beállítja a fenti kép szerint, vörös vonalakat húz a rajzon és a következő szerint lesz kinyomtatva 

(Black,  ByLayer és 0.5mm). 
 

 
Kiválaszthat többszörös szint a  Ctrl vagy a Shift gombbal. Pr
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❏ STB  fájl használata 

 
STB beállítja a plot stílust a fóliára és objektumokra  Például,  ‘Visible  Line’  fólia, ‘Center  Line’  fólia és 

objektumok vannak beállítva néhány stílusban az STB beállításhoz. Dupla kattintás az STB-re hasonlóan 

CTB-hez, vagy kattintson a ‘Modify’  (Módosítás) gombra a Plot Styles  Manager (Nyomtatási stílus 

kezelő) jobb oldalán. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Amikor a ‘Plot  Style  Table Editor’  (Nyomtatásistílustáblázat-kezelő), amikor mint a fenti képen, 

szerkeszteni tudja a tulajdonságokat. Hasonlóan a  CTB-hez, be kell állítani a  ‘Color’,  ‘Screening’ 

(Telítettséget) és a ‘Lineweight’ (Vonalvastagság) tulajdonságokat. 
 

Új nyomtatási stílus hozzáadásához  ‘Plot  Style’,  kattintson a 'Stílus hozzáadása' gombra. Például,  

hozzon létre  ‘Thick  Line’  (vastag vonal) stílust, mint a következő képen ezután be tudja állítani a 

vonalvastagságot  ‘0.5mm’-re.  Nem tudja módosítani/törölni  (modify/delete)  ‘General’ helyen  a  ‘Plot  

Style’ (Nyomtatási stílus) terület tetején. Pr
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Nyissa meg a sablon szettet, mint STB,  amikor elkezd egy új rajzot. 
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❏ Amikor beállítja a fóliát 

 

 
A rajzhoz  állítsa be a CTB-t, a Fóliatulajdonság kezelőben (Layer  Property Manager), a színt 

megjeleníti, mint nyomtatási stílus (Plot Style) szín, mint a lenti képen.   

 

 
 

 
 

Ha a rajz be van állítva mint STB,  a nyomtatási stílus (Plot Style)  megjeleníti mint STB, a lenti kép szerint. 
 

 

 
 
 

Ha ‘Normal’-t választ,  egy fülön kiválaszthatja az  STB  Plot Style  megjelenítéseket. 
 

A ‘Select  Plot Style’ dialógus panelben  kattintson a legördülő listán az ‘Active  Plot Style Table’-ra, és 

válassza ki a meglévő STB fájlt, hogy megjelenítse a megadott STB fájl stílus listát a ‘Plot  Style’ területen. Pr
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Most, kiválaszthatja mindegyik fólia nyomtatási stílusát a beállításhoz, mint a lenti képen. 
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❏ Objektumok használata 

 

 
Válasszon ki egy objektumot a rajz területen és nyissa meg a tulajdonság palettát, ezután válassza ki a 

stílust a ‘Plot Style’ listából a beállításhoz.   
 

 
Ezt a módszert használva magasabb a prioritás a Layer-t használva, így nehéz kitalálni melyik nyomtatási 

stílust használja a jövőben. 
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Egy teljes léptékű rajz plottolása 
 

 
 

  A4-formatumú  rajz. 
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  Klikk alkalmazás menü ⇨ [Print]  ⇨ [Print] 

 

‘Print  - Model’  dialógus panel megnyílik. 
 

 
 

  Jelöljön ki egy nyomtatót. 
 

 
 
 

 
  Állítsa be a papír méretet A4-re. 

 

 
 
 

 
    Állítsa be az ablakot ‘What  to  print’  opcióra,  ezután válasszon ki két pontot:  (0,0),  (210,297). 

 

 
 
 

 
  Állítsa be  a ‘Printer  Offset’ -et (Nyomtatás eltolása ), mint 0.0. 

 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

558 

 

 

 
 

 

 
 

  Állítsa be a  ‘Print  Scale’  (Nyomtatási léptéket), mint lentebb. 
 

 
 
 

  Állítsa be a ‘Drawing  Orientation’ (Rajz tájolása), mint portré. 
 
 
 

 
 

 
 
 

  Állítsa be   ‘Printer  Style Table’ (Nyomtatási stílus tábláza), mint ‘Icad.ctb’. 
 
 

 
  Klikk         a jobb oldalra. 

‘Print  Style  Table Editor (Nyomtatási stílus táblaszerkesztő) –   Icad.ctb’  dialógus panel 

megnyílik. 

 
➀ Menjen a  ‘Form  View’  fülre. 

➁ Állítsa be a vonalvastagságot ( LineWeights) a következőképpen: 

 

Válassza ki a ‘Color_1’ -et a Nyomtatási stílus listán, ezután a ‘Properties’  területen,  állítsa 

be a színt ‘Color’  mint fekete (Black), vonalvastagságot ‘LineWeight’  ‘0.13mm’-re. 

Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

Plot  Drawing  10 

559 

 

 

 

 
 

 
 

Válassza ki  ‘Color_7’  a Print Styles (Nyomtatási stílus)  listában, ezután a  ‘Properties’  

(Tulajdonság) területen,  állítsa be a  ‘Color’  mint ‘Use  object  color’ (Objektum szín 

használat), ‘LineWeight’ (Vonalvastagság) ‘1.00mm’-re. 
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➂ Klikk ‘OK’. 

 
 

 
 
 
 

 
  Klikk ‘Preview’  (Előnézet) a beállítás ellenőrzésére. 

 

 
 
 
 

  Klikk ‘OK’  a rajz nyomtatása. 
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02 Rajzolás folyamatának összegzése 
 

 

2.1 Objektum kiválasztása 
 
 
 

Amikor az objektumot már kiválasztotta, ahogy lehet használja a legpontosabb eszközt, hogy 

megmérje a horizontális, vertikálos távolságokat és a magasságot.  
 

 
 

 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

562 

 

 

 

 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

Plot  Drawing  10 

 
 

563 

 

 

 
 

 

 
 

2.2 A rajzlap és a léptékek beállítása   
 
 

Alkalmazza a méréseket az objektum méretarányának megadásával a papírmérethez.   
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2.3 Állítsa be a mértékegységet és a pontosságot 
 
 
 

Használja a UNITS parancsot a mértékegység és a pontosság fokának beállításához.  
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2.4 Határok, kontúrok és a középpont jelek beállítása 
 

 
 

 
 

 

2.5 Vonaltípus léptékek beállítása 
 

(2:1  = 0.5,  1:1  = 1.0,  1:2  = 2.0) 
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2.6 Fóliák kiválasztása 
 

 
 

❏ Fólia beállítása a CAD rajzban 

 
Fólia Vonaltípus Szín Vonalvastagság Név 

 
OL Continuous Blue  0.8mm  Outline 

 
VL Continuous Green   0.5mm  Visible  Line 

HL HIDDEN2 Yellow 0.35mm  Hidden  Line 

CL CENTER2  Red  0.18mm  Center  Line 

IL PHANTOM2 Pink 0.18mm  Phantom  Line 

 
FL Continuous White 0.18mm  

Hatching  Line, 

Dimension  Line 
 

SL CENTER Green  0.5mm  Surface  Line 

 
DL CENTER White 0.18mm  Cutting  Plane  Line 

 
RS Continuous Cyan  0.26mm  Finishing Symbol 

 

 
 
 

 
 

<  Egy példa a fóliák beállítására  > 
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2.7 A modell beállítása három  nézetre alapozva  
 

 
 

 
 

 

 
 

2.8 Sraff beszúrása –  Sraff fóliák létrehozása,  lépték alkalmazás 
 

(2:1  = 0.5,  1:1  = 1.0,  1:2  = 2.0) 
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2.9 Szöveg beszúrása  –  Szöveg fóliák létrehozása és szövegstílus 
 

 
 

 
 

 

 

2.10 Méretezés  –  Méret fólia készítés és stílus  
 

(2:1  = 0.5,  1:1  = 1.0,  1:2  = 2.0) 
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Exercise  74  Rajzolja meg a következőt  (1:1  A4) 
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Exercise  75  Rajzolja meg a következőt  (2:1  A4) 
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11 
 

 

Izometrikus nézet 
 
 
 
 
 
 

 

A következő fogalmakat tárgyaljuk meg ebben a fejezetben: 

•  Izometrikus nézet 
•  Izometrikus nézet áttekintés és izometrikus beállítások  
•  Szöveg beszúrása az izometrikus nézetben 
•  Méretezés az izonometrikus nézetben 
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01 Izometrikus nézet 
 
 

Általában, az izometrikus nézet az objektumokat szilárd testként 2-1/2D környezetben ábrázolja, 

amelyet az emberek könnyen megértenek. 

Az izometrikus nézetet gyakran használják alkatrészre bontott (robbantott) ábrában, 

tevékenység diagramban, termék katalógusban marketing célból, kézikönyvben és építészeti 

tisztánlátás, gépi struktúrák bemutatásához és alkatrész szerelési módokhoz.   
 

 
 

<Izometrikus nézet> <Perspektíva nézet> 
 

<Robbantott nézet> 
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1.1 Izometrikus nézet áttekintése és izometrikus beállítás 
 
 
 

Az izometrikus vetület izometrikus nézete a nézetek egy típusa, amely elforgatja az objektumot, 

30 fokos szöget készít az objektum éle és a horizont vonala között. Ez három 120 fokos szöget 

készít a szélesség, magasság és hoszsúság minden két kombinációja közzé.  Ezt a három oldalt 

hívjuk izometrikus tengelyeknek, és mindegyik tengelynek ugyanannyi a lépték tényezője.  

CADian rendszer igényli a három izometrikus sík beállítását, hogy izometrikus nézetben tudjon 

rajzolni. 

Szintén, szabadkézi vázlatos képi rajz ferde nézetben kulcs fontosságú a koncepciális tervezés 

folyamatában. Hatékonyan fejezi ki a koncepciókat vagy elképzeléseket a tervezők felé. Ezért a 

tervezőnek helyesen és pontosan meg kell rajzolni a képi vázlatot első lépésben, azért hogy felgyorsítsa a 

kommunikációt a munkatársak között, valamint a rajzolás folyamatát.  

Az izometrikus nézet és raszter segít a 3D objektumok megrajzolásában a 2-1/2D térben. A felhasználó a 

három izometrkikus sík egyikére igazíthatja az entitásokat.  Megjegyezve azt, hogy mégha a rajz 

izometrikus nézetben van, ez 3D rajznak tűnik, ami valójában 2D-ben készült. Ezért a felhasználó nem 

tudja kivenni a 3D távolságot vagy területet/teret. Megjeleníti az objektumot egy nézetablakban és 

eltávolítja a takart vonalat az objektumról.    
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❏ Izometrikus nézet beállítás SNAP paranccsal 

 
 
 

Command:  SNAP 
 

Snap is off (x and y = 0.5000): ON/Rotate/Style/Type/Aspect/<Snap spacing>: S 

Isometric/<Standard>:  I 

Vertical  spacing  <0.5000>:  10 
 
 
 

 
❏ Izometrikus nézet beállítás DSETTINGS paranccsal 
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1.2 Kör rajzolása (Ellipszis)  izometrikus nézetben 
 
 
 

❶ Izometrikus nézet beállítása munkakörnyezetbe. 
 

 
 

Command:  SNAP 
 

Snap is off (x and y = 0.5000): ON/Rotate/Style/Type/Aspect/<Snap spacing>: S 

Isometric/<Standard>:  I 

Vertical  spacing  <0.5000>:  10 
 
 

 
Command:  GRID 

 

Grid  is  off:  ON/Snap/Aspect/<Grid  spacing  (x  and  y =  0.5000)>:  10 
 

Command:  GRID 
 

Grid  is  off:  ON/Snap/Aspect/<Grid  spacing  (x  and  y =  0.5000)>:  ON 
 

 
❷ Kurzor vezérlés és rajzolás 

 
 

➀ Nyomja meg az F5-öt vagy (Ctrl-E) gombot, és amikor a kurzor megjelenik mint ➀ kép,  

rajzoljon egy párhuzamos négyszöget. 

Nyomja meg az F5-öt vagy (Ctrl-E) gombot, és amikor a kurzor megjelenik mint  kép,  

rajzoljon egy párhuzamos négyszöget. 

Nyomja meg az F5-öt vagy (Ctrl-E) gombot, és amikor a kurzor megjelenik mint  kép,  

rajzoljon egy párhuzamos négyszöget. 
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❸ Rajzoljon ellipszist 
 
 

Command:  ELLIPSE 
 

Arc/Center/<First  end  of  ellipse  axis>:  I 

Center  of  circle:  P1 

Diameter/<Radius  of  circle>:  P2 
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1.3 Szöveg beszúrása izometrikus nézetben 
 

 
 

❏ Beállítja a szövegstílust 

 

❶ Klikk [Format]  (Formátum) ⇨ [Text  Style]  (Szövegstílus) a legördülő menüben. 

❷ Klikk   (Új) gomb a 'New  Text Style' (Új szövegstílus) dialógus panelen.  

Gépeljen RISO mint stílus név.  

 

❸ Beállítja a fontot (Arial), szélességi tényező (0.85)  és a dőlésszög(30). 

Válasszuk ki a RISO szövegstílust és kattintsunk a  (Aktuális) gombra. 

 
 
 

 
 

 

Klikk 'Apply' (Alkalmaz) vagy 'Close'  (Bezárás) gombra, hogy kilépjen  a 'Text  Styles 

Manager' (Szövegstílus kezelő) dialógus panelből. Pr
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❏ Szöveg beszúrása 

 
 

Command:  DTEXT 

Specify  start  point  of  text  or [Justify/Style]:  P1 
 

Specify  height <0.2000>:  12.5 
 

Specify  rotation  angle  of  text <0>:  30 
 

ISO  TEXT  INPUT 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
❏  Izometrikus nézet szövegstílus beállítás 

 

 
 

Szöveg stílus Szélesség tényező Dőlésszög Szöveg elforgatás foka 

 

LeftISO 
 

 
0.85 

 

-30  -30 

 

RightISO 
 

 
30 

 

30 

 

TopISO 
 

-30 Pr
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1.4 Méretezés izometrikus nézetben 
 

 
 

❏ Méret bevitel 
 

 
 

Command:  DIMALIGNED 

ENTER to select  entity/<Origin  of  first  extension  line>:  P1 

Origin  of  second extension  line:  P2 

Angle/Mtext/Text/<Location  of  dimension  line>:  P3 
 

 
 
 
 
 

 
 

 

❏ Méret szerkesztése 
 

 
 

Command:  DIMEDIT 
 

Enter type  of  dimension  editing:    Home/New/Rotate/Oblique/<Home>:  R 

Angle of dimension  text:  30 

Select  entities  to rotate  text:  P1 

Entities  in  set:  1 
 

Select  entities  to rotate  text: Pr
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Command:  DIMEDIT 

 

Enter type  of  dimension  editing:    Home/New/Rotate/Oblique/<Home>:  O 

Select  linear  dimensions  to  make  oblique:  P1 

Entities  in  set:  1 
 

Select  linear  dimensions  to  make  oblique: 

Enter obliquing  angle:  -30 
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Exercise  76  Rajzolja meg a következő izometrikus ábrát. 
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Exercise  77  Rajzolja meg a következő izometrikus ábrát. 
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Exercise  78  Rajzolja meg a következő robbantott ábrát. 
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Exercise  79  Rajzolja meg a következő robbantott ábrát. 
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Exercise  80  Rajzolja meg a következő robbantott ábrát izometrikus nézetben. 
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02 CADian 2012 segédletek –  Tervek és rajzok 
 
 

* rendelkezésre  áll CADian2012  vagy magasabb 

verzóban 
 
 
 

2.1  Eszköz négyszög alak rajzolásához 
 
 
 

Ezt a parancsot négyszög vagy trapézalak rajzolásához használja, amely automatikusan 

lekerekíti, élletöri és csipkézi az éleket.  
 

 
 

Command:  DRECT 

Dialog/<Start  Point>:  D (Open  dialog  box) 
 

 
 

 
 

 
 

❏ Rajzolási módszer: Válassza ki a kívánt formát a dialógus panelből. Négyszög megrajzolásához használja 

a felső szintet vagy a lentit a négyszögekhez.  
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❏ Fillet ( Lekerekítés):  Beállítja a formát és a sugarat. 

 

 
❏Chamfer  (Élletörés): Gépelje be a vízszintes és függőleges távolságokat. 

 

❏ Dimension (Méret):  Gépelje be a vízszintes és függőleges hosszakat. 

 

•  Width (Szélesség):  Set  the  Width   of a line 

•  Height  (Magasság):  Állítsa be a doboz vastagságát (magasságát). 

 
 

Dialog/<Start  Point>:   

Next  Point:   

Opposite  corner:  
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Command:  DRECT 

Dialog/<Start  Point>:  D (Open  dialog  box) 
 
 

 
 

 
 

Dialog/<Start  Point>:   

Next  Point:   
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Command:  DRECT 

Dialog/<Start  Point>:  D (Open  dialog  box) 
 

 
 

 
 
 
 
 

Dialog/<Start  Point>:   

Opposite  corner:  

Pick Point:   
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2.2 Eszközök sokszög alak rajzolásához 
 
 
 

Ezt az eszközt a sokszög rajzoláshoz használjuk és automatikusan lekerekíti és letöri az élt.    
 

 
 

Command:  PGON 

Number  of  sides <5>: 

Polygon  Start  Point  or  [Fillet/Champer]:  F 

Polygon  Fillet  Radius    <0.0000  : 5 

Polygon  Start  Point  or  [Fillet/Champer]:   

Polygon  [Inscribed/Circumscribed/Edge/fixAngle]/<Inscribed  Radius>:    I 

Polygon  [Inscribed/Circumscribed/Edge/fixAngle]/<Inscribed  Radius>:   
 

 

 
 

 
 

Command:  PGON 

Polygon  Start  Point  or  [Fillet/Champer]:  F 

Polygon  Fillet  Radius    <0.0000>:  5 

Polygon  Start  Point  or  [Fillet/Champer]:   

Polygon  [Inscribed/Circumscribed/Edge/fixAngle]/<Inscribed  Radius>:    E 

Polygon  [Inscribed/Circumscribed/Edge/fixAngle]/<Edge  Point>:   Pr
ó

ba
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2.3 Eszköz a hornyok rajzolásához 
 
 

Automatikusan rajzolja a horony mélyedést. 
 

 

❏ Horony rajzolás 1 

 
Command:  DSLOT 

Slot  Hole  [Slot/Flange/sIde/Centers]  /  <Start  point>:   

Slot  Radius:    20 

 
 

 
 

 
Slot  Length:   Pr
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❏ Horony rajzolás  2 

 
 

Command:  DSLOT 

Slot  Hole  [Slot/Flange/sIde/Centers]  /  <Start  point>:  C 

Slot  Hole  [Slot/Flange/sIde/Centers]  /  <Start  point>:   

Slot  Radius:  20 
 
 
 
 
 
 
 
 
 
 
 
 

Slot  Length:  40 
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❏ Perem rajzolás 

 
 

Command:  DSLOT 

Slot  Hole  [Slot/Flange/sIde/Centers]  /  <Start  point>:  F 

Slot  Hole  [Slot/Flange/sIde/Centers]  /  <Start  point>:   

Slot  Radius:  20 
 
 

 
 

 

Horony hossz:   
 
 

 
 

 

Horony sugár:   Pr
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2.4 Eszköz a törésvonalakhoz 
 
 
 

  Törés vonalakat rajzol. 
 

 
 

Command:  BKLINE 

Break  Line  [Size  (5)]  /  <Start  point>:  S 

Size (5):  10 

Break  Line  [Size  (10)]  /  <Start  point>:   

Break  Line  [Size  (10)]  /  <Start  point>:   

Break  Point  <Mid  point>: 

 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

Isometric View   11 

595 

 

 

 
 

 
 

 
 

 
 

 

 
 

2.5  Eszközök hengeres keresztszelvényekre 
 
 
 

Használata a rudak vagy csövek rajzolásához. 

 
 

Command:  BKSEC 

Cylinder  Section  [Single/Double]  <Single  Start  point>:   

('Double'  option  draws  two  section  lines) 

End Point:   
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03 CADian  2012 Segédletek  - Görbék 
 

 

3.1 Görbe irányának jelölése 
 
 
 

Megjeleníti a görbe vonalak irányát.   
 

 
 

Command:  CURVEDIR 

Select  Curve  [Vertex  disp/Definite  disp]:   
 

 
 

 
 

3.2  Görbe irányának változtatása 
 
 
 

Command:  CURVEDIR 
 

 

Kattintson  a görbe objektumra, hogy az irányát megváltoztassa.   
 

 

3.3 Visszakapcsolás az ív vonallánchoz 
 
 
 

  Objektumok tulajdonságainak  mint a vonal, ív, kör arc módosítása  vonallánccá. 

 
 

Command:  CURVEPOLY Pr
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3.4 Vonallánc szélességének szerkesztése 
 
 
 

Automatikisan szerkeszti a vonallánc vastagságát, amikor vonallánc, vonal vagy ív lett kiválasztva.   

 

 
 

Command:  POLYWIDTH 

Select  entities:   

Select  entities: 
 

 
 

 
 

 
Polyline  Width  <1>:  2 

 
 
 
 
 
 
 

3.5 Vonallánc szerkesztése 
 
 

Módosítja a megrajzolt vonallánc vertexét egy egyenes vonalat ívvé, ívet egyenes vonallá, amelyet 

beszúrhat új objektumként két objektum közzé. Vonallánc szerkesztésénél, akkor működik, amikor a   

ORTHOMODE ki van kapcsolva (off). 
 
 
 

Command:  POLYEDIT 

Select  Entity:   Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba
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PolyLine  Vertex  Insert  [Remove/Move/Stretch/arC/Tangenarc/Line/Fixed/eXit]  :  

Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba
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ó
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PolyLine  Vertex  Insert  [Remove/Move/Stretch/arC/Tangenarc/Line/Fixed/eXit]:  R 

PolyLine Vertex Remove [Append/Move/Stretch/arC/Tangenarc/Line/Fixe d/eXit]:  
 

 
 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó
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PolyLine Vertex Remove [Append/Move/Stretch/arC/Tangenarc/Line/Fix ed/eXit]: M 

PolyLine Vertex Move [Append/Remove/Stretch/arC/Tangenarc/Line/Fix ed/eXit]:  
 
 

 
 

 
 
 

PolyLine Vertex Move [Append/Remove/Stretch/arC/Tangenarc/Line/Fix ed/eXit]:  S 

PolyLine Vertex Stretch [Append/Remove/Move/arC/Tangenarc/Line/Fix ed/eXit]:  
 

 
 
 

 Pr
ó

ba
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PolyLine Vertex Stretch [Append/Remove/Move/arC/Tangenarc/Line/Fix ed/eXit]:  C 

PolyLine Vertex Arc [Append/Remove/Move/Stretch/Tangenarc/Line/Fix ed/eXit]:  
 
 

 
 

 
 
 

PolyLine Vertex Arc [Append/Remove/Move/Stretch/Tangenarc/Line/Fix ed/eXit]: T 

PolyLine Vertex TangentARc [Append/Remove/Move/Stretch/arC/Line/Fixed/eXit]:   
 
 

 
 

 
 
 

PolyLine Vertex TangentARc[Append/Remove/Move/Stretch/arC/Line/Fixed/eXit]: L 

PolyLine Vertex Line [Append/Remove/Move/Stretch/arC/Tangenarc/Fixed/eXit]:  Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba
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PolyLine Vertex Line [Append/Remove/Move/Stretch/arC/Tangenarc/Fix ed/eXit]: A 

PolyLine  Vertex  Insert  [Remove/Move/Stretch/arC/Tangenarc/Line/Fixed/eXit]:  F 

(When  a cursor moves, automatically  inserts  vertex  where cursor  is  at,  and vertices  are 

only   allowed   to  be inserted  on the  cursor   position.) 

PolyLine  Vertex  Insert  [Remove/Move/Stretch/arC/Tangenarc/Line/Fixed/eXit]:   
 
 

 
 
 

 
PolyLine  Vertex  Insert  [Remove/Move/Stretch/arC/Tangenarc/Line/Fixed/eXit]:  X Pr

ó
ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba
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3.6 Objektumok Z értékének szerkesztése 
 
 
 

Válasszon ki egy objektumot és szerkesztésre írja be a  3D kootdináta értékét  (Z érték). 
 

 
 

Command  : CURVEZ 
 

 
 
 
 

3.7 Vonalak összekapcsolása 
 
 
 

Objektumoknak mint egyenes vonalaknak vagy íveknek  végpontjaik össze vannak kötve,  vonallánccá 

konvertálja azokat. 
 
 
 
 

Command  : LINEJOIN 

Pr
ó

ba
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ba
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ba
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04  CADian  2012 segédletek  - Módosítás 
 

 

4.1 XY Lépték 
 
 
 

Állíthatja a léptéket a kiválasztott objektumoknál vízszintesen és függőlegesen külön-külön. Amikor a 

léptéket állítja a kiválasztott vonallánc objektumnál szétveti vonalakká és ívekké.    
 
 

Command  : XYSCALE 

Select  entities:      ,   
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Base Point:   

X Scale  factor  or  Pick  Point  [Reference/Copy]  <   2  >:  1 

Y Scale  factor  <   3  >:  2 
 
 
 
 
 
 
 
 
 
 
 
 
 

XY Scale  factor  <1  ,  2> Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba
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4.2 Dupla eltolás 
 
 

Válasszon ki egy objektumot az eltolásho 

 

 

z, amelyet eltol mind a két irányba egy adott távolságra.    
 

 
 

Command  : DOST 

Double  Offset  Distance  <10>:  1000 

Select  Entity:     
 
 

 

 
 

 
 
 

Select  Entity: 
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ó

ba
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ó

ba
Pr

ó
ba
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4.3 Ismételt eltolás 
 
 
 

Ez a parancs hasonló mint az előző, de a felhasználó be tudja írni, hogy hányszor akarja eltolni.   
 
 
 
 

Command  : RPOST 

Offset  Distance:  1000 

Select  Entity:   

Side  for  parallel:   
 
 

 
 
 

 

Repeat:  3 
 
 

 
 

 
Select  Entity: Pr

ó
ba

Pr
ó

ba
Pr

ó
ba
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ba
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4.4  Növekményes eltolás 
 
 

Az egyik oldalra folyamatosan eltolja a kiválasztott objektumot.  

A felhasználó megtartja a szeparált távolságot. 
 

Command  : INCOST 

Select  Object:     

Side  for  parallel:   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Offset  Distance:  1000 
 
 
 
 
 
 
 
 
 
 

Offset  Distance:  2000 
 
 
 
 
 
 
 
 
 
 
 
 
 

Offset  Distance: 
 
 
 

Pr
ó

ba
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ba
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ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

608 

 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 
 

4.5  Növekményes dupla eltolás 
 
 

Ez a parancs hasonló mint az előző parancs, de az eltolás mind a kéz oldalra történik. 

 
 

Command  : INCDOST 

Select  Entity:     
 
 
 
 
 
 
 
 
 
 
 
 
 

Offset  Distance:  1000 

Offset  Distance:  2000 
 

 

 
 
 

 
Offset  Distance: 

 

 
 
 
 

4.6 Üres entitások törlése 
 
 

Vonal,  vonallánc,  ív, kör  (kezdő pont és vég pont  ugyanaz),   üres szöveg és pont. 

 
 

Command  : ERASEEMPTYENT Pr
ó

ba

Pr
ó

ba
Pr

ó
ba
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ba



Pr
ó

ba

 
 

Isometric View   11 

609 

 

 

 
 

 
 

 
 

 

05  CADian  2012 segédletek - Szöveg 
 

 

5.1 Szöveg szerkesztés 
 
 

Szöveget entitás tulajdonságokat beszúr, töröl vagy szerkeszt, olyanokat mint magasság, szín és szög. Ha 

egy entitás kiválasztásra kerül, a következő dialógus panel jelenik meg. A dialógus panelben a 

beállításokat használva, a felhasználó könnyen tudja a szöveget szerkeszteni.  
 
 
 

 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba
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ó

ba
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❏ Tulajdonság módosítása 

 
 
 

 

Command  : TEXTMODIFY 

Select Text:  ,  
 
 

 

 
 
 
 
 

Select  entities: 

Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba
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•  Text  Box (Szöveg doboz):  A kiválasztott szövegeket kilistázza a szövegdobozban. A felhasználó 

szerkesztheti a szöveget a lista jobb oldalán.   

 

•  Text Height (Szöveg magasság):  Megjeleníti a rendszerben beállított aktuális szövegmagasságot. 

Ha az érték megváltozik, az összes szöveg entitásnak a rajzban egy új szöveg magassága lesz.  Csak a 

kiválasztott szöveg magasság módosításához jelölje a 'Modify  only selected  item'  (Csak a 

kiválasztott tételek módosítása) beállítást. 
 

•  Rotate  (Elforgatás): Megjeleníti a rendszerben beállított aktuális szöveg forgatás szöget. Ha az érték 

megváltozik, az összes szöveg entitásnak a rajzban egy új szöveg forgatás szög lesz.  Csak a 

kiválasztott szöveg forgatás módosításához jelölje a 'Modify  only selected  item'  (Csak a kiválasztott 

tételek módosítása) beállítást. 
 

• Width (Szélesség):  Megjeleníti a rendszerben beállított aktuális szöveg vastagságot. Ha az érték 

megváltozik, az összes szöveg entitásnak a rajzban egy új szöveg vastagság lesz.  Csak a kiválasztott 

szöveg szélesség módosításához jelölje a 'Modify  only selected  item'  (Csak a kiválasztott tételek 

módosítása) beállítást. 
 

• Oblique (Dőlt): Megjeleníti a rendszerben beállított aktuális szöveg dőlésszögét. Ha az érték 

megváltozik, az összes szöveg entitásnak a rajzban egy új dőlésszögű szöveg lesz.  Csak a 

kiválasztott szöveg dőlésszög  módosításához jelölje a 'Modify  only selected  item'  (Csak a 

kiválasztott tételek módosítása) beállítást. Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba
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•  Text Color (Szöveg szín): Megjeleníti a rendszerben beállított aktuális szöveg színt. Ha az érték 

megváltozik, az összes szöveg entitásnak a rajzban egy új szöveg szín lesz.  Csak a kiválasztott 

szöveg szín módosításához jelölje a 'Modify  only selected  item'  (Csak a kiválasztott tételek 

módosítása) beállítást. 

•  Upside down (Fordítva):  Jelölje be, hogy a szöveg entitást fordítva  jelenítse meg. 

•  Backwards (Visszafelé):  Jelölje be, hogy a szöveg entitást tükrözve visszafelé jelenítse meg. 

•  Justify  (Igazít): Megjeleníti a rendszerben beállított aktuális sorigazítást. Ha az érték megváltozik, 

az összes szöveg entitásnak a rajzban egy új sorigazítása lesz.  Csak a kiválasztott szöveg sorigazítás 

módosításához jelölje a 'Modify  only selected  item'  (Csak a kiválasztott tételek módosítása) 

beállítást. 
 

 
 

 
•  Text Style (Szövegstílus): Megjeleníti a rendszerben beállított aktuális szövegstílust. Ha az érték 

megváltozik, az összes szöveg entitásnak a rajzban egy új szövegstílusa lesz.  Csak a kiválasztott 

szöveg szövegstílus módosításához jelölje a 'Modify  only selected  item'  (Csak a kiválasztott tételek 

módosítása) beállítást. 
 

•  Modify  only selected  item  (Csak a kiválasztott tételek módosítása):  Jelölje a módosított tulajdonság 

alkalmazásához csak a kiválasztott szöveg entitásnál a szöveg doboz listájában.    

•  View (Nézet): Kattintással előnézetben láthatja a szerkesztett beállítást a rajzon.   A dialógus panel 

ideiglenesen zárva lesz, az alkalmazott beállítások megjelennek. ESC-pel újra megnyílik a dialógus 

panel.  A változtatott beállítások addig nem lesznek alkalmazva amíg nem kattint az OK-ra.  
 

 
 

❏ Szöveg módosítás 

 

 
 

Command  : TEXTMODIFY 

Select Text:  ,  Pr
ó

ba
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ó

ba
Pr

ó
ba
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ó
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Select  entities: 
 
 

 Pr
ó
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•  Change  ( Cse re ) :    Egyes sztringeket  új sztringekre cseréli. 

Ex)  20 =>  30 :  CADian2012   =>  CADian3012 
 

 

•  Parenthesis (Zárójel):  Hozzáadja vagy eltávolítja a zárójelet a szöveg körül.    

Ex)  CADian2000  => (CADian2000),   {CADian2000}   => CADian2000 
 
 

•  Upper.lower  (Fent-lent)  Fel-le kapcsolja a nagy és kisbetús szöveget,  azok beállításától függően. 

-  Upper letter  ( N a g y b e t ű ) :  Az összes kiválasztott entitást   nagy betűs szövegre cseréli. 

Pl.)  CADian2000   =>  CADIAN2000 

-  Lower letter (Kisbetű):  Az összes kiválasztott entitást  kis betűs szövegre cseréli. 

Pl.)  CADian2000   =>  cadian2000 

-  First  Upper letter  ( E l s ő  n a g y b e t ű ) :  A kiválasztott szöveg entitás első betűjét nagy betűre 

cseréli .  Pl.) cadian2000    =>  Cadian2000 

-  Swap (Csere):  Cseréli az összes szöveg entitás karaktert  nagyról kicsire, és kicsiről nagyra.  

Pl.) CADian2000   =>  cadIAN2000 

 
•  Append   text (Szöveg csatolás):  Extra csatolást tesz a kiválasztott szöveg entitáshoz.  Új kifejezést lehet 

csatolni az elejéhez, közepéhez és a végéhez   (vagy bármilyen kombinációjában a három pozíciónak)  

az eredeti szövegnek. 

Pl.) Prefix (Előtag):     Csatolás ie   :  (CADian2000   =>  ieCADian2000) 

Middlefix (Köztestag) :  Csatolás yes ,  Mid location  (Köztes hely):  6 (CADian2000   

=>  CADianyes2000)  

Suffix (Utótag) :  Csatolás  ok   :  (CADian2000   =>  CADian2000ok) 

 
 

❏ Szöveg eltávolítás 

 

 
 

Command  : TEXTMODIFY 

Select Text:  ,  Pr
ó

ba
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ó
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Pr

ó
ba
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Select  entities: 
 

 
 

 Pr
ó
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•  Blank (Szóköz):  Szóköz karaktereket hozzáad vagy eltávolít a kiválasztott szöveg entitásból.   

•  Text: Kiválaszt egy karaktert a kiválasztott szöveg entitásból, hogy eltávolítsa a sztringet a karakter 

mögött.  És csak egy bizonyos karaktert távolít el a kiválasztott szöveg entitásból. Ha több mint 

egy megfelelés van,  a parancs végrehajtódik a szöveg bal oldalától. A parancs megkülönbözteti a 

nagy/kis betűket.    
 

 
Front remove  (Eltávolítás előlről):  'a' alkalmazása 

Pl. CADian2000   =>  an2000 

Back remove  (Eltávolítás hátulról):  'a' alkalmazása 

Pl. CADian2000   =>  CADia  

Text  remove (Szöveg eltávolítás):  'a' alkalmazása 

Pl.  CADian2000   =>  CADin2000 
 
 

•  Trim (Kimetsz): Eltávolít egy megadott számú karaktert  elejéről/végéről vagy a közepéről az 

opciótól függően.  Az opció különbséget tesz kis és nagybetűk között. 

     Front  (Elől):  3 

    Pl.)  CADian2000   =>  ian2000 

    Back (Hátul) :  4 

    Pl.)  CADian2000   =>  CADian 

    Middle (Közép) :  3~6 

   Pl.)  CADian2000   =>  CAD2000 
 
 
 

  5.2 Növekvő számok 
 
 

Folytonosan másol egy kiválasztott szöveg entitást ennek szám  növekményével. 
 
 

❏ Növekvő karakterek az elején 

Pr
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Pr

ó
ba
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Command  : TEXTINC 

Select Text:  ,   
 
 

 
 

 

Select  entities: 

Increment  Value  <   1  >:  2 

Digits  <   1  >:    2 

Placement  of  Number[Front/Back]:  F 

Base Point:     

Next  Point:  , ,   

Next  Point: 
 

 
 

 

❏ Növekvő karakterek a végén 

 
 

 
 

Command  : TEXTINC 

Select Text:  ,  . Pr
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ba
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Select  entities: 

Increment  Value  <   1  >:  1 

Digits  <   1  >:    2 

Placement  of  Number[Front/Back]:  B 

Base Point:     

Next  Point:  , ,   

Next  Point: 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
❏ Növekvő "?" sztring 

 

 
Ha egy szöveg entitás "?" tartalmaz,  ez egy számmal van összekapcsolva a növekmény miatt. Ha 

egy szöveg entitásnak van "?", és egy szám a "?", akkor figyelmen kívül lesz hagyva, és csak a szám 

növekszik majd.  

 
 
 

Select  entities:   Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

Isometric View   11 

619 

 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
Increment  Value  <   1  >:  1 

Digits  <   1  >:    2 

Placement  of  Number[Front/Back]: 
 
 

 
 
 

Base Point:   

Next  Point:  (Keep  selecting  points,  ENTER  to  end the  command.) 
 
 
 

 
5.3  Lineárisan növekvő szöveg 

 
 

Lineárisan folyamatosan másol egy szöveg entitást, egy megadott távolságig adott számú növekménnyel. 
 
 

❏ 1. Módszer 

 
 

Command:  LINCTEXT 

Select  entities:   
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Select  entities: 

Increment  Value  <1>:  2 

Digits  <1>:  2 

Placement  of  Number[Front/Back]:  F 

Base Point:   

Space:  1000 

Position:   
 
 
 
 
 
 
 
 
 
 
 

❏ 2 .  Módszer  

 

 
Ha egy szöveg entitás "?"-et tartalmaz kapcsolva van egy konstans szám növekménnyel.   Ha egy 

szöveg entitásnak van "?" és egy szám a "?" figyelmen kívül lesz hagyva és csak a szám növekszik 

majd.  

 
 
 

Command:  LINCTEXT 

Select  Entities:   Pr
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ba
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Select  entities: 

Increment  Value  <1>:  2 

Digits  <1>:  2 

Placement  of  

Number[Front/Back]:  

B Base Point:   

Space:  1000 

Position: 
 

 

*  Amikor a kurzort jobb oldalra mozgatjuk, az A betű a példa  szövegben  az adott növekmény 

távolsággal fog eltünni. Ha a szöveg számot tartalmaz,  a parancs figyelmen kívül  hagyja a "?" jelet, 

és megnöveli a számot.  
 
 
 

 
5.4 Poláris növekményű szöveg   

 
 

Egy kiválasztott szöveg entitást folyamatosan kör-körösen másol egy adott szám növekménnyel.   
 

 
❏ 1. Módszer 

 

 

Command:  PINCTEXT 

Select  entities:   Select  entities: 

Increment  Value  <1>  : 1 

Digits  <1>  : 1 

Placement  of  Number[Front/Back]:  F Pr
ó

ba
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Center  Point  :   (Use  CEN   of  OSNAP) 

Column   [Angle/Rotate]   <4>:  12 
 
 
 

 
 

 
Draw Angle  [Rotate]  (+=CCW,  -=CW)  <   360 >:    R 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Draw Angle  [Rotate]  (+=CCW,  -=CW)  <   360 >:   360 Pr
ó

ba
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ba
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❏ 2. Módszer 

 

 
Ha egy szöveg entitás "?"-et tartalmaz, és egy konstans szám növekménnyel kapcsolva van. Ha egy 

szöveg entitásnak van "?", és egy szám a "?", figyelmen kívül lesz hagyva, és csak a szám növekszik 

majd.  

 
 
 

Command:  PINCTEXT 

Select  entities:   

Select  entities: 

Increment  Value  <1>:  1 

Digits  <1>:  2 

Placement  of  Number[Front/Back]:  B 

Center  Point:    (Use  CEN   of  OSNAP) 

Column  [Angle/Ratate]  <4>:  12 
 

 
 
 

 
 
 
 

Draw  Angle [Rotate] (+=CCW,   -=CW)  <   360 >:    360 Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

624 

 

 

 
 

 
 

 
 

 
 

 
 

 

 
 

 
 
 
 
 
 
 
 

5.5 Számok beszúrása 
 
 
 

Egy szöveg beszúrása (pl.  sorozatszám),   amelynek van egy adott formátuma. 
 
 
 

Command:  TEXTNUMBERING 

Select  entities:  ,  

Select  entities: 
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Start  No [Dialog]  <   1  >:  D 
 

 
 

 
 
 

•  Start  no ( I n d u l ó  é r t é k ) :  Léptesse be a kezdő szám első értékét. 

•  Increment (Növekmény) :  Jelöljön ki egy értéket a  növekményhez. 

•  Digits (Számjegyek)  :  Léptesse be a szöveg számjegyeit.  (pl.  :  001) 

•  App Text (Szöveg csatolás):  További szöveg hozzáadása előtte/ utána.  (pl. :  TA-001-L) 

•  Blank (Szóköz) :  Szóköz karakterek hozzáadása a csatolt szöveg elé.   

•  Placement  of number  in text (Szám elhelyezés a szövegben) 

-  Prefix (Előtag) :  Hely a szöveg előtt (pl.  :    TEXT  =>  T1L TEXT) 

-  Suffix  (Utótag) :  Hely a szöveg után (pl.  :    TEXT  =>  TEXT  T1L) 

-  Middlefix  (Előtag) :  Hely a szöveg előtt (pl.  :    TEXT  =>   TE  T1L XT) 

 

 
•  Order (Sorrend) 

-  Left->Right (Balról - jobbra) :  A növekmény sorrendje balról jobbra. 

-  Upper->Lower (Felső - alsó) :  A növekmény sorrendje felső - alsó. 

-  Select (Kiválaszt) :  Saját növekmény sorrend kiválasztás. 
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5.6 Szöveg körvonal 
 

 
Formát rajzol a növekményes szöveg köré,  vagy növekményes szöveg  szúr a forma közepébe. 

 
 

Command:  TEXTMARK 
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•  New Text:  Beleír egy szöveget és egy formát a kiválasztott pozícióba. 

•  Text:  A meglévő szöveg köré rajzol egy formát. 

•  Start:  Válassza ki az első számot a kezdéshez. 

•  Inc Value:  Kijelöli a növekmény értékét. 

•  Digit:  Beállítja a számjegyeket. 

•  Prefix:  Szöveget fűzz az elejéhez.  Átlépi, ha nincs hozzáadható szöveg.  (Ex: AA001) 

•  Suffix:  Szöveget fűzz  a végéhez. Átlépi, ha nincs hozzáadható szöveg. (Ex: 001BB) 

•  Leader:  Megrajzol egy mutató vonalat. 

•  Mark Center:  Mutató vonal véget rajzol az alakzat középpontjából.   

•  Mark Up,Down,Left,Right: Egy alakzat középpontját automatikusan igazítja, attól függően, hogy 

lett a mutató vonal megrajzolva.    

 
 

 
 

Leader  Position:   

Mark  Position:   

Leader  Position:   

Mark  Position:   

Leader  Position: 
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5.7 Szöveg elrendezés 
 
 
 

Bekezdéses szöveget egyszerre elrendezi balra/jobbra vagy fentre/lentre.   
 

 
❏ Függőleges elrendezés 

 

 
 

Command:  TEXTARRANGE 

Select  entities:  ,  

Select  entities: 

Arrange  Point:   
 

 

 
 

 
 
 

Text  Arrange  [Horizontal/Vertical/Spacing/Left/Center/Right/Bottom/Mid/Top 

/Attribute/eXit]:  L 
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Text  Arrange  [Horizontal/Vertical/Spacing/Left/Center/Right/Bottom/Mid/Top 

/Attribute/eXit]:  S 

Text  Spacing:  ,  
 

 
 

 
 

 
 

Text  Arrange  [Horizontal/Vertical/Spacing/Left/Center/Right/Bottom/Mid/Top 

/Attribute/eXit]:   
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❏ Vízszintes elrendezés 
 
 

Command:  TEXTARRANGE 

Select  entities:  ,  

Select  entities: 

Arrange  Point:   
 
 

 
 
 
 

Text  Arrange  [Horizontal/Vertical/Spacing/Left/Center/Right/Bottom/Mid/Top 

/Attribute/eXit]:  M 
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Text  Arrange  [Horizontal/Vertical/Spacing/Left/Center/Right/Bottom/Mid/Top 

/Attribute/eXit]:    (Use  MID   of  OSNAP) 
 

 
 

 
 

 
 

5.8 Szöveg másolás 
 
 
 

Csak a sztringet másolja a szöveg entitásból anélkül, hogy módosítaná a tulajdonságát. 
 
 

Command: TEXTCOPY 

Select Origin  Text:  

Select Copy Text:   

 

 
 

 

Select Copy Text: 
 

 

 
 
 

5.9 Szöveg csere 
 

 
Két szöveg entitás sztring cseréje anélkül, hogy megváltoztatná ezek tulajdonságát.   

 
 

Command  : TEXTSWAP 

Select Text:   

Select  Change Text  :  Pr
ó

ba

Pr
ó

ba
Pr

ó
ba

Pr
ó

ba



Pr
ó

ba

 
 

 
 

CADian 2012 

632 

 

 

 
 

 
 
 
 

 
 

 
 
 

5.10 Szöveg hozzáadása 
 

 
 

Felszed két szöveg entitást azért, hogy a második szöveget hozzáfűzze az első szöveg végéhez.  

 Az összefűzött szöveg entitás megörökli az első szöveg entitás tulajdonságait.  
 

 
 

Command:  

TEXTADD Select 

Text:   

Select  entities: 

Append   Text  Select:   
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06 CADian 2012 segédletek - Blokk 
 

 

6.1 Multi-Blokk beszúrása 
 
 
 

MINS parancs  automatikusan egyszerre beszúr több blokkot  a hozzáadandó nevük opciójával minden 

blokk alatt.  

 

 

Command:  MINS 
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•  Append (Hozzáfűz) : Megnyitja a lenti dialógus dobozt.  Válassza ki a blokkokat a beszúráshoz,  

ezután  kattintson az ‘Open’-re (Megnyitás). 
 
 
 

 
 

 
•  Remove (Eltávolít): Eltávolítja a kiválasztott blokkot a listából. 

•  Pitch (Osztásköz): Kattintson a Pitch gombra, amely ideiglenesen zárja a dialógus dobozt, 

hogy megkapja a  Pitch értékeket a felhasználótól. A felhasználó rajzol egy négyszögletes 

alakot, hogy belépesse az X és Y osztásközöket.   

•  Pitch X (Osztásköz X): Kattintson a Pitch gombra, amely ideiglenesen zárja a 

dialógus dobozt, hogy megkapja az osztásköz értéket a felhasználótól. A felhasználó 

egy vonalat rajzol, hogy beléptesse az X osztásközt. 

•  Pitch Y (Osztásköz Y):  Kattintson a Pitch gombra, amely ideiglenesen zárja a 

dialógus dobozt, hogy megkapja az osztásköz értéket a felhasználótól. A felhasználó 

egy vonalat rajzol, hogy beléptesse az Y osztásközt. 

•  Space: Kattintson a Pitch gombra, amely ideiglenesen zárja a dialógus dobozt, hogy 

megkapja a space értéket a felhasználótól. A felhasználó rajzol egy négyszögletes 

alakot, hogy belépesse az X és Y space-eket.   

•  Space X :   Kattintson a Pitch gombra, amely ideiglenesen zárja a dialógus dobozt, 

hogy megkapja a space értéket a felhasználótól. A felhasználó egy vonalat rajzol, 

hogy beléptesse az X space-t. 

•  Space Y : Kattintson a Pitch gombra, amely ideiglenesen zárja a dialógus dobozt, 
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hogy megkapja a space értéket a felhasználótól. A felhasználó egy vonalat rajzol, 

hogy beléptesse az Y space-t. 

 
 

 
 
 

•  GAP (Hézag): Jelölje az opciót, hogy beállítsa a  Gap  távolságot az  X és Y osztásközökhöz, ahogy 

lent az ábra mutatja.  
 
 
 

 
 
 
 
 

 

•  Outline  (Körvonal): Jelölje az opciót, hogy megrajzolja a  cím blokk körvonalat. 

•  Block Name  (Blokk név): Jelölje az opciót, hogy beszúrja a blokk nevét. 
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•  Column (Oszlop) : Léptesse be az oszlopok számát.  Ha a blokkok száma 

több mint az oszlopok száma,  akkor a CADian automatikusan hozzáad 

egy külön oszlopot a blokkok elrendezéséhez.  

•  Text height (Szöveg magasság) : Beállítja a szöveg magasságot. 

•  Block : A beszúrt blokkokat egyedi blokk formátumban készíti. 

•  Explode (Szétvet) : A blokkokat szétvetett formában szúrja be,  alkatrészenként elkülönítve az elemeket. 

•  External reference (Külső referencia) : A beszúrt blokkokat külső hivatkozás formátumban  készítheti el. 

•  Relative path (Relatív útvonal) : A külső hivatkozást mint relatív útvonalként készítheti. 

 

 
 
 
 

6.2 Külső hivatkozást beszúr 
 
 

Kiválaszthat egy külső blokk hivatkozást, hogy módosítsa annak tulajdonságát egy 

belső blokkhoz.  
 

 
 

Command:  XREFINS 
 

 
 
 
 
 

6.3 Külső hivatkozás leválasztása 
 

 
 

 Kiválaszthat egy külső blokk hivatkozást, hogy leválassza a rajzról.  
 

 
 

Command:  XREFDETACH Pr
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6.4 Külső hivatkozás törlése 
 

 
 

A kiválasztott külső blokk hivatkozás kitörlése a rajzból.  Újra lehet tölteni megint az XREF paranccsal. 

 

 
 
 
 

Command:  XREFUNLOAD 
 
 
 
 
 
 

6.5 Blokk név változtatása 
 
 
 

Válassza ki a blokk objektumot a lenti dialógus ablak megnyitásához. A blokk nevet könnyen lehet 

módosítani a dialógus panelben.  

 

 
 

 
Command:  BLOCKRENAME Pr
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ba
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6.6 Egy blokk beszúrási pontjának változtatása 
 
 
 

Válassza ki az objektumot a beszúrási pontjának módosításához. Szedje fel előbb a blokkot, ezután válassza 

ki az új beszúrási pontot. 

 

 
Command: BLOCKREORIGIN 

 

 
 
 
 
 

6.7 Objektumok hozzáadása a blokkhoz 
 
 
 

 Hozzáad egy objektumot egy már beszúrt blokkhoz a rajzban. 
 
 
 

Command:  APPENDBLKENT 

Select  Block  :  

Select  entities:   

(e.g.  Adds CADian   Text) 
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6.8 Objektumok törlése a blokkból 
 
 
 

Kitöröl bizonyos objektumokat a blokkból amelyek részei a beszúrt blokknak.   
 

 
 
 

Command:  REMOVEBLKENT 
 

 
 
 
 
 

6.9 Objektumok másolása a blokkban 
 
 
 

 Másol bizonyos objektumokat a blokkból amelyek részei a beszúrt blokknak egy másik helyre. 
 

 
 

Command:  COPYBLKENT 
 
 
 
 
 
 

6.10 Többszörösen beszúrt blokk szétvetése 
 
 
 

Szétvet egy blokkot, amely a MINSERT  paranccsal került beszúrásra. 
 

 
 

Command:  MULTBLOCKEXP Pr
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ba
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07 CADian 2012 segédletek - kiosztás 
 

 

7.1 Lineáris kiosztás 
 

 
 

Dinamikusan vonszolja a kiválasztott objektumot egy egyenes vonalon történő kiosztáshoz. 
 

(A kiosztási információt támogató súgó szöveg mérete részarányos a “PICKBOX” értékéhez.) 
 
 
 

Command  : LARRAY 

Select  entities:   

Array  Column  [Base] <10>:  5 
 

 

 
 

 
Array  Space <100>  : 800 

Linear  Array[Base/Column/Space/Rotatae/eXit]  Angle: <0.00>:  45 
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7.2 Körkörös kiosztás 
 
 
 

Körkörösen kiosztja a kiválasztott objektumot a vizuális megjelenítés mellett.  
 

 
 

Command:  PARRAY 

Select  entities:   

Select  entities: 

Center  Point:   

Item  Column  [Angle]  <4>:  10 
 
 

 
 
 

Draw Angle  (+=CCW,   -=CW)  <   360 >:  270 
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Polar  Array  [Base/Column/Angle/Drawangle/Row/RowSpace/ROtate/eXit]:  R 

Row <1>:  3 
 

 
 
 

 
 
 

Polar  Array  [Base/Column/Angle/Drawangle/Row/RowSpace/ROtate/eXit]:  RS 

Row Space <100>:  900 
 
 

 
 
 

Polar  Array  [Base/Column/Angle/Drawangle/Row/RowSpace/ROtate/eXit]:  X Pr
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7.3 Négyszögletes kiosztás 
 

 
Válassza ki azt az objektumot, amelyet kiosztani szeretne és vonszolja a kurzorral hogy dinamikusan 

megjelenítse az objektumot sorban és oszlopban. A felhasználó gyorsan használhatja a kiosztás (array) 

parancsot, amíg a monitort nézi. 

 
 

Command:  RARRAY 

Select  entities:   

Select  entities: 

Column  [Angle/Column]:  C 
 
 

 
 
 

Column  <3>:  4 

Row <1>:  3 
 
 

 
 
 

Column  Space[Space]:  S 

Column  Space [Length]  <2418.1>:  2400 

Row Space [Length]  <2418.1>:  3000 Pr
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Rectangular   Array   [Column/Row/Column   Space/Row Spece/Angle/ROTate/eXit]   <eXit>:   X 

or  

Click  

LMB 
 

 

* Ha a parancsot kilépésre kényszerítik mielőtt teljesen befejeződött, a kiosztás 

parancs nem lesz végrehajtva a rajzban.   
 
 
 
 

7.4 Görbe kiosztás 
 
 
 

Az objektumot dinamikusan, gyorsan kiosztja a kiválasztott görbe vonalon. 
 
 

❏ Zárt görbe nyitott intervalluma 

 

 
 

Command:  

CARRAY Select  

entities:  ,  

Select  entities: 

Select  Curve entity  :  

(Ha az alapértelmezett bázispont az objektum bázispontja . A bázis pont változtatásához, használj a 'Base' (bázis) opciót) Pr
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Column  [Base/StartPos/ROtate]  <10>:  4 

 
 

 
 

 
 
 

Column  Space [Full]  <3000>  : F 

Curve Array [Base/Column/Space/Row/RowSpace/ROtate/eXit]  <eXit>:    B 

Base Point:   

(A kiosztás lehet fentről lefelé,  a görbe kezdőpontjától függően.) Pr
ó

ba
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Curve Array [Base/Column/Space/Row/RowSpace/ROtate/eXit]  <eXit>:  RO 

 
 

 
 

 
 
 

Curve Array [Base/Column/Space/Row/RowSpace/ROtate/eXit]  <eXit>:  R 
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Row <1>:  2 
 
 

 
 

 

Curve Array [Base/Column/Space/Row/RowSpace/ROtate/eXit]  <eXit>:    X 
 

 

* Ha a parancsot kilépésre kényszerítik mielőtt teljesen befejeződött, a kiosztás parancs nem lesz 

 végrehajtva a rajzban.   
 
 

❏  Zárt görbe zárt intervalluma 

 
 

Command:  CARRAY 

Select  entities:  ,  

Select  entities: 

(If   a curved  object  is  a  circle,  the  default  base point  will  be 0  degree.  To change 

the  base point,  use SP   option.) 
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Column  [Base/StartPos/ROtate]<10>:  SP 

Start  Pos:   

Array Direction:   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Column  [Base/StartPos/ROtate]  <10>:  8 

Column  Space [Full]  <2352.47>:  F 

 

 
 

Curve Array [Base/Column/Space/Row/RowSpace/ROTate/eXit]  <eXit>:  X Pr
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7.5 Vektor kiosztás 
 

 
 

A kiosztás nem négyszög alakú hanem trapéz formájú.  
 
 
 

Command:  VARRAY 

Select  entities:   

Select  entities: 

Base Point:   

X Axis  Vector:   

Y Axis  Vector:   
 
 

 

 
 

Array Position  :  

(A parancs az objektumot virtuális gyémánt formában rendezi.) 
 
 

 
 

 
 

Vector Array  [Column/Row/ColumnSpace/RowSpace/eXit]:  R 

Row <4>:  3 Pr
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Vector Array  [Column/Row/ColumnSpace/RowSpace/eXit]:  R 

Column  Space [Length]  <5000>:  8000 
 
 

 
 

 
Vector  Array  [Column/Row/ColumnSpace/RowSpace/eXit]:  X 
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08   CADian 2012 segédletek - Méretek 
 

 

8.1 Hosszirányú méret  
 

 
Válasszon ki két pontot, ahol rögzíteni szeretné a távolságot, és mozgassa a kurzort a lenti kép szerint, 

ezután automatikusan változtatja a vízszintes, függőleges vagy ferde méretet.  Végül válasszon ki egy 

vertex-et, hogy befejezze a méret rőgzítését.  

 

 
Command:  LDIM 

 

 
 

 
 

 
 
 

8.2 Körkörös méret 
 
 
 

Automatikusan megrajzolja a vonalat, sugár vagy szög méreteket a szálkereszt helyén vagy opció beállítás, 

ha kiválaszt egy kört vagy ívet.   

 
❏ Kör 

 

Mint a lenti képen, a méretvonal formák függenek a szálkereszt helyétől.  Átmérőhöz vagy sugárhoz,  

gépeljen  “R”  vagy “D”  kulcsszót az automatikus módosításhoz.   

 

 

Command:  CDIM Pr
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ba
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❏ Ív 

 
 

Command:  CDIM 

Select  arc or circle:   
 
 
 
 
 
 
 
 
 
 
 

Specify dim ension line location [Diameter/Radius/Angular/arcLeng/Ch ordleng/eXit]: R 

(Módosítja a sugár méretet a következő ábra szerint.) 
 
 

 
 
 

Specify dimension line location [Diam eter/Radius/Angular/arcLeng/Ch ordleng/eXit]: A 

(Módosítja a szög méretet a következő ábra szerint.) 

 

 
 
 

Specify dimension line location [Diam eter/Radius/Angular/arcLeng/Ch ordleng/eXit]: L 

(Módosítja az ívhossz méretet a következő ábra szerint.) Pr
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Specify dimension line location [Diam eter/Radius/Angular/arcLeng/Ch ordleng/eXit]: C 

(Módosítja az ívhossz méretet a következő ábra szerint.) 
 
 

 
 

 
 

8.3 Objektum méret 
 

 
 

Ha kiválasztja az összes objektumot, amelyet mérettel akar jelölni, automatikusan megtalálja a 

szálkereszt helyen és felveszi a méretet.  

 

 

Command:  OBJDIM 

Select  entities  : ,  
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[Horizontal/Vertical/aliGned/Diameter/Radius/Angular/arcLeng/Chordleng/Intersect/ 

Pick/eXit]  <aliGnedDiameter>:   

(Egy virtuális méretvonalat folyamatosan rajzol a kurzor.)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

[Horizontal/Vertical/aliGned/Diameter/Radius/Angular/arcLeng/Chordleng/Intersect/ 

Pick/eXit]  <aliGnedDiameter>:  I 

(Amikor a vonalak metsződnek, a méretvonal automatikusan megáll a metsződésnél, de 
használva  a "I" opciót mellőzi a metsződést, továbbhalad a ponttól.) 

[Horizontal/Vertical/aliGned/Diameter/Radius/Angular/arcLeng/Chordleng/Intersect/ 

Pick/eXit]  <aliGnedDiameter>:   

(use  I   option  again  to  disable  the  feature.) 
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[Horizontal/Vertical/aliGned/Diameter/Radius/Angular/arcLeng/Chordleng/Intersect/ 

Pick/eXit]  <aliGnedDiameter>:  A 

(Amikor a kurzor az íven van,  a parancs automatikusan megméri az ív szögét.) 

[Horizontal/Vertical/aliGned/Diameter/Radius/Angular/arcLeng/Chordleng/Intersect/ 

Pick/eXit]  <aliGnedDiameter>:   

 
 

 

 
 

 
 
 

[Horizontal/Vertical/aliGned/Diameter/Radius/Angular/arcLeng/Chordleng/Intersect/ 

Pick/eXit]  <aliGnedDiameter>:  X 
 
 

Használhatja a funkció billentyűket a parancs alatt, hogy különböző méretstílust használjon.   
 

 
 
 

8.4  Körvonal méretezés 
 

 
Ez a parancs automatikusan megtalálja a kiválasztott objektumok külső méretének területét és rajzát. 

Mozgassa a szálkeresztet addig, míg a kívánt méretvonal nem látszik, és kattintson a méretvonal 

felvételhez.  A külső méretet bármikor lehet alkalmazni. Aktuális méretstílusa van. Pr
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Command:  OUTDIM 

Select  entities:  ,  

 

 
 

 
 

<Amikor az objektumot kiválasztotta, a virtuális méretvonalakat megrajzolja az objektum 

kontúr vonalának egy pontján.  A felhasználó átpozícionálhatja a méretvonalakat.  Amikor a 
változtatások megerősítésre kerülnek, a méreteket automatikusan megrajzolja.> 

 
Specify  dimension  line  location  [Continuous/Zigzag/Baseline/Stack/Ordinate/oriGin/ 

All/sIngle/Double/eXit]:  B 

* A méretvonalakat automatikusan átirányítja,  a bázisponttól függően.  Ha a bázispont nincs 

megerősítve,  a méretek nem lesznek  megrajzolva. 
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Specify  dimension  line  location  [Continuous/Zigzag/Baseline/Stack/Ordinate/oriGin/ 

All/sIngle/Double/eXit]:  I 

(Mint a következő ábrán,  a méretek csak abban az irányban vannak megrajzolva,  amerre a 

kurzor mutat.) 
 
 

 
 

 

Specify  dimension  line  location  [Continuous/Zigzag/Baseline/Stack/Ordinate/oriGin/ 

All/sIngle/Double/eXit]:  D 

(Mint a következő ábrán,   a méretek csak vízszintes és függőles  irányban vannak megrajzolva, 

amerre a kurzor mutat.) 
 
 

 
 

 

Specify  dimension  line  location  [Continuous/Zigzag/Baseline/Stack/Ordinate/oriGin/ 

All/sIngle/Double/eXit]:  G 

(A méretvonalak kezdőpontját elrendezi, mint  a lenti ábra mutatja.) 

Specify  dimension  line  location  [Continuous/Zigzag/Baseline/Stack/Ordinate/oriGin/ 

All/sIngle/Double/eXit]:  Z 

(A méretvonal szövegeket cikkcakk sorozatban elrendezi.  Ez az opció hasznos 

amikor a közök szűkek a méretek között. )Pr
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Specify  dimension  line  location  [Continuous/Zigzag/Baseline/Stack/Ordinate/oriGin/ 

All/sIngle/Double/eXit]:   

(A megerősítéshez válasszon ki egy pontot és lépjen ki a parancsból.) 
 

 
 

 
 

 
 
 

8.5  Görbék megjelenítési hossza 
 

 
 

Lenti képhez hasonlóan,  ha görbe vonalra kattint(vonallánc,  spline,  ellipszis),  automatikusan rajzol 

egy vonalat és sugarakat. (A szöveg nagyságra,  az aktuális méretstílus szöveg nagyságot alkalmazza 

(szöveg méret  x  méret lépték ”DIMSCALE”). 

 
 

❏  Amikor vonallánc van kiválasztva 

 

 
 

Command:  CURVELEN 

Length,RadiusAll/LEngth/Radius/Intersect/eXit]:   
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❏ Amikor egymást metsző objektumok vannak kiválasztva 

 
 

Command:  CURVELEN 

Length,  Radius  [All/LEngth/Radius/Intersect/eXit]:  I 

Intersect  [All/LEngth/Radius/Intersect/eXit]:     ,  

(Automatically  measures all  intersecting  points  for  an object.) 
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**Álnév lista 
 

 
Álnevek listája amelyet gyakran használnak 2D rajzoláshoz. 

Az álnév egy parancs amely a gyorsbillentyű parancsa.  A listázott álnevek alapértelmezett beállítások, 

de a felhasználó mindegyik álnevet szabadon testreszabhatja. 
 

A 
 

 Function Command  Alias Description 

Arc 

Area 

Array 

 ARC 

AREA 

ARRAY 

a 

aa 

ar 

  

 

B 

Function Command  Alias  Description 

Block BLOCK -b 
 

Boundary Polyline BPOLY 

Break BREAK br 
 

  

C 

 

Function Command  Alias Description 

Calculator CAL    

Center Snap CENTER    

Chamfer CHAMFER cha   

Change CHANGE -ch   

Change Properties CHPROP    

Circle CIRCLE c   

Clear Entity Snaps NONE    

Close Drawing CLOSE    

Color COLOR    

Command Bar CMDBAR    

Coordinate COORDINATE    

Copy Entity COPY co   

Copy Entity Data COPYEDATA    

Copy History COPYHIST    

Copy to Clipboard COPYCLIP    

Customize CUSTOMIZE    

Cut to Clipboard CUTCLIP    Pr
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Alias  List 

 

 

 

 
 

 
D 

 

Function Command  Alias Description 

Database List 

Define Attributes 

Define View 

Delay 

Delete 

Delete Entity Data 

Dimension 

DBLIST 

DDATTDEF 

DVIEW 

DELAY 

DELETE 

DELEDATA 

DIMENSION 

 
 
 
 
 
 
 
 
 

dim 

  

Dimension Aligned DIMALIGNED dal   

Dimension Angular 

Dimension Baseline 

Dimension Center Lines 

Dimension Continue 

Dimension Diameter 

Dimension Edit 

Dimension Leader 

Dimension Linear 

Dimension Ordinate 

Dimension Override 

Dimension Radius 

Dimension Reposition Text 

Dimension Rotated 

Dimension Settings 

Dimension Style 

Distance 

Divide 

Donut 

Dragmode 

Drawing Settings 

DXF In 

DXF Out 

DIMANGULAR 

DIMBASELINE 

DIMCENTER 

DIMCONTINUE 

DIMDIAMETER 

DIMEDIT 

DIMLEADER 

DIMLINEAR 

DIMORDINATE 

DIMOVERRIDE 

DIMRADIUS 

DIMTEDIT 

DIMLINEAR 

SETDIM 

DIMSTYLE 

DIST DIVIDE 

DONUT 

DRAGMODE 

SETTINGS 

DXFIN 

DXFOUT 

dan 

dba 

dce 

dco 

ddi 

ded 

le 

dli 

dor 

dov 

dra 

 
 
 

d 

dst 

di 

div 

do 

 

 
 

dn 

dx 
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E 

 

Function Command Alias Description 

Edit Attribute ATTEDIT -ate  

Edit Block Attributes DDATTE ate  

Edit Entity Data EDITEDATA   

Edit Length EDITLEN len  

Edit Polyline EDITPLINE pe  

Edit Text DDEDIT ed  

Elevation ELEVATION   

Ellipse ELLIPSE el  

Elliptical Arc ELLIPSE   

Endpoint Snap ENDPOINT   

Entity Snap  Precision APERTURE   

Entity Snap  Settings SETESNAP os  

Entity Snaps ESNAP -os  

Erase ERASE e  

Exit EXIT   

Explode EXPLODE x  

Explore Blocks EXPBLOCKS b  

Explore Coordinate Systems EXPUCS dducs  

Explore Dimension Styles EXPDIMSTYLES ds  

Explore Layers EXPLAYERS la  

Explore Linetypes EXPLTYPES   

Explorer EXPLORER   

Explore Text Styles EXPFONTS   

Explore Views EXPVIEWS v  

Export EXPORT exp  

Extend EXTEND ex  

External Reference XREF   

Extract Attributes DDATTEXT   Pr
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F 

Function Command  Alias  Description 

Fill                                                  FILL 

Fillet                                               FILLET                   f 

Filter                                               FILTER                   fi 

Flatten                                            FLATTEN 

Font                                                FONT                      st 

Freehand                                        FREEHAND 

 
G 

Function  Alias  Description 
 

Graphics  Screen GRAPHSCR  

Grid GRID g 

 

H 

Function Command  Alias  Description 

Hatch HATCH h 

Help HELP 

 
I 

Function Command  Alias  Description 

ID  Coordinates IDPOINT id 

Import                                            IMPORT 

Infinite Line                                  INFLINE 

Insert                                              INSERT 

Insert Block DDINSERT i 

Insert Object INSERTOBJ io 

Insertion Point Snap INSERTION 

Intersection Snap INTERSECTION 

Isometric Plane ISOPLANE is 

 

J 

Function Command  Alias  Description 

Join JOIN Pr
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L 

 

Function Command  Alias Description 

Layer 

Limits 

Line 

Linetype 

Linetype Scale 

Links 

List Entity Information 

Load Application 

LAYER 

LIMITS 

LINE 

LINETYPE 

LTSCALE 

OLELINKS 

LIST 

APPLOAD 

 
 
 

l 
 

 
 
 
 

li 

  

   

M 
  

Function 

Mail 

Marker Blips 

Measure 

Menu 

Menu Load 

Menu Unload 

Midpoint Snap 

Mirror 

Command 

MAIL 

BLIPMODE 

MEASURE 

MENU 

MENULOAD 

MENUUNLOAD 

MIDPOINT 

MIRROR 

 
 

 
bm 

 

 
 
 
 
 
 
 

mi 

Alias Description 

Model Space Toggle 

Move 

Move  Entity Data 

Multiline Text 

Multiple 

Multiple Insert 

MSPACE 

MOVE 

MOVEEDATA 

MTEXT 

MULTIPLE 

MINSERT 

ms 

m 

 
mt 

  

   

N 
  

Function Command  Alias Description 

Nearest Snap 

New  Drawing 

NEAREST 

NEW 

 

 
n 

 

New  Drawing  Wizard NEWWIZ ddnew  Pr
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O 

Function Command  Alias  Description 

Open Drawing OPEN op 

Options CONFIG pr 

Orthogonal ORTHOGONAL or 
 

 
P 

 

Function Command  Alias Description 

Pan PAN p   

Paper Space Toggle PSPACE ps   

Paper Space Views MVIEW    

Parallel PARALLEL    

Paste from Clipboard PASTECLIP o   

Paste Special PASTESPEC pa   

Perpendicular Snap PERPENDICULAR    

Plan View PLAN    

Plan View  Intersection Snap PLANVIEWINT    

Plane PLANE so   

Point POINT po   

Point Snap NODE    

Polygon POLYGON pol   

Polyline POLYLINE pl   

Print PRINT    

Print Preview PPREVIEW pre   

Print Setup PSETUP    

Prompt History Window PMTHIST    

Properties ENTPROP mo   

Purge PURGE    

 

Q 

Function Command  Alias  Description 

Quadrant Snap QUADRANT 

Quick Print QPRINT 

Quick Save QSAVE 

Quick  Snap QUICK 

Quick Text QTEXT qt Pr
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R 

 

Function Command  Alias Description 

Ray RAY    

Rectangle RECTANGLE rec   

Redo REDO    

Redraw REDRAW r   

Redraw All REDRAWALL ra   

Regenerate REGEN re   

Regenerate All REGENALL rea   

Regenerate Automatically REGENAUTO    

Rename RENAME -ren   

Rotate ROTATE 
ro 

 

 
 

S 
 

Function Command   Alias Description 

Save SAVE  sa   

Save All SAVEALL     

Save As SAVEAS     

Save Block WBLOCK  w   

Scale SCALE  sc   

Scroll Bars SCROLLBAR     

Select SELECT     

Select All SELGRIPS     

Select Color SETCOLOR  col   

Set Layer by  Entity SETLAYER     

Set UCS SETUCS     

Snap SNAP     

Spelling SPELL  sp   

Spline SPLINE  spl   

Status STATUS     

Status Bar STATBAR     

Stretch STRETCH  s   

System Windows SYSWINDOWS     Pr
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T 

 

Function Command  Alias Description 

Tangent Snap TANGENT    

Text (Paragraph) DTEXT dt   

Text (Single Line) TEXT    

Thickness THICKNESS    

Time Variables TIME ti   

Toolbar TOOLBAR    

Toolbar Configuration TBCONFIG to   

Trim TRIM th   

Tip of  the Day TIPOFDAY    

Tolerance TOLERANCE tol   

 

U 

Function Command  Alias  Description 

UCS                                                UCS 

UCS Icon                                      UCSICON 

Undelete                                         UNDELETE            oo 

Undo                                              U 

Undo  Multiple                               UNDO 

Units                                               UNITS                     -un 

 
V 

Function Command  Alias  Description 

Variable Settings                          SETVAR                 set 

View  Control VIEWCTL 

View  Resolution VIEWRES 

View  Save/Restore                       VIEW                      -v 

View  Snapshot                              VSNAPSHOT         vs 

Viewpoint                                      VIEWPOINT 

Viewport Layer Control              VPLAYER              vl 

Viewports VIEWPORTS 

Visible Intersection Snap VISIBLE Pr
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W 

Function Command  Alias  Description 

Window Cascade WCASCADE 

Window Close WCLOSE 

Window Close All WCLOSEALL 

Window New WOPEN 

Workspaces PMSPACE 

 

Z 

Function Command  Alias  Description 

Zoom ZOOM z 
 

 
 
 

* A CADian  2012 nem tartalmazza az összes listában lévő álnevet.  

Amikor a felhasználó már járatos az álnevek használatában,  a rajzolási folyamat felgyorsul és a 

felhasználó sok időt takarít meg.   

 
*  Az információk a CADian 2012 segédprogram használatához kötött előzetes értesítés nélkül változhatnak a 

funkció és a minőség javítása véget a termék kezelési kézikönyvében. 

 
*  Autodesk és az AutoCAD bejegyzett védjegyei vagy védjegyei az Autodesk Inc-nek., az Egyesült Államokban és 

más országokban. 

 

* DWG  természetes fájlformátuma az Autodesk  AutoCAD®  szoftvernek és védjegyye  az 

Autodesk  Inc-nek. 

* CADianSoft nem leányvállalata az  Autodesk  Inc-nek. 
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